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Preface

Welcome to the Oracle Trade Management Implementation Guide, Release 11i.

This guide assumes you have a working knowledge of the following:

■ The principles and customary practices of your business area.

■ The Oracle Trade Management application.

If you have never used Oracle Trade Management, Oracle suggests you attend 
one or more of the Oracle Applications training classes available through Oracle 
University.

■ Oracle Self-Service Web Applications. 

To learn more about Oracle Self-Service Web Applications, read the Oracle 
Self-Service Web Applications Implementation Manual.

■ The Oracle Applications graphical user interface.

To learn more about the Oracle Applications graphical user interface, read the 
Oracle Applications User’s Guide.

See "Other Information Sources" for additional Oracle Applications product 
information.
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How To Use This Guide
The Oracle Trade Management Implementation Guide contains the information you 
need to understand and use Oracle Trade Management. This guide contains seven 
chapters and five appendixes:

■ Chapter 1: Provides an overview of Oracle Trade Management, its features and 
functions, and features new in this release. 

■ Chapter 2: Describes how to implement the mandatory and optional 
prerequisites for the Oracle E-Business Suite.

■ Chapter 3: Describes how to implement the Oracle Trade Management 
prerequisites. 

■ Chapter 4: Shows how to implement Budgets.

■ Chapter 5: Details how to implement Trade Planning.

■ Chapter 6: Provides procedural tasks for implementing Claims.

■ Chapter 7: Show how to implement Indirect Sales.

■ Appendix A: Provides a list of the Oracle Trade Management system profile 
options.

■ Appendix B: Presents a summary of Oracle Trade Management lookups.

■ Appendix C: Details Oracle Trade Management concurrent programs.

■ Appendix D: Describes seeded user statuses. 

■ Appendix E: Lists Claim Interface tables. 

Documentation Accessibility 
Our goal is to make Oracle products, services, and supporting documentation 
accessible, with good usability, to the disabled community. To that end, our 
documentation includes features that make information available to users of 
assistive technology. This documentation is available in HTML format, and contains 
markup to facilitate access by the disabled community. Standards will continue to 
evolve over time, and Oracle is actively engaged with other market-leading 
technology vendors to address technical obstacles so that our documentation can be 
accessible to all of our customers. For additional information, visit the Oracle 
Accessibility Program Web site at http://www.oracle.com/accessibility/. 
xvi



Accessibility of Code Examples in Documentation
JAWS, a Windows screen reader, may not always correctly read the code examples 
in this document. The conventions for writing code require that closing braces 
should appear on an otherwise empty line; however, JAWS may not always read a 
line of text that consists solely of a bracket or brace.
xvii



Other Information Sources
You can choose from many sources of information, including online documentation, 
training, and support services, to increase your knowledge and understanding of 
Oracle Trade Management.

If this guide refers you to other Oracle Applications documentation, use only the 
Release 11i versions of those guides.

Online Documentation
All Oracle Applications documentation is available online (HTML or PDF).

■ PDF Documentation- See the Documentation CD provided with each release 
for current PDF documentation for your product. This Documentation CD is 
also available on OracleMetaLink and is updated frequently.

■ Online Help - You can refer to Oracle iHelp for current HTML online help for 
your product. Oracle provides patchable online help, which you can apply to 
your system for updated implementation and end user documentation. No 
system downtime is required to apply online help.

■ 11i Release Content Document - Refer to the Release Content Document for 
new features listed release. The Release Content Document is available on 
OracleMetaLink.

■ About document - Refer to the About document for patches that you have 
installed to learn about new documentation or documentation patches that you 
can download. The new About document is available on OracleMetaLink.

Related Documentation
Oracle Trade Management shares business and setup information with other Oracle 
Applications products. Therefore, you may want to refer to other guides when you 
set up and use Oracle Trade Management.

You can read the guides online by choosing Library from the expandable menu on 
your HTML help window, by reading from the Oracle Applications Document 
Library CD included in your media pack, or by using a Web browser with a URL 
that your system administrator provides.

If you require printed guides, you can purchase them from the Oracle Store at 
http://oraclestore.oracle.com.
xviii



Guides Related to All Products

Oracle Applications User’s Guide
This guide explains how to enter data, query, run reports, and navigate using the 
graphical user interface (GUI). This guide also includes information on setting user 
profiles, as well as running and reviewing reports and concurrent processes.

You can access this user’s guide online by choosing "Getting Started with Oracle 
Applications" from any Oracle Applications help file.

Guides Related to This Product

Oracle Trade Management User Guide
This guide provides user information for Oracle Marketing implementation. This 
document includes user procedures for creating campaigns, budgets, lists, list 
import, data sources, and eMerchandising. 

Oracle Advanced Pricing User Guide
Implementers need this guide to set up pricing features of Oracle Trade 
Management.

Oracle Business Intelligence System Implementation Guide
This guide outlines the steps required to create the End User Layer (EUL) and 
import EUL Export File (EEX) for Oracle Discoverer.

Oracle General Ledger User Guide
This guide provides information on setting up Oracle General Ledger, a 
dependency for Oracle Trade Management budgets.

Oracle Inventory User’s Guide
This guide provides information on setting up Oracle Inventory, a mandatory 
dependency for Oracle Trade Management. 

Oracle Receivables User Guide
This guide provides information on setting up Oracle Receivables, a mandatory 
dependency for Oracle Trade Management. 
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Oracle Receivables Tax Manual
This manual provides information about calculating tax. It covers implementation 
procedures, setup forms and windows, the Oracle Receivables tax calculation 
process, tax reports and listings, and tax-specific open interfaces.

Using Oracle HRMS - The Fundamentals
This guide provides information on using Oracle Human Resources, a mandatory 
dependency for Oracle Marketing. 

Oracle Common Application Components Implementation Guide
This guide provides an overview of what you need to have installed, implemented, 
and verified before implementing the Oracle Trade Management. Some foundation 
components are required, others are optional, see specific Oracle Trade 
Management implementation tasks for details. 

Installation and System Administration

Oracle Applications Concepts
This guide provides an introduction to the concepts, features, technology stack, 
architecture, and terminology for Oracle Applications Release 11i. It provides a 
useful first book to read before an installation of Oracle Applications. This guide 
also introduces the concepts behind Applications-wide features such as Business 
Intelligence (BIS), languages and character sets, and Self-Service Web Applications.

Installing Oracle Applications
This guide provides instructions for managing the installation of Oracle 
Applications products. In Release 11i, much of the installation process is handled 
using Oracle Rapid Install, which minimizes the time to install Oracle Applications, 
the Oracle8 technology stack, and the Oracle8i Server technology stack by 
automating many of the required steps. This guide contains instructions for using 
Oracle Rapid Install and lists the tasks you need to perform to finish your 
installation. You should use this guide in conjunction with individual product 
user’s guides and implementation guides.

Maintaining Oracle Applications
Use this set of guides to help you run the various AD utilities, such as 
AutoUpgrade, AutoPatch, AD Administration, AD Controller, AD Relink, License 
Manager, and others. It contains how-to steps, screenshots, and other information 
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that you need to run the AD utilities. This guide also provides information on 
maintaining the Oracle applications file system and database.

Oracle Applications System Administrator’s Guide
This guide provides planning and reference information for the Oracle Applications 
System Administrator. It contains information on how to define security, customize 
menus and online help, and manage concurrent processing.

Oracle Alert User’s Guide
This guide explains how to define periodic and Event alerts to monitor the status of 
your Oracle Applications data.

Oracle Applications Developer’s Guide
This guide contains the coding standards followed by the Oracle Applications 
development staff. It describes the Oracle Application Object Library components 
needed to implement the Oracle Applications user interface described in the Oracle 
Applications User Interface Standards for Forms-Based Products. It also provides 
information to help you build your custom Oracle Forms Developer 6i forms so that 
they integrate with Oracle Applications.

Other Implementation Documentation

Multiple Reporting Currencies in Oracle Applications
If you use the Multiple Reporting Currencies feature to record transactions in more 
than one currency, use this manual before implementing Oracle Trade Management. 
This manual details additional steps and setup considerations for implementing 
Oracle Trade Management with this feature.

Multiple Organizations in Oracle Applications
This guide describes how to set up and use Oracle Trade Management with Oracle 
Applications' Multiple Organization support feature, so you can define and support 
different organization structures when running a single installation of Oracle Trade 
Management.

Oracle Workflow Administrator's Guide
This guide explains how to complete the setup steps necessary for any Oracle 
Applications product that includes workflow-enabled processes, as well as how to 
monitor the progress of runtime workflow processes.
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Oracle Workflow Developer's Guide
This guide explains how to define new workflow business processes and customize 
existing Oracle Applications-embedded workflow processes. It also describes how 
to define and customize business Events and Event subscriptions.

Oracle Workflow User's Guide
This guide describes how Oracle Applications users can view and respond to 
workflow notifications and monitor the progress of their workflow processes.

Oracle Applications Flexfields Guide
This guide provides flexfields planning, setup and reference information for the 
Oracle Trade Management implementation team, as well as for users responsible for 
the ongoing maintenance of Oracle Applications product data. This manual also 
provides information on creating custom reports on flexfields data.

Oracle eTechnical Reference Manuals
Each eTechnical Reference Manual (eTRM) contains database diagrams and a 
detailed description of database tables, forms, reports, and programs for a specific 
Oracle Applications product. This information helps you convert data from your 
existing applications, integrate Oracle Applications data with non-Oracle 
applications, and write custom reports for Oracle Applications products. Oracle 
eTRM is available on Metalink

Oracle Manufacturing APIs and Open Interfaces Manual
This manual contains up-to-date information about integrating with other Oracle 
Manufacturing applications and with your other systems. This documentation 
includes APIs and open interfaces found in Oracle Manufacturing.

Oracle Order Management Suite APIs and Open Interfaces Manual
This manual contains up-to-date information about integrating with other Oracle 
Manufacturing applications and with your other systems. This documentation 
includes APIs and open interfaces found in Oracle Order Management Suite.

Oracle Applications Message Reference Manual
This manual describes Oracle Applications messages. This manual is available in 
HTML format on the documentation CD-ROM for Release 11i.
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Oracle Common Application Components Implementation Guide
Many E-Business Suite products common components from the Application 
Foundation. Use this guide to correctly implement the Application Foundation.
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Training and Support

Training
Oracle offers a complete set of training courses to help you and your staff master 
Oracle Trade Management and reach full productivity quickly. These courses are 
organized into functional learning paths, so you take only those courses appropriate 
to your job or area of responsibility.

You have a choice of educational environments. You can attend courses offered by 
Oracle University at any one of our many education centers, you can arrange for 
our trainers to teach at your facility, or you can use Oracle Learning Network 
(OLN), Oracle University's online education utility. In addition, Oracle training 
professionals can tailor standard courses or develop custom courses to meet your 
needs. For example, you may want to use your organization structure, terminology, 
and data as examples in a customized training session delivered at your own 
facility.

Support
From on-site support to central support, our team of experienced professionals 
provides the help and information you need to keep Oracle Trade Management 
working for you. This team includes your technical representative, account 
manager, and Oracle’s large staff of consultants and support specialists with 
expertise in your business area, managing an Oracle server, and your hardware and 
software environment.

OracleMetaLink
OracleMetaLink is your self-service support connection with web, telephone menu, 
and e-mail alternatives. Oracle supplies these technologies for your convenience, 
available 24 hours a day, 7 days a week. With OracleMetaLink, you can obtain 
information and advice from technical libraries and forums, download patches, 
download the latest documentation, look at bug details, and create or update TARs. 
To use MetaLink, register at (http://metalink.oracle.com).

Alerts: You should check OracleMetaLink alerts before you begin to install or 
upgrade any of your Oracle Applications. Navigate to the Alerts page as follows: 
Technical Libraries/ERP Applications/Applications Installation and 
Upgrade/Alerts.

Self-Service Toolkit: You may also find information by navigating to the 
Self-Service Toolkit page as follows: Technical Libraries/ERP 
Applications/Applications Installation and Upgrade.
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Do Not Use Database Tools to Modify Oracle Applications Data
Oracle STRONGLY RECOMMENDS that you never use SQL*Plus


, Oracle Data 

Browser, database triggers, or any other tool to modify Oracle Applications data 
unless otherwise instructed.

Oracle provides powerful tools you can use to create, store, change, retrieve, and 
maintain information in an Oracle database. But if you use Oracle tools such as 
SQL*Plus to modify Oracle Applications data, you risk destroying the integrity of 
your data and you lose the ability to audit changes to your data.

Because Oracle Applications tables are interrelated, any change you make using 
Oracle Applications can update many tables at once. But when you modify Oracle 
Applications data using anything other than Oracle Applications, you may change a 
row in one table without making corresponding changes in related tables. If your 
tables get out of synchronization with each other, you risk retrieving erroneous 
information and you risk unpredictable results throughout Oracle Applications.

When you use Oracle Applications to modify your data, Oracle Applications 
automatically checks that your changes are valid. Oracle Applications also keeps 
track of who changes information. If you enter information into database tables 
using database tools, you may store invalid information. You also lose the ability to 
track who has changed your information because SQL*Plus and other database 
tools do not keep a record of changes.

About Oracle
Oracle develops and markets an integrated line of software products for database 
management, applications development, decision support, and office automation, 
as well as Oracle Applications, an integrated suite of more than 160 software 
modules for financial management, supply chain management, manufacturing, 
project systems, human resources and customer relationship management.

Oracle products are available for mainframes, minicomputers, personal computers, 
network computers and personal digital assistants, allowing organizations to 
integrate different computers, different operating systems, different networks, and 
even different database management systems, into a single, unified computing and 
information resource.

Oracle is the world’s leading supplier of software for information management, and 
the world’s second largest software company. Oracle offers its database, tools, and 
applications products, along with related consulting, education, and support 
services, in over 145 countries around the world.
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About Oracle Trade Manage
1

About Oracle Trade Management

Oracle Trade Management empowers many areas of a manufacturer's business to 
operate more effectively by providing closed-loop planning and execution. Oracle 
Trade Management further helps manufacturers to get the greatest impact from 
marketing, sales, co-op, and trade promotion campaigns across the entire demand 
chain. Oracle Trade Management is designed to improve the return on investment 
for B2B interactions.

Oracle Trade Management provides an integrated solution addressing four 
functional areas critical to B2B interactions: 

■ Budget management: Efficient and cohesive budgeting and financial 
processing. This eliminates wasteful spending and ensures trade funding is 
allocated and being utilized as intended. 

■ Promotional planning and execution: Enables manufacturers to improve their 
management of trade spending. 

■ Deduction management: Reduces and controls short-payment problems.

■ Chargebacks: Monitor and verify chargebacks for wholesalers and third parties. 

Oracle Trade Management functionality is grouped into four categories to handle 
these four functional areas. These categories are explained in more detail in these 
sections.

■ Section 1.1, "Budgets"

■ Section 1.2, "Trade Planning"

■ Section 1.3, "Claims"

■ Section 1.4, "Indirect Sales Management"
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Budgets
This first release of Oracle Trade Management as a separate product contains many 
new features that it did not have when it was part of Oracle Marketing. See 
Section 1.5.1, "New Features" for more information.

1.1 Budgets
Oracle Trade Management’s budget management functionality provides a central 
repository for sales, marketing and partnering fund usage. This assists a company 
in maintaining control over spending.

See Section 1.5.3, "Budget Enhancements" for Budget enhancements in this release.

The key features of Oracle Trade Management’s budget management are:

■ Order Channel Integration: Oracle Trade Management automatically retrieves 
promotional expenses and accruals calculated based on sales orders entered 
from all ordering channels such as Oracle Order Management, Oracle iStore, 
and Oracle Quoting.

■ Accrual Management and Oracle General Ledger Integration: After Oracle 
Trade Management retrieves order information, it further handles adjustments 
by automatically calculating changes to accruals based on:

– Return order

– Changes to volume rebate offer

– Accruals based on cumulative sales volume changes

– Spreading of lump sum offer accruals

– Scan data promotion accrual changes 

■ Discount Expense Management and Oracle General Ledger Integration: After 
Oracle Trade Management retrieves order information, it further handles 
adjustments by automatically calculating changes to discount expenses based 
on:

– Return order

– Changes to volume rebate offer

■ Tracking Budget Balances: Sales and marketing teams can flexibly track budget 
balances by category, product or brand, customer, geography, or sales territory. 
Budget available balance, planned amount, and customers’ earned (accrued) 
versus paid balance are all tracked separately.
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Trade Planning
■ Top Down Bottom Up Budgeting: Budget is allocated to various users within a 
territory hierarchy based on the territory's historical sales data. The budgeting 
process in Oracle Trade Management also enables users to submit feedback or 
negotiate a different allocation.

1.2 Trade Planning
Trade planning enables a user to create, plan, and execute promotional deals (also 
known as Offers). Trade planning provides trade professionals with the necessary 
tools to enable fact-based decision making. With a well informed business rationale, 
trade strategies can be precisely executed for promotional activities.

See Section 1.5.2, "Trade Planning Enhancements" for Trade Planning enhancements 
in this release.

The key features of Oracle Trade Management’s Trade Planning are:

■ Account Planning: Enables sales representatives to analyze their customers’ 
historical sales and promotion performance and plan for future activities with 
those accounts. 

■ Quota and Target Allocation: Enables sales management to allocate sales 
quotas through all sales territories based on prior year sales. Enables sales 
representatives to set targets over time across their accounts and products to 
more effectively plan to achieve their quotas, and to automate this process.

■ Forecasting: Enables offer users, such as sales representatives or trade 
marketers, to forecast the impact of a promotion on sales volume, based on 
historical sales, viewed by time, market, or product.

■ Manufacturer ROI Calculator: Enables offer users, such as sales representatives 
or trade marketers, to forecast the ROI for their promotions based on forecast 
sales volume.

■ Product Creation: Inventory access enables product and product bundle 
creation. 

■ Offer Discounts: Enables targeted offers for customers and products. 

■ Offers and Campaign Association: Enables companies to coordinate offers 
with marketing campaigns. 

■ Applying Offers Automatically: Enables companies to automatically give 
customers order discounts, ultimately minimizing pricing disputes. 
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Claims
■ Order and Promotion Updates: Enables companies to record sales orders and 
promotional expenses into the budget, enabling a real-time view of the market.

■ Performance Tracking and Validation: Enables sales representatives or trade 
marketers to track the activities a customer is required to perform in order to 
qualify for a promotion. The system automatically validates activities based on 
the customer’s purchase volume, however, activities such as advertisements or 
in-store displays run by a customer must be manually verified. The customer 
may submit a copy of an advertisement or a photo of an in-store display, or a 
sales representative can verify it upon a store visit.

■ Capturing Customer and Competitor Pricing Information: Enables sales users 
to capture information on how a customer prices and displays the company’s 
products, along with how the customer prices and displays the competitor’s 
products. Such data provides valuable information on the market and the 
competitive landscape and may be used by the company as the basis for other 
analysis.

1.3 Claims
Oracle Trade Management enables users to manage processes required for claim 
reconciliation, deductions or overpayments. Oracle Trade Management helps you 
research, validate, and settle claims.

See Section 1.5.4, "Claim Enhancements" for Claim enhancements in this release.

The key features of Oracle Trade Management’s Claims management are:

■ Auto-Resolution: Enables resolution of deductions and overpayments. When a 
deduction or overpayment is recognized, Oracle Receivables automatically 
creates a deduction/overpayment in Oracle Trade Management. 

■ Contra Charge Settlement: Enables offsetting Accounts Receivable and 
Accounts Payable balances.

■ Claims Management: Claims created in Oracle Trade Management are 
associated to promotional accruals, settled automatically by check, credit memo 
or RMA. 

■ Autopay: When settling autopay claims, Oracle Trade Management integrates 
with ERP financial applications for settlement. Oracle Trade Management 
integrates with Oracle General Ledger to provide accounting entries for 
promotional accruals. 
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Indirect Sales Management
■ Promotional Payments: Provides the ability to associate customer accruals to 
claims payments by check or credit. It also enables viewing of customer 
balances (earned versus paid).

■ Task Management: Allows claims users to manage necessary research tasks. 
Workflow notifications alert assignees of their tasks.

■ Claims Aging: Groups claims and deductions in different aging buckets, so that 
claims users and managers can view how much in claims and deductions is 
outstanding for each customer.

■ Discoverer Tool: Used as a research tool, promotional accrual information is 
displayed providing valuable views, such as a customer's 360 degree view and 
a Claims Aging view.

1.4 Indirect Sales Management
The Indirect Sales Management module enables you to validates requests from 
retailers and wholesalers (or dealers and distributors), and manage and track funds 
when trade promotion activities are executed indirectly through retailers and 
wholesalers.

See Section 1.5.5, "Indirect Sales Enhancements" for Indirect sales enhancements in 
this release.

The key features of Oracle Trade Management’s Indirect Sales Management are:

■ Chargebacks: When a wholesaler sells products to retailers or end users, if the 
price is lower than the price the wholesaler paid to purchase the products from 
the manufacturer, the wholesalers can claim the difference between their 
purchase price and selling price from the manufacturer.

■ Third Party Accruals: When retailers buy products from wholesalers, they 
might not get the discounts that they are entitled to if they buy directly from the 
manufacturer. The manufacturer can accrue these discounts for the retailers 
based on the data that wholesalers send through Third Party Accrual.

■ Indirect Inventory Tracking: Trade Management allows companies to track 
their customers' (distributors') inventory level. Automated tracking is based on 
Order Management integration and the indirect sales data submissions. Users 
can also make adjustments to any time period based on any reason.

■ Special Pricing: Retailers or wholesalers may request a special price or discount 
from a manufacturer in order to dispose of existing inventory, meet a 
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New in This Release
competitor’s price, or win a deal for an existing customer. The manufacturer 
can use Special Pricing to pay the retailers the discount based on these requests.

■ Soft Funds: Retailers or wholesalers may request a budget in order to execute 
trade promotion activities on behalf of the manufacturer.

■ Referral Management: Referral Management is a feature in Partner 
Management that integrates with Oracle Trade Management. In the 
background, it creates a net accrual offer and in Referral Compensation it 
creates a claim in the background for payment. A claim is sent for partner 
acceptance after Claims approvals but before settlement. 

1.5 New in This Release
The current release of Oracle Trade Management includes a few new features, and 
enhancements to the existing features.

Topics included are:

■ Section 1.5.1, "New Features"

■ Section 1.5.2, "Trade Planning Enhancements"

■ Section 1.5.3, "Budget Enhancements"

■ Section 1.5.4, "Claim Enhancements"

■ Section 1.5.5, "Indirect Sales Enhancements"

1.5.1 New Features
The following sections describe the new features in this release.

Quota and Target Allocation
Quota is the total sales target (money or quantity of products) that must be achieved 
in a specific time period. Quota Allocation is the process by which you can allocate 
sales targets to individual Sales Representatives of different territories.

Target allocation is the process whereby targets are automatically allocated to the 
customer accounts of the sales representatives. The target allocation is automatically 
generated based on the sales figures during the same period in the previous year. If 
you are a Sales Representative, then you can track the total target allocated by the 
Sales Management, and analyze the same. The Sales Management can view the 
target allocation and the performance of individual Sales Representatives.
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New in This Release
The Administrator can create threshold rules, which highlight any exceptional 
conditions through alerts and notifications. Alerts appear either as workflow 
notifications, or as dashboard alerts.

The quota and target allocation functionality enables you to:

■ Define product eligibility for a quota

■ Create quotas based on previous year sales data

■ Add thresholds to a quota

■ Create quota allocations

■ Allocate targets by accounts and by products

Account Manager Dashboard
Account Manager Dashboard in Oracle Trade Management is an integrated 
planning and controlling tool that enables sales representatives to effectively 
monitor and manage their accounts. Using the Account Manager Dashboard, a sales 
representative can:

■ Create an account plan for each account based on different time periods to plan 
for all the promotions he will run.

■ Use historical sales analysis as well as current sales performance reports,to 
better analyze past performance to design future promotions, as well as to 
monitor current performance to ensure sales objectives are met. 

■ Evaluate promotional lift before execution, based on forecast volume and price 
and cost information.

■ Automatically calculate discounts based on user inputs on manufacturer's 
suggested retail price and the retailers' margin requirements. 

■ Monitor retailers' performance, competitors' pricing and positioning and 
product shelf facing information, by capturing data from thousands of sales 
people in a central repository, and then using it for further research and 
analysis. 

■ Access other Oracle Trade Management tools such as Quota and Target 
Allocations, Forecasting and Promotional Calendar in Gantt Chart format, 
further facilitating the planning and analysis processes. 
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New in This Release
Account and Activity Planning
An account plan gives you an overall view of the activities related to a customer 
account. You can access information such as marketing promotions, outstanding 
claims, competitive products, and all other activities that are related to the customer 
account. Tools such as the Offer Evaluator, Offer Worksheet, and Discount 
Calculator enable you to forecast, plan, create, and evaluate trade promotion 
activities such as offers and campaigns, and evaluate potential returns. You can 
generate graphs based on different account and product combinations. Retail 
Monitoring enables you to capture retail pricing and competitive intelligence.

Indirect Sales Data Import
Any indirect sales or point of sales (POS) data can be imported into the system 
using XML Gateway or the WebADI tool.

Chargeback
Chargeback in Oracle Trade Management enables companies to process rebates and 
chargeback claims for their customers and their wholesaler network. You can 
calculate the earnings and initiate payment for each transaction batch or for 
multiple batches. You can validate the chargeback transactions, and either process 
or reject the transactions based on whether they are valid or invalid. By automating 
the whole process, companies can minimize discrepancies in chargeback requests 
and reduce time required to process chargeback adjustments.

Indirect Inventory Tracking
The inventory levels of wholesalers can be automatically tracked in Oracle Trade 
Management. You can track the quantity of products that wholesalers have 
purchased from your organization and the quantity of products that they have sold, 
and also make adjustments to the wholesalers’ inventory levels.

Oracle Partner Management Business Flow Support
Special Pricing, Soft Funds, and Referrals are features that are available in Oracle 
Partner Management. Oracle Trade Management supports Oracle Partner 
Management business flow such that whenever there are any requests related to 
Special Pricing, Soft Funds, and Referrals, funds are sourced from budgets in Oracle 
Trade Management. Offers and claims are automatically created in, and settled 
through Oracle Trade Management by the claims user.

■ Special Pricing
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New in This Release
Partners can request special pricing from a portal for three types of special 
pricing - Meet Competitor Quote, Blanket Request, and Bid Request. The 
process of submitting, and approving requests is managed through Oracle 
Partner Management. See Section 7.6, "Special Pricing Requests" for more 
information.

■ Soft Funds

In the earlier releases, manufacturers were able to manage the soft funds by 
using the budgets and offers functionality. In this release, partners can also 
manage the whole process through Oracle Partner Management. See 
Section 7.7, "Soft Fund Requests" for more information.

■ Referrals

A partner (retailer or wholesaler) can refer a business prospect, lead, or an 
opportunity to a vendor (manufacturer). If the referral results in an order, the 
partner can claim incentive for the referral.

1.5.2 Trade Planning Enhancements
The offer enhancements in this release include the following:

■ Autopay for offers

Autopay enables you to specify the payout date and payment method for 
Autopay at the offer level.

■ Volume-based performance requirements

The performance requirements functionality has been enhanced to enable you 
to structure trade deals with performance requirements that are based on 
volume and value. You can create incentives that have quantifiable objectives, 
and this increases the predictability of an offer.

■ Offer adjustment enhancement

The Offer Adjustment functionality has been enhanced to support unlimited 
backdating functionality.

■ Net Accrual offer

Net Accrual offer is a new type of offer, which bypasses Oracle Advanced 
Pricing. It directly processes order transactions data and applies accruals based 
on the net sales of the specified product, or for the specified customer.
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New in This Release
1.5.3 Budget Enhancements
The budget enhancements in this release include the following:

■ Profile-driven Oracle General Ledger postings

In this release of Oracle Trade Management, Oracle General Ledger entries for 
accruals are created based on a profile option setting. The setting can be either 
Ship Confirmed or Invoiced.

■ Additional earned column with Oracle General Ledger postings tracking

The price adjustments and accruals that are estimated before the order is 
ship-confirmed are tracked in the Utilized column. An extra column called 
Earned tracks all the adjustments and accruals based on the status of the order. 
The Oracle General Ledger postings can be viewed by certain types of users for 
better tracking and reconciliation purposes.

■ Option to post off-invoice discounts

This is an option to account for discounts that have been taken off the invoices. 
By using this option, you can create a debit and credit entry to account for the 
off-invoice amount as promotional expenses, thereby accounting these as 
expenses rather than reductions in revenue.

■ Facility to view transaction information from the Budget Checkbook

You can view the invoice and shipment information of an order through the 
Budget Checkbook.

■ Budget mass transfer (transfer of committed but unearned funds)

When you create a budget for the upcoming year, a transfer program 
automatically transfers funds that are committed, but are not yet earned. Offers 
that span multiple fiscal periods can therefore have the earnings tracked in the 
right budget.

1.5.4 Claim Enhancements
The claim enhancements in this release include the following:

■ Lockbox Integration

For large volume claim management, automatically creates deductions and 
overpayments and uses the Quickcash feature. This reduces deduction creation 
time and improves deduction processing efficiency. 

■ Ability to handle subsequent receipts
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New in This Release
When customers pay for invoices that were short paid earlier, or deducted, 
Oracle Trade Management receives notifications through Oracle Receivables. 
Thus, claim amounts and receipts get mapped between the two applications.

■ Netting overpayments and deductions

Netting of overpayments and deductions enables you to offset an overpayment 
with a deduction.

■ Customer reason code mapping

The claim reason codes used by the customer can be imported and matched 
with your organization’s internal reason codes. When the cash application 
processes take place in Oracle Receivables, the customer reason codes are 
automatically translated to internal reason codes.

■ Total write-off solution

Total write-off solution enables you to write off claims below a certain 
threshold. You can also choose a write-off activity to determine where the 
write-off expenses will be absorbed.

■ Passing memo lines

Passing memo lines refers to passing all the parameters that can be used for 
configuring the necessary Oracle General Ledger accounts.

■ Mass settlement

You can offset multiple transactions against multiple claims, for example, credit 
memos against deductions or invoices against overpayments.

■ Paying earnings over thresholds

In cases where a customer gets paid more than the actual accrual, you can set 
up a threshold limit to how much an overpayment can be. This feature enables 
you to maintain control over the payments.

■ Autopay enhancements

Autopay enhancements include performance validation, mapping to Oracle 
General Ledger period, as well as enhanced buying group and account 
relationships support.

■ Claim Import enhancement

Using the import feature, companies can integrate Oracle Trade Management 
with any third party or legacy ERP systems, using the new WebADI integration. 
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New in This Release
1.5.5 Indirect Sales Enhancements
The earlier releases include the Third Party Accrual API, which enables 
manufacturers to import any indirect sales data into the system. Based on an Oracle 
Advanced Pricing simulation call, accruals can be calculated and be placed into 
different budgets. Third Party Accrual enhancements in this release include:

■ Ability to upload data through multiple sources

You can load third party accrual data into the point of sales (POS) tables either 
through a web interface, or through an XML data feed by using the XML 
Gateway. Indirect customer data will be validated and deduped during the 
loading process. Based on the POS data, you can create party relationships 
between the indirect customer and direct customer. This enables you to have a 
comprehensive view of your indirect customers.

■ Ability to configure the processing of Indirect Sales Data

You can specify the type of processing that must be done on the indirect sales 
data at the system level, and account level. This enables you to process rebates 
only from authorized accounts.

■ Ability to maintain cross-reference information for each account

You can map the codes and IDs that are used by customers, with the internal 
codes and IDs.

■ Pay earnings 

You can specify the payment frequency (immediately, weekly, monthly, 
quarterly) at the account level. Even though the amounts will be accrued at the 
time of processing, the payment will be processed based on the account setup. 
This enables you to schedule payments based on the type of contractual 
agreements that your organization has with the customers.

Note: This document describes functionality to be delivered in the 
Oracle E-Business Suite 11.5.10 release. If you are implementing this 
product prior to the release using product minipacks or family 
packs, some new functionality may be dependent on integration 
with other Oracle products. Please consult Oracle MetaLink for 
relevant product patches and documentation.
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Best Practices for Implementation
1.6 Obsolete in This Release
None of the functionality from the previous release, in which Oracle Trade 
Management was part of Oracle Marketing, has been obsoleted.

1.7 Implementation and Administration Process Overview
Oracle Trade Management implementation leverages many common setups 
performed during the basic Oracle Marketing implementation described in 
Chapter 3, "Trade Management Essential Tasks". To ensure that your organization 
can fully utilize Oracle Trade Management’s budget, offer, and claim functionality, 
you must verify some of the basic Oracle Marketing implementation. Additional 
tasks for previously implemented components must also be performed. 

Two general types of tasks must be performed: 

■ Implementation tasks: One-time tasks performed during or shortly after 
installation. Examples include setting profile options, creating and verifying 
lookup values, and creating users.

■ Administrative tasks: Repetitive tasks performed post-installation. Examples 
include creating claim types and reasons, configuring a budget threshold, and 
creating custom setups.

As you follow the implementation procedures, you will notice that some tasks are 
required while others are optional.

1.8 Best Practices for Implementation

1.8.1 Map Out Order to Cash Processes and Business Needs 
During the process of mapping out business processes and needs, a company 
implementing Oracle Trade Management should be open-minded and take the 
chance to proactively uncover any inefficient processes. It is important at the 
beginning stages of implementation to distinguish between true business needs and 
the way things have always been done. You do not want to be limited by business 
norms that have developed because of the limitations of legacy systems.

Some questions to ask are: 

■ How do you track budget balances? Is it by sales territory, geography, customer 
grouping, product or brand, or budget category? 
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■ Are promotions discount-based or accrual-based? If they are accrual-based, are 
their liability and impact on sales accounted for on a timely and accurate basis? 

■ When customers remit payments, do they short pay? If they do, are there any 
current systems in place to help expedite their resolution?

■ Do customers submit point of sale (POS) data? If so, for what business 
purposes?

1.8.2 Identify the Users Involved 
Identify users based on the answers to the questions in section 1.8.1. For example, if 
budget balances are tracked by brand, a budget user may then be a brand manager. 
If budget balances are tracked by sales territory, a budget user may then be a sales 
representative or a sales manager.

Users who create promotions in the system can be determined by both business 
needs and implementation scope. Business needs may require that the person who 
determines promotions is the same person who creates the promotion. Regardless 
of whether it is a trade marketer, a sales representative or a brand manager, that 
person must be set up as an Oracle Trade Management user. The scope of the 
Implementation may means that the person who determines a promotion, for 
instance, a sales representative, is not the person who performs the data entry; that 
job is performed by a sales administrator. In this case, the actual Oracle Trade 
Management user is the sales administrator and not the sales representative.

If the company wants to account for its promotions, then finance or accounting 
users may be set up to use Oracle Trade Management. If analysis of the company’s 
business practices indicates that claims and deductions are most efficiently resolved 
if managed by the company's customer service representatives, then they should be 
set up as Oracle Trade Management users. However, if it is determined that claims 
and deductions for are most efficiently resolved if the users from specific functional 
areas are involved, then you can set up different users. For example, claims for 
shipping reasons may be most efficiently resolved by a shipping clerk; in that case 
the shipping clerk is set up as an Oracle Trade Management user. 

In addition to identifying the users, a company should also identify an internal 
implementation owner, a person familiar with multiple departments and business 
functions.

Oracle Trade Management invariably touches upon multiple front-end and 
back-end areas of the company. A particularly important step to take at this stage is 
to form a cross-functional team consisting of representatives from different 
departments that will be impacted by the implementation. When managers or users 
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from multiple functional areas get together, it provides a valuable opportunity to 
uncover better ways to manage integration points, to model customer and product 
data in a way that supports processes in different departments, and to effectively 
plan for division of labor during the actual implementation. 

1.8.3 Determine Which Functional Areas to Implement
Based on findings from sections 1.8.1 and 1.8.2, the company should have a good 
idea on whether to:

■ Implement the entire Oracle Trade Management application to integrate with 
the company's Order to Cash process 

■ Implement the entire Oracle Trade Management application not just to 
streamline the back-end processes but also to provide a Sales Force Automation 
tool to the sales teams

■ Implement only the claims and deductions area because that is where the 
company currently is wasting the most money and this area impacts the bottom 
line most directly 

■ Focus on the Indirect Sales Management functional area of Oracle Trade 
Management in order to manage distributor or wholesaler chargeback claims, 
track POS data and channel inventory, or create third party accruals 

We recommend the second option. By managing the entire Oracle Trade 
Management process as an integrated flow, the sales force can become actively 
involved in achieving the maximum benefits of reducing and controlling trade fund 
spending and liability, increasing sales effectiveness and promotional ROI, and 
reducing claim cost and complexity in managing indirect sales data.

1.8.4 Determine Integration Points of Oracle Trade Management 
These integration points may be between Oracle Trade Management and third party 
ERP systems. They may also be between Oracle Trade Management and the Oracle 
E-Business Suite.

This step is important because whether Oracle Trade Management is used with the 
Oracle E-Business Suite or with external ERP systems determines how integrations 
are implemented. If the application is used with external ERP systems, 
implementers should familiarize themselves with all of the open system support 
provided by Oracle Trade Management and Oracle technology in general. If the 
application is used with the Oracle E-Business Suite, implementers should 
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understand how customer and product data modeled in the suite are used in Oracle 
Trade Management.

1.8.5 Determine Implementation Objectives, Priorities, Phases and Milestones 
Prioritization may be based on a myriad of factors, such how critical the business 
needs are, or the complexity of the implementation tasks that are necessary to 
enable features to manage those needs. A highly critical business need can be 
phased in later if the complexity of managing it is high, such as requiring 
integration with many other systems. A less urgent business need may be phased in 
first if the implementation tasks are simpler. Designing a matrix and a scoring 
system for these different factors aids the decision making process.

For example, a company that plans on implementing the entire Oracle Trade 
Management application along with the rest of the Oracle E-Business Suite may 
choose to do so in two phases. In the first phase they would roll out Oracle Trade 
Management to sales users to manage the majority of sales-created promotions that 
are simple to implement, such as lump sum promotions or scan data promotions. In 
a later phase, they would integrate Oracle Trade Management with Advanced 
Pricing and Order Management to manage more complex promotions, such as 
volume rebate promotions.

1.8.6 Understand Multi-Org Needs 
Oracle Trade Management is sometimes referred to as a "bridging" application 
between CRM and ERP. Currently, certain areas in the application are "org-striped" 
while others are not. Org-striped means that the areas are segregated based on 
operating units. It is important to understand which areas are org-striped and 
which areas are not and to design the setups to meet your business needs.

1.8.7 Test Out a Basic Business Flow 
Do the basic setups. For example, if the implementation scope is the entire Oracle 
Trade Management application, then test a basic business flow that spans across the 
whole Order to Cash process:

1. Create a budget

2. Create sales quotas/targets

3. Analyze past promotional ROI

4. Create account plans and promotions
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5. Book and ship sales orders

6. Track promotional expenses and accruals in the budget

7. Pass accounting entries to the accounting system

8. Create claims or deductions

9. Associate claims or deductions to promotional accruals

10. Resolve claims or deductions

1.8.8 Execution
The best strategy and plan in the world are useless without disciplined execution. 
Deep dive into features and functionalities of the application. List all possible 
business scenarios. This will also serve as the basis for a comprehensive testing 
plan.
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Prerequisites and Optional Integrations

This chapter provides information on the E-Business Suite applications that are 
mandatory prerequisites and applications that integrate with Oracle Trade 
Management.

Topics include: 

■ Section 2.1, "Oracle E-Business Suite Prerequisites and Integrations"

■ Section 2.2, "Setting Up Oracle Human Resources"

■ Section 2.3, "Integrating General Ledger"

■ Section 2.4, "Implementing the Account Generator"

■ Section 2.5, "Integrating Oracle Receivables"

■ Section 2.6, "Integrating Oracle Payables"

■ Section 2.7, "Integrating Advanced Pricing"

■ Section 2.8, "Integrating Order Management"

■ Section 2.9, "Integrating Oracle Inventory"
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2.1 Oracle E-Business Suite Prerequisites and Integrations
Oracle Trade Management has two mandatory prerequisites and several optional 
integrations within the E-Business Suite of applications.

Mandatory Prerequisites
■ Oracle Human Resources

Oracle Human Resources provides the underlying technology stack, schema, 
and structure for Trade Management. Implementing this application is required 
and must be complete before you can implement Trade Management.

■ Oracle Inventory

Oracle Inventory is the repository for products or collateral used in conjunction 
with Trade Management promotions. It is also used by the ROI Calculator. 
Integration with this application allows you to create and execute accrual-type 
offers and budgets as well as off-invoice (also known as on-invoice) offers. This 
application is not required for lump sum and scan data type offers.

Optional Integrations
Optional integrations are applications that, when integrated with Trade 
Management, extend and enhance product functionality. Based on your business 
requirements, you may want to integrate some or all of the following Oracle 
E-Business Suite applications. Setups are typically partial and are limited to the 
functions necessary for Trade Management to function properly.

■ Oracle General Ledger

Integration with Oracle General Ledger allows you to post to General Ledger 
and track accruals, accrual adjustments, and discounts. You can track:

– Promotion-related accruals

– Off-invoice promotion expenses

– Budget adjustments

– Claims or deductions with promotional accruals or earnings settled by 
credit memo or check

■ Account Generator

Account Generator can be implemented along with General Ledger if your 
business requires the dynamic generation of Oracle General Ledger account 
codes.
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■ Oracle Receivables

Integration with Oracle Receivables allows you to manage and settle claims by 
credit, and manage and settle deductions and overpayments.

■ Oracle Payables

Integration with Oracle Payables allows you to settle claims by check.

■ Advanced Pricing 

Advanced Pricing provides the offer logic. Price lists and offers created in Trade 
Management are stored in the Advanced Pricing schema.

Integration with this application allows you to create and execute accrual-type 
offers and budgets as well as off-invoice (also known as on-invoice) offers. This 
application is not required for lump sum and scan data type offers.

■ Oracle Order Management

Integration with Order Management enables Oracle Trade Management to 
perform offer execution, the tracking of accruals, budget updates and the 
creation of return material authorizations (RMAs) to settle claims.

Integration with this application allows you to create and execute accrual-type 
offers and budgets as well as off-invoice (also known as on-invoice) offers. This 
application is not required for lump sum and scan data type offers.

■ Tax Engine

Integration with the Tax Engine is recommended if your business resides in a 
country where you must charge taxes, or if you have business units that are 
subject to taxes. For Trade Management purposes, on claims there is the ability 
to find out the estimated taxes that Payables calculates before sending a claim 
over for settlement. This minimizes errors due to mismatch of tax amount that 
result in Payables invoices being rejected.

■ Oracle Partner Management (OPM)

Oracle Trade Management integrates with Oracle Partner Management so that 
whenever there are any approved requests related to Special Pricing or Soft 
Funds, offers and claims are automatically generated in Oracle Trade 
Management; these claims are settled by the claims user. See the 

■ Data Quality Management (DQM)

Data Quality Management is a tool from the trading community architecture 
(TCA) group that is used to check for potential duplicate customer, contact 
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address, and contact points for a given customer, contact, or address. See 
Section 7.5.3, "Set Up DQM Integration" for more information.

■ Costing

Trade Management depends on Oracle Costing to get the Cost of Goods for a 
product. This Cost of Goods is used in the Return On Investment (ROI) 
calculation in Offer Forecast.  The Cost of Goods is obtained by calling the API 
CST_COST_API.get_item_cost with the Product and the Organization ID.

■ Collections

Collections is used to expose claims information. For details see the Oracle 
Collections User Guide.

2.1.1 Flexfields
Use a flexfield when you want to set up a text field that is preset with a recognizable 
name and a specific type of data that it will accept. For example, a field can be 
called Item Number, and be set up to be a five-character numeric field. This helps 
minimize entry errors.

Oracle Trade Management uses descriptive flexfields, which provide customizable 
expansion space on a page. There are five flexfields used in this release:

See the Oracle Applications Flexfields Guide for information about setting up 
flexfields.

Table 2–1 Flexfields in Oracle Trade Management

Name Title Table Name Structure Column

AMS_CLAM Claims OZF_CLAIMS_ALL ATTRIBUTE_CATEGORY

AMS_CLAM_DEDU Deductions OZF_CLAIMS_ALL DEDUCTION_
ATTRIBUTE_CATEGORY

AMS_CLAM_LINE Claim Lines OZF_CLAIM_LINES_ALL ATTRIBUTE_CATEGORY

AMS_FUND Budgets OZF_FUNDS_ALL_B ATTRIBUTE_CATEGORY

AMS_TRADE_PROFILE Trade Profile OZF_CUST_TRD_PRFLS_ALL ATTRIBUTE_CATEGORY
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2.2 Setting Up Oracle Human Resources
Oracle Human Resources Management System (HRMS) is used to store and 
maintain the following organizational information that is utilized by Trade 
Management: 

■ Business Groups

■ Locations

■ Legal Entities 

■ Operating unit

■ Employee

See Using Oracle HRMS - The Fundamentals for more information.

To implement HRMS for Trade Management use the following procedures:

■ Section 2.2.1, "Determining the HRMS Navigation Path"

■ Section 2.2.2, "Creating Lookup Values for Organization Type"

■ Section 2.2.3, "Creating Locations"

■ Section 2.2.4, "Creating Business Groups"

■ Section 2.2.5, "Creating Organizations"

■ Section 2.2.6, "Assigning the Security Profile"

■ Section 2.2.7, "Adding a Legal Entity, Operating Unit and HR Organization"

■ Section 2.2.8, "Creating A Business Unit"

■ Section 2.2.9, "Assigning Multi Org Responsibilities"

2.2.1 Determining the HRMS Navigation Path
The responsibilities and navigation paths for performing HRMS tasks is different 
depending on the terms of your license (shared versus full). 

■ Shared HRMS license: Create employees using CRM Foundation. 

– Responsibility: CRM Administrator

– Navigation Path: CRM Foundation > Resource Manager > Maintain 
Employees > Employees

■ Full HRMS license: Create employees using HRMS. 
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– Responsibility: HRMS Manager

– Navigation Path: People > Enter and Maintain

2.2.2 Creating Lookup Values for Organization Type 
In this step you are creating sub organization types. For example, if the organization 
is divided into business groups, then create an organization type called Business 
Group.

This procedure adds values for a specific lookup “Organization Types (ORG_
TYPE)”. If the organization is divided into subsidiaries, create an organization type 
called Subsidiary.

Note: If you are implementing Oracle Trade Management as a stand-alone 
application, see the HRMS documentation for steps to create lookup values. If your 
implementation is part of a full HRMS implementation, this step is not required to 
be done separately for Oracle Trade Management implementation.

2.2.3 Creating Locations
Each physical site where your employees work should be set up as a separate 
location in Oracle HRMS. You can set up:

■ Global locations which are available in all business groups.

■ Business group locations which are available in a single business group.

Similarly, you enter the addresses of external organizations that you want to 
maintain in your system, such as employment agencies, tax authorities, and 
insurance or benefits carriers. When setting up internal or external organizations, 
you select from a list of these locations.

Note: If you are implementing Oracle Trade Management as a stand-alone 
application, perform the following steps to create locations. If your implementation 
is part of a full HRMS implementation, this step is not required to be done 
separately for Oracle Trade Management implementation.

To create a work structure Location use the following procedure: 

Prerequisites
None
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Steps
1. Log in to Oracle Forms with Human Resources Super User responsibility.

2. Navigate to Work Structures > Location.

3. Enter a name for the location and, optionally, a description and inactive date.

4. Select or deselect the Global check box based on these guidelines:

■ Deselect if you want the location to only be available within the default 
business group of your current responsibility. The location name must be 
unique within the business group and all of its global locations.

■ Select if you want the location to be global and therefore available to all 
business groups. The location name must be unique across all business 
groups.

■ You cannot change the Global selection once you have set up your location.

5. If the country displayed in the Address Style field is incorrect, open the LOV 
and select the appropriate country. If correct, proceed to the next step.

The Location Address form opens automatically.

6. Place your cursor in the Address field to open the Location Address form. 

7. Complete this form and click OK.

8. Enter shipping details, other details and extra information as desired.

9. Save your work.

2.2.4 Creating Business Groups
The business group is the largest organizational unit representing the enterprise. A 
business group may correspond to a company or corporation, or to a holding or 
parent company in large enterprises. It can be an organization with a physical 
location, or it may be an abstract representation of a legal entity that employs 
people assigned to work in organizations beneath it.

The business group is also the highest level in the organizational structure, such as 
the consolidated enterprise, a major division, or an operation company. It secures 
human resources information. For example, if you request a list of employees, you 
will see all of the employees in the business group of which your organization is a 
part.

Multiple sets of books can share the same business group if they share the same 
business group attributes, including HR flexfield structures.
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A default business group has been set up for you, therefore this step is not required 
for Trade Management to be fully operational. However, you must set up operating 
units if you plan to use any financial ERP applications in the future, such as Oracle 
Receivables or Payables.

For more information on business groups, refer to Multiple Organizations in Oracle 
Applications. 

2.2.5 Creating Organizations
The first organization to set up is the business group; all other organizations will 
belong to the business group. Below the business group, you represent the 
groupings in which employees work, such as branches, departments or sections, by 
means of internal organizations. To enable the assignment of employees to an 
internal organization, you classify it as an HR Organization.

If you are implementing Oracle Trade Management as a stand-alone application, 
perform the following steps to create Organizations. If your implementation is part 
of a full HRMS implementation, this step is not required to be done separately for 
Oracle Trade Management implementation.

To create Organizations for work structures use the following procedure: 

Prerequisites
None

Steps
1. Log in to Oracle Forms with HRMS Manager Responsibility.

2. Navigate to Work Structures > Organization > Description.

3. Click New.

4. Enter a name. 

5. Open the LOVs for Type, Location, Internal or External and select the 
appropriate values.

6. Save your work.

7. Open the LOV for Organization Classifications and select the appropriate value.

8. Select the Enabled check box.

9. Save your work. 
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10. Click Others.

The Additional Organization Information box appears. Depending upon the 
organization classification you selected, you may or may not be able to proceed. 
There may be no additional information for the classification you selected.

11. Select and enter the appropriate additional information.

12. Save your work.

2.2.6 Assigning the Security Profile
In this step, you will be defining the security level for specific Trade Management 
responsibilities. To do this, use the profile HR: Security Profile. This profile enables 
access (based on responsibility) to a single business group. 

To assign the security profile use the following procedure: 

Prerequisites
None

Steps
1. Log in to Oracle Forms with System Administrator responsibility. 

2. Navigate to Profile > System.

The Find System Profile Values form opens.

3. Check the Application box and in the Application field enter Oracle Trade 
Management.

4. Check the Responsibility box and in the Responsibility field search and select 
the responsibility for which the profile is being set. 

5. In the Profile field enter HR: Security%.

6. In the HR: Security Profile, at Site level, select an organization.

The organization selected is the business group that users will have access to. 
They will have access only to records within this business group. 

7. Save your work. 

Validate that the setting for HR: Business Group is the same organization as the 
HR: Security profile. 
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2.2.7 Adding a Legal Entity, Operating Unit and HR Organization
If you are implementing Oracle Trade Management as a stand-alone application, 
perform the following steps. If your implementation is part of a full HRMS 
implementation, this step is not required to be done separately for Oracle Trade 
Management implementation.

To perform the HRMS task of creating a Legal Entity, Operating Unit, and HR 
Organization follow the procedure below.

Prerequisite
None

Steps
1. Log in to Oracle Forms with the appropriate HRMS Manager responsibility. For 

more information on determining this see Section 2.2.1, "Determining the 
HRMS Navigation Path". 

2. Navigate to Work Structure > Organization > Description.

The Find Organization form opens. 

3. Search/and or Select your Organization.

4. Place your curser in the Organization Classification Name field. 

5. Using the LOV select GRE / Legal Entity. 

6. Select the Enabled radio button. 

7. Save your work and close this form (the Organization form will still be open in 
the background). 

8. Select Others. 

9. Select GRE / Legal Entity.

10. Select a Set of Books (defined above).

11. Click OK.

12. Save your work.

13. Add an Operating Unit:

a. Under Organization Classifications Name, add Operating Unit.

b. Click the ellipsis to select a classification.
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c. Select a Legal Entity. 

d. Click Others.

e. Select Legal Entity Accounting. 

f. Select a set of books.

g. Click OK.

h. Enable by selecting the checkbox.

i. Save your work.

14. Add an HR Organization:

a. Under Organization classifications name, add HR Organization from the 
LOV.

b. Enable by selecting the checkbox.

c. Save your work.

d. Click Others to enter additional information.

e. Save your work.

15. Close the form. 

2.2.8 Creating A Business Unit
Trade Management uses the concept of Business Unit:

■ To classify budgets (they are selected during budget creation)

■ When setting up budget approval rules

See Section 4.11.1, "Creating Business Units" for more information.

Note: If you are implementing Oracle Trade Management as a stand-alone 
application, perform the following steps to create locations. If your implementation 
is part of a full HRMS implementation, this step is not required to be done 
separately for Oracle Trade Management implementation.

To create a new Business Unit use the following procedure: 

1. Log in to Oracle with the appropriate HRMS Responsibility. 

For more information on the appropriate HRMS responsibility see Section 2.2.1, 
"Determining the HRMS Navigation Path". 

2. Navigate to Work Structure > Organization > Description. 
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3. Click New.

4. Fill in Name of Business Unit.

5. Select Type (Business Unit).

6. Select a Location. 

7. Select an Organization Classification. 

8. Select Internal or External.

9. Save your work.

2.2.9 Assigning Multi Org Responsibilities
Trade Management requires the implementation of a Multiple Organization 
Structure. Please refer to Multiple Organizations in Oracle Applications for additional 
information.

Some transactions types, such as customer parties and accounts, are visible to all of 
the operating units within an organization. Other transaction types are restricted to 
a particular operating unit. The restricted transaction types are referred to as being 
org-striped. Here are some examples:

■ Order Management – orders

■ Oracle Receivables – transactions, receipts 

■ Oracle Payables – checks 

Setups can also be org-striped, for example:

■ Customer account sites

■ Vendor sites

These are the org-striped transactions and setups used in Trade Management:

■ System parameters

■ All claim related setups such as claim type, reason

■ Approval rules for claims and trade profiles

■ Claims, deductions, overpayments and all settlement methods (for example, 
credit, RMA, check)

■ Associate earnings in claims

These are the non-org-striped transactions and setups in Trade Management:
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■ Basic admin setups such as custom setups, locking and mandatory rules and, 
user status

■ Budgets and offers

You assign Multi Org responsibilities to a selected Trade Management 
responsibility. This displays the appropriate Business Unit when using that 
responsibility.

Prerequisites
None

Steps
1. Log in to Oracle Forms with System Administrator responsibility.

2. Navigate to Profile > System.

3. Select a responsibility to be assigned to this profile.

4. In the profile field enter MO%.

5. Click Find and select MO: Operating Unit.

6. Click the Responsibility field and select the appropriate Operating Unit from 
the drop-down list. 

The organization’s Business Rules will determine how Operating Units are 
structured.

7. Save your work.

Please refer to Multiple Organization in Oracle Applications for additional information. 

2.3 Integrating General Ledger
Accruals, accrual adjustments, and discounts are tracked in Oracle General Ledger 
(GL). When Oracle General Ledger is integrated with Oracle Trade Management, 
you can track the following:

■ Offer-related accruals

■ Claims or deductions with promotional accruals or earnings settled by credit 
memo or check.

■ Off-invoice discounts
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Several types of Trade Management offers can result in the creation of accruals, such 
as accrual, lump sum, scan data and volume offers.

Trade Management creates accounting entries as follows.

■ When accruals occur:

– Debit Sales or Expense Account

– Credit Liability Account

■ If the off invoice posting option is enabled, it creates these entries when the 
sales order line with the offer applied has been invoiced:

– Debit Sales/Expense/Charge (set up in Trade Management)

– Credit Revenue (from AR)

■ For negative adjustments made to accruals, these reversal entries are created:

– Debit Liability Account

– Credit Sales or Expense Account

■ When a claim or deduction is associated with promotional accruals or earnings, 
and the claim is being settled by credit memo, Trade Management passes the 
Receivables Clearing Account to Oracle Receivables and creates these entries:

– Debit Liability Account

– Credit Receivables Clearing Account

■ When a claim or deduction is associated with promotional accruals or earnings, 
and the claim is being settled by check, Trade Management passes the Vendor 
Clearing Account to Oracle Payables and creates these entries:

– Debit Liability Account

– Credit Vendor Clearing Account

To integrate General Ledger with Trade Management, perform the procedures in the 
following sections:

■ Section 2.3.1, "Set System Profile Options"

■ Section 2.3.2, "Verify Lookups"

■ Section 2.3.3, "Run Concurrent Programs"

■ Section 2.3.4, "Set Up General Ledger Accounts"

■ Section 2.3.5, "Verify the Journal Source"
2-14 Oracle Trade Management Implementation Guide



Integrating General Ledger
■ Section 2.3.6, "Verify Journal Categories for Trade Management"

2.3.1 Set System Profile Options
You must set the following system profiles to integrate General Ledger with Trade 
Management. 

2.3.2 Verify Lookups
If an error occurs, verify these General Ledger-related lookups. You cannot add 
lookups, and the codes for them cannot be changed. You can change the meaning of 
the lookup (what is displayed to the Trade Management user). No extensible or user 
lookups need to be verified or created.

■ AMS_GL_Event_Line_Type

■ AMS_GL_Event_Status

■ AMS_GL_Event_Type

2.3.3 Run Concurrent Programs
The following concurrent programs must be run for General Ledger integration:

■ Workflow Background Process — item = Claim Settlement

Table 2–2 System Profile Options for Integrating General Ledger with Trade Management

Profile Name Required Level Description and Settings

OZF : Show GL Accounts on 
Screen

No Site

User

If Y: General Ledger accounts are displayed on the 
budget, system parameters, and claim type setup 
pages. Oracle General Ledger postings will also be 
visible from budgets by drilling down in the budget 
Earned column.

Example: set sales user to N and finance user to Y.

OZF: Create GL Entries for Orders No Site Determines whether or not General Ledger entries 
are created for order-related accruals.

If Yes, select one of the following:

■ Shipped: Entries created when order line status 
is Shipped or Closed.

■ Invoiced: Entries created when the order line 
status is Invoiced or Closed.
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Creates General Ledger entries for promotional claims

■ OZF-TM: Transfer to General Ledger

– Transfers accounting entries from the Trade Management table to the 
General Ledger interface table. You have the option of triggering the 
Journal Import process in General Ledger right after transfer.

– Journal Import creates journals out of these entries in General Ledger.

– Transfers can be grouped by account date and period, or by details.

■ The Posting program in General Ledger.

2.3.4 Set Up General Ledger Accounts
Create the following General Ledger accounts for Oracle Trade Management. Refer 
to the Oracle General Ledger User’s Guide for instructions.

■ Sales Expense

■ Accrual Liability

■ Receivables Clearing

■ Vendor Clearing

Accounting entries use base General Ledger accounts from the following Trade 
Management setups in this order:

1. Budget set up

2. Budget category set up

3. System parameter set up

Accounting entries as a result of claim resolution use base General Ledger accounts 
from the following Trade Management setups, in this order:

■ System Parameters page. See Section 2.3.9, "Set System Parameters".

■ Budget details page. Refer to the Oracle Trade Management User Guide for more 
information.

■ Claim type.

If the Account Generator Workflow is implemented, these base accounts are 
configured dynamically.
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2.3.5 Verify the Journal Source 
The journal source determines whether journals created by Trade Management can 
be updated or require approval in General Ledger. After accounting entries are 
created in Trade Management, they are first posted to the OZF interface table. The 
OZF-TM: Transfer to General Ledger concurrent program is used to transfer these 
entries to the General Ledger interface table.

Out-of-the-box, journal entries generated by Trade Management are identified by a 
General Ledger source called Marketing. For more details on General Ledger 
Sourcing, refer to the Oracle General Ledger User’s Guide.

Verify the journal source as follows if you find errors in Trade Management General 
Ledger entries.

Prerequisites
None

Steps
1. Log in to Oracle Forms with General Ledger Responsibility. 

2. Navigate to Setup > Journal > Sources.

3. Query for Source = Marketing.

4. Verify that the Import Journal References flag is checked.

5. Verify the Freeze Journals and Require Journal Approval flags.

6. Verify the Effective Date Rule.

2.3.6 Verify Journal Categories for Trade Management
Journal entries created by Trade Management can be further identified using the 
following General Ledger Journal Categories. These categories should be set up in 
General Ledger by default.

■ Fixed budgets: Used for entries created when offers sourced from fixed budgets 
generate accruals. 

■ Accrual budgets: Used for entries created when fully accrued budgets generate 
accruals. 

■ Settlement: Used for entries created when promotional claims or deductions 
are settled. 
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To verify category setups, use the following procedure. 

Prerequisites
None

Steps
1. Log in to Oracle Forms with General Ledger Responsibility. 

2. Navigate to Setup > Journal > Categories.

3. Perform queries and verify that the fixed budget, accrual budgets and 
settlement categories exist.

2.3.7 Verify General Ledger Periods Are Open
Verify that General Ledger periods are open to ensure that General Ledger postings 
can be created.

To verify that General Ledger periods are open, follow this procedure:

Prerequisites
General Ledger has been set up.

Steps
1. Log in to Oracle Forms with General Ledger Super User responsibility.

2. Click Setup.

3. Click Open/Close.

On this form you can view which periods are open or closed.

2.3.8 Verify Sequence Assignment
Sequence assignment is mandatory for the credit memos, debit memos, 
chargebacks, and invoices that Trade Management interfaces to in Oracle 
Receivables and Oracle Payables. It is a good practice to verify the sequence 
assignment before using them in Trade Management. 

You can verify document sequences, define or query document categories and 
assign document sequence to categories. 

Verify the sequence assignment by performing the following procedure.
2-18 Oracle Trade Management Implementation Guide



Integrating General Ledger
Prerequisites
None

Steps
1. Log in to Oracle Forms with a System Administrator responsibility.

2. Navigate to Application > Document.

3. Verify the data in the Define, Categories, and Assign Documents screens.

Validate if proper document sequencing exists for Oracle Receivable credit 
memos, debit memos, and chargeback. Make sure the Oracle Payables invoices 
and Order Management orders are valid.

4. Save your work.

2.3.9 Set System Parameters
When you set system parameters for General Ledger integration in the Trade 
Management user interface, you:

■ Indicate whether or not you want Trade Management to integrate with General 
Ledger.

■ Indicate whether or not you want General Ledger entries created for off-invoice 
discounts

■ Specify the following:

– Default General Ledger accounts

– General Ledger balancing segment

– General Ledger date type

Notice at the top of this page that a set of books and the accounting method to be 
used are already designated. The set of books specified here defines the functional 
currency. It is the main currency used by the General Ledger set of books and to 
create General Ledger postings. As such, an equivalent functional currency is 
created in the background when Trade Management users are working with other 
currencies to perform tasks such as creating budgets and offers.

Prerequisites
General Ledger accounts for Trade Management have been created (Sales Expense, 
Accrual Liability, Receivables Clearing, Vendor Clearing).
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Steps
1. Log in to Oracle Trade Management and navigate to Administration > Trade 

Management > Setup > System Parameters.

2. Select the Post to GL check box.

Important: You must select this check box to integrate Trade Management with 
General Ledger. If not selected, the two applications will not be integrated.

3. Select the Create GL Entries for Off-Invoice Discounts check box if applicable.

When selected, the following General Ledger entries are created:

Debit Sales/Expense/Charge (Trade Management)
Credit Revenue (Oracle Receivables)

4. Select a General Ledger date type.

5. Click the Search icons for the account fields and select the appropriate accounts.

6. Click Update.

2.3.10 Set Up Currency Conversion Rate Types 
Use the following procedure to set up currency conversion rate types. Although this 
set up is optional, it is required if you plan to set up daily conversion rates 
(Section 2.3.11, "Set Up Currency Conversion Rates").

See the Oracle General Ledger User’s Guide for more information.

Prerequisites
None

Steps
1. Log in to Oracle Forms with General Ledger Super User responsibility.

2. Navigate to Setup > Currencies > Rates > Types.

3. Enter Rate Type.

4. Enter Description. 

For example, Corporate, Corporate Exchange Rate, Spot, or Spot Exchange Rate.

5. Save your work.
2-20 Oracle Trade Management Implementation Guide



Integrating General Ledger
2.3.11 Set Up Currency Conversion Rates
To set up currency conversion rates, follow this procedure.

See the Oracle General Ledger User’s Guide for more information.

Prerequisites
Currency conversion rate types must be set up.

Steps
1. Log in to Oracle Forms with General Ledger Super User responsibility.

2. Navigate to Setup > Currencies > Rates > Daily.

The Daily Rate Form opens.

3. Click Enter by Date Range.

4. Open the From and To LOVs and select the appropriate currencies.

5. Open the From Date and To Date LOVs and select the appropriate dates.

6. Select a Conversion Type. 

7. Enter an exchange rate. 

The inverse rate is automatically calculated.

8. Click Apply.

9. Repeat this procedure to define more conversion rates.

10. Save your work.

2.3.12 Creating a Set of Books
A set of books is created in General Ledger. A set of books determines the functional 
currency, account structure, and accounting calendar for each company or group of 
companies. If you need to report on your account balances in multiple currencies, 
you should set up an additional set of books for each reporting currency. Your 
primary set of books should reflect your functional currency. Each reporting set of 
books should use one of your reporting currencies. See the Oracle General Ledger 
User Guide for the procedure for creating a set of books.
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2.4 Implementing the Account Generator
Trade Management creates accounting entries in General Ledger in the following 
manner: 

■ Promotional accruals: Base General Ledger accounts are taken from a budget, a 
budget category, or system parameters.

■ Budget adjustments: Base General Ledger accounts are taken from a budget, a 
budget category, or system parameters.

■ Promotional claim and deduction settlements: Base General Ledger accounts 
are taken from the claim type or system parameters.

■ Off-invoice discounts: Base General Ledger accounts are taken from Debit 
Sales/Expense/Charge, set up in Trade Management.

By using the Trade Management account generator workflow, rather than the base 
General Ledger accounts, you can configure these accounts dynamically. 
Configuration is accomplished by modifying the account generator workflow using 
the workflow administration tool. Values of various segments for each account can 
be changed.

When implemented, Account Generator replaces the Oracle General Ledger 
product segment account information with the product segment of the COGS 
account (from the inventory item on which accrual is made). If an inventory item 
cannot be determined, then the base Oracle General Ledger account is used.

Example
Account structure = company-account type-customer-product-spare

Base account = 01-0001-0002-0000-000

Customized = 01-0001-8888-2344-000

The change is based on the customer and product derived from an order.

2.4.1 About the Account Generator Workflow 
The workflow API used to derive Accrual liability and Expense account 
information is called AMS : Account Generator. This workflow process happens 
when utilizations are accrued or adjusted from: 

■ Accrual offers

■ Lump sum offers
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■ Trade Deals

■ Scan data offers

■ Volume offers

■ Manual adjustments 

When implemented, Account Generator replaces the General Ledger product 
segment account information with the product segment of the COGS account (from 
inventory item based on which accrual is made). If an inventory item cannot be 
determined for the utilization, then the base General Ledger account is used.

Modifying the Account Generator requires expertise in the following areas:

■ PL/SQL

■ Oracle Workflow

■ General Ledger

The Trade Management Account Generator consists of the following:

■ Process: Generate a default account

■ Function: Get expand CCID for line

■ Package: AMS_ACCT_GENERATOR

■ Procedure: Get Cost_Sale_Item_Derived

2.4.2 Debugging the Account Generator
To debug the account generator workflow, set the profile Account Generator : 
Debug mode to Yes. The workflow process can then be seen from process editor. 
The owner of the workflow runs the concurrent program or performs an action 
which invokes accounting.

Workflow processes can then be seen from the process editor and the owner of the 
workflow will be the user who runs the concurrent program or performs an action 
which invokes accounting.

The default account generator assumes an accounting structure with a product 
segment named Product. This must be changed in the workflow based on the 
implementation. Additional attributes, functions and processes can be added. The 
current process can be customized to suit business requirements. 
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2.4.3 Understanding Account Generator Prerequisites 
Before using the Account Generator to create an accrual liability or expense 
accounts, you must perform the following prerequisite tasks: 

■ Define your accounting flexfield structure for each set of books.

■ Define flexfield segment values and validation rules.

■ Determine whether your organization will use the default Account Generator 
process, or customize it to meet your accounting needs. Trade Management 
comes with the following Account Generator item type: Generate Default 
Account.

You must also do one of the following for each set of books:

■ Choose to use the default Account Generator process.

■ Customize the default Account Generator process, test your customization, and 
choose the process for a flexfield structure, if necessary.

Evaluate whether the default Account Generator process meets the accounting 
requirements of your organization. The default process can be updated later as 
needs change. You may only need to make minor changes to the default process 
without changing its name.

2.4.4 Implementing the Account Generator Workflow
To implement the Account Generator workflow process, follow the procedures in 
the following sections: 

■ Section 2.4.4.1, "Starting Generating Code Combination"

■ Section 2.4.4.2, "Copying Values from Code Combinations"

■ Section 2.4.4.3, "Getting the CCID for a Line"

■ Section 2.4.4.4, "Copying Segment Value from Code Combinations"

■ Section 2.4.4.5, "Validating Code Combination"

■ Section 2.4.4.6, "Ending Generating Code Combination"

■ Section 2.4.4.7, "Default Function to get COGS Account"

Note: Be sure to read the Account Generator chapter in the Oracle 
Applications Flexfields Guide before customizing the Trade 
Management Account Generator.
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■ Section 2.4.4.8, "Default Attributes Defined in Workflow"

■ Section 2.4.4.9, "Lookups Codes for Accrual Liability and Expense Accounts"

■ Section 2.4.4.10, "Attributes Set in Workflow"

2.4.4.1 Starting Generating Code Combination
This is a standard activity that marks the start of the workflow process. 

2.4.4.2 Copying Values from Code Combinations
This function copies all the segment values from a given code combination to the 
combination that is being generated. This function has two attributes:

■ Code Combination ID: The Default Code Combination ID (CCID) set when the 
workflow is invoked. 

■ Replace Existing Value: Set to True to always copy the segment values.

2.4.4.3 Getting the CCID for a Line
This function determines a value that is used in 2.4.4.4 to derive the Accrual 
Liability/Expense Accounts. The derivation of this value cannot be achieved using 
standard Oracle workflow functions. Instead, a PL/SQL procedure is used to derive 
the COGS (Cost of Goods Sold) Account CCID for an inventory item.

If the function executes successfully and receives a CCID, the process branches to 
2.4.4.5. If the function is unable to derive a COGS Account CCID, then the function 
branches to 2.4.4.4.

2.4.4.4 Copying Segment Value from Code Combinations
This function copies a specific segment value from a given code combination to the 
combination being generated. This function has four attributes:

■ Code Combination ID: The COGS CCID that was derived in 2.4.4.3.

■ Segment Identifier: Set to Name since this will replace a segment that has a 
name of Product

■ Segment Value: Set to a constant value of Product, which denotes the name of 
the segment.

■ Replace Existing Value: Set to True to always copy the segment values.

This function gets the Product segment from COGS CCID and replaces it with 
this value on the generated code combination ID.
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2.4.4.5 Validating Code Combination
This function executes after 2.4.4.4 where the default account is modified, or after 
2.4.4.3 when it fails to get COGS CCID. It validates the generated code combination 
and has two attributes.

■ Validation Type: Set to Generate Code Combination ID to execute a full 
validation and generate a code combination ID.

■ New Code Combinations are Allowed: Set to Trow so that if the key flexfield 
structure has dynamic insert allowed, then the validation will not generate an 
error if the combination does not exist in the code combination table.

2.4.4.6 Ending Generating Code Combination
This function is called to end the Generate Default Account process. It is marked as 
the End activity.

2.4.4.7 Default Function to get COGS Account
The function, Get CCID for a Line, gets the COGS account from inventory item and 
assigns the value into a workflow attribute.

2.4.4.8 Default Attributes Defined in Workflow
The following table lists attributes and the location or field from which they are 
derived:

Table 2–3 Default Attributes in Workflow

Attribute Field or Location

Header ID Order Header

Order Category Order Category

Order Type ID Order Type

Price Adjustment ID Price Adjustment

Line ID Order Line

Commitment ID Line Commitment

Salesrep ID Salesrep

Option Flag Oe_Globals.G_ITEM_OPTION

Organization ID Shipping Organization or Organization giving Lumpsum, 
Adjustment
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2.4.4.9 Lookups Codes for Accrual Liability and Expense Accounts
The lookup codes for Accrual Liability and Expense Accounts are as shown in the 
following table:

2.4.4.10 Attributes Set in Workflow
Attributes that will be set in workflow may change based on the method used to 
accrue the utilizations. See the tables below for a list of these attributes.

Customer ID Sold to Customer

Chart of Accounts ID Based on set of books in system parameters

Operating Unit Booking Organization or Organization giving Lumpsum, 
Adjustment

Budget ID Budget

Offer ID Offer

Inventory Item ID Product

Item Category ID Product Category

Generated CC ID Used to store the COGS (Cost Of Goods Sold) Account

Default CC ID Default Account from Budget

Account Type Account Type being derived

Table 2–4 Lookup Codes

Attribute Source

Accrual Liability ACCRUAL_LIABILITY

Expense Account EXPENSE_ACCOUNT

Error Message To store error messages, if any

Claim ID For future use

Transaction Type For future use

Table 2–3 Default Attributes in Workflow

Attribute Field or Location
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Table 2–5 Lumpsum Offers Attributes

Attribute Field or Location

Organization ID Organization offering the Lumpsum offer

Customer ID Customer receiving the Lumpsum offer

Chart of Accounts ID Chart of Accounts for the Set of Books in the System 
Parameters

Operating Unit Organization offering the Lumpsum offer

Budget ID Budget sourcing the Lumpsum offer

Offer ID Lumpsum offer

Inventory Item ID Product

Item Category ID Product Category (either Product or product category will 
exist on a lumpsum record, but not both)

Account Type Accrual Liability or Expense Account

Default CC ID Default account CC ID

Generated CC ID COGS Account derived from inventory item, if one exists

Account Type Account Type being derived

Table 2–6 Accruals at Order Header Attributes

Attribute Field or Location

Header ID Order Header

Order Category Order Category

Order Type ID Order Type

Price Adjustment ID Price Adjustment

Salesrep ID Salesrep at Order Header

Organization ID Shipping Organization

Customer ID Sold to Customer

Chart of Accounts ID Based on set of books in system parameters

Operating Unit Booking Organization (Org ID)

Budget ID Budget sourcing the Accrual

Offer ID Accrual Offer
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Inventory Item ID Product which accrues

Account Type Account Type being derived

Generated CC ID Used to store the COGS (Cost Of Goods Sold) Account

Default CC ID Default Account from Budget

Table 2–7 Accruals at Order Line Attributes

Attribute Field or Location

Header ID Order Header

Order Category Order Category

Order Type ID Order Type

Price Adjustment ID Price Adjustment

Line ID Order Line

Commitment ID Line Commitment

Salesrep ID Salesrep at Order Line

Organization ID Shipping Organization

Customer ID Sold to Customer

Chart of Accounts ID Based on set of books in system parameters

Operating Unit Booking Organization (Org ID)

Budget ID Budget sourcing the Accrual

Offer ID Accrual Offer

Inventory Item ID Product which accrues

Account Type Account Type being derived

Generated CC ID Used to store the COGS (Cost Of Goods Sold) Account

Default CC ID Default Account from Budget

Table 2–6 Accruals at Order Header Attributes

Attribute Field or Location
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2.5 Integrating Oracle Receivables
Trade Management integrates with Oracle Receivables to manage and settle 
deductions and overpayments. The following steps describe the flow of information 
between the two applications.

1. Payment is received from a customer in Oracle Receivables.

2. Cash is applied with discrepancies in Oracle Receivables.

3. An overpayment or deduction is created in Oracle Trade Management.

4. An owner is assigned to the deduction or overpayment in Oracle Trade 
Management.

5. The deduction or overpayment is researched in Oracle Trade Management.

6. The settlement is approved in Oracle Trade Management.

7. Transactions are created and receipts are adjusted in Oracle Receivables.

When a customer is charged $X, but pays $Y, the discrepancy is first realized in 
Oracle Receivables. As such, deductions and overpayments are created in Oracle 
Receivables. When integrated with Trade Management, deductions and 

Table 2–8 Manual Adjustment Attributes

Attribute Field or Location

Organization ID Shipping Organization

Customer ID Sold to Customer

Chart of Accounts ID Based on set of books in system parameters

Operating Unit Booking Organization (Org ID)

Budget ID Budget sourcing the Accrual

Offer ID Accrual Offer

Inventory Item ID Product which accrues

Item Category ID Product Category on which adjustment is made (either the 
product or item category can exist on an adjustment record, 
but not both)

Account Type Account Type being derived

Generated CC ID Used to store the COGS (Cost Of Goods Sold) Account

Default CC ID Default Account from Budget
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overpayments are passed to the claim module in Trade Management where they are 
researched and the settlement method is approved. 

These settlements invariably involve transaction adjustments or receipts that must 
be communicated back to Oracle Receivables. Trade Management automatically 
creates these adjustments and receipts and passes them back to Oracle Receivables 
where the deductions and overpayments are closed out.

By integrating Oracle Receivables with Trade Management, the following 
settlement methods are automated:

■ Credit memo - on account

■ Credit memo - invoice

■ Chargeback

■ Write off

■ Debit memo

■ On-account cash

For a credit memo, the invoice includes the ability to credit invoice lines and invoice 
tax.

To integrate Oracle Receivables with Trade Management, follow the procedures 
listed in these sections:

■ Section 2.5.1, "System Profile Options"

■ Section 2.5.2, "Set Up the Workflow Notification for Claim Settlement"

■ Section 2.5.3, "Verify Line Transaction Flexfields"

■ Section 2.5.4, "Set Up Defaults for Claims"

■ Section 2.5.5, "Create Transaction Types"

■ Section 2.5.6, "Create a Transaction Source for Claim-related Credit and Debit 
Memos"

■ Section 2.5.7, "Create an Aging Bucket for Claims and Deductions"

■ Section 2.5.8, "Attaching Trade Management Requests"

■ Section 2.5.9, "Set Up Related Customer Accounts"

■ Section 2.5.10, "Set Up Receivable Activity"

■ Section 2.5.11, "Verify Receivables System Options"
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■ Section 2.5.12, "Set Up the Tax Engine"

■ Section 2.5.13, "Set Up Lockbox Integration"

■ Section 2.5.14, "Verify Receivable Application Transaction Flexfields"

■ Section 2.5.15, "Set Up Write Off Limit"

2.5.1 System Profile Options
The table below shows the required and optional system profile options for Oracle 
Receivables integration with Oracle Trade Management.

Table 2–9 Oracle Receivables System Profile Options

Profile Option Name Required Description

OZF: AR Credit Method for 
Rule

Yes This profile value determines the use of 
invoicing and accounting rules for the credit 
memo generated by Credit Memo-Invoice 
settlement.

The available Rules Methods include:

Last In First Out (LIFO): Choose this option to 
back out revenue starting with the last general 
ledger period and reverse all prior periods 
until it has used up the credit memo.

Prorate: Choose this option to credit an equal 
percentage to all account assignments for this 
invoice.

Unit: Choose this option to reverse the revenue 
for the number of units you specify from an 
original line of the invoice.

During settlement, if this profile value is not 
defined, the value defaults to Prorate.
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OZF: AR Credit Method for 
Installment

Yes For Credit Memo-Invoice settlement, if the 
crediting transaction has multiple installments, 
this profile determines the split term method.

The available Split Term Methods include:

First in First Out (FIFO): This method credits 
the first installment first.

Last In First Out (LIFO): This method credits 
the last installment first.

Prorate: This method credits the installments of 
the credited transaction and prorates them 
based on the amount remaining for each 
installment.

During settlement, if this profile value is not 
defined, the value defaults to Prorate.

OZF: Select Write-off 
Activities Based on GL 
Balancing Segments

No Y = GL Balancing Segment check box appears 
on the System Parameters page, and GL 
Balancing Segment field appears on the Claim 
Type page.

N = Default setting. Oracle General Ledger 
Balancing Segment options do not appear on 
these pages.

Allows users to filter receivable write off 
activity based on Oracle General Ledger 
balancing segment values.

OZF : Automate 
Deduction/Overpayment 
Settlement

No Y = settlement automation enabled 
between Oracle Receivables and Trade 
Management

N = settlement automation disabled 

See Section 2.5.2, "Set Up the Workflow 
Notification for Claim Settlement".

OZF : Automate RMA 
Settlement

No If Y = settlement automation is enabled 
between Oracle Receivables and Trade 
Management

If N = settlement automation is disabled

See Section 2.5.2, "Set Up the Workflow 
Notification for Claim Settlement".

Table 2–9 Oracle Receivables System Profile Options

Profile Option Name Required Description
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Use the following procedure to define option values for the profile OZF : Modifier 
to adjust unit price for RMA settlement.

Steps
1. Log in to Order Management as the Super User responsibility.

2. Navigate to Pricing > Modifiers > Modifier Setup.

The Advanced Pricing - Define Modifier window appears.

3. In the Main tab, enter a Modifier Type = Discount.

4. In the Number field, enter the modifier list number.

5. In the Name field, enter the modifier list name

6. Check the Active box.

7. Enter a currency.

The currency must be the same as the claim currency.

8. Enter the start date and end date that the modifier lines are effective.

9. Enter a description of the modifier list.

10. In the Modifiers Summary tab, enter the Level = Line

11. Enter Modifier Type = Discount

OZF : Allow Un-Related 
Ship To

No Y = payment can be made to a party different 
from the party taking a deduction

OZF : Modifier to adjust unit 
price for RMA settlement

No This profile is used for RMA settlement in the 
following case:

In a claim line, a user enters a product price 
which is different from the price list or original 
invoice or order price. The modifier defined in 
this profile for adjusting the unit price for RMA 
settlement is used for price adjustment to the 
RMA order line selling price in Order 
Management.

The option values of this profile can be defined 
in Order Management. See the steps following 
this table.

Table 2–9 Oracle Receivables System Profile Options

Profile Option Name Required Description
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12. Enter the start date and end date for this modifier line.

13. Uncheck the Automatic box.

14. Check the Override box.

15. Enter Pricing Phase = All Lines Adjustment.

16. Click Save.

2.5.2 Set Up the Workflow Notification for Claim Settlement
The majority of settlement methods integrated with Oracle Receivables are 
automated, either through real-time API calls or through the Autoinvoice program. 
However, sometimes you want to turn off automation, for example, when you need 
to integrate with a third party/legacy system. To disable settlement automation, 
turn off the following profiles:

■ OZF: Automate Deduction/Overpayment Settlement 

■ OZF : Automate RMA Settlement 

Automation of the following settlement methods is supported: 

■ Credit memo

■ Debit memo

■ Chargeback

■ On-account cash

■ Write-off

■ RMA

2.5.2.1 Creating a Workflow Notification for Claim Settlement
To create workflow notifications for claim settlement, use the following procedure. 

Prerequisites
A valid Oracle Receivables responsibility exists.

Steps
1. Open Workflow Builder.

2. Open AMS: Claims Settlement from the database.
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3. Select File > Load Roles from database. 

4. Enter the appropriate Receivables responsibility in Find Roles and perform a 
query.

5. Select the desired Receivables role from the query results and add it to the 
loaded roles. 

6. Click OK.

7. Expand Item Type and Attribute for AMS: Claims Settlement. 

8. Double-click attribute Receivable Role.

9. Open the Value drop-down list in the default section, and assign the 
appropriate Receivables responsibility to this attribute. 

10. Save your work.

2.5.3 Verify Line Transaction Flexfields
Oracle Trade Management passes claim settlement method information to Oracle 
Receivables using the Oracle Receivables line transaction flexfields. To verify that 
the line transaction flexfield content set up properly, follow this procedure. 

Prerequisites
None

Steps
1. Log in to Oracle Forms with System Administrator responsibility. 

2. Navigate to Application > Flexfields > Descriptive > Segments.

3. Press Control + F11 to open the search mode.

4. In the Application field, type Oracle Receivables. 

5. In the Title field, type Line Transaction Flexfield. 

6. Press Control + F11 to perform a query. 

7. In the Context Field Values table, under the Code column, place your cursor in 
the CLAIM field.

8. Click Compile. 

9. Click OK. 
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2.5.4 Set Up Defaults for Claims
The following defaults must be defined for integration with Oracle Receivables:

■ Claim type and reason

■ Days due

■ Owner

These defaults are specified if these defaults are not defined, deductions and 
overpayments cannot be passed to Trade Management. Selecting the Assignment 
Manager check box on the System Parameters page indicates that territories have 
been set up for automatic claim owner assignment.

For instructions on defining these and other claim defaults, see Section 6.9, "Set Up 
Defaults for Claims".

This process can be performed on the System Parameters page and also in other 
places. The claim type and reason, if set up on the Claim Defaults page, override the 
settings for deductions and overpayments from Oracle Receivables on the System 
Parameters page.

2.5.5 Create Transaction Types
Transaction types drive accounting, tax, cash applications rules and so on. All 
Oracle Receivables transactions required a transaction type. For integration with 
Trade Management, you must create transaction types for credit memos, debit 
memos, and chargebacks. 

These transaction types and receivable activities are mandatory in Oracle 
Receivables and Order Management. If you do not enter them as a claim type or in 
System Parameters, the corresponding settlement methods will not work.

2.5.5.1 Creating Transaction Types
To create transaction types, refer to the Oracle Receivables User Guide.

2.5.5.2 Verifying Transaction Type Creation
To verify these transaction types, follow the procedure below.

Prerequisites
Claim defaults must be specified.
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Steps
To verify that you have successfully created transaction types:

1. Create a deduction and overpayment in Oracle Receivables.

2. Create a chargeback in Trade Management.

3. Settle and approve the related claims for each in Trade Management.

4. In Oracle Receivables:

a. Verify that the overpayment and deduction reference the claim number 
from Trade Management.

b. Verify that the chargeback has been created.

2.5.6 Create a Transaction Source for Claim-related Credit and Debit Memos
This setup is optional.

The settlement of a claim in Trade Management can result in the automatic creation 
of a debit or credit memo in Oracle Receivables. A transaction source is used for 
data validation and is required for this automated process to occur. The transaction 
source also determines whether on-account credit and debit memos created via 
Trade Management affect sales credits.

This set up is optional because existing transaction sources can also be used for 
Trade Management. Create a transaction source specifically for Trade Management:

■ For tracking purposes.

■ If validation requirements for credit and debit memos generated via Trade 
Management are different from others.

Prerequisites
None

Steps
1. Log in to Oracle Forms and select the Receivables Super User responsibility.

2. Navigate to Setup > Transactions > Sources.

3. Follow these guidelines to complete the Transaction Sources form:

■ Name: Enter a name for the transaction source

■ Type: Select Imported
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■ Batch Source tab: Open the Reference Field Default Value LOV and select 
interface_header_attribute1.

■ Autoinvoice Options tab: Accept the defaults

■ Customer Information tab: Choose ID for all options

■ Accounting Information tab: Choose ID or Percent for all options

■ Other Information tab: Choose ID or Code for all options

■ Sales Credit Data Validation tab: Choose ID or Percent for all options 

4. Save your work.

2.5.7 Create an Aging Bucket for Claims and Deductions
Claims Aging is an optional setup that summarizes all claim amounts by customer 
and days due. The claims processor can use this view to determine which customer 
has the largest number of outstanding claims and work on those claims first.

An aging bucket can be configured in Oracle Receivables and used by Trade 
Management to review and report open claims. It is defined by a specific time 
period. Each aging bucket can have multiple bucket lines (time periods):

■ Current: Ages the claims outstanding or not yet resolved based on the claim 
date. For example, by specifying 0 to 10 days old, claims that are 0 to 10 days 
past the claim date are displayed.

■ Past Due: Ages the claims that are past due in the range specified in the line. 
Note that aging analysis is based on the due date specified on the claim. For 
example, by specifying 10 to 20 days due, claims that are 10 to 20 days past the 
past due date are displayed.

■ Future: Ages claims that are due in the future. Note that aging analysis is based 
on the due date specified on the claim. For example, specifying -10 days to -5 
days displays claims that will be past due 5 to 10 days from the current date.

If aging buckets are already defined in Oracle Receivables, they can be reused for 
Trade Management. Create one specifically for Trade Management only if claim 
aging bucket definitions are different from others.

To avoid duplication of amounts on claims aging, use a consistent aging bucket type 
for each bucket setup. For example, to set up a claims aging bucket view, set up a 
complete past due setup for an aging bucket without any overlapping buckets.
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2.5.7.1 Creating an Aging Bucket for Oracle Trade Management
Follow the procedure below to create an aging bucket for Trade Management.

Prerequisites
None

Steps
1. Set up an aging bucket using the instructions listed in the Oracle Receivables User 

Guide.

2. Run the concurrent program AMS-TM: Claims Aging Populating.

3. Select the aging bucket you have set up for Trade Management when you are 
prompted to enter a parameter.

The LOV displays a list of all the aging buckets in Oracle Receivables.

2.5.7.2 Verifying Aging Bucket Creation
To verify aging bucket creation:

1. Open the Claims Aging page.

2. Verify that the bucket definitions (for example, 0 to 30 days) are visible on the 
horizontal heading.

3. Verify that customer names are listed in the first vertical column.

4. Drill down into a claim number for a particular customer account and verify 
that you see a list of claims for that account and aging bucket.

2.5.8 Attaching Trade Management Requests 
As an option, you can add Oracle Trade Management concurrent requests to the 
Oracle Receivables user responsibility. People with Oracle Receivables 
responsibilities often need to run Trade Management related claim-related requests, 
and it is much easier for them to be able to do so from within their Oracle 
Receivables responsibility. Also, the Oracle Receivables user does not need to be 
assigned a Trade Management responsibility simply to run concurrent programs. 

In the same way, you can add any of the Oracle Receivables concurrent requests to a 
request group associated to a Trade Management responsibility.
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Prerequisites
None

Steps
1. Log in to Oracle Forms with System Administrator Responsibility. 

2. Navigate to Security > Responsibility > Request Groups.

3. Query for Group = Receivables All. 

4. Under the Request table, add any program used by Trade Management.

5. Save your work. 

6. To add concurrent requests to the Trade Management responsibility, query for 
Group = Trade%. 

7. Select the Trade Management responsibility and add the Oracle Receivables 
concurrent requests you need.

8. Save.

2.5.9 Set Up Related Customer Accounts 
Claims can be settled for the claiming customer account and all other related 
accounts. Claims always use customer accounts in TCA, not parties. For example, if 
accruals were tracked at the account level, and the claim is from a bill-to account, 
payments can be made to related ship-to accounts.

For instructions on defining account relationships, refer to the Oracle Receivables 
User Guide.

2.5.10 Set Up Receivable Activity
By setting up receivable activity, you:

■ Enable claim investigation for deductions and overpayments.

■ Enable the creation of accounting entries for deductions and overpayments.

■ Support two different types of write-off adjustments for Oracle Trade 
Management

The benefits of setting up receivable activity are:

■ Invoices can be closed with zero
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■ Deductions and overpayments can be tracked in different account not related to 
the invoices.

■ Any General Ledger account can be used to track deductions and 
overpayments.

Deductions
Two types of deductions exist: 

■ Transaction-related: Can be referenced back to a specific transaction such as an 
invoice, debit memo, or chargeback. During the cash application process, the 
balance of the transaction is left on the transaction itself.

■ Non-transaction related: Cannot be referenced back to a specific transaction. 
When remittance is made, the customer may indicate that all transactions are 
being paid in full. In addition, they submit a separate debit memo, resulting in a 
deduction.

In the claim module, it is assumed that the transactions themselves are paid in full. 
In reality, however, the cash amount received may be less than the actual balance. 
This difference must be accounted for. 

Example: A customer sends a check for $1,000 and indicates full payment for 10 
invoices totally $1200. On a separate line of the invoice, the customer takes a 
deduction of $200 and references an internal debit memo number. Accounting 
entries will be:

■ Debit Cash $1,000

■ Debit Receivable Activity for claim investigation $200

■ Credit Receivables $1,200

Overpayments
Overpayment claims are always non-transaction related. All nontransaction-related 
claims require an accounts receivable activity.

Example: A customer sends a check for $1200 and indicates full payment for 10 
invoices totally $1000. The $200 is not related to a specific invoice. Without knowing 
what to do with the extra $200, Oracle Receivables creates an overpayment claim 
that will be researched.

Accounting entries will be:

■ Debit Cash $1,200
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■ Credit Receivable Activity for claim investigation $200

■ Credit Receivables $1,000

2.5.10.1 Procedure to Set up Receivable Activity
To set up receivable activity, follow the procedure below.

Prerequisites
None

Steps
1. Log in to Oracle Forms and select the Receivables Super User responsibility. 

2. Navigate to Setup > Receipts > Receivable Activities.

3. Enter a Name. 

4. Enter a Description.

5. In the Type field, select Claim Investigation.

6. Accept the defaults for GL Account Source and Tax Code Source.

7. In the Activity GL Account field, select the account that will hold amounts from 
nontransaction-related claims while they are being investigated.

8. Click OK.

9. Select appropriate Oracle General Ledger account.

10. Click OK.

11. Save your work.

2.5.10.2 Procedure to Verify Receivable Activity Set Up
To verify that you have successfully set up receivable activity:

1. Create a receipt in Oracle Receivables and designate it for claim investigation.

2. Open the LOV for the Activity column; your receivable activity should be listed.

2.5.11 Verify Receivables System Options
In order to set up integration for claim creation to use the auto lockbox feature, you 
must perform the following setup. This setup determines what types of unmatched 
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remittances for which you want to create claims, and also how to handle claims for 
matched remittances.

If you do not want to create deductions for credit memos, you can exclude credit 
memos on the system options in Oracle Receivables, so that the lockbox process 
does not create deductions for any short payments against credit memos.

Steps
1. Log into Oracle Forms with the Oracle Receivables responsibility.

2. Navigate to Setup > System > System Options.

3. Open the Claims tab.

4. In the Unmatched Remittances region, indicate the type of remittance line for 
which you want Receivables to create claims.

5. In the Matched Remittance Lines region, select the Prepare for Claim Creation 
box if you want Receivables to create claims for matched remittances.

6. Select the Exclude Credit Memos box if you want Receivables to exclude credit 
memos from automatic claim creation.

2.5.12 Set Up the Tax Engine
Claims are enabled to quote an estimated tax for the claim line at the time of tax 
calculation action. Tax calculation action is only qualified for Credit Memo-On 
Account, Debit Memo, and RMA Settlement.

The tax estimate can be based on:

■ Tax status

■ Address information

■ VAT (Value Added Tax) codes assigned to items, ship-to sites, and customers

If a tax code is entered in the claim line, tax calculation is based on that tax code.

The Tax list of values for Credit Memo-On Account, Debit Memo, an RMA 
Settlement brings up tax codes with type VAT or Sales Tax only and must be ad hoc.

If the profile option Tax: AllowOverride of Tax Code is set to No, the Tax list of 
values is not invoked and the user cannot enter or change the tax code in the claim 
line.

The actual tax value that appears on the credit memo or debit memo in Oracle 
Receivables may vary. See: Oracle Receivables User’s Guide, Overview of Tax and 
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Setup Steps for Value Added Tax for details. If the actual tax amount is different 
from the tax amount on the claim, the claim tax amount is adjusted when the Claim 
Settlement Fetcher program is run.

For Credit Memo-On Account, Debit Memo, and RMA Settlement, if the user does 
not calculate the tax and adjust the line amount, Autoinvoice determines the tax 
calculation flow. See Oracle Receivables Tax Manual, Overview of Calculating Tax for 
more information.

2.5.13 Set Up Lockbox Integration
In order to use the new Lockbox Integration feature, some steps must be performed 
in Oracle Receivables. For more information, see Section 6.29, "Lockbox 
Integration".

Prerequisites
None

Steps
1. Log in to Oracle Forms with the Oracle Receivables responsibility. 

2. Create a Transmission Format that accepts customer reference and customer 
reason codes.

You must first work with your banks to accept customer reference and customer 
reason codes in your lockbox.

3. In the Lockbox window, check the Evaluate for Claim Eligibility box.

If this option is enabled, the lockbox process automatically creates claims for 
eligible remittance lines.

4. Navigate to Setup > System > System Options.

5. Open the Claims tab and indicate claim handling preferences. See Guidelines.

6. Attach a General Ledger account for claims on the receipt class or payment 
methods setup.

7. Log into Oracle Trade Management to perform Customer Reason Code 
Mapping (see Section 6.14, "Importing and Mapping Customer Reason Codes".
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Guidelines
If you select the evaluate claim eligibility for claims handling, then the lockbox 
looks at your claims system options to determine which imported receipts are 
eligible for claim creation. You can specify here how the system should handle the 
unmatched remittance lines and the matched remittance lines.

See the Oracle Receivables User Guide for more information.

2.5.14 Verify Receivable Application Transaction Flexfields
Oracle Receivables passes receipt application information to Oracle Trade 
Management using Oracle Receipt Application Information flexfields. 

On creation of a deduction or overpayment from Oracle Receivables, the Receipt 
Application Information flexfield is sent as the Deductions flexfields to Oracle Trade 
Management.

When there is a deduction with Chargeback, the Deductions flexfield values are 
passed to the Transaction Information flexfields on the transaction.

For the mapping to be consistent, flexfield segments that are enabled for Receipt 
Application Information, Deductions, and Transaction Information must be 
evaluated and enabled appropriately.

Additionally, the Invoice Transaction flexfield has been seeded with a new context, 
CLAIM, which has the following segments:

■ Claim Number

■ Customer Reference

■ Customer Reason

■ Claim Reason

When a claim is settled with Credit Memo-On Account, Debit Memo or 
Chargeback, this flexfield context, along with the values, are passed to Receivables. 
The context value of Receivables Application Information flexfields must be the 
same as the Deduction flexfields in Oracle Marketing.

Perform the following procedure to verify receivable application transaction 
flexfields.

Prerequisites
None
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Steps
1. Log in to Oracle Forms with System Administrator responsibility.

2. Navigate to Application > Flexfield > Descriptive > Segments.

3. Press F11 to open the search mode.

4. In the Application field, enter Oracle Receivables.

5. In the Title field, enter Receipt Application Information.

6. Press Control + F11 to perform a query.

7. In the Context Field Values table, under the Code column, create a new context 
code, for example Claim Investigation. Enter a code, name, and description.

If a value is already defined in the Context Field Values table, you must 
uncheck the Freeze Flexfield Definition box in order to enter a new value. This 
may affect validity of data that uses this flexfield.

8. Click Segments, and on the Segment Summary screen, enter Number, Name, 
Window Prompt, and Column.

The Number is the flexfield display sequence. 

9. Save, and close the Segment Summary screen.

10. Check the Freeze Flexfield Definition box.

11. Click Compile.

12. Click OK.

13. Press F11 to open the search mode.

14. In the Application field, enter Oracle Marketing.

15. In the Title field, enter Deductions.

16. Press Control + F11 to perform a query.

17. Uncheck the Freeze Flexfield Definition box.

18. In the Context Field Values table, under the Code column, create a new context 
code.

The context code must be the same as the one defined in step 7. 

19. Click Segment, then enter Name, Window Prompt, and Column

20. Check the Freeze Flexfield Definition box.
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21. Click Compile.

22. Click OK.

2.5.15 Set Up Write Off Limit
When integrating Oracle Trade Management with Oracle Receivable Application 
11.5.10, you must set up the Write-off Limit needs to be setup in order to automate 
Receipt Write-Off settlement. To set up the Write-off Limit in the Oracle Receivables 
application, perform the following procedure.

Steps
1. Log in to Oracle Forms with Receivables responsibility.

2. Navigate to Setup > System > System Options.

3. Click the Miscellaneous tab.

4. Set up the amount range for the Write-off Limits Per Receipt, for example, a 
minimum of -100 and maximum of 100.

Guidelines
The Write Off Limit setup is used only in Oracle Receivables release 11.5.10.

2.6 Integrating Oracle Payables
Bill back requests are entered in Trade Management as claims. Claims can be 
associated with promotional earnings and accruals. They can be settled by check, 
credit memo or RMA (which creates a credit memo). When the customer is paid by 
check, Trade Management uses Open Interface Import in Oracle Payables (AP) to 
create a payables invoice. The invoice is then converted to a check.

To implement Oracle Payables for Trade Management, follow the procedures in 
these sections:

■ Section 2.6.1, "Create a Source for Invoices"

■ Section 2.6.2, "Verify Payment Terms"

■ Section 2.6.3, "Verify Payables System Options"

■ Section 2.6.4, "Set Up Vendors and Vendor Sites"

■ Section 2.6.5, "Set Up the Tax Engine"
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2.6.1 Create a Source for Invoices
When settling a claim with a check, Trade Management populates the Oracle 
Payables invoice interface tables with the payables invoice details. A source is 
required for this. For additional information, refer to the Oracle Payables User Guide.

To create a source to identify Oracle Payables invoices generated by Trade 
Management, use the following procedure.

Prerequisites
None

Steps
1. Log in to Oracle Forms with Accounts Payable Responsibility. 

2. Navigate to Setup > Lookups > Payables. 

3. Query for Type = SOURCE.

4. Add the Source code to be used by Trade Management.

5. Save your work. 

2.6.2 Verify Payment Terms
When settling a claim with a check, Trade Management populates the Oracle 
Payables invoice interface tables with payables invoice details. Once created in 
Oracle Payables, an Oracle Payables payment term can be selected in the system 
parameters for AMS. While populating the Oracle Payables invoice interface tables, 
Trade Management passes this payment term to create the invoice.

For more details, refer to the Oracle Payables User Guide.

To verify Oracle Payables payment term set ups, use the following procedure.

Prerequisites
None

Steps
1. Log in to Oracle Forms with Accounts Payable Responsibility.

2. Navigate to Setup > Invoice > Payment Terms. 
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3. Review the Payment Terms you intend to pass from Trade Management to 
Oracle Payables. 

4. Save your work. 

2.6.3 Verify Payables System Options
The interface with Oracle Payables that is used in claims integration with Oracle 
Payables requires reference to the tax options that are set up under the Payables 
system options. Please see the Oracle Payables User Guide for specific steps.

To view the Oracle Payables system options, log into Oracle Forms with the Oracle 
Payables responsibility and navigate to Setup > Options > Payables.

2.6.4 Set Up Vendors and Vendor Sites
Claims integration with Oracle Payables requires that vendors and vendor sites are 
set up. This is performed in Oracle Payables. To set up the vendor and vendor site 
settings, perform this procedure.

Steps
1. Log in to Oracle Forms with the Oracle Payables responsibility.

2. Navigate to Suppliers > Entry.

3. Query for a supplier.

4. Click the Sites button.

5. On the Supplier Sites page, check the Pay box in the Site Uses section if you 
want that site to appear on the Claims and Trade Profiles pages in Oracle Trade 
Management.

6. Save.

2.6.5 Set Up the Tax Engine
Claim tax calculation is not enabled for check settlement. By default, tax calculation 
is done in Oracle Payables. In the Oracle Payables application, the supplier site 
needs to set up to use Line Level automatic tax calculation. When a claim is settled 
by check, it is interfaced to Payables with the amount_includes_tax_flag equal to Y 
to indicate that the amount includes one or more non-use type taxes (sales, user, 
and so on).
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During invoice validation of the imported invoice, Oracle Payables calculates the 
tax amount based on the tax code or tax group in the TAX_CODE column and 
creates one or more additional tax distributions in the appropriate amounts. 
Payables also reduces the amount of this distribution by the tax amount.

If a user does not enter the tax code in the claim line, the tax code assignment is 
based on the Tax Code Defaults hierarchy that was previously defined in the 
Oracles Payables Options window. For more information, see the Oracle Payables 
User Guide, Defaulting Tax.

If a user does enter the tax code in the claim line, the tax_code_override_flag is set 
to Y, and the tax code user selected in the claim line is passed to Oracle Payables. 
However, if the Tax: Allow Override of Tax Code profile option is not enabled, the 
tax code value defaults during import based on standard tax defaulting rules.

In the Claim line, when a user selects Check as the settlement method, the Tax Code 
list of values displays tax codes with type of Sales, Use, and User-defined in Oracle 
Payables.

For more information about defining the tax code in Oracle Payables, please refer to 
the Oracle Payables User Guide, Payables Setup > Tax Codes.

2.7 Integrating Advanced Pricing
Advanced Pricing (QP) provides the following functionality for Trade Management:

■ Provides Promotion (offer) logic

■ Price lists created in Trade Management are stored in the Advanced Pricing 
schema

■ Offers created in Trade Management are stored in the Advanced Pricing schema

When an offer or price list is created in Trade Management, a call to the Advanced 
Pricing APIs is made. 

To implement Advanced Pricing for Trade Management, perform the following:

Set Advanced Pricing Profiles
Trade Management offers are created in Advanced Pricing as modifiers of type 
Promotion. Users can modify offers from within Advanced Pricing, as determined 
by the profile option QP: Source System Code set at either the site, application or 
user level. 
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For Trade Management, this profile option can be set to Oracle Pricing or Oracle 
Marketing. 

■ If set to Oracle Pricing: An Advanced Pricing user is able to edit Trade 
Management offers. 

■ If set to Oracle Marketing: Advanced Pricing user is unable to edit Oracle 
Trade Management offers. 

Because offers typically go through an approval process, we recommend setting this 
profile to Oracle Pricing.

Set Profile Option for Indirect Sales
Trade Management provides the ability to handle rebates and chargeback claims 
from customers and wholesaler networks for indirect sales. Three types of gateways 
can be used to import customer information in batches: XML gateway, EDI or 
WebADI.

From this data, chargebacks and third party accruals are created automatically.

Special pricing is also included in this functionality. Indirect Sales uses a price list to 
store the terms and conditions between the company (manufacturer) and its end 
customer for chargeback claim scenarios.

You can also track your customers’ inventory levels. Once an inventory level is 
established, it is updated based on the sales and stock movement data you import. 
This process ensures that your customers do not claim more than they are entitled 
to. Adjustments can be made manually.

To implement this functionality in Advanced Pricing, set the profile option 
QP: Return Manual Discounts to Yes, so that all adjustments (manual and 
automatic) are returned by the pricing engine.

Set Promotional Limits
When creating offers, Trade Management users can define a promotional limit, 
referred to as a cap. To enable promotional limits, set the following profile options: 

■ Set QP: Promotional Limits Installed to Yes at the site level. This profile 
enables the promotional limit feature. 

■ Set QP: Limit Exceed Action, at site, responsibility, or user levels. For this 
profile select one of the following settings: 
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– Soft - Full Benefit Amount: Sends the Trade Management user a warning 
message when promotional limits are being violated. Although the warning 
appears, the order process can proceed. 

– Hard - Adjust Benefit Amount: Puts the order on hold when promotional 
limits are violated.

These settings enable the actual limit amount of each offer to have a cap amount. 
This amount is passed by Trade Management to Advanced Pricing and Trade 
Management as the promotional limit.

For more details, refer to the Oracle Order Management Suite Implementation Guide 
and Oracle Advanced Pricing Implementation Guide.

2.8 Integrating Order Management
Trade Management integrates with Order Management (OM) for the following 
purposes: 

■ Advanced Pricing - Order Management: Trade Management offers are passed 
directly into the Advanced Pricing schema. Although they reside in the 
Advanced Pricing schema, they are executed in Trade Management. For this 
integration point, no setups are necessary.

■ Order Management - Trade Management Budgets: Once an offers is applied to 
a sales order, an off-invoice discount or accrual adjustment is created for the 
order. AMS Funds Accrual Engine fetches the order (and the related offer 
adjustment information), ultimately updating the budget utilized column. For 
this integration point, no Trade Management setups are necessary. 

■ Trade Management Claims - Order Management: When customers return 
products (for any reason), they can apply a deduction or claim at the same time. 
For this reason, claims and deductions can be triggered by customer returns. As 
such, Trade Management provides the ability to create a Return Materials 
Authorization (RMA) that is passed directly into Order Management in with 
the status Booked. Ultimately, this RMA goes through Trade Management 
processes, finally generating a credit memo. When this happens, Trade 
Management can automatically locate it using the Claims Settlement Fetcher 
program. This program enables automatic closure of a claim or deduction using 
the credit memo. For this integration point, several Trade Management setups 
are required. For details see Section 2.8.1, "Set Up Transaction Types". 

For more details on how to setup Order Management, refer to the Oracle Order 
Management Suite Implementation Guide.
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To setup transaction types for OM, use the following procedure. 

2.8.1 Set Up Transaction Types
For Trade Management, you must verify the Trade Management Transaction Type 
Setup. The life-cycle of an order is driven by its transaction type and the workflow 
set up behind it. For an RMA, the workflow determines many factors, such as 
whether or not the return order will affect inventory. 

To set up transaction types in OM, use the following procedure: 

Prerequisites
None

Steps
1. Log in to Oracle Forms with the Order Management Responsibility. 

2. Navigate to Setup > Transaction Types > Define.

3. Query for the transaction type.

Query for the type you plan on using for Trade Management RMAs.

4. Verify that the transaction type code is ORDER.

5. Verify that Order Category is either Mixed or Return.

6. Note the Order Workflow.

7. On the Main tab, verify that there is a Default Return Line Type populated.

8. On the header, click the Assign Line Flows button.

9. Verify that Order Type is populated. 

10. In the Assign Workflow Processes table:

a. Find the Return Line Type entered on the Main tab, and note the Process 
Name.

For Trade Management, workflow determines whether a credit is generated 
for the RMA. A credit memo is generated if the workflow contains an 
Invoicing Activity function. This function must be checked using Oracle 
Workflow Builder, a mandatory setup for RMAs to work in Trade 
Management. 
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After workflow does its basic check, it contains an Invoicing Activity, which 
generates a credit. 

b. Verify that the workflow is assigned to a valid transaction type. After 
verifying that there is a valid transaction type 

c. Assign this in the Trade Management System Parameters and/or Claim 
Types. 

11. Save your work. 

2.9 Integrating Oracle Inventory
Oracle Inventory serves as the repository for items that can be used in Trade 
Management. Use Oracle Inventory to create new products or collateral. After 
creating new inventory products/items you can add them to an offer or campaign. 
Items stored in Oracle Inventory reside in the MTL_SYSTEM_ITEMS table. 

Oracle Inventory requires one Inventory Organization to be identified. Typically 
this is the Master Inventory Organization. In a multiple operating unit environment, 
the Master Inventory Organization should consist of all the products from all the 
operating units; it serves as the highest organizational level. If you need to separate 
products (sold from each operating unit) into different Inventory Organizations, 
create a separate Inventory Organization for each operating unit. These operating 
units should exist only as subsets of the Master Inventory Organization.

Implement Oracle Inventory is described in the Oracle Inventory Implementation 
Guide.
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Trade Management Essential 
3

Trade Management Essential Tasks

This chapter provides details on the first tasks you must perform to implement 
Oracle Trade Management.

Topics include: 

■ Section 3.1, "Oracle Trade Management Essential Tasks Overview"

■ Section 3.2, "Set Up the Time Structure"

■ Section 3.3, "Set up Calendars and Rates"

■ Section 3.4, "Set System Parameters"

■ Section 3.5, "Create Trade Management Users"

■ Section 3.6, "Perform the Basic Setups"

■ Section 3.7, "Perform Customer Set Ups"

■ Section 3.8, "Set Up Buying Groups"

■ Section 3.9, "Implement and Verify Oracle CRM Technology Foundation 
Applications"
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3.1 Oracle Trade Management Essential Tasks Overview
This chapter contains information and instructions for tasks that:

■ Must be performed before proceeding with the rest of the Trade Management 
implementation

■ Affect all of the Trade Management modules (Budgets, Trade Planning, Claims, 
Indirect Sales)

We recommend you perform the tasks in the order in which they are presented in 
this chapter. Tasks include:

■ Setting up the Time Dimension Structure: This sets up how the calendars used 
in Trade Management function and interact.

■ Setting System Parameters: These define the accounting structure for the 
application.

■ Creating Trade Management Users: This process sets up one implementation 
user and also the employee users for the application.

■ Performing Basic Setups: These setups include setting up activities, categories, 
rules, and other building blocks of the Trade Management process.

■ Performing Customer Setups: This process is used to set up your customers in 
the application, including classifications, relationships, and trade profiles.

■ Setting Up Buying Groups: Buying groups are set up so companies can 
leverage high volume purchase discounts.

■ Implementing and Verifying Oracle Foundation Applications: These 
applications are the basis for running Oracle applications. They include 
Resource Manager, Notes, Territory Manager, Task Manager, and Calendar 
(HTML and Forms-based).

3.2 Set Up the Time Structure
This section describes the recommended steps and cautions for setting up the Time 
Structure. This is the first task you must perform when implementing Oracle Trade 
Management. The Time Structure facilitates activities such as quota creation quota 
allocation, target allocation, offer forecasting, and reporting features such as sales 
performance graphs.

Note: The time structure must be properly set up before running any concurrent 
programs for populating any materialized views.
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The time structure you set up provides data at these levels:

■ Day

■ Week

■ Enterprise Period

■ Enterprise Quarter

■ Enterprise Year

Trade Management must have a defined Oracle General Ledger calendar. Make sure 
that the Oracle General Ledger Calendar is set up correctly. See the Oracle General 
Ledger User’s Guide.

To use Trade Management pages effectively, you must be sure that Enterprise 
calendar has periods defined from the Global Start Date to any future dated 
transactions on which you will report. For example, if you are reporting on future 
dated transactions such as quotas or forecasts, periods must be defined for all 
possible future dates.

When you add more periods in the General Ledger calendar, do not change any 
profile options. Rerun the concurrent program for updating the time structure with 
the new "TO DATE" parameter and view the log.

To set up the time structure, follow the instructions listed in these sections:

■ Section 3.2.1, "Set Profile Options"

■ Section 3.2.2, "Run the Concurrent Program for Updating the Time Structure"

■ Section 3.3.1, "Set Up the Accounting Calendar"

■ Section 3.3.2, "Update an Accounting Calendar"

■ Section 3.3.3, "Set Up Calendar Type"

■ Section 3.3.4, "Set Up Period Rates"

■ Section 3.3.5, "GL Daily Rates"

■ Section 3.3.6, "Set Up the Calendar"

3.2.1 Set Profile Options
Set the following profile options to define the calendar that will be used by your 
Oracle Trade Management team. The values you assign to these profiles should be 
based on your specific business needs.
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Note: You should not change these parameters after implementation is complete. If 
you do change the parameters after data is loaded into Trade Management, you will 
have to truncate all tables and rerun all concurrent processes. For more information 
on changing global parameters, see the Trade Management System Administrator 
Guide.

Prerequisites
None

Steps
1. Log into Oracle Forms using the Oracle Trade Management Administrator 

responsibility.

2. Navigate to Profile > System.

3. Set the profile options as shown in the table below.

The table displays six profile options. The first four are required. Profiles 5 and 
6 are optional. It is highly recommended that you set profile 5 to yes, so that 
you can view the log after running the concurrent program for updating the 
time structure.

Table 3–1 Trade Management Calendar Profile Options

Profile Option Name Description

AMS: Marketing Calendar Enter the Oracle General Ledger Calendar Name: AMS_
CAMPAIGN_DEFAULT_CALENDAR.

The calendar type determines the year and the periods within 
the year that are available for trade planning and/or 
cross-functional analysis. You can select any calendar that is 
defined in General Ledger. Multiple calendars can be created 
in General Ledger, but the one used by Trade Management is 
the value entered in this profile.Throughout the application, 
the periods found by users are definitions based on the 
calendar entered in this profile. Suggested value: Accounting. 
See the General Ledger User’s Guide.

OZF: Start Day of Week Start_day of week: OZF_TP_START_DAY_OF_WEEK. The day 
of the week selected here is the day on which your financial 
week will begin. Only values of 1-7 are valid; they correspond 
to the days of the week, Sunday through Saturday. For 
example, choosing 2 means that that the week starts on 
Monday (which is the suggested value).
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3.2.2 Run the Concurrent Program for Updating the Time Structure
Run the concurrent program OZF-TM: Update Time Structure. Suggested 
parameters are:

■ FROM DATE: 1-JAN-1997 0:0:0

■ TO DATE: 31-DEC-2005 0:0:0 (the last date previously defined in General 
Ledger)

■ All Level: Y

For the procedure to run concurrent programs, see Section C.1, "Running 
Concurrent Programs".

OZF: Period Type Period_type: OZF: TP_PERIOD_TYPE. Period Type is 
required. It sets the default period type used for Trade 
Management. This contains the name of the period type that is 
defined in General Ledger, for example, Month. The value in 
this profile cannot be Year or Quarter. Month is the suggested 
value. See Period Types in the General Ledger User’s Guide.

OZF: Global Start Date 
(mm/dd/yyyy)

Global Start Date: OZF_TP_GLOBAL_START_DATE. This 
required profile contains the earliest date from which you 
want to populate the time structure. It sets the absolute start 
date for Trade Management data. The Oracle General Ledger 
calendar should have data from that date onwards, with no 
gaps. All data that is loaded into the Trade Management 
transaction tables which refers to the time structure tables is 
collected as of this date. Historical data is maintained in a 
Trade Management materialized view from this date forward.

OZF: Debug Mode Debug Mode: OZF_TP_DEBUG_MODE. If the value is set to 
Yes, details of the Time Structure are written in a file that can 
be accessed from the Forms application (View Requests > 
View Log). It is highly recommended that you set the value to 
Yes, so you can view the log after running the concurrent 
program for updating the time structure.

OZF: Degree of 
Parallelism-Src

Degree_of_parallelism: OZF_TP_PARALLEL_SRC. This 
profile is used for performance reasons. For example, running 
Trade Management on multiple servers saves processing time. 
Enter a positive integer such as 1, 2, 5 to reflect the number of 
processes that you want to run simultaneously. The suggested 
value is 1.

Table 3–1 Trade Management Calendar Profile Options

Profile Option Name Description
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3.3 Set up Calendars and Rates

3.3.1 Set Up the Accounting Calendar
Set up at least one accounting calendar based on your business requirements. 
Multiple calendars can be defined, with a different calendar assigned to each set of 
books. For example, you can use a monthly calendar for one set of books and a 
quarterly calendar for another.

A calendar can be set up for any fiscal year, with up to 366 accounting periods for 
actuals, and 60 periods for budgets. The periods can be of different lengths, but they 
must all be the same period type for one set of books. Otherwise, General Ledger 
will not recognize them.

You can define an accounting calendar for past or future periods. Be sure that the 
enterprise calendar has periods defined from the Global Start Date to any future 
dated transactions upon which you will report.

It is a good practice for Oracle Trade Management to define periods for two or more 
years into the future. This is useful for forecasting and quotas. Define a complete 
financial year. Be sure not to miss defining any period.

The GL period type should be defined in the same language as the instance.

Accounting calendars can be created in Trade Management or in General Ledger. 
The procedure below is for Trade Management.

Prerequisites
Period (calendar) types must be created.

Steps
1. Log in to Trade Management and navigate to Administration > General > 

Globalization > Accounting Calendar.

2. Click Create.

3. Enter the calendar name.

4. Enter a prefix.

For example, Jan or Q1, or FY04.

5. Select a type.

6. Enter a year.
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7. Enter a number for each period.

8. Define From and To dates.

9. Enter a subject (period name) and continue until all periods are entered.

10. Click Create.

3.3.2 Update an Accounting Calendar
To update an existing accounting calendar, perform the following procedure.

Prerequisites
Period (calendar) types and accounting calendar must be created.

Steps
1. Log in to Trade Management and navigate to Administration > General > 

Globalization > Accounting Calendar.

2. Search for the calendar.

3. In the Periods area, make any changes that you need.

4. Click Update.

3.3.3 Set Up Calendar Type
Before defining an accounting calendar, you must create period types. Period types 
can be created in General Ledger or in the Trade Management user interface. The 
procedure below is for entering them in the Trade Management user interface. The 
period types are still created in General Ledger in the background.

Prerequisites
None

Steps
1. Log in to Trade Management and navigate to Administration > General > 

Globalization > Calendar Types.

2. To create new periods, enter the appropriate information in the Period Types 
section and click Update.

3. To display a particular period type or group of periods:
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a. Enter the appropriate year and period type in the Find Period Types section 
of the page.

b. Click Search.

3.3.4 Set Up Period Rates
You can maintain period–average, period-end, and revaluation exchange rates for 
any foreign currency you have enabled. General Ledger uses:

■ Period–average and period-end rates when you translate your actual and 
budget account balances.

■ The revaluation rate when you revalue account balances that are denominated 
in a foreign currency.

Prerequisites
Rate types (conversion types) have been defined in General Ledger. Type mapping 
has been performed in General Ledger or in the Trade Management user interface.

Steps
1. Login to Trade Management and navigate to Administration > General > 

Globalization > Period Rate.

2. Select a calendar.

3. If necessary, search for a period name.

4. To create or modify pseudo period rates, enter the appropriate information and 
click Update.

5. To create a new period rate, in the Period Rates area:

a. Select a blank row.

b. Search for a period.

The conversion type automatically defaults based on type mapping.

c. Select the From currency and To currency.

d. Enter a date.

e. Click Update.
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3.3.5 GL Daily Rates
The GL Daily Rate is the actual exchange rate between two currencies on a 
particular day. Use this procedure to enter the rate so it can be used throughout the 
application whenever currency conversion is performed for that date. Use the 
following procedure to view, update, or create GL Daily Rates.

Prerequisites
The rate type (conversion type) has been defined in General Ledger.

Steps
1. Log in to Trade Management and navigate to Administration > General > 

Globalization > GL Daily Rate.

2. Select the From Currency and the To currency.

3. Select ANY Currency to display all records.

4. You can select the conversion date and conversion type if known.

5. Click Search.

6. To update information, make changes to the data and click Update.

7. To create a new GL Daily Rate

a. Select a blank row.

b. Enter the From currency and To currency.

c. Enter a conversion date.

d. Enter a conversion type. 

e. Enter a conversion rate.

The inverse conversion rate is automatically calculated as 1/conversion rate 
entered.

f. Click Update.

3.3.6 Set Up the Calendar
The calendar defined in this step becomes a value in the LOVs for the profile AMS: 
Marketing Calendar. 

To set up the calendar use the following procedure:
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Prerequisites
None

Steps
1. Log in to Oracle Forms with System Administrator responsibility.

2. Navigate to Profile > System.

3. In the Application field enter Oracle Marketing.

4. In the Profile field enter AMS: Marketing Cal%.

5. At the Site level, use the list of values to view available AMS: Marketing 
Calendar options.

6.  Select the appropriate Accounting Calendar created previously. For more 
information see Section 3.3.1, "Set Up the Accounting Calendar". 

7. Save your work.

This is a generic calendar available to all Trade Management users. Different users 
can have different views of the Calendar, however contents are not personalizable at 
user level. The Calendar displays marketing objects based on statuses and time 
range. Procedures need to be performed to centrally set up what objects are shown 
in the Calendar. 

For Trade Management, the Calendar supports:

■ Campaigns

■ Offers

To implement the calendar use the following procedure:

■ Section 3.3.6.1, "Assigning Usage to Resource Group"

■ Section 3.3.6.2, "Selecting Calendar Display Parameters"

■ Section 3.3.6.3, "Running Concurrent Program for Calendar"

■ Section 3.3.6.4, "Configuring User Profiles"

3.3.6.1 Assigning Usage to Resource Group
Before users can view the Calendar, their group must be assigned the CRM 
Foundation Calendar Items Group Usage. Only users on groups with “Calendar 
Item” usage will be able to view Objects. For more information see the Oracle 
Marketing User Guide. 
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To assign usage to a resource group follow the procedures below: 

Prerequisites
None

Steps
1. Log in to Oracle Trade Management. 

2. Navigate to Administration > Resources > Groups Summary.

3. Click a group name. 

The Group Detail page appears. 

4. Fill in the following mandatory fields on the Group Detail page:

■ Group Name: Name of the group by which Calendar usage privileges are 
requested.

■ Start Date: Start date for which the group will be able to access the 
Calendar. 

5. Fill in the following mandatory field for Group Usages: 

■ Usage: To enable Calendar functionality, select CRM Foundation Calendar 
Items from the drop-down menu. 

6. Click Update to save changes. 

3.3.6.2 Selecting Calendar Display Parameters
The Administrator must decide on the parameters that will ultimately be displayed 
in the Calendar. The Administrator has 2 options: 

■ Criteria: Displays Objects based on a criteria for which they qualify. For 
example, an Event Schedule may have a criteria of Status “new” and Date 
“January 1, 2003 - March 1, 2003". 

■ Object: Displays Objects specified. The Calendar supports Campaign Schedule, 
Event Schedule, One-off Events, and Offers. 

To specify Calendar parameters follow the procedure below: 

Prerequisites
None
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Steps
1. Log in to Oracle Trade Management. 

2. Navigate to Administration > Trade Management > Setup > Calendar Criteria. 

The Calendar Criteria Overview page opens. 

3. Select Create. 

The Create Marketing Calendar Criteria page opens.

4. Fill in the following details: 

■ Object: Object that will be displayed on the Calendar. 

■ Custom Setup: Select a custom setup for the Object selected. 

■ Start Date: Start date by which the Object selected will begin appearing on 
the Calendar. 

■ End Date: End date for which the Object selected will stop appearing on the 
Calendar. 

■ Priority: Priority level by which the Object will appear in the Calendar. 

■ Status: Object Status. For example, if the Object selected for display is 
“Campaign Schedule”, the status chosen may be Active Schedules. In this 
case, only Active Campaign Schedules will appear on the Marketing 
Calendar. 

5. Click Update to save your work. 

3.3.6.3 Running Concurrent Program for Calendar
Before the new object or criteria will display on the Calendar, run the concurrent 
program AMS : Interface Marketing Objects to Calendar. This program is a 
workflow background process and will update the Calendar as needed. For the 
procedure to run a concurrent program, see Section C.1, "Running Concurrent 
Programs".

3.3.6.4 Configuring User Profiles
Before a user can view the Calendar they must specify in their user profile what 
Objects they want to view. Further, users can personalize the Calendar by saving 
preferences based on their needs. 

To configure user profiles for Calendar preferences follow the procedure below: 

1. Log in to Oracle Trade Management. 
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2. Select the Profile icon. 

3. Navigate to Calendar > Personalize. 

The Calendar Personal Preferences Page opens.

4. In the Display Items drop-down menu choose Yes. The default value for this 
drop-down menu is No. This profile turns on the Calendar feature. 

5. Select Update to save your work. 

3.4 Set System Parameters
System parameter defaults define the following basic information:

■ Set of Books: When a user creates a budget in TM, it can be in any currency. In 
the background, however, a functional currency is recorded with the budget. 
The functional currency (defined for this set of books) is the main currency used 
by the Oracle General Ledger set of books. Oracle General Ledger postings are 
created in this functional currency.

■ Accounting Method: Select Accrual. 

■ Accounting section: Oracle General Ledger integration parameters including 
default accounts

– Sales, Expense, and Charge Account: For accruals created from lump sum, 
accrual, scan data or volume offers. If the option to post off invoice 
discounts to Oracle General Ledger is enabled, this is also used for the debit 
entry there. The accounting created will be debit sales/expense/charge, 
credit revenue account from the invoice in Oracle Receivables. The 
following accounting entries are created in Trade Management and tracked 
as liabilities in Oracle General Ledger.

– Debit Sales or Expense or Charge

– Credit Liability

– Accrual liability account: Accruals created either from a Lump Sum, 
Accrual, Scan Data, or Volume offers may be treated as liabilities by some 
companies. Crediting the liability account increases the liability balance.

– Receivable clearing account: This Oracle General Ledger entry, along with 
Debit Liabilities, is created when a claim or deduction is created and 
associated to promotional accruals if the claim settlement method is a credit 
memo.
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– Vendor clearing account: This Oracle General Ledger entry, along with 
Debit Liabilities, is created when a claim or deduction is created and 
associated to promotional accruals if the claim settlement method is a 
check.

■ Claim section: 

To set up these system parameter defaults, use the following procedure. It is broken 
down into subsections that reflect the sections on the System Parameters page.

Prerequisites
■ Business requirements for defaults have been established.

Steps
1. Log in to Trade Management.

2. Navigate to Administration > Trade Management > Setup > System Parameters.

3. Select the Post to GL check box.

Important: You must select this check box to integrate Trade Management with 
Oracle General Ledger. If not selected, the two applications will not be 
integrated.

4. Select the following check boxes based on your business requirements:

■ Create GL Entries for Off-Invoice Discounts: select to have Oracle General 
Ledger entries created for off-invoice discounts.

■ Prorate Associated Earnings by Products: select to have the system 
proportionately break up all earnings on offers by product.

5. Select a GL Date Type.

■ System date: System date is the default date on the claim settlement page.

■ Claim date: Claim creation date is the default date on the claim settlement 
page.

6. Select a GL Balancing Segment 

■ Balancing segments enable the filtering of transaction types and receivable 
activity defined in Oracle Receivables before making them available for a 
particular claim type in Trade Management. The filtering is done based on 
the balancing segment in the account code combinations used to set up the 
various receivables-related accounts on the transaction types and 
receivables activities in Oracle Receivables. .
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7. Click the Search icons for the account fields and select the appropriate accounts.

■ Receivable Clearing Account: When a claim or deduction is created and 
associated to promotional accruals, and if the settlement method is a credit 
memo, Trade Management creates the following Oracle General Ledger 
entries:

– Debit Liabilities

– Credit Receivables Clearing 

■ Vendor Clearing account: When a promotional claim is settled by a check, 
the following Oracle General Ledger entries are created:

– Debit Liabilities

– Credit Vendor Clearing 

■ Liabilities account: Same account used as when accruals occur, or new 
accounts configured by the Account Generator, if the profile option OZF: 
Derive Accrual Accounting during Claim Settlement is set to Y/N. The Oracle 
Payables Clearing accounts used during claim settlement are taken from the 
following setups:

– Claim type and any Account Generator workflow updates.

– System parameters and any Account Generator workflow updates.

8. Click Update if finished; otherwise, continue setting system parameter defaults.

The remaining sections of the system parameters page do not need to be completed 
at this time. Some require other setups to be completed before values can be 
entered. The instructions for completing these sections are provided in other 
sections of this document and are referenced below.

Claim Section
To complete this section of the system parameters page, you must first create claim 
types and reasons. For information on completing this section of the system 
parameters page, see Section 6.4, "Set System Parameter Defaults".

Settlement Section
Instructions are provided in Section 6.4, "Set System Parameter Defaults".
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Autopay Section
Instructions are provided in a Section 6.8.2, "Set Up Autopay in System Parameters" 
and Section 6.4, "Set System Parameter Defaults".

Earnings Payments Section
See Section 6.4, "Set System Parameter Defaults".

Indirect Sales Section
Instructions are provided in Section 7.5.1, "Set System Parameter Defaults for 
Indirect Sales".

Planning Section
Instructions are provided in Section 5.4.2, "Set Up Quota Allocations".

3.5 Create Trade Management Users
Prior to implementing Trade Management , you must create the Implementation 
User. This user is assigned the roles and responsibilities necessary to complete 
implementation tasks. Having a single implementation user makes the process 
easier as only one user and password is required to complete all steps.

The Implementation user should be assigned to an admin group. 

To create the implementation user use the following procedures:

■ Section 3.5.1, "Creating the Employee"

■ Section 3.5.2, "Creating the Implementation User"

■ Section 3.5.3, "Setting the Default Responsibility"

■ Section 3.5.4, "Importing the Employee as a Resource"

■ Section 3.5.5, "Granting Access to Customer and Administration Tabs"

■ Section 3.5.6, "Updating Group Access"
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3.5.1 Creating the Employee
To create the employee follow the procedure below: 

Prerequisites
None

Steps
1. Log into Oracle Forms as HRMS Manager Responsibility. 

2. Navigate to People > Enter & Maintain.

3. In the Find Person box, select New.

4. Enter the following information:

■ Last Name and First Name

■ Title 

■ Gender

■ Type = Employee

■ Social Security # (will be checked against existing SS#)

■ Birth Date

5. Save your work. 

A confirmation will appear in the lower left corner of the window.

6. Select Assignment and enter the following: 

■ Organization

■ Team/Group

■ Location 

■ Supervisor

If a dialog box with Update and Correction buttons displays, select Correction 
to revise existing data and Update to create a new record.

7. Save your work. 

A confirmation will appear in the lower left corner of the window.

8. Select Yes to use the new location.
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9. Save your work. 

3.5.2 Creating the Implementation User
To create the implementation user use the following procedure: 

Prerequisites
None

Steps
1. Log into Forms with System Administrator responsibility.

2. Navigate to Security > User > Define. 

The Users form opens. 

3. In the User Name field, enter a name. 

4. In the Responsibilities block, assign the following responsibilities to the 
Implementation User:

– General Ledger Super User

– HRMS Manager

– Inventory

– CRM Administrator

– Oracle Trade Management User

– Oracle Trade Management Administrator

– Account Manager

– Workflow User Web Applications

– System Administrator

– Oracle Receivables 

– Oracle Payable 

– Advanced Pricing

– Receivables Manager

5. Save your work.
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Two procedures are presented below. Use the seeded Oracle Trade Management 
User responsibility for Trade Management. This responsibility gives the user access 
to both basic Marketing functions (core) and Trade Management. To restrict user 
access to Trade Management functionality, create a custom responsibility. 

3.5.2.1 Seeded Trade Management Users and Responsibilities

Users
■ TRADEMGR/WELCOME

Responsibilities
■ Oracle Trade Management Administrator

■ Oracle Trade Management Super User

■ Oracle Trade Management User

■ Account Manager

Logs in via the personal home page screen to access the Account Manager 
dashboard. 

3.5.2.2 Creating a Trade Management User
To create a user for Trade Management use the following high-level procedure: 

1. Create an employee in Human Resources. 

2. Create a user ID. 

3. Assign the employee to the user ID. 

During this task, assign Trade Management responsibilities to the user.

4. Import the employee as a Resource.

For a more detailed procedure, see Section 3.5, "Create Trade Management Users".

3.5.2.3 Creating Custom Responsibilities
To create a custom responsibility use the following high-level procedure: 

1. Create the menu structure. 

2. Create the new responsibility. 

3. Assign the menu to the new responsibility.
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For specific procedures on creating a custom responsibility, refer to the Oracle 
Applications System Administrator’s Guide. 

A sample menu structure for a custom Trade Management responsibility is 
provided in the following table:

3.5.3 Setting the Default Responsibility
Use the following procedure to assign a default responsibility to the 
Implementation user: 

Prerequisites
None

Steps
1. Log in to Oracle Trade Management. 

2. Select your default responsibility from a drop-down list.

3. To change the default responsibility at any time, 

a. Click the Profile icon.

Table 3–2 Sample Trade Management Custom Responsibility Menu Structure

Prompt Submenu Function

Home ASF_HOME ASF_HOME

Customer OZF_NEW_CUSTOMER_MENU ASF_ORGZN_SUMRY

Product Oracle Marketing New Product Menu Products Overview

Quota OZF_NEW_QUOTA_MENU OZF_TP_QUOTA_OVER

Budget OZF_NEW_BUDGET_MENU OZF_FUND_OVER

Trade Planning OZF_NEW_TRADE_PLANNING_
MENU

OMO Programs Overview

Claim OZF_NEW_CLAIM_MENU OZF_CLAM_SUMMARY

Indirect Sales 
Management

OZF_NEW_INDIRECT_SALES_MENU OZF_RESL_SUMMARY

Administration OZF_NEW_ADMIN_MENU ASF_SETUP_OPP_CALTYPE_
MAIN

Calendar OZF HTML Calendar Main Menu JTF HTML Calendar.Daily 
View
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b. In the side panel menu, click Navigation Preferences in the Personalization 
area.

c. Select a current or default responsibility.

d. Click Update.

3.5.4 Importing the Employee as a Resource
In order to use Trade Management, an employee you created previously must be 
imported into the application as a resource. Use the following procedure to do so. 

Prerequisites
Employee exists in Resource Manager

Steps
1. Log in to Oracle Forms with CRM Administrator responsibility.

2. Navigate to Resource Manager > Maintain Resources > Import Resources.

3. Locate the employee created in Section 3.5.1, "Creating the Employee". 

4. Enter employee’s name in the name fields

5. Select Search.

6. Select Create Resource.

7. Click OK to accept default values.

8. Click Save Resource (record the transaction number).

9. Click Details to validate that the User Name field is populated with the proper 
user created for this employee resource.

3.5.5 Granting Access to Customer and Administration Tabs
Using this procedure, you will specify Roles and Groups. This step is required to 
gain access to the Customer and the Administration tabs. 

Prerequisites
None
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Steps
1. Navigate to Resource Manager.

2. Select the user as the resource.

3. Click Details.

4. On the Roles tab, select a role type of Sales and a Role of Sales Representative.

5. On the Group tab, select a group with Usages of Sales and TeleSales and Oracle 
Trade Management. 

6. Make sure that the Group Member Role Sales Representative is associated to the 
above group on the resource details screen.

7. Save your work. 

3.5.6 Updating Group Access
Perform this step to set up the implementation user as an administrator, who is able 
to access all objects in Trade Management.

Prerequisites
None

Steps
1. Add the implementation user to a resource group.

2. Select the resource group in the AMS: Admin Group profile option.

3. Run the Concurrent Program AMS: Group Access Refresh to finish the process 
of creating the implementation user. See Section C.1, "Running Concurrent 
Programs" for this procedure.

3.6 Perform the Basic Setups
This section includes the instructions for performing the following basic setups:

■ Section 3.6.1, "Create Activities"

■ Section 3.6.2, "Create Marketing Mediums"

■ Section 3.6.3, "Create Categories"

■ Section 3.6.5, "Create Custom Setups"
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■ Section 3.6.6, "Create Mandatory Rules"

■ Section 3.6.7, "Create Locking Rules"

■ Section 3.6.8, "Create User Statuses"

■ Section 3.6.9, "Create Approval Rules"

■ Section 3.6.10, "Set up Product Options"

■ Section 3.6.11, "Set Up Calendar Criteria"

3.6.1 Create Activities
An Activity manages the relationship between an object’s Activity Type and the 
Marketing Medium. 

Understanding Activity Types
Activities are used to identify the general purpose of a promotion. Examples of 
activity types are:

■ Advertising

■ Listing allowance

■ Shelf Space

■ In-store activities

The Activity page within the Administration tab manages the relationship between 
an object’s Activity Type, Activity and available Marketing Medium. Using this 
page, an organization can specify the available Activity and Marketing Mediums 
combination for a given Activity Type.

Activities can be created within the application and can be linked to an existing 
Activity Type. When an Activity Type is selected for a Object Create or Custom 
Setup, the Activities that has been created for the Activity Type populates the 
Activity LOV.

If you are implementing Oracle Marketing also, you can also use the activity setup 
screen to set up related activities. Please see the Oracle Marketing Implementation 
Guide for details.

Creating Activities
Use the following procedure to create an activity.
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Prerequisites
None

Steps
1. Log in to Oracle Trade Management and navigate to Administration > Trade 

Management > Setup > Activity.

2. Enter an Activity Name.

3. Select an Activity Type = deal.

4. Mark Active. Only Active Activities are available within the application.

5. Associate Marketing Medium. 

6. Click Go.

a. Select a Marketing Medium from the list of active Marketing Mediums 
displayed.

b. Select Active From and Active To dates. These dates should fall within the 
Active From and Active To dates of the Marketing Medium.

c. Marketing Medium shown up on the Object details page based on the 
Association of the Marketing Medium with the various activities in the 
create Activity screen. A single Marketing Medium may be associated with 
multiple Activities.

7. Save your work. 

3.6.2 Create Marketing Mediums
Marketing mediums relate to a specific channel used by a customer to execute a 
promotion’s performance activity. Therefore, they differ by activity.

For example, a trade management program for a new toy includes the activities of 
Advertisement and In-Store Display. The advertising appears in the local 
newspaper, community magazine, and on the radio. In-Store displays include an 
End-Aisle Display and a display by the cash register.

Use the following procedure to create a marketing medium. 

Prerequisites
None
3-24 Oracle Trade Management Implementation Guide



Perform the Basic Setups
Steps
1. Log in to Oracle Trade Management and navigate to Administration > Trade 

Management > Setup > Marketing Medium. 

2. Click Create. 

3. Fill out the following required fields as they relate to Marketing Mediums. 

■ Marketing Medium Name: This name should reflect the activity type and 
the activity it will be associated with. 

■ Country: Choose the appropriate country for the Marketing Medium. 

■ Activity: Choose the appropriate activity for which this medium will 
support. For example, if the Marketing Medium is Direct Mail House, 
choose Direct Mail for the activity. 

4. Click Create.

Confirmation text appears on the page indicating that changes are saved. 

3.6.3 Create Categories
Categories are used to group objects. They can be used as selection and search 
criteria to locate objects. In Trade Management, the Budgets categories is used to 
impose a business rule and to integrate to General Ledger. 

Use the following procedure to create a category. 

Prerequisites
None

Steps
1. Log in to Trade Management and navigate to Administration > Trade 

Management > Setup > Category. 

2. Click Create.

3. Enter a Category Name.

4. Select a Parent Category.

5. Select the Enabled checkbox to make the Category available.

6. Select Budget from the Created For drop-down menu.

The display changes to include more fields.
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7. Enter a description.

8. Enter data in the Sales/Expense/Charge field. (See Guidelines.)

9. Enter an accrual liability account number.

10. Enter a prefix.

11. Enter activities.

12. Click Create.

Guidelines
For steps 8 through 10, see Section 3.4, "Set System Parameters".

3.6.3.1 Verify Category
Use the following procedure to verify that a category is properly implemented:

Prerequisite
Category has been set up.

Steps
1. Log in to Trade Management.

2. Click the Budget tab.

3. Click Create. 

Verify that the category you created is displayed as a value in the Category 
drop-down menu.

3.6.4 Create Thresholds
1. Log in to Trade Management and navigate to Administration > Trade 

Management > Setup > Thresholds.

2. Click Create.

3. Select a Threshold Type (budget or quota).

4. Enter or select values for the remaining fields.

5. Click Create.
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3.6.5 Create Custom Setups
In Trade Management, budgets, offers, claims, quota, and price list use custom 
setups.

Custom setups determine:

■ Source Code Suffix for budgets, offers and claims.

■ Side Navigation Menu: The vertical menu which appears on the left hand side 
of the page once an object is created. The side panel menu does not appear until 
you create a new object.

■ Menu Items: These are the smallest components on the Side Navigation Menu. 
Menu items are the functional areas within the application where data can be 
created or where objects are viewed. Some of the menu items have functional 
implications, others are used for information purposes only. 

■ Component Groups: Each of the menu items are logically grouped into various 
sections based on functionality. Component Groups include Planning, 
Execution, Tracking, Collaboration and Approval. Within each Component 
Group is a logical collection of menu items. 

■ Approval requirements for:

– Budgets: approval rule setup

– Offers: whether a budget and budget approval is required; theme approval; 
adjustment approval

– Claims: whether or not approval is required

Custom setups are not org-striped therefore you see the same setups in every 
operating unit. Some seeded custom setups are included with Trade Management. 
Additional custom setups can be created by following the procedure below.

3.6.5.1 Creating Custom Setups

Prerequisites
None

Steps
1. Log in to Trade Management and navigate to Administration > Trade 

Management > Setup > Custom Setup.

2. Click Create.
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3. Complete the fields as required, and click Create.

4. Enter a Custom Setup name.

5. Select a value for Associate With.

The Activity Type field appears.

6. Select an Activity Type.

The selection of Activity Type and Activity determines the available 
Component Groups and Menu Items. 

7. Select the Active check box to make the setup available for users.

8. Select the Allow Essential and Optional Grouping if this setup can be used with 
the Side Navigation Look profile option.

9. Enter a suffix to be used as part of the source code.

The suffix set here is reflected when an object is created. The suffix can be alpha, 
numeric or a combination. The maximum number of characters is 3.

Enter a brief description for this Custom Setup.

10. Click Create.

11. Proceed to Section 3.6.5.2, "Specifying Custom Setup Details" below.

If you selected Offer along with Scan Data or Lump sum, read About Reversing 
Product Family Accruals for Lump Sum and Scan Data Offers below.

About Reversing Product Family Accruals for Lump Sum and Scan Data 
Offers
An option is provided that allows the reversal of product family accruals for lump 
sum and scan data offers. If enabled, the option works as follows. If an offer line 
specifies a product family only, then the following Oracle General Ledger entries are 
created during claim settlement:

1. Reversal of original accrual posting. No call to Account Generator for either:

■ Debit original liability account by associated earnings amount

■ Credit original sales/expense account by associated earnings amount

2. Recreation of accrual posting. The base accounts are taken from the budget or 
budget category (should be the same as the original base accounts, unless the 
base Oracle General Ledger accounts on a budget or category have been 
changed.) A call is made to Account Generator for the following:
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■ Debit sales/expense account by associated earnings amount

■ Credit liability account by associated earnings amount

The Account Generator workflow should provide the configuration of the 
Oracle General Ledger accounts to achieve the goal of posting actuals for 
particular products even when accrual postings were created for product 
families. The claim itself does not need any validation.

3. Creation of actual postings. For regular actual postings, there is a profile option 
that drives whether the liability account should be constructed by the Account 
Generator or should be taken directly from the original liability account. For 
these postings, this profile option is bypassed and the liability account 
referenced in the step above is always used. Both of the following entries are 
offsetting entries — the debit entry offsets the credit entry created in the step 
above; the credit entry offsets the debit entry created by Oracle Receivables or 
Oracle Payables. Therefore, no call to the Account Generator is necessary for:

■ Debit liability account by associated earnings amount

■ Credit receivables/vendor clearing account by associated earnings amount

Lump Sum Scattered Posting
Companies can divide the budget total into smaller amounts and create postings to 
the budget and General Ledger periodically. Previously the amount could not be 
split, and postings occurred only once at start of offer.

3.6.5.2 Specifying Custom Setup Details
Once you have created a custom setup, follow this procedure to configure it.

Prerequisites
A custom setup has been created.

Steps
1. In the Components section of the Custom Setup Details page, provide the 

following: 

■ Component Group: Displays by default based on the Activity and Activity 
type selected for Custom Setup. 

■ Display Sequence: Use this column to control the order of the objects (as 
they appear in the cue card). For example, if Products is to appear on the 
cue card directly below Main, Product should be sequentially numbered 
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directly after Main. Main is not an optional setting and must be included. In 
this example, Main could be given a value of 10, and Product could be 
given a value of 11. 

■ Available Attributes: Use this column to indicate if the attributes for this 
object should be made available. 

■ Essential: To control the display order of a particular object, check the 
Essential box (be sure to select the Essential check box that aligns with the 
correct object). Anything not checked in the “Essential” column is 
considered “Optional” and is listed in alphabetical order. 

■ Essential Display Sequence: Display sequence is a numeric setting used to 
order objects in cue cards. If the Essential box is checked, numeric values 
need to be provided enables the “Essential” objects to be ordered 
appropriately. The Display Sequence column is used to determine the order 
when “Business Process View” profile value is selected.   

■ Reports: Place a check in the Show In Reports box to enable attributes to be 
shown in the portals. 

2. Click Update.

3.6.6 Create Mandatory Rules
Mandatory rules enable a company to control data entry by requiring that data be 
entered in specific data fields on specific screens. Rules can be created to make 
certain data fields mandatory. Certain values in the selected columns are seeded as 
mandatory and cannot be removed.

In Trade Management, many procedures can use mandatory rules. These include 
budgets, offers, claims, adjustment types, claim types, budget thresholds, budget 
request, claim reason, system parameter, trade profile, and price list.

For example, in Claims, Reference is not a mandatory field by default. Seeded, it is 
an optional field. If your business requirements mandate that users must select a 
value for this field, then you can create a mandatory rule to enforce this business 
requirement. When the field is made mandatory, an asterisk appears next to it.

To create mandatory rules (for the example shown above), follow the procedure 
below: 

Prerequisites
None
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Steps
1. Log in to Trade Management and navigate to Administration > Trade 

Management > Setup > Mandatory Rules. 

2. Select a value for Parent Object Type and Object Attribute 

Object Attribute is the side navigation menu for which this field appears. 

3. Highlight the desired fields in the Available Fields column and move them to 
the Selected Fields column.

The field names in the Selected Fields column will be mandatory.

4. Click Update.

3.6.7 Create Locking Rules
In Trade Management, budgets, claim, budget request, offers, and price list can use 
locking rules. Locking rules allow companies to control data entry by disallowing 
updates to certain data when that data is a particular status.

Locking rules enable companies to control data entry by preventing updates to 
specific data at certain statuses. By design, locking rules are ignored for the Oracle 
Trade Management Super User responsibility. In other words, when an Oracle Trade 
Management Super User is logged in, the fields which are supposed to be locked 
are updatable.

To create a locking rule, use the following procedure:

Prerequisites
None

Steps
1. Log in to Trade Management and navigate to Administration > Trade 

Management > Setup > Locking Rules.

2. Select a value for the Parent Object Type field.

For each selection, different object selections become available in the Object 
Attribute and System Status drop-down lists.

3. Select a value for the Object Attribute field.

This is the side navigational menu for which this field appears.

4. For System Status, select New. 
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5.  Highlight field names in the Available Fields column and move them to the 
Selected Fields column.

The fields in the Selected Fields column will be locked. Note: Certain fields are 
seeded in the mandatory rule and cannot be removed from the Selected Fields.

6. Click Update. 

3.6.8 Create User Statuses
In Trade Management, budgets, offers, claims, price list, and budget sourcing can 
utilize user statuses. User statuses are for tracking and classification purposes only; 
system statuses drive system behavior. Once set up, Trade Management users can 
select user statuses for budgets, offers and claims.

Seeded user statuses are included with Oracle Trade Management. See Appendix D, 
"Seeded User Statuses" for a complete listing of seeded user statuses. You can create 
additional ones by following the procedure below.

Example
A team of claim users is administering a claim. They all need to review the 
performance details on the claim before they actually settle it, so multiple user 
statuses are created:

The first reviewer logs in to the system, finds the claim, completes the claim and 
puts it to “Pending Close - First Reviewer" user status. At this user status, because 
the underlying system status is Pending Close, the claim has all the behavior of a 
claim in the pending close status, and none of the fields on the claim can be 
updated. But putting the claim in this user status also lets all of the other claims 
users know that the claim is under the first review. When this first reviewer finishes, 
he can then change the status to “Pending Close - Second Reviewer” which lets 
everyone know that he has finished with reviewing the claim.

Prerequisites
None

System Status User Status

Pending Close First Reviewer

Pending Close Second Reviewer

Pending Close Third Reviewer
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Steps
1. Navigate to Administration > Trade Management > Setup > User Status.

2. Click Create.

3. Complete the fields and select the Enabled check box to activate the new user 
status.

4. Click Create.

5. To select a user status as the default, select the Default check box on the User 
Status page.

Otherwise, one of the seeded user statuses for budgets, claims and offers is 
used.

6. Click Update. 

3.6.9 Create Approval Rules
In Trade Management, budgets, offers, and claims (sometimes referred to objects) 
can use approval rules. Approval rules determine what must be approved, by who, 
and at what status.

Approval rules for budgets or for budget requests can be configured using multiple 
parameters such as amount, budget category, organization, and custom setup. 

Approval rules for claims can be configured using multiple parameters such as 
amount, claim type, claim reason, and organization. When claim processors 
determine settlement methods for their claims, managerial approval may be 
required. Approval rules can be set up so that the settlement process will not 
proceed until approval is given.

If no approval rules are set up for a given transaction, notification is sent to users 
with the Marketing Default Approver role.

Approvers can be assigned by role, user, function or a combination of all three. You 
can use functions such as Object Owner, Parent Object Owner, Budget Owner, or 
Parent Budget Owner.

These are similar to approval roles but are different in that they are dynamic based 
on each Object and do not have to be assigned to a User. If the approval needs to be 
sent through a chain of approvers, the approvers must be set in an order. 

Approver attributes are:

■ Order = the order in which approvers are notified.
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■ Roles = Marketing Default Approver role type.

■ Function = any customized program to search for approvers.

Example

Scenario: All claims under $100 are automatically approved. All claims over $100 
with the reason Promotion go to Mary Smith, Sales Administrator, for approval.

Solution: Set up two approval rules. The first one is for claim amounts $0 to $100. 
They are routed to a default dummy approver that has automatic approval set up in 
the workflow notification.

The second rule is for claim amounts over $100 with reason Promotion. These 
claims are routed to Mary Smith for approval.

To set up approval rules, follow these procedure below.

■ Section 3.6.9.1, "Setting Up Role Types for Approvals"

■ Section 3.6.9.2, "Setting Up Roles for Approvers"

■ Section 3.6.9.3, "Setting System Profiles for Approvals"

■ Section 3.6.9.4, "Creating Approval Rules"

■ Section 3.6.9.5, "Assigning Approvers"

■ Section 3.6.9.6, "Running Workflow Background Process for Approvals"

3.6.9.1 Setting Up Role Types for Approvals
The required role types for approvals are:

■ Default Marketing Approver: Approver of any new marketing object requiring 
approval. This role type should be assigned to one person only.

■  Marketing Approver: Approvers specified by the approval rules.

Use the following procedure to set up role types for approvals: 

Important: After all of your approval rules are set up, you 
should test each one carefully to be sure that the correct rule is 
being used. This testing process identifies conflicting rules.
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Prerequisites
None

Steps
1. Log in to Oracle Forms and select the CRM Administrator responsibility.

2. Navigate to Resource Manager > Setup > Role Types.

3. Use Find to check for the role type of AMSAPPR. If the role type does not exist, 
it must be created as follows:

a. Click the New icon to create a new line.

b. Under the Code column, enter AMSAPPR.

c. Under Meaning, enter Default Marketing Approver.

d. Under Description, enter Default Marketing Approver.

e. Save the record.

4. If more than one person in the organization will be approving budgets, claims 
and offers, create a role type called Marketing Approver as follows:

a. Use Find to check for the role type of MKTGAPPR. 

If it does not exist, continue with this procedure. Otherwise, proceed to the 
next section.

b. From Menus, select New to create a new line.

c. Under the Code column, enter MKTGAPPR.

d. Under Meaning, enter Marketing Approver.

e. Under Description, enter Marketing Approver.

f. Save the record.

3.6.9.2 Setting Up Roles for Approvers
The role of Default Marketing Approver must be created and assigned to a user for 
Trade Management to function properly. The Default Marketing Approver receives 
approval notification for any budget, offer or claim not meeting the criteria 
specified in your approval rules. 

The Default Marketing Approver Role can only be assigned to one user. If more 
than one user receives this role, the approval process will fail. The system will not 
prevent you from assigning the role to more than one user.
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Use the following procedure to set up approver roles:

Prerequisites
None

Steps
1. Log in to Oracle Forms with CRM Resource Manager responsibility. 

2. Navigate to Setup > Roles.

3. Query to determine whether the role AMS_DEFAULT_APPROVER exists. If 
not, create it with the following steps. 

4. From Menus, select New to create a new line.

5. Under the Code column, enter AMS_DEFAULT_APPROVER.

6. Under Name Type, enter Default Marketing Approver.

7. Under Type, use the LOV to select Default Marketing Approver or the 
description you gave the Default Marketing Approver Role Type.

8. Under Description, enter Default Marketing Approver Role.

9. Check the Active and Manager boxes.

10. Save your work.

11. Assign this role to a valid user. 

3.6.9.3 Setting System Profiles for Approvals
See the table below for system profiles and their values.

Table 3–3 Profiles Options for Approvals

Option Required Level Setting Effect/Limitation

AMS : 
Cutoff 
Percentage 
for 
Approval

Yes Site Enter a value 
between 0 and 
100

This determines what percentage of 
the estimated budget amount an offer 
must secure in actual funding before 
the offer can go active.

For example, if you enter 100, it means 
100%. An offer’s estimated budget 
amount is $10K, meaning that it is 
estimated that this offer must get 
budget approved for $10K before the 
offer can go active.
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3.6.9.4 Creating Approval Rules
The creation process involves first creating an approval rule and then assigning 
approvers to the rule. 

The attributes of approval rules are weighted to determine which rules should be 
used in different situations. If there are multiple rules that may apply, these weights 
determine which rule to use.

■ Business Unit = 6 (if the business unit matches the rule, this weight is assigned)

■ Organization = 5

■ Approval Object Type = 4 (budget)

■ Budget Category = 3

■ Custom Setup = 1

Follow this procedure to create approval rules.

Prerequisites
None

Steps
1. Navigate to Administration > Trade Management > Setup > Approval Rule.

2. Click Create.

3. Enter a name and select a start date. 

4. In the Approval Rule For field, select what the approval rule will be used for.

The page will redraw and the fields will change based on your selection.

OZF : 
Source from 
Parent 
Object

Yes Site Yes/No If set to Yes, objects may only source 
from their parent objects. For example, 
for an offer and a campaign schedule, 
the parent is a campaign; for an Event 
schedule, the parent may be an Event 
or a campaign. 

If set to No the schedule sources funds 
directly from a budget.

Table 3–3 Profiles Options for Approvals

Option Required Level Setting Effect/Limitation
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5. Complete the remaining fields.

6. Click Create.

3.6.9.5 Assigning Approvers
Approvers can be assigned by role, user, function or a combination of all three. The 
functions in use will be functions such as Object Owner, Parent Object Owner, or 
Budget Owner. 

These are similar to approval roles but are different in the sense that they are 
dynamic based on each object (budget, claim, campaign, etc.) and do not have to be 
assigned to a User. If the approval must be sent through a chain of approvers, an 
order must be designated. 

For example, you have a trade promotion budget for which there are three 
approvers for the Budget Line Approval. After the rule is created, the approvers 
must be added to the rule in the order in which they are expected to approve. 
Approver with Order [1] will be the first approver followed by Approver with 
Order [2] and so on.

3.6.9.6 Running Workflow Background Process for Approvals
Run the following concurrent program to perform background processes necessary 
for the approvals implementation to be complete. 
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3.6.10 Set up Product Options
Product templates enable users to configure product attributes. Configurable 
Product Options can be defined when Oracle Trade Management is installed. These 
determine the list of product attributes displayed in the inventory options side 
navigation menu for any responsibility. 

This allows customization of a list of product attributes based on business needs 
and integration requirements. Trade Management provides a default template 
based on whether you are defining a product or a service. Selecting or deselecting 
the desired product attributes can override the template. 

You can define the list of product attributes for each responsibility and you can also 
specify if the product attributes are editable in the inventory options page. This 
feature allows you to isolate product attributes and limit their access to the 
appropriate users in accordance with business and integration requirements. 

Trade Management product options are different from inventory templates. The 
options created here are used only in Trade Management screens, which gives the 
user an option to configure the product attributes displayed in the inventory option 
side navigation menu. 

To create product options: 

Table 3–4 Workflow Background Process for Approvals

Concurrent Manager Required Description

Workflow Background 
Process

Yes Parameters required:

■ Set Item Type: AMS Marketing Approvals 
for budget fund requests or AMS Marketing 
Generic Approval for budget approvals.

■ Minimum Threshold: Leave blank.

■ Maximum Threshold: Leave blank.

■ Process Deferred: Yes

■ Process Timeout: Yes

The concurrent process is required to process the 
approvals. As mentioned earlier, there are three 
approval processes to complete: Theme, Budget 
Line and Budget.

The concurrent process is required for Theme 
and Budget Line approvals. Other approvals, 
Budget Request, Root Budget and Object 
approval, occur in real time.
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1. Create Product Templates - choose Service or Product Type.

2. Associate a responsibility to the template.

3. For each product attribute select whether the attribute is defaulted, editable or 
hidden.

4. Depending on the responsibility of the user creating the product the templates 
associated to that responsibility will be implemented. If no templates are 
associated to the user, the default-seeded template is used.

To create and enable a new template, use the following procedures:

■ Section 3.6.10.1, "Create a New Product or Service Template"

■ Section 3.6.10.2, "Set up the New Template"

■ Section 3.6.10.3, "Selecting Product Attributes in Seeded Product Templates"

3.6.10.1 Create a New Product or Service Template
To create a new template use the following procedure:

1. Log in to Oracle Trade Management and navigate to Administration > Trade 
Management > Setup > Product Option. 

2. Select Create Product Template.

3. Enter the following:

■ Template Name: Enter a unique, descriptive name for the template.

■ Type of template: Select Product or Service. 

■ Description: Optionally, enter a description for the template.

4. Click Apply.

3.6.10.2 Set up the New Template
From the Product Templates page:

1. Click the hyperlink of the new template.

2. In the Responsibilities table, click the Search icon to retrieve responsibility to 
link to the template. Only one product template and one service template can be 
assigned to a responsibility. 

Optionally, remove an assignment. 
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3. Scroll down to the Attributes table, and set the following parameters for each 
attribute as desired. 

■ Default: Select to make an attribute the default when a product is created.

■ Editable: Select to make an attribute updatable in the product screens. If 
Editable is selected, Hide is ignored.

■ Hide: Select to make the attribute hidden in the product screens. This is 
overridden by a selected Editable parameter. 

■ Select All: Select this flag to enable all the attributes. 

4. Click Apply. 

3.6.10.3 Selecting Product Attributes in Seeded Product Templates
Different Inventory attributes can be assigned to a product, depending upon the 
type of product created -- Inventory or Service. If an Inventory product has been 
created, the attributes screen will display the specific Inventory and Order 
Management attributes; if the Service option has been selected, the specific Service 
default attributes will be displayed. The tables in this section list the seeded 
attributes for each of the two seeded product templates:

■ Product (Inventory) Template 

■ Service Template 

See the Oracle Marketing User’s Guide for more information on seeded Templates for 
Products and Service Attributes.

3.6.11 Set Up Calendar Criteria
The Oracle Trade Management Administrator must decide on the parameters that 
will ultimately be displayed in the Marketing Calendar. The Administrator has two 
options: 

■ Criteria: Displays Objects based on a criteria for which they qualify. For 
example, an Event Schedule may have a criteria of Status “new” and Date 
“January 1, 2005 - March 1, 2005". 

■ Object: Displays Objects specified. The Marketing Calendar supports 
Campaign Schedule, Event Schedule, One-off Events, and Offers. 

To specify Calendar parameters follow the procedure below: 
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Prerequisites
None

Steps
1. Log in to Trade Management and navigate to navigate to Administration > 

Trade Management > Setup > Calendar Criteria. 

2. Click Create. 

3. Complete the fields on the Create Marketing Calendar Criteria page.

■ Object: Object that will be displayed on the Calendar. 

■ Custom Setup: Select a custom setup for the Object selected. 

■ Start Date: Start date by which the Object selected will begin appearing on 
the Calendar. 

■ End Date: End date for which the Object selected will stop appearing on the 
Calendar. 

■ Priority: Priority level by which the Object will appear in the Calendar. 

■ Status: Object Status. For example, if the Object selected is Campaign 
Schedule, the status chosen may be Active Schedules. In this case, only 
Active Campaign Schedules will appear on the Calendar. 

4. Click Create. 

3.6.11.1 Running Concurrent Program for Calendar
You must run the concurrent program AMS : Interface Marketing Objects to 
Calendar for the new object or criteria to be displayed on the Calendar. Run this 
program as needed to update the Calendar.

3.6.11.2 Configuring User Profiles
Before a user can view the Calendar they must specify in their user profile what 
objects they want to view. In addition, users can personalize the Calendar by saving 
preferences based on their needs. 

To configure user profiles for Calendar preferences follow the procedure below: 

1. Log in to Trade Management. 

2. Click the Profile link. 

3. Navigate to Calendar > Personalize. 
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The Calendar Personal Preferences page opens.

4. In the Display Items drop-down menu choose Yes. The default value for this 
drop-down list is No. This profile turns on the Calendar feature. 

5. Click Update. 

3.7 Perform Customer Set Ups
Customer setups are described in the following sections:

■ Section 3.7.1, "Create Customer Classifications"

■ Section 3.7.2, "Define Customer Relationships"

■ Section 3.7.3, "Create Trade Profiles"

3.7.1 Create Customer Classifications
To create customer classifications, see the Oracle Trading Community Architecture 
Administration User Guide.

3.7.2 Define Customer Relationships
To define customer relationships, see the Oracle Trading Community Architecture 
Administration User Guide.

3.7.3 Create Trade Profiles
Trade profiles are used to:

■ Store basic customer information such as customer name, account number, site 
and address.

■ Provide a link to vendor setups if applicable.

■ Define Autopay parameters for accrual reimbursements including payment 
frequency, threshold, and method.

■ Define parameters for claim payments including days due and write off 
thresholds for deductions and overpayments.

■ Define earning payment parameters for unearned offer accruals including 
various threshold settings.

■ Define indirect sales parameters including batch and line tolerances.
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■ Define code mapping for customer reason, agreement, unit of measure (UOM), 
item, and end customer.

For information and instructions on setting up trade profiles, refer to Chapter 6.10, 
"Set Up Trade Profiles".

3.8 Set Up Buying Groups
Buying groups are formed to enable companies to leverage high volume purchase 
discounts. Buying groups that purchase in bulk allow a company to negotiate more 
competitive pricing. Buying groups are commonly found in the broad definition of 
the consumer goods sector. They are formed in Oracle Trade Management by 
linking various TCA parties together based on a pre-determined party relationship.

Assume Organization 1 below is the buying group. Organization 2 and 3 are 
members of the buying group. 

Figure 3–1 Buying Group Organizational Structure

When creating offers, you can create the offer for Organization 1, the buying group. 
When you do, all accounts below it will get the offer. In the example, Account 2A, 
Account 2B, Account 3A, and Account 3B all receive the offer. As such, the overall 
buying group or structure is as follows: 
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Figure 3–2 Buying Group Organization Structure for Trade Management

To create a buying group, use the following procedure. 

Prerequisites
None

Steps
1. Log in as the TCA Manager.

2. On the Overview page, in the Relationship Types, select a relationship type of 
Buying Group of from the Create Relationships of Type drop-down list.

3. Click Go.

4. On the Create Relationships page, select a relationships phrase of Parent of 
(Organization) from the drop-down list.

5. Select a previously defined object name from the list of values to add a child to 
the parent organization, for example, Organization 2.

6. On the Hierarchy page, in the Relationships section, expand the hierarchy to 
show the newly added object.

7. Click the Create Relationship icon next to the parent to add any more child 
objects to the hierarchy, for example, Organization 3.

8. Continue building the hierarchy by clicking the Create Relationship icon next to 
objects to add a child level of objects, for example, Account 2A and Account 2B.

9. You can click the icon in the Details column to see more information about the 
party.
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After the buying group is built, you can create an offer for Organization 1.

3.9 Implement and Verify Oracle CRM Technology Foundation 
Applications

Oracle CRM Technology Foundation is a prerequisite for implementing any Oracle 
CRM module. It provides a common infrastructure upon which all CRM 
applications are built. 

By providing a set of application components, CRM Foundation ensures that all 
applications interact with key business objects in a consistent manner. For detailed 
information about Oracle CRM Foundation see Oracle CRM Application Foundation 
Implementation Guide. 

The following components provided by CRM Foundation are required for Oracle 
Trade Management:

■ Resource Manager

■ Notes

■ Territory Manager

■ Task Manager

■ Calendar (HTML and Forms-based)

To implement CRM Foundation for Oracle Marketing use the following procedures: 

■ Section 3.9.1, "Set Up Resource Manager"

■ Section 3.9.2, "Set Up Territory Manager for Trade Management"

■ Section 3.9.3, "Set Up Task Manager"

■ Section 3.9.4, "Set Up Note Types"

3.9.1 Set Up Resource Manager
Resource Manager is a central repository for various types of resources, groups, 
teams, and roles can be created. It enables Trade Management and other 
applications to use resources regardless of where they are created. 

You can import resources such as employees, suppliers, parties and partners created 
in other applications. Once imported into Resource Manager, resources are available 
for use by other applications. 
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Resource Manager enables:

■ Groups

■ Roles

■ Role Types 

■ Employee Import 

For instructions on setting up Resource Manager, refer to the Oracle Common 
Application Components Implementation Guide.

3.9.2 Set Up Territory Manager for Trade Management
Trade Management uses territories for: 

■ Budget Allocation: For fixed budget allocation and fully accrued budgets. 
Transaction Type = Offer in Territory Manager.

■ Quota Allocation: For allocating quotas down territory hierarchies.

■ Claim Owner Assignment: For transaction types analogous to the Claim in 
Territory Manager.

As such, the concept of winning territory in other applications equates to budget 
and claim owner assignment in TM. To implement Territory Manager for Trade 
Management, perform the procedures in the following sections in the order they are 
presented:

■ Section 3.9.2.1, "Setting Up Territory Types"

■ Section 3.9.2.2, "Setting Up Territories for Budgets"

■ Section 3.9.2.3, "Setting Up Territories for Claim Owner Assignment"

■ Section 3.9.2.4, "Running Concurrent Processes"

3.9.2.1 Setting Up Territory Types
Setting up territory types is mandatory for Trade Management budgets, but 
optional for claim owner assignment. It is the first task you must perform when 
setting up Territory Manager for TM. Territory types map to a specific level in a 
Trade Management budget. Each level in the territory hierarchy must have a unique 
territory type. For more details on Territory Manager, refer to the Oracle CRM 
Foundation User and Implementation Guide.

To create territory types, use the following procedure. 
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Prerequisites
None

Steps
1. Log in to Oracle Forms with the CRM Administrator Responsibility. 

2. Navigate to Territory Manager > Territory Administration.

3. Using the Navigator panel select View By = Territory Types.

4. Select Oracle Trade Management.

5. Right-click Oracle Trade Management. 

Territory types do not need to be arranged in any hierarchy, so always 
right-click Oracle Trade Management instead of an existing territory type.

6. Select New.

7. Enter a Name for the territory.

8. Optional. Enter a Description.

9. Enter a Transaction Type. 

Transaction types for Trade Management are Claims or Offer. What you select 
here determines the list of values available in the Transaction Qualifiers table.

We recommend selecting:

– Claims if you are setting up territory types for claim owner assignment.

– Offers if you are setting up territory types for budgets, offers, and quota 
allocations.

10. In the Transaction Qualifiers table, select the qualifiers you want associated 
with the territory type. 

For example, if using the territory type Region, you may want to include the 
qualifiers state and country. Once selected, these qualifiers are available when 
you create a territory using this territory type. 

11. Save your work.

To continue creating territory types, place your cursor on the Name field, and 
click the + icon.
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3.9.2.2 Setting Up Territories for Budgets
Fixed budgets and fully accrued budgets use territories in the following ways: 

■ Fixed budgets: Fixed budgets use territories for allocation purposes, thus 
enabling a company to allocate money to each sales territory. Fixed budgets are 
allocated down a particular territory hierarchy. When the allocation is complete, 
a budget hierarchy mimicking the territory hierarchy is created. The primary 
resource for each territory is the budget owner. Other territory resources 
become team members of the budget.

■ Fully accrued budgets: Fully accrued budgets use territories to create budget 
hierarchies. These budgets can be created based on a specific territory hierarchy. 
When approved, a budget hierarchy mapped to the selected territory hierarchy 
is created. Each child node (at the lowest level of the budget) is created using an 
Advanced Pricing modifier. When an order that meets the defined criteria is 
placed, the appropriate child budget total or utilized amount is increased. The 
primary resource for each territory is the budget owner. Other territory 
resources become team members of the budget.

For more specific details on Territory Manager, refer to the Oracle CRM Foundation 
User Guide and Implementation Guide. 

The territory hierarchy for budgets can be reused for quota allocation purposes. If 
you want to build a separate hierarchy for quota allocation, follow the same steps as 
shown below.

To create Territories, use the following procedure.

Prerequisites
Territory types must be set up. See Section 3.9.2.1, "Setting Up Territory Types".

Steps
1. Log in to Oracle Forms with the CRM Administrator responsibility. 

2. Navigate to Territory Manager > Territory Administration.

3. On the Navigator panel, select View By = Territories. 

4. Select Oracle Trade Management.

5. Begin building the Territory hierarchy as follows:
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a. Enter a Name for your territory

b. Enter a Type. 

The type is mandatory for a territory to be used for budget allocation.

Transaction types default to Claim and Offer as set up in the territory type.

c. Click the Transaction Qualifiers tab.

d. Verify your Qualifiers for this territory. 

Qualifiers define the territory. After budget allocation, if any offers require 
funding, and Budget-Offer Validation is turned on, these qualifiers are used 
during the validation. 

The validation determines whether an offer is eligible for funding by 
comparing its market, customer and product selections to the market and 
eligible product specifications for the budget.

For example, you enter the qualifier California for a territory. After budget 
allocation, a sub-budget is allocated for this territory. If an offer created for a 
customer in New York requests funding from the California territory 
budget, Budget-Offer Validation will fail and the request will be denied. 
This validation ensures that money set aside for certain customers and 
products are used specifically for those customers and products only.

Child territories by definition inherit the qualifiers from their parent. View 
them by clicking the Show Inherited Qualifiers button.

e. Optional. To search for the right resources based on their Human Resource 
records such as competence, language, and job title, select the Resource 
Qualifiers tab. 

f. Select the Resources tab.

g. Search for the name of the resource that you want to add to this territory. 

h. If you select the Primary Contact check box for a particular resource, then 
that person is designated as the budget owner. 

Note: The easiest way to build the hierarchy is to build it from the 
top-down. When you right-click an existing territory and select 
New, you create a child territory. If you right-click Oracle Trade 
Management, you are defining a root territory which by default has 
a parent called Catch All.
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Resources not flagged as primary contacts become team members for the 
budget. The sub-budget owner is the primary contact for the territory. 

For example, you have a territory called US West, whose parent is United 
States. It is managed by a regional sales manager John. There are two other 
sales representatives in this territory, Mary and Bob. When creating the US 
West territory, you flag John as the primary contact. When you allocate a 
budget down the United States territory hierarchy, a sub-budget is created 
for US West with John as its owner. Mary and Bob are added to the US West 
budget team and can view the budget.

6. Save your work.

7. To continue defining sub-territories below the current territory, select the 
sub-territories tab. 

3.9.2.3 Setting Up Territories for Claim Owner Assignment
Claim owner assignment works much like how territories are used in other 
applications. For example, claim territory AZS can be set up so that if the claiming 
customer is Business World, the claim is assigned to John. Other AZS territory 
resources are assigned as team members to the claim. Territory A is the “winning” 
territory.

For more details on Territory Manager, refer to the Oracle CRM Foundation User and 
Implementation Guide.

Prerequisites
None

Steps
1. Log in to Oracle Forms with CRM Administrator Responsibility. 

2. Navigate to Territory Manager > Territory Administration.

3. On the Navigator panel select View By = Territories.

4. Select Oracle Trade Management

5. Enter a Name for the Territory.
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6. Ignore the Number of Winners field. 

7. Enter a Rank. 

Rank determines the order by which a territory is evaluated. 

8. Click the Transaction Qualifiers tab.

Verify your qualifiers for this territory. Qualifiers define the territory. Child 
territories by definition inherit the qualifiers from their parent. View them by 
clicking the Show Inherited Qualifiers button.

9. Optional. Click the Resource Qualifiers tab. 

Resource Qualifiers can help you search for the right resources based on their 
Human Resources records such as competence, language, job title, etc. 

10. Select the Resources tab.

11. Search for the resource name you want to add to this territory. 

If you check the Primary Contact flag for a particular resource, then that person 
becomes the claim owner. Resources not flagged as the primary contacts 
become a team members for the claim. Claim team members differ from budget 
team members in that claim team members can update claims. Budget team 
members can only view their budgets, unless designated otherwise by the 
budget owner.

12. Save your work.

13. To continue defining sub-territories below the current territory, click the 
Sub-Territories tab and the New Sub-Territory button.

3.9.2.4 Running Concurrent Processes
Each time you change a territory definition, you must run the following concurrent 
programs: 

■ In Territory Manager: Generate Territory Package 

Note: For claim owner assignment, no complex hierarchies need 
to be set up. All the claim territories can be created on the same 
level without a hierarchy.

Transaction types default to Claim and Offer as set up in the 
territory type.
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■ In Trade Management: OZF-TM: Import Territory Hierarchy, OZF-TM: 
Generate Party List for Market Qualifiers

When running the OZF-TM: Import Territory Hierarchy program, you are 
prompted for a Territory Hierarchy Start Node. This value will be any root territory 
defined under Oracle Trade Management in Territory Manager.

See Also
For more information on Territory Manager, refer to the Oracle CRM Foundation User 
and Implementation Guide.

3.9.3 Set Up Task Manager
Task Manager is optional for a basic implementation. All Oracle CRM products use 
Task Manager to manage tasks. It provides an effective mechanism for 
organizations to respond to customer needs in a timely manner. Using Task 
Manager you can create, assign, manage, sort, and prioritize a task. 

If implementing task transition rules, after defining a rule and assigning it an 
appropriate responsibility, set the following profile: 

Task Manager: Default Task Status 

If no rules are assigned to a responsibility, all statuses will be displayed in the Status 
LOV. In this case, the Task Manager: Default Task Status does not need to be set.

To set up Task Manager use the following procedure: 

Prerequisites
None

Steps
1. Log in to Oracle Forms with the System Administrator responsibility. 

2. Navigate to Functions > Profile > System. 

3. In the Application field enter Trade Management.

4. In the profile field enter Task Manager: Default Task S%.

The System Profile Values form opens. 

5. At Site level, select a default Status (accepted, cancelled, failed, in progress, etc.) 

6. Save your work. 
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See the table below for System Profiles and their values. 

The Task Manager: Default Task Status value must be set to the first status value 
defined in Task Status Transition Rule for Trade Management . 

This status applies to the Trade Management Super User. 

For more information on Tasks, see the Implementing Tasks section of the Oracle 
Common Application Components Implementation Guide.

3.9.4 Set Up Note Types
Setting up note types is optional. Although Oracle Notes comes with a set of 
predefined note types, you can create customized note types. When using Trade 
Management , both the predefined set of notes and the customized notes are 
available.

Refer to the Implementing Notes section of the Oracle Common Application 
Components Implementation Guide for additional information.

To create customized Note Types, use the following procedure:

Table 3–5 Task Manager Profile Options

Option Required Level Setting Effect/Limitation

Task 
Manager: 
Default Task 
Status

Optional Appli
cation

User Defined Required for implementing a task 
transition rule. This profile option 
must be set to the initial status of the 
rule.

Task 
Manager: 
Owner type 
for a task

Optional Appli
cation

User Defined Specifies the default task type when 
creating a task.

Task 
Manager: 
Default 
Priority

Optional Appli
cation

User Defined Specifies the default task priority 
when creating a task.

Task 
Manager: 
Default 
assignee 
status

Optional Appli
cation

User Defined Specifies the default assignee status 
when creating or assigning a task. 
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Prerequisites
None

Steps
1. Log in to Oracle Forms with CRM Administrator responsibility. 

2. Navigate to Notes Setup> Note Type Setup. 

The Application Object Library: Note Types Lookups form opens. 

3. Define the new Lookup code.

4. Define the meaning. 

Carefully describe the Note Type meaning. It is this description that will later be 
used to map the Note Type to the Trade Management Object. 

5. Add a short description. 

6. In the tag column enter Note. 

7. Save your work. 

8. To associate the Note Type with specific Trade Management objects, perform 
the following procedure:

a. Navigate to Notes Setups > Source and Note Type Mappings.

b. Using the Source Object LOV, select the appropriate Trade Management 
Object that you want to use this Note Type. For example, Campaign 
Schedule. 

c. Using the Note Type LOV, select the new Note Type created. The Note Type 
LOV displays the text entered as the Note Type meaning. 

d. Select an End Date for the Note Type Mapping. 

e. Using the Application LOV, select Oracle Trade Management. 

f. Save your work. 

g. Repeat for additional Trade Management objects.

Note: If a note type is not associated with a specific Trade 
Management object, it becomes available to all Trade Management 
objects.
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Implementing Budgets

Oracle Trade Management supports two types of budgets:

■ Fixed Budgets: A fixed budget is a pool of money with a value greater than 
zero. This value is used to fund sales, marketing and partnering activities. Fixed 
budgets can be defined for different customer and product attributes.

■ Fully Accrued Budgets: Fully accrued budgets are also called live funds. Unlike 
fixed budgets, fully accrued budgets start at zero and increase based on 
customer sales. Multiple accrual parameters can be defined, for example, accrue 
different percentages for different products:

■ 3% for product X

■ 5% for product Y

How budgets are implemented will vary depending on business requirements. To 
implement budgets, follow the procedures in these sections:

■ Section 4.1, "Set Profile Options for Budgets"

■ Section 4.2, "Verify Lookups for Budgets"

■ Section 4.3, "Run Concurrent Programs for Budgets"

■ Section 4.4, "Performing Budget Mass Transfers"

■ Section 4.5, "Set Up Budget Security"

■ Section 4.6, "Set Up Budget Adjustment Types"

■ Section 4.7, "Set Up Budget Thresholds"

■ Section 4.8, "Set Up Budget Categories"

■ Section 4.9, "Budget System Status and User Status"

■ Section 4.10, "Set Up Budget Approval Rules"
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■ Section 4.11, "Create Business Units for Budgets"

■ Section 4.12, "Set Up Budget-Offer Validation"

■ Section 4.13, "Set Up Multiple Currencies for Budget"

■ Section 4.14, "Set Up Budget Allocation Based on Prior Year Sales"

■ Section 4.15, "Set Up Top-down and Bottom-up Budgeting"

■ Section 4.16, "Set Up Budget Requests"

■ Section 4.17, "Funds Accrual Engine Overview"

■ Section 4.18, "Set Up Recalculated Committed"

■ Section 4.19, "Setting Up Budget Reconciliation"

■ Section 4.20, "Setting Up Budget Roll-up Views"

■ Section 4.21, "Set Up Third Party Accrual API Import"
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4.1 Set Profile Options for Budgets
Profile options enable an organization to configure the application to suit business 
requirements. Some profile options are required and some are optional. Most profile 
options have preset default values that you can change as needed.

To implement budgets for Trade Management, see Appendix A.3, "Profile Options 
for Budgets". For the specific procedure for setting up system profile options, see 
Appendix A.2, "Setting Profile Options".

4.2 Verify Lookups for Budgets
Lookups supply the content of many of the lists of values (LOVs) in the Oracle 
Trade Management user interface. Most lookups are predefined (seeded in the 
application). The seeded values can be left as is, or you can customize them to fit 
your business needs. Lookup values make choosing information quick and easy, 
they ensure that users enter only valid data into Oracle Trade Management.

For Budgets, create or verify the lookups. See Appendix B.3, "Lookups for Budgets" 
for the complete listing of lookups. For steps for setting up new lookups, see 
Appendix B.2, "Creating New Lookup Types".

4.3 Run Concurrent Programs for Budgets
For Budgets, certain concurrent programs must be run. Run the concurrent 
programs based on your business requirements. See Appendix C.3, "Concurrent 
Programs for Budgets" for the list of concurrent programs. Refer to Appendix C.1, 
"Running Concurrent Programs" for information on running concurrent programs.

4.4 Performing Budget Mass Transfers
Promotional offers to customers may span multiple fiscal periods. During the 
changeover of fiscal periods, new budgets will be established, while the old ones 
reach end date. Since the offers may not be fully utilized in the old period, they will 
continue to be executed. Utilizations of these offers that happen in the new period 
should be tracked in the budgets in the new period.

You can run a concurrent program called OZF-TM : Unutilized Commitment Mass 
Transfer to automatically create new budgets for the next fiscal period and 
optionally  transfer all unutilized budgets to the new budget. There are several 
parameters you can use to define their query criteria to pick up the budget.  
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You can use budget mass transfers to:

■ Define query criteria through personalization for mass transfer budgets

■ Select a budget for transfer from saved query or budget lists

■ Create a new budget for itself or its hierarchy

■ Create new budget with the same budget amount or zero budget amount

■ Activate a new budget automatically when the old budget's end date is reached 
and new budget is still in draft status

■ Transfer an unutilized budget automatically when the old budget end date is 
reached

■ Activate new budgets manually

■ View the link between the old budget and the new budget

The concurrent program automatically creates new budgets for the next fiscal 
period and optionally transfers all unutilized budgets to the new budget. There are 
several parameters you can use to define their query criteria to pick up the budget.  

When you open a next year's budget by running the above concurrent program. He 
can change the budget amount of the new version and submit it for Approval. 

While running above concurrent program, if the old budget's end date is reached 
and new budget is still in "Draft" status, the new budgets will be activated 
automatically with budget amount zero.

While running above concurrent program, if the old budget's end date is reached 
and new budget is in Active status, the unutilized budget amount from old budget 
will be transferred to new budget. If the old budget's end date is reached and new 
budget's budget amount is zero, the transferring unutilized will occur depend on 
the profile setting.

4.5 Set Up Budget Security
Not every user can update or view a budget. The table below explains the different 
access levels for budgets.
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Based on the responsibility of the user creating the budget, budgets are created with 
an organization ID (or operating unit ID). This ID does not drive update or view 
access to a budget.

 The Oracle Trade Management Super User responsibility does not automatically 
get access to a budget. Whether a user with this responsibility can update or view a 
budget is still as explained by the table above. If the user does fall into one of the 
above access levels, he or she can update all fields including those locked by locking 
rules. 

From any Budget Request screen, the list of values for available budgets displayed 
follows the security levels described above. In other words, a budget requestor will 
only be able to request money from budgets of which he is either an owner or a 
team member. 

Table 4–1 Budget Security Levels

Security Level User Name Security Level Access

1 AMS: Admin Group Update all fields:

■ Excluding those locked by system

■ Including those locked by locking 
rules

2 Owner Update all fields:

■ Including Owner field

■ Including adding Team

■ Excluding those locked by system

■ Excluding those locked by locking 
rules

3 Team members with Edit 
Metrics

Update all fields:

■ Excluding Owner field

■ Including adding Team members

■ Excluding those locked by system

■ Excluding those locked by locking 
rules

4 Team members without Edit 
Metrics

View budget only

5 Everyone else No access, no view
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Unlike claims which are org-striped, budgets are not org-striped. They are, 
however, stored with the organization ID (according to the responsibility of the user 
who created the budget). Budget Utilization is org-striped.

The following table describes the various access levels of objects (such as offers, 
campaigns, Events) and as they relate to which users can access the Budget cue card 
with each object. Not everybody with access to an object will automatically have 
access to the Budget cue card or the Budget Request function.

Table 4–2 Object and Budget Security Levels

 Number User Name Security Level Access

1 AMS: Admin Group Update all fields:

Excluding those locked by system

Including those locked by locking rules

2 Owner Update all fields:

■ Including Owner field

■ Including adding Team members

■ Excluding those locked by system

■ Excluding those locked by locking rules

3 Team members with Edit 
Metrics

Update all fields:

■ Including adding Team members

■ Including Cost & Revenue Cue Card

■ Including Budget Cue Card

■ Excluding Owner field

■ Excluding those locked by system

■ Excluding those locked by locking rules

4 Team members without 
Edit Metrics

Update all fields:

■ Excluding adding Team members

■ Excluding Cost & Revenue Cue Card

■ Excluding Budget Cue Card

■ Excluding Owner field

■ Excluding those locked by system

■ Excluding those locked by locking rules
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4.6 Set Up Budget Adjustment Types
The budget adjustment types you create allow budget owners to manually adjust 
budget checkbooks. For example, budget owners can adjust (decrease) the earnings 
committed to customers who fail to meet offer performance requirements. The 
funds they free up can then be allocated to other activities. 

When creating adjustment types, you can utilize a different set of Oracle General 
Ledger accounts for budget adjustments than the ones originally used for accruals. 
This functionality allows you to skip Account Generator workflow setup and 
maintenance for simple Oracle General Ledger postings.

Example: A customer’s accruals are not paid at the end of the month. Instead, an 
adjustment is made to the offer. Based on the adjustment type, the funds are put 
into a single pool—a common set of Oracle General Ledger accounts used for all 
offer adjustments.

As long as all of the Oracle General Ledger accounts used belong to the same Oracle 
General Ledger balancing segment, different accounts can be used.

Prerequisite
If you plan to use different Oracle General Ledger accounts for budget adjustments, 
then those accounts must be set up in Oracle General Ledger before creating budget 
adjustment types.

Steps
1. Log in to Oracle Trade Management and navigate to Administration > Trade 

Management > Budget > Adjustment Types.

2. Click Create.

3. Complete the Create Adjustment Types page based on your business 
requirements.

■ Start Date: Date from which the adjustment type can be used. 

■ End Date: Date the adjustment type can no longer be used.

5 Everyone else, 
regardless of operating 
unit

View only

Table 4–2 Object and Budget Security Levels

 Number User Name Security Level Access
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■ Adjustment Type:

– Decrease Committed Amount: User can decrease a commitment if he 
or she has already committed for that activity. A validation is 
performed - budget commitments can be decreased only to the extent of 
the balance left after budget utilization. Negative commitments and 
earnings are not allowed. 

– Decrease Committed and Earned Amount: In addition to the above 
validation, earning validations listed below would also be performed. 
To post negative earning against a budget a positive earning must exist. 
If no earning exists for the budget, the user will receive an error 
message. 

– Decrease Earned Amount: Allows earning decreases against any 
budget. Amount cannot exceed the balance left after budget utilization. 
May be done because a customer fails to meet the performance criteria 
of an offer.

– Increase Earned Amount: Allow earning increases against any budget.

4. Click Create.

5. Select the appropriate default accounts.

6. Click Update.

4.7 Set Up Budget Thresholds
Budget thresholds enable companies to:

■ Set budget rules

■ Send budget alert notifications

■ Inform users of fund usage 

■ Inform user of depletion at various level

These rules and parameters defined in the budget threshold are assigned to a 
budget. 

■ Threshold Example: if a promotion has just started and has already used up 
90% of a budget, more funds may need to be transferred in.

■ Threshold Rule Example: A rule may be set up to send email alerts to budget 
owners when actual expenditure is >= 90% of committed.
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Budget thresholds can be based on the following amount types: 

■ Planned 

■ Committed 

■ Re-Calculated Committed

■ Utilized 

■ Earned

■ Paid 

■ Budget balance (Available - Committed)

To set up a budget threshold, use the following procedure. 

Prerequisite
None

Steps
1. Log in to Trade Management and navigate to Administration > Trade 

Management > Setup > Thresholds. 

2. Click Create.

3. For Threshold Type, select Budget.

4. Enter the following required information: 

■ Name: Name the budget threshold. The name will appear on the budget 
details page threshold LOV and can be assigned to a particular budget.

■ Start and End Periods: Optional. These are periods defined in the 
Accounting calendar. If specified, they will limit the start and end dates that 
can be entered below.

■ Start Date: The date from which the threshold is used.

■ End Date: The date upon which the threshold is no longer used.

■ Owner: Defaults to the user creating it. (For tracking only; no other 
function.)

■ Enabled: Must be checked if you intend to use this threshold, regardless of 
what you enter for start date.

5. Click Create. 
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6. In the Threshold Rules section, enter: 

■ Start Date: The date from which the threshold line (one particular rule) is 
used.

■ End Date: The date upon which the threshold line (one particular rule) is 
no longer used.

■ Value Limit: The amount type on which the budget threshold is based.

■ Operator: 

– > = (greater than or equal to)

– <= (less than or equal to)

– = (equal to)

■ Percent: Enter any number for percent. (No need to enter% sign).

■ Off Baseline: Values available are determined by the value limit you select

■ Frequency: Enter any number.

■ Period Type: Select Days, Weeks, Months, Quarters and Years. 

Together with Frequency, these define how often the budget owner will 
receive the notification within the Start and End dates of the line, once the 
threshold condition is met. If you enter Frequency = 2 and Period Type = 
Weeks, it means a budget owner will get a notification once every two 
weeks once the threshold condition becomes true, until the end date of the 
threshold line. 

■ Enabled: Select to use the threshold, regardless of the Start and End dates.

7. Click Update. 

4.8 Set Up Budget Categories
Budget categories are used for the following:

■ Classification

■ Approval rule setups

■ General Ledger account defaults

■ Specifying multiple sets of books

To create categories for budgets, follow the procedure below. 
4-10 Oracle Trade Management Implementation Guide



Budget System Status and User Status
Prerequisites
None

Steps
1. Log in to Trade Management and navigate to Administration > Trade 

Management > Setup > Category. 

2. Click Create.

3. In the Created For field, select Budget. 

4. Enter a Category Name.

5. Select the Enabled check box to make the category available.

6. Select or enter the following:

a. Select a Sales/Expense/Charge Account and a Liability Account

These accounts are used for posting. The Sales/Expense/Charge Account 
and the Accrual Liability Account are account flexfields. When a posting is 
made to one of these two accounts, the numeric identifier for each 
component of the flexfield is obtained through the Account Generator 
workflow process, and the account number is created. 

b. Enter an appropriate Prefix.

This prefix is added to the budget numbers that are generated 
automatically.

c. Select Activities from the table.

Optional. Activities are created using the activity page under the 
Administration tab. For more information, see Section 3.6.1, "Create 
Activities".

7. Click Create.

4.9 Budget System Status and User Status 
A budget goes through the following main system statuses:

■ Draft: Amounts are entered but not approved

■ Pending Approval: Being reviewed but needs approval to become active.

■ Active: Has been activated and can be used to fund activities.
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Approval rules are used to determine the route from Draft to Active. Approval rules 
are highly configurable and multiple ones can be created based on the budget's 
characteristics.

The following table lists budget statuses used in Trade Management and a 
description of each.

Table 4–3 Budget System Status

Status Description

Draft Budgets in draft status can be updated at any time in any way.

Draft status may be updated to Pending Approval or Cancelled.

It can also be updated to Active directly in case the budget owner 
is also the owner of the parent budget, and the parent budget is 
already Active.

Pending Approval The budget has been submitted for and is awaiting approval.

After all approvers have responded positively, a budget may 
become Active or On Hold. 

If approvers reject the budget it will become Rejected.

On Hold On Hold is an interim status that is used when budget has 
already obtained approval, and is just not completely ready to be 
made active. 

At On Hold status, a user can then manually change it to Active 
or Closed.

Rejected Budget approvers have rejected the budget.

From Rejected, the status can be manually changed back to Draft.

Active A budget that has been approved and is ready to fund various 
activities and promotions.

From Active, the status can be changed to Closed and Cancelled. 

Cancelled Indicates the budget has been aborted.

From Cancelled, the status can only be changed to Archived.

Archived The budget can no longer be used.

This cannot be changed to any other status.

Closed From On Hold or Active, Budget status can be manually changed 
to Closed. 

It indicates that the budget has ended and is no longer available 
to fund activities and offers.
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4.10 Set Up Budget Approval Rules
Approval rules are created to determine who approves budgets and under what 
circumstances. Approval rules for budget/root budget requests and transfers are 
evaluated based on the following:

■ Organization = 5

■ Approval Object Type = 3 (budget category)

■ Custom Setup = 1

The higher the number, the more important the parameter is in determining which 
approval rule will apply to a particular budget.

Root budget approval is always required unless 1) a child budget is submitted for 
approval and the owner also owns the parent budget, and 2) the sole approver is 
the budget owner.

■ Request: A budget or offer requests fund from another budget.

■ Transfer: A budget or offer is transferring money to another budget.

Approval requirements are based on custom setups. Approval notifications are 
routed regardless of the responsibility the users have to access the notification. 
Email notifications can be used.

Two types of budget approval rules can be created:

■ Rules where the budget request or transfer must always be approved. These 
rules are defined in the user interface.

■ Rules where budget requests and transfers can be approved automatically if 
they are under a certain amount. These rules are defined in Oracle Forms.

4.10.0.1 Creating Budget Approval Rules in the User Interface
Follow this procedure to create budget approval rules in the user interface.

Prerequisite
Custom setups must be created.

Steps
1. Log in to Trade Management and navigate to Administration > Trade 

Management > Setup > Approval Rule.

2. Click Create.
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3. Select a value for the Approval Rule for field:

■ Root Budget Request to define a rule for root budget request approvals.

■ Budget Request to define a rule for budget request approvals. 

■ Budget Transfer to define a rule for budget transfer approvals.

The page redraws and the fields might change.

4. Complete the page as required for your business needs.

■ Start Date: The date upon which the rule will become effective

■ End Date: The date upon which the rule will become effective will no 
longer be used

■ Organization: Displays a list of operating units

■ Setup Type: Custom setups created for budgets

5. Click Create. 

The page refreshes and an Approvers table appears. 

6. In the Approvers table, specify the individuals who must approve this type of 
budget request or transfer.

■ Order: Enter any integers in ascending order. 

■ Type: Select Function (for customization), Role (defined for Trade 
Management and assigned to Resources), or User. 

■ User/Role: Depending on the Type selected above, you will see a list of 
functions, roles or users.

■ Start Date: The date upon which the approver is active. Within the range of 
the approval rule, each line can also have a start date and end date.

■ End Date: The date upon which the approver is no longer active.

7. Click Update.

8. Ensure that the following processes are run. They find the correct rule and route 
the approval notification.

■ Workflow Background Process: Marketing Generic Approval (for root 
budget approvals)

■ Workflow Background Process: Marketing Approval (for budget request 
and transfer approvals)
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4.10.0.2 Creating Automatic Budget Approval Rules in Oracle Forms
Users can set rules for themselves in Workflow to automatically approve budgets 
under a certain amount.

Follow this procedure to create automatic budget approval rules in Oracle Forms.

Prerequisite
None

Steps
1. Log in to Oracle Forms and select the Workflow responsibility.

2. Select Notification Rules and click Create Rule.

3. Select AMS: Marketing Generic Approvals <Is this OZF now?>

4. Select Approval Required: [Approval Subject]

Two are listed.

5. Select the Respond button.

6. In the Approved Amount field, enter an amount (no commas).

All budgets under this amount will be approved automatically by this 
individual.

7. Action = Approve.

8. Click OK.

9. Ensure that the following processes are run. 

■ Workflow Background Process : Marketing Generic Approval (for root 
budget approvals)

■ Workflow Background Process : Marketing Approval (for budget request 
and transfer approvals)

They find the correct rule and route the approval notification.

4.11 Create Business Units for Budgets
When creating a budget, the list of values for the Business Unit field comes from the 
organizations defined in the HRMS application. For budgets, business units are 
used:
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■ To classify budgets, and are selected during budget creation

■ When setting up budget approval rules

4.11.1 Creating Business Units
Follow the procedure below to create business units.

Prerequisite
None

Steps
1. Log in to Oracle Forms as and select the HRMS Super User responsibility.

2. Navigate to Work Structures > Organization > Description.

3. Click New.

4. In the Name field, enter a name for the business unit.

5. In the Type field, select Business Unit.

6. In the Location field, select a location.

Notice that Location Address is completed automatically.

7. Click the Save icon to save your work.

8. In the Name field of the Organization Classifications area, select GRE/Legal 
Entity and the Enabled check box.

9. Save your work.

10. Click Others and select Legal Entity Accounting.

11. Click the Legal Entity Accounting field, and select the appropriate set of books.

12. Click OK, then OK again and save your work.

4.11.2 Verifying Business Unit Creation
To verify that you have successfully created business units: 

1. Log in to Oracle Trade Management.

2. Navigate to Budget > Budgets and click Create.
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3. Open the Business Unit drop-down list and verify that the business units you 
have created appear in the list.

4.12 Set Up Budget-Offer Validation
Budget-offer validation validates that the market and product eligibilities of an offer 
fall within the targets of the budget. This option ensures that funds set aside for 
specific customers and products are used appropriately. 

To set up budget-offer validation, set the profile OZF: Validate market and product 
eligibility between object and budget to one of the following values at the site and 
responsibility levels.

■ No validation for customers and products: no validation will take place.

■ Validate customer and products by each budget: market and product 
eligibilities for the budget and offer must match.

Even if different parameters are used for defining eligibility. In the case where a 
budget uses Territories, but the offer uses Customer, the validation procedure 
can determine whether the offer meets budget criteria. For example, a budget 
says “US West” territory, but the offer says “Business World”. The procedure 
can determine whether or not the US West territory includes the customer 
Business World.

■ Validate customer by each budget, product by all budgets:

This validation option is useful in the following scenario. A sales representative 
is responsible for selling multiple products to a single customer account. These 
products belong to different brand managers, and each brand manager has his 
own budget, so if the sales representative wants to request funding for his 
promotion, he may request funds from multiple brand managers. In such cases, 
it does not make sense to mandate that each brand manager's budget must 
cover all of the products in the promotion. It is only necessary that each covers 
some products, but that in total, all of the brand managers' budgets cover 
funding for all products in the promotion. For example, a sales representative 
who sells regular cola and sports drinks to Bigmart, may in addition to his own 
funds also request the brand manager for regular cola to fund his promotion as 
well. It doesn't make sense for the system to fail the validation because the 
regular cola budget doesn't cover sports drinks. 

■ Validate product by each budget, customer by all budgets: 

In this scenario, a sales representative is promoting a particular product to 
multiple accounts in his territory and is requesting funding from budgets 
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created specifically for some bigger accounts. For example, he is promoting 
product X to both Goodway and Bigmart, and in addition to funding it from his 
own budget, he may also request money from a bigger budget set aside for 
Bigmart nationally. In this case it doesn't make sense for the system to fail the 
validation simply because the Bigmart national budget doesn't cover Goodway.

Validation occurs at the same time for both market and product eligibilities. If 
validation fails, an error message is sent to the offer owner. The status of the offer 
reverts to Draft. 

4.13 Set Up Multiple Currencies for Budget
Budgets can be created in multiple currencies. Although the budget may reflect 
multiple currencies, Oracle General Ledger postings use the functional currency 
defined by the set of books specified on the system parameters page. Trade 
Management automatically performs currency conversion based on the rates 
defined in the profile option OZF: Default Currency Code. 

Users can transfer funds to different budgets or request money from budgets in any 
currency. The source budget are not required to be in the same currency. When users 
request money in one currency, they will also see an approval notification and 
money transfer in the same currency. Similarly when the budget owner receives a 
request, the system automatically converts the requested amount to the budget 
currency. The budget owner then approves the amount in the budget currency. 

Currency conversion for each transaction is recorded based on the currency 
conversion type specified by the profile option OZF: Currency Conversion Type. 
This profile is set at the site level. When viewing the budget, you will see both the 
transaction currency and the budget currency amounts.

4.14 Set Up Budget Allocation Based on Prior Year Sales
Budget allocation enables a company to allocate money to each sales territory for 
the salespeople to spend. Allocation can be based on:

■ Even Distribution: This is derived by dividing the total allocation amount by 
the number territories selected. 

■ Manual: Enters any number manually. 

■ Prior Year Sales: A proportionate split is calculated to allocate the money for 
the current year. 
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To set up budget allocation based on Prior Year Sales, run the OZF-TM: Refresh 
Materialized View for Base Sales and Actual Sales concurrent program. Budget 
allocation makes use of Territories set up in Territory Manager, so it is also 
necessary to import the territories for Trade Management purposes.

■ For more information about setting up Territories Section 3.9.2, "Set Up 
Territory Manager for Trade Management". 

■ For more information about concurrent programs see Appendix C, "Summary 
of Concurrent Programs".

4.15 Set Up Top-down and Bottom-up Budgeting 
Budget amounts allocated from management down to lower levels is called a 
top-down budgeting process. Budget amounts rolled up from lower levels to 
management, is called a bottoms-up budgeting process. 

To implement top-down or bottoms-up budgeting: 

■ Allocate budget based on a specific criteria (for example, prior year sales). 

■ Accept inputs from lower levels. 

Trade Management enables you to automate the time-consuming budget process by 
facilitating communication between management and sales people at all levels in 
the sales hierarchy.

For more information on Top-down and Bottom-up budgets see the Oracle 
Marketing User’s Guide. 

4.16 Set Up Budget Requests
To access Budget Request screen, you need to set up proper security access level for 
the users based on the rules in the above section “Setting Up Budget Security”. For 
more information see Section 4.5, "Set Up Budget Security". 

In addition, define multiple Transfer Reasons to record the reasons for each request. 
To do so, extend the Lookup AMS_TRANSFER_REASON. 

4.17 Funds Accrual Engine Overview
Funds Accrual Engine is a program that handles Accrual Management capabilities 
in Oracle Trade Management. 

This section contains the following subsections: 
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■ Section 4.17.1, "Funds Accrual Components"

■ Section 4.17.2, "Logical Procedures for Accruing Funds"

4.17.1 Funds Accrual Components
This engine enables you to calculate Budget Accrual Liability. All features listed 
below are implemented through the same concurrent process. 

■ Ability to calculate budget utilization and earnings based on ship confirmed 
orders.

■ In case of Fully Accrued type of budgets with accruing to Customer, the Budget, 
Committed and Earned columns are to be updated with the accrued amount. 
But in case of budgets that accrue to Sales; only the Budget column must be 
updated. Committed and Earned should not be populated. This allows users to 
transfer money from a fully accrued budget to any other fixed budgets. If max 
cap is specified against the fully accrued budget, the budget can be 
accumulated only to the level of max cap. For fixed budgets, the budget earned 
column is updated with the accrued amount.

■ Ability to reconcile budget utilization and earnings when an order is cancelled. 
When an order is cancelled, running the concurrent process reconciles the 
already adjusted budget amount.

■ Ability to reconcile budget utilization and earnings when an order is returned 
When an order is returned, running the concurrent process reconciles the 
already adjusted budget amount.

4.17.2 Logical Procedures for Accruing Funds
To accrue funds, use the following procedures:

1. In Trade Management, create an Active Fixed Budget.

2. In Trade Management, create an Offer.

3. In Trade Management, source the Offer from the Active Budget.

4. In Trade Management, activate the Offer (status of the Offer = Active).

4.18 Set Up Recalculated Committed
This functionality recalculates the funding level based on the sales performance of a 
promotion. Funds can be increased or decreased. If the promotion performs well, 
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funding can be automatically increased, and vice versa. This ensures that funds do 
not run out for promotions that are performing well. 

The committed amount determines the maximum of what the Utilized amount can 
be. The relationship is reversed for Re-Calculated Committed. If Re-Calculated 
Committed is implemented then the Utilized amount determines what 
Re-Calculated Committed amount should be.

■ Re-Calculated committed amount can be higher or lower than committed 
amount

■ Re-Calculated Committed amount can be higher or lower than total amount

Subsequent budget requests from offers will increase the committed amount of the 
budget - not the Re-Calculated Committed. 

For example, Budget A has the following numbers:

■ Total = $10,000

■ Planned = $0

■ Committed = $5,000

■ Re-Calculated Committed = $12,000

■ Utilized = $6,000

Offer A then requests money from Budget A. Offer A is for $2,000. The user submits 
Offer A for budget approval for $2,000 from Budget A. Offer’s status is now at 
Pending Budget Approval. As a result, Budget A’s numbers are updated as follows:

■ Total = $10,000

■ Planned = $2,000 

■ Committed = $5,000 

■ Re-Calculated Committed = $12,000

■ Utilized = $6,000

Once the budget request for offer A is approved, Offer A has Active status. 
Budget A is updated as follows.

■ Total = $10,000

■ Planned = $0

■ Committed = $7,000

■ Re-Calculated Committed = $12,000
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■ Utilized = $6,000

To set up Re-Calculated Committed budgets, use the following procedure. 

Prerequisites
None

Steps
1. Set the profile OZF: Allow Recalculation of Committed Budget to Yes at site 

level.

2. Set the profile OZF: Default Period in Days for Recalculating Committed 
Budget. 

Enter any number = 1. This profile determines how often you would like to see 
Re-Calculated Committed change. For example:

■ If set to 1, it means that you would like to see Re-Calculated Committed 
change after 1 day. 

■ If set to 2, it means that you would like to see Re-Calculated Committed 
change after 2 days. 

■ This number should be set to be less than or equal to the shortest offer 
duration in the system in order to get the most updated Re-Calculated 
Committed amount. For example, if the shortest offer in the system lasts for 
6 days, but you set the profile here to 10. It means that you will not see 
Re-Calculated Committed reflect this particular offer’s actual utilization 
until 4 days after the offer ends. 

3. Run the concurrent program OZF-TM: Perform Recalculated Commitment for 
Offers. 

■ The lowest number of days for the OZF: Default Period in Days for 
Recalculating Committed Budget is 1, therefore, it does not make sense to 
schedule this program to run more than once per day. 

■ Example 

Offer A is committed for $10,000 for 10 days from Day 1 to Day 10. It gives 
a 10% accrual on Product A which regularly sells for $100. 

OZF: Default Period in Days for Recalculating Committed Budget = 1.

Average committed for Offer is therefore $10,000 / (10 / 1) = $1,000.
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The OZF-TM: Perform Recalculated Commitment for Offers program is 
scheduled to run once every day at 00:01 hour (1 minute after midnight).

Day 1, a customer buys 120 units of Product A, total sales = 120 x $100 = 
$12,000. This customer gets Offer A, so the accrual calculated for him is 
$12,000 x 10% = $1,200. Assume budget utilization is updated 
immediately[3]. This increases budget utilization by $1,200.

Re-Calculated Committed amount does not change during Day 1. 1 minute 
after Day 1, the concurrent process runs as scheduled. Re-Calculated 
Committed is increased by $(1,200 – 1,000) = $200. This is shown as a 
“Re-Calculated Committed Increase” Adjustment of the budget. You will 
see this if you drill down into the Re-Calculated Committed number.

In this example, even if the concurrent process was scheduled to run twice 
every day, the result is still the same. In other words, because OZF: Default 
Period in Days for Recalculating Committed Budget = 1, the earliest 
Re-Calculated Committed will update is 1 second after midnight. So even if 
the process was run at 23:59 hour of Day 1, Re-Calculated Committed will 
not increase by $200.

4. To View Re-Calculated Committed amount:

a. Log in to Oracle Marketing

b. Navigate to the Budget tab. 

c. If this budget summary page does not have Re-Calculated Committed as 
one of the columns displayed, select the Personalize button.

d. Define your search criteria, and from the Available Column window, select 
Re-Calculated Committed and move it to the Display Column window. 
Name and save your search. Go back to the budget summary page and you 
can now see this column.

5. Save your work.

4.19 Setting Up Budget Reconciliation
Budget reconciliation is a way to return money at the end of an offer. It can be done 
manually or automatically.

■ Manual Reconciliation: Using the Budget cue card’s Reconcile button 

■ Automatic Reconciliation: Running OZF-TM: Release Committed Budget 
Amount After Grace Period program.
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To set up budget reconciliation run the concurrent program OZF-TM: Release 
Committed Budget Amount After Grace Period. See Section C.1, "Running 
Concurrent Programs" for this procedure.

4.20 Setting Up Budget Roll-up Views
Budget rollup view displays a budgets own amount plus all numbers of its 
descendent budgets. 

Budgets can be allocated and arranged in a hierarchy, the rollup view gives an 
organization a “birds-eye” view of all budget balances summed up to each level. 
Activities and usages can be viewed by drilling down into different numbers such 
as committed, utilized. When drilled down from a rollup view, the details will show 
for the budget itself and all of its child budgets. 

For example, a budget called “California” has committed amounts of $10K. A 
budget called “Oregon” has $20K. Their parent budget “Western US” funds no 
other activities, its rollup view committed therefore = $30K.

To set up the budget roll-up view, set the profile OZF: Universal Currency for 
Budget Rollup View at the site level. This stores the one currency which is used to 
convert to all other currencies. In addition, for each user, set JTF_PROFILE_
DEFAULT_CURRENCY so he can view the rollup view in his own currency. 

Prerequisites
None

Steps
1. Log in to Oracle Forms with System Administrator responsibility.

2. Set the profile option OZF: Universal Currency for Budget Rollup View at the 
site level.

3. For each user set the “JTF_PROFILE_DEFAULT_CURRENCY” at user level.

This determines what currency a user will see his budget rollup view in. 

4. To view the budget roll-up:

a. Log in to Oracle Marketing.

b. Navigate to the Budget tab. 

c. Select from drop down menu, the value “Rollup View”. 
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Self View will show all amounts for the budget itself only whereas Rollup 
View will show all amounts summed for the budget itself and all budgets 
underneath it.

d. Wait for page to refresh.

The rollup view converts all budgets to the profile currency as set up above. 
Because the profile is set at user level, different users will see the rollup 
view accordingly.

4.21 Set Up Third Party Accrual API Import
The Third Party Accrual API enables customers to generate accruals on orders 
made through third party whole sale corporations. This API simulates the pricing of 
orders and then creates order information in chargeback order tables. It posts the 
difference between customer paid price and simulated price to a budget that is 
setup by the customer. Any discount and accrual applied to the order is accrued. 

Order information is stored in ozf_chargeabck_int_all table. The API process orders 
from direct customers as well as indirect customers. For indirect customer orders, 
the API does not run the pricing simulation. It copied the order information to the 
chargeback order tables. 

For direct customers, the API validates the data, runs the simulation, creates the 
order and posts the accrual amount. Direct_customer_flag in ozf_chargeback_int_all 
indicates whether the order record is from a direct customer or not. Discount and 
accrual related information is stored in ozf_chargeback_price_adj_all table.

For any exception generated during the process, a log record is created in an 
interface log table. User can use this table to modify the data.

4.21.1 Third Party Accrual API Concurrent Programs 
The API consists of two concurrent programs:

OZF-TM: Third Party Accrual from Interface Table
This program is used to create a third party accrual based on the resale data in the 
OZF_RESALE_LINES_INT_ALL table.

OZF-TM: Chargeback Purge
The OZF-TM: Chargeback Purge Program deletes the processed order from the 
OZF_RESALE_LINES_INT_ALL interface table. 
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4.21.2 Preparing the Concurrent Program
Before running the concurrent program do the following: 

■ A user needs to setup the profile: AMS: Price Different Budget for the 
concurrent program to run.

■ Oracle General Ledger account information in ozf_sys_parameters needs to be 
setup properly.

■ Account generator workflow needs to be compiled properly.

■ Tables updated by the concurrent program:

– Ozf_chargeback_int_all

– Ozf_chargeback_headers_all

– Ozf_chargeback_lines_all

– Ozf_funds_utilized_all_b

– Ozf_funds_all_b

– Ams_act_budgets
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Implementing Trade Planning

Trade planning is used by managers to create and allocate sales quotas. It is also 
useful for evaluating past offers and creating new ones. 

Sales representatives use the account planning area of trade planning. They also can 
monitor offer and retailer performance. Account planning tools include the Activity 
Summary, Offer Evaluator, Discount Calculator and Offer Worksheets. See 
Section 5.5, "Set Up Account and Activity Planning" for more details.

Discount planning is an integral part of trade planning. It involves setting discounts 
that encourage customers to buy products, while at the same time providing the 
desired return on investment. By offering discounts, organizations can improve 
sales, achieve sales targets, and gain competitive advantage. Different types of 
discounts can be offered based on varying business conditions and scenarios.

Offers in Marketing simplifies the process of discount planning, execution, and 
tracking. You can plan and create different kinds of offers depending upon the 
requirements and the results that you want to achieve. You can associate offers with 
products or campaigns, predict the performance of new offers, and create 
adjustments to active offers. You can also track and monitor the costs and revenues 
for active offers.

The way in which you implement and administer the trade planning component of 
Trade Management depends on your specific business requirements. Therefore, not 
all administrative tasks must be performed.

This chapter describes the tasks required to implement and administer trade 
planning. Implementation tasks are one-time procedures performed during or 
shortly after installation. Examples include setting profile options, creating and 
verifying lookup values, and creating users. Administrative tasks are repetitive 
operations performed post-installation. Examples include creating claim types and 
reasons, configuring a budget threshold, and creating custom setups.
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Topics in this chapter include:

■ Section 5.1, "Set Profile Options for Trade Planning"

■ Section 5.2, "Verify Lookups for Trade Planning"

■ Section 5.3, "Run Concurrent Programs for Trade Planning"

■ Section 5.4, "Set Up Quota Allocations and Alerts"

■ Section 5.5, "Set Up Account and Activity Planning"

■ Section 5.6, "Implementation Set Ups Related to Offer Creation and 
Functionality"

■ Section 5.7, "Set Up Posting of Offers to General Ledger"

■ Section 5.8, "Source Funds for Offers"

■ Section 5.9, "Set Up Forecasting"

■ Section 5.10, "Set Up Budget-Offer Validation"

■ Section 5.11, "Set Up Volume Offers"

■ Section 5.12, "Set Up Backdating"

■ Section 5.13, "Set Up Scan Data Offers"

■ Section 5.14, "Set Up Lump Sum Offers"

■ Section 5.15, "Set Up Net Accrual Offers"

■ Section 5.16, "Set Up Business Events and Flexfields for Trade Planning"

■ Section 5.17, "Customize the Account Generator for Offers"
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5.1 Set Profile Options for Trade Planning
There are certain system profile options that must be set for Trade Planning to 
function properly. Select the settings that meet your business requirements. Most 
offers, except for lump sum and trade deals) leverage Advanced Pricing. 

For the profile options for Trade Planning and the specific procedure for setting up 
those profile options, see Appendix A.4, "Profile Options for Trade Planning".

5.2 Verify Lookups for Trade Planning
Lookups supply the content of many of the lists of values (LOVs) in the Oracle 
Trade Management user interface. Most lookups are predefined (seeded in the 
application). The seeded values can be left as is, or you can customize them to fit 
your business needs. Lookup values make choosing information quick and easy, 
they ensure that users enter only valid data into Oracle Trade Management.

For Trade Planning, create or verify the lookups. See Appendix B.4, "Lookups for 
Trade Planning" for the complete listing of lookups and for steps for this procedure.

5.3 Run Concurrent Programs for Trade Planning
For Trade Planning, certain concurrent programs must be run. For the list of 
concurrent programs, see Appendix C.4, "Concurrent Programs for Trade Planning". 
Steps for running concurrent programs can be found at Appendix C.1, "Running 
Concurrent Programs".

5.4 Set Up Quota Allocations and Alerts
A quota allocation is a sales goal that must be met within a specific period of time. 
Quotas are assigned by upper management down a sales team hierarchy based on 
territory structures that you create.

Quotas can be assigned as a monetary value or by quantity. For example, Ben 
Johnson, a sales representative for ABC Corp., may have to sell $25,000 worth of 
product during ABC Corp.’s third quarter if he has a quota based on monetary 
value. If his quota were quantity-based, he might have to sell 1,000 cases of product 
A and 500 cases of product B during that quarter.

You can also create threshold rules that trigger alerts sent to sales representatives 
(reps) regarding their quotas. These alerts are designed to help keep reps aware of 
their actual sales performance in relation to their quota.
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Before you set up quota allocations and alerts, you must set up the Time Dimension 
Structure. See Section 3.2, "Set Up the Time Structure" for this procedure.

To set up quota allocations and alerts:

1. Set Up Territories for Quota Allocations

2. Set Up Quota Allocations

3. Set Up Threshold Rules for Quota Related Alerts

5.4.1 Set Up Territories for Quota Allocations
To set up territories for quota allocations, follow the instructions listed under 
Section 3.9.2, "Set Up Territory Manager for Trade Management" and Section 3.9.2.2, 
"Setting Up Territories for Budgets".

Guidelines
■ Territory type = Offer.

■ We recommend:

– Assigning an owner to each territory.

– Limiting owner assignment to one hierarchy per person.

If a person owns more than hierarchy, there should be no overlap. For 
example, a person owns the California hierarchy, which contains San 
Francisco and Los Angeles. If that person also owns the Western Cities 
hierarchy, it cannot also contain Los Angeles.

Owners are referred to as Resources in the Territory Manager instructions 
referenced above. To designate a resource as the quota owner for a 
particular level of the hierarchy, select the Primary Contact check box.

5.4.2 Set Up Quota Allocations
These are the three parts of the setup for Quota Allocations:

■ Set a system parameter to select amount or quantity

■ Set system profiles for currency, unit of measure, and conversion type

■ Run a concurrent program to update order information
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Prerequisites
Before setting up quota allocations, you should have set up territories for quota 
allocations.

Setting System Parameter to Select Amount or Quantity
1. Log in to Trade Management and navigate to Administration > Trade 

Management > Setup > System Parameter.

2. Scroll down to the Planning section and select a quota allocation type of 
Amount or Quantity (unit of measure).

If Amount is selected, then quotas are allocated in the currency specified by the 
system profile OZF: Currency for Quota Allocation. If Quantity is selected, then 
quotas are allocated based the unit of measure specified by the profile option 
OZF: Unit of Measure for Quota Allocation.

3. Click Update.

Setting System Profiles for Currency, Unit of Measure, and Conversion 
Type
1. Log in to Oracle Forms and select the Oracle Trade Management Administrator 

responsibility.

2. Navigate to Setups > Profiles.

3. In the Find System Profiles Values window, search for the following profiles 
and assign values to them based on your business needs.

■ OZF: Currency for Quota Allocation

■ OZF: Unit of Measure for Quota Allocation

■ OZF: Currency Conversion type

For example:

a. In the Profile field, enter: ozf%quota% and click Find.

b. In the Site field next to the profile OZF: Currency for Quota Allocation, 
select the appropriate currency.

c. Click the Save icon, then close the window.

d. Repeat this process for the remaining profiles.
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Running the Concurrent Program to Update Order Information
Run OZF-TM: Refresh Materialized View for Order Sales.

5.4.3 Set Up Threshold Rules for Quota Related Alerts
Threshold rules are created to trigger alerts that are sent to salespeople regarding 
their quotas. These alerts are designed to help keep salespeople aware of their 
actual sales performance in relation to their quota. Based on this knowledge, 
salespeople can make changes to their account plans to meet their goals.

Threshold rules can be set based on various conditions including:

■ Month-to-date, quarter-to-date, or year-to-date sales

■ Total shipments possible

■ Outstanding, current, future and back orders

Prerequisites
Before creating threshold rules for quota allocation alerts, you should have set up 
thresholds and quota allocations.

Steps
1. Log in to Trade Management.

2. Navigate to Administration > Trade Management > Thresholds.

3. You must enter the following information:

■ Name = name for the threshold

■ Threshold Type = Quota

■ Start Period = your choice

■ End Period = your choice

Notice that the start and end dates are entered automatically when you select 
the periods.

4. Click Create.

5. Complete the Threshold Rules section of the Threshold Details page and click 
Update.

See Guidelines below for more information on threshold rule set up.
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6. Set up the concurrent program, OZF-TM: Validate Budget and Quota 
Thresholds, to run on a daily basis. See Section C.1, "Running Concurrent 
Programs" for this procedure.

5.5 Set Up Account and Activity Planning
Salespeople use the account planning functionality to plan and execute the activities 
they will use to meet their quotas. It is also used to monitor the performance of their 
retailers and active offers. Tools provided include gantt charts, sales graphs, and the 
following:

■ Account Manager Dashboard: This tool displays the performance of all of the 
account manager’s customer accounts.

■ Activity Summary: This tool displays the summary of all trade activities 
planned or being executed for a customer account for a given time period. 

■ Offer Evaluator: This tool enables sales representatives to evaluate the 
performance of past and current offers.

■ Discount Calculator: This tool is used to determine what discount will be 
beneficial to both the manufacturer and the retailer before actually creating an 
offer.

■ Offer Worksheet: This tool is used to determine the appropriate terms for an 
offer before publishing it. Sales representatives can calculate the ROI for various 
discounts before creating the offer.

5.5.1 Set Up Account Manager Dashboard
The Account Manager Dashboard displays data for all the accounts in the territories 
owned by the logged in user. Data on the dashboard are current as of the last time 
the OZF-TM: Refresh Account Manager Dashboard concurrent program was run.

Prerequisites
Quota must be allocated for the user. Please see "Set Up Quotas and Alerts" 

Steps
1. Run OZF-TM: Refresh Materialized View for Order Sales

Sales information in the dashboard and the sales performance graphs is current 
as of the last time this program was run.
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2. Run OZF-TM: Refresh Account Manager Dashboard

Data on the dashboard is current as of the last time this program was run.

5.5.2 Set Up Activity Summary and Offer Evaluator
The Activity Summary displays all the Offers and Campaign Schedules. The Offer 
Evaluator displays all offers and their forecasted and/or actual sales information.

Prerequisites
Offers and Campaigns must exist in the system

Steps
1. Run OZF-TM: Refresh Trade Management Activities (Offers and Schedules)

This program populates de-normalized tables with up-to-date information of 
new and changed Offer and Schedules. Both the Activity Summary and Offer 
Evaluator data is current as of the last time this concurrent program was run.

All of the activities in the account plan and Offer Evaluator are current as of the last 
time the OZF-TM: Refresh Trade Management Activities (Offers and Schedules) 
concurrent program was run.

5.6 Implementation Set Ups Related to Offer Creation and Functionality
The following sections include instructions on setups required for full offer 
functionality. These sections include:

■ Section 5.6.1, "Offer Payout Dates and Methods"

■ Section 5.6.2, "Offer Theme Approval Set Up"

5.6.1 Offer Payout Dates and Methods
For accrual-type offers, the offer owners can specify:

■ The date to automatically pay the customer, or the number of days from the 
offer end date upon which to pay the customer.

■ The payment method (check or on-account credit).

■ The customer to be paid.

To implement this functionality, you must:
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1. Verify the following lookups:

■ OZF_OFFER_AUTOPAY_METHOD

– Meanings are Account Credit and Issue Credit

■ OZF_AUTOPAY_CUST_TYPES

– Meanings are Customer Name; Customer - Bill To; Customer - Ship To

2. Set up Autopay to run every day. 

The Autopay program checks to see which offers meet the pay out date 
specifications. When an offer meets this criteria, the Funds Accrual Engine is 
invoked, a claim is created, and the claim is settled. The offer owner is notified 
when payment is made. For more information on Autopay, see Section 6.8, "Set 
Up Autopay".

5.6.2 Offer Theme Approval Set Up
Theme approval functionality allows businesses to require upper management 
approval for promotional ideas prior to allocating budget resources. The use of this 
functionality is optional.

To implement theme approval for offers, you must verify the lookup OZF_OFFER_
STATUS.

Offer theme approval functionality is enabled and disabled by selecting an option 
called Theme Approval when you create custom setups for offers. For more 
information on custom setups, see Section 3.6.5, "Create Custom Setups".

5.7 Set Up Posting of Offers to General Ledger
You can configure Oracle Trade Management to transfer General Ledger (GL) 
postings for offers from the Trade Management interface to the Oracle General 
Ledger interface table.

Posts to Oracle General Ledger occur when:

■ Lump sum or accrual offers update the budget utilized column

■ Claims or deductions for an offer are settled

■ The utilized amount for lump sum and accrual offers increases or decreases due 
to an adjustment of the utilized column
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■ Off invoice postings are done when updating the budget utilized column. The 
Create Oracle General Ledger entries for off-invoice discount option must be 
enabled on the System Parameters page.

Posts will not occur to Oracle General Ledger when the following offers are 
associated with an order:

■ Promotional goods

■ Order value

■ Terms Upgrade

If posted to the budget checkbook, the Utilization and Paid columns will reflect the 
value.

To configure Oracle Trade Management to transfer Oracle General Ledger (GL) 
postings for offers, run the OZF-TM: Transfer to General Ledger concurrent 
program. It can be run with the option of “Submit Journal Import” or not. This 
program transfers the Oracle General Ledger postings from Trade Management’s 
interface to Oracle General Ledger’s interface.

From Oracle General Ledger’s interface, you will still need to run Journal Import 
and/or Post to Oracle General Ledger programs. Source = Marketing.

To set up Trade Management to post offers to Oracle General Ledger, follow the 
procedure below.

Prerequisites
None

Steps
1. Log in to Oracle Forms and select the Oracle Trade Management Administrator 

responsibility.

2. Navigate to Concurrent Requests > Run, and select Single Request. 

3. Click OK.

4. Run the concurrent program OZF-TM: Transfer to General Ledger.

While running this program, you have the option to submit journal import at 
the same time. Or, you can wait for the request to finish and then:

■ Switch to the General Ledger responsibility.
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■ Run Journal Import separately for the Marketing source from the Run 
Journal Import screen in Oracle General Ledger.

5. Select the remaining parameters for the request and submit the request.

6. Switch to the General Ledger responsibility and navigate to Journals > Enter.

7. Query the journal entries using the source Marketing.

8. Review the journal details.

9. Post the journal batch by navigating to More Actions > Post Batch.

Once posting is complete, the batch status changes to Posted, and the respective 
account balance is updated.

5.8 Source Funds for Offers
Individual offers can have the option to source from either a campaign (parent) or a 
budget directly. This allows offers the flexibility to define its funding source. When 
a campaign is the funding source of an offer, the campaign acts like a 
“mini-budget”. The offer can only source up to what available amounts the 
campaign has.

Sourcing funds for offers from a campaign or budget functionality gives the sales 
manager the ability to create multiple campaigns from a single budget and assign 
owners to specific campaigns, thus enhancing the manager’s ability to monitor 
spending. The function also permits the sales person to source funding for Trade 
Deal type offers from either a campaign or a budget, which simplifies the offer 
execution process.

This functionality is based on the profile OZF : Source from Parent Object. See 
Section A.4, "Profile Options for Trade Planning" for details.

5.9 Set Up Forecasting
Trade Management’s forecast functionality is used to evaluate and consider the 
historical data of past offers to help create successful new offers. This functionality 
is accessed by clicking the Forecast side navigation link from the details page of any 
offer.

Forecasts can be created for all types of offers and any offer status. The exception to 
this is for Order Value. Order Value offer does not have any product specification.   
Implementing Trade Planning 5-11



Set Up Forecasting
Forecasts can be created only if there is at least one customer and one product 
selected in the Offer. Forecasts support multiple customers and products. 

You can update a Forecast before it is frozen. After it is frozen, a Forecast and 
product combination can not be changed, regardless of changes in the Offer’s 
customer and product selection. A frozen Forecast cannot be deleted. New Forecast 
versions can be created after a previous one is frozen. Forecasts are created in 
quantity, not monetary value.

Forecasts are created at Offer or Campaign level. If created on Offer level, it looks 
up the historical sales data for the customers and products selected for that given 
Offer. If created on the Campaign level, it sums up for the different campaigns.

For Offer Forecasting, Trade Management uses an API from Inventory called CST_
COST_API.get_item.cost. The list price of the item is fetched using the Advanced 
Pricing API called QP_preq_grp.price_request. When you input the inventory item 
ID and org ID, they are passed on to the API, which returns the cost of goods sold.

5.9.1 Implement Forecasts for Offers
To implement Forecasts for Offers, use the following procedure.

Prerequisites
None

Steps
1. Run OZF-TM: Refresh Materialized Views for Order Sales.

Because Forecasts are done based on historical sales data, there must be 
historical sales data in the system.

2. Set OZF: Default Forecast UOM profile option at the user level. 

This profile option determines the default unit of measure (UOM) used for 
calculating forecasts. If historical sales data are in different UOMs, they will all 
be converted to the UOM specified here. 

3. Ensure that the Forecast flag is checked as Available Attributes in the 
corresponding Campaign or Offer Custom Setup. To verify: 

a. Log in to Oracle Trade Management.

b. Navigate to Administration > Trade Management > Setup > Custom Setup.

Forecasts can be created for Campaign or Offer. 
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5.9.2 Set Up Other Costs for ROI Calculator
You can set up Other Costs for an item in addition to the cost of goods retrieved by 
the API CST_COST_API.get_item_cost.

For each item and event "oracle.apps.ozf.forecast.OtherCosts" is raised. Subscribe to 
this with a phase between 1 and 99 so that the subscription will be executed 
synchronously. This subscription should have a function that returns the other costs 
for the item.

To subscribe to the Event, perform the following procedure.

Prerequisites
None

Steps
1. Log in to Self Service Applications as System Administrator.

2. Select the Workflow Administrator Web Applications responsibility.

3. Select Business Events under Administer Workflow. 

4. Enter oracle.apps.ozf.planning.OtherCosts in the Search Criteria and click Go.

5. Click the Subscription icon for the Event.

6. Click Create Subscription.

7. Enter all of the required information.

Make sure that Phase = Between 1 and 99

These parameters are sent in the Event:

Name Description

P_OBJ_TYPE Calling object code. 
WKST if called from Offer Worksheet Discount Calculator.
OFFR if called from Offer - Forecasts

P_OBJ_ID Calling objects Id.
If P_OBJ_TYPE is WKST then
OZF_WORKSHEET_HEADERS_B.WORKSHEET_HEADER_ID
If P_OBJ_TYPE is OFFR then
OZF_OFFERS.QP_LIST_HEADER_ID
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Code Example
Users can write the generate function in the subscription as follows:

FUNCTION return_other_costs(p_subscription_guid in raw,
                            p_event in out wf_event_t) 
RETURN VARCHAR2

  -- Initialize parameters
  l_parameter_list         wf_parameter_list_t;
  l_parameter1             VARCHAR2(1000);
  l_parameter2             VARCHAR2(1000);
  l_parameter3             VARCHAR2(1000);
  l_parameter4             VARCHAR2(1000);
  l_parameter5             VARCHAR2(1000);

  l_other_costs            NUMBER;

BEGIN

  -- Read parameter passed by the event

  l_parameter_list := WF_PARAMETER_LIST_T();
  l_parameter_list := p_event.GetParameterList;

  l_parameter1 := wf_event.GetValueForParameter(
                                              'P_OBJ_TYPE, 
                                               l_parameter_list);

  l_parameter2 := wf_event.GetValueForParameter(

P_PRODUCT_ATTRIBUTE Attribute of the discount line.
For product: PRICING_ATTRIBUTE1
For Category: PRICING_ATTRIBUTE2

P_PRODUCT_ATTR_VALUE Id of the Attribute. 
For product: Inventory_Item_Id
For category: Category_Id

P_UOM Unit of Measure for Other Costs 

P_OTHER_COSTS The subscription should set value of other costs to this parameter. 
Application will read this value and add to Cost of Goods.
Note: Should always be a NUMBER

Name Description
5-14 Oracle Trade Management Implementation Guide



Set Up Budget-Offer Validation
                                              'P_OBJ_ID,
                                               l_parameter_list);
  
  ... 
  ...  Read all other parameters...

  -- Custom code to fetch other_costs
  ...
  ...
  ...
  l_other_costs := <Calculated Value >

  ----------------------------------------

  -- Send value of other costs back to the event.

  p_event.AddParameterToList(pName    => 'P_OTHER_COSTS',
                             pValue   => l_other_costs  ;

  return 'SUCCESS';

EXCEPTION

END;

5.10 Set Up Budget-Offer Validation
Enable this option to make sure that customer and product targets for promotional 
offers match those specified in the budget from which it is sourcing money. It makes 
sure that funds planned for certain customers and products are used appropriately.

For example, a company may create a budget used for California Retailers and 
Orange Juice only. If the validation is turned on, an offer created for Oregon 
Retailers and Milk will not be allowed to source from that budget.

To enable this functionality, set the profile option called OZF: Validate market and 
product eligibility between object and budget. Set this option at the site and 
responsibility levels.

The values for this profile option are:

■ No validation for customers and products.

■ Validate customer and products by each budget.
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■ Validate customer by each budget, product by all budgets.

■ Validate product by each budget, customer by all budgets.

If validation fails, the revert status process reverts the status of an object (such as an 
offer) from Submitted or Pending back to the previous status, for example, draft. A 
notification is sent to the object owner.

5.11 Set Up Volume Offers
In the consumer goods industry, manufacturers frequently enter into trade 
commitments with customers that span months, quarters, or even an entire calendar 
or fiscal year. These commitments may also surround special trade events such as 
new product introductions. Trade commitments are commonly referred to as 
Performance Programs, Purchase Contracts or National Agreements. 

The goal of a volume offer is to provide an enticement to purchase. The incentive 
covers the cumulative purchases of the specified goods, and accrues as the 
manufacturers ships their goods to the customer. 

Typically the commitment provides multiple performance tiers for the customer. 
For example, an offer may be executed for one quarter with the following structure:

■ Purchase $100k receive 3% incentive

■ Purchase $200k receive 4% incentive

■ Purchase $300k receive 5% incentive

Oracle Trade Management accommodates volume offers. Shown below are the 
columns in the Offer Checkbook that tell about the financial and budgeting details 
of an offer.

■ Utilized: Updated after the offer applies on an order, which is determined by 
QP's Event Phase setups. If offer is set as Retroactive, additional updates to 
Utilized will be made on previous orders as well.

■ Earned: Updated as determined by profile option OZF: Create GL Entries for 
Order.

■ Paid: Claim/Deduction is settled

Volume Offer Seeded Values 
■ Volume Type Seeded Values: Amount or Quantity

■ Discount Type Seeded Values: Amount and Percent
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Calculating Volume Offer
The Volume Offer considers actual shipments within the date range of the offer, not 
booked orders for the product(s) specified in the Product Profile table. Actual 
shipment values are derived from Order Management.

5.12 Set Up Backdating
Often, business requirements mandate manufacturers to have the ability to easily 
alter the original conditions of an offer while the offer is still active. Using the 
backdating functionality in Trade Management, you can enter an active offer and 
adjust the discount terms and product group involved.

The Offer Adjustment Function is available for user-defined role. Access to the 
“Offer Adjustment” page is determined by the user’s role and responsibility. 

You can use Offer Adjustment, when active, for planned, active, and draft versions 
of the following offer types:

■ Off-Invoice

■ Accrual

■ Trade Deal

■ Order Values

■ Promotional Goods

Use the backdating concurrent process to initiate a search for all postings relating to 
the specific offer, sort by customer and product and calculate the corresponding 
differential.

The differential is posted to the checkbook by product. The posting is categorized as 
a backdating adjustment and the Oracle General Ledger posting occurs in the same 
month that the concurrent process is run. Backdating adjustments, as well as 
adjustments of all types made to an offer, are reflected in the Claims Association 
Offer Summary view.

The Funds Accrual Engine concurrent process creates the backdated adjustment 
accruals. See Section 4.17, "Funds Accrual Engine Overview" for more information.

5.13 Set Up Scan Data Offers
Scan data offers are a common promotional tactic executed by companies in most all 
consumer goods industries. Common examples of scan data promotions are 
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coupons or consumer rebate programs, which may be received by a manufacturer 
as an import file from a POS system. These manufacturer sponsored rebate 
programs or discounts coupons are redeemed at retail by the consumer, then 
processed through a third party clearing house, which in turn passes the data to the 
manufacturer, who makes payment to the retailer. In some cases, the retailer may 
submit the scan data directly to the manufacturer. In that situation, the 
manufacturer validates the data and remits payment to the retailer. 

Trade Management has the ability to allow the acceptance of such scan data from a 
third party source. The collected data can then be researched, verified and resolved 
so payment to the appropriate retailer may be made and the open liability settled. 
In some cases the retailer may submit the scan data directly to the manufacturer, in 
those cases the manufacturer validates the data and remits payment to the retailer. 

■ Utilized: Total offer amount updates Utilized when offer goes Active.

■ Paid: Claim/Deduction is settled

Steps
1. Set the following profile options in Oracle Forms:

■ OZF: Invoke Workflow for Manual Scan Data Adjustments

■ OZF: Scan Data UOM

See Appendix A.4, "Profile Options for Trade Planning" for more information.

2. Log in to Trade Management and navigate to Administration > Trade 
Management >Setup >Activity. 

3. To create an activity:

a. Enter an Activity Name.

b. Select an Activity Type

c. Select the Active check box to activate the activity.

d. Associate the appropriate marketing media using the table.

e. Click Create.

 The values displayed for Marketing Media are predicated on the Activity 
selected. The user may create and customize additional Activity / Trade 
Medium relationships as needs arise or the values may be defined during setup.

4. Log in to Oracle Forms and select the General Ledger Super User responsibility.

5. Navigate to GL Posting for Accrual.
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At the same time a scan data offer updates the budget utilized column, if Oracle 
General Ledger postings created by Trade Management are used based on a 
profile, Trade Management writes a debit and a credit accounting entry into its 
interface to be transferred to Oracle General Ledger. 

Per line in the offer, in this case per scan data profile line, the following entries 
are created:

■ Sales Expense

■ Liability

6. Customize Account Generator. 

The Oracle General Ledger accounts are taken first from the Budget, then 
Budget Category, then System Parameters. If implemented, Account Generator 
workflow can be modified to customize the Oracle General Ledger accounts for 
each offer line.

5.14 Set Up Lump Sum Offers
In addition to offers made to customers tied to specific product transactions (for 
example, $1.00 off per case), a supplier may pay customers for other services and 
expenses. These include payments to secure shelf space (slotting allowances), events 
(new store opening activities), and payments to reimburse customers for 
advertising costs, for example. For these situations, the vendor uses a lump sum 
offer to issue a check or credit to the customer for a specific amount.

Prerequisites
None

Steps
1. Log into Oracle Trade Management and navigate to Trade Planning > Offers.

2. Click Create.

3. Select the Lumpsum setup type.

Note: An option is provided that allows the reversal of product 
family accruals for lump sum and scan data offers. It is selected 
when creating custom setups for scan data offers. For more 
information, see Section 3.6.5, "Create Custom Setups".
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4. Enter an offer name for the lump sum offer. 

5. Select a customer from the list of values.

6. Enter a start date and an end date.

The lumpsum is earned throughout the active date range.

7. Select a currency type. 

US Dollars is the default setting.

8. Set the Distribution Type. See Guidelines.

9. Select an activity type.

10. Select Budget or Campaign as the source for the lumpsum. Check the Source 
from Campaign box to source from a campaign that has its own budgets.

Available budgets in the list of values are determined by the Activity type 
selected. Only member campaigns are available in the campaign list of values. 
Campaigns with multiple budgets are drawn against in proportion to the 
budget amounts. 

11. Select a payment type.

If you select a payment type of Issue Check or Credit Memo, a claim request is 
created automatically and settled immediately. No workflow approval is 
required. This function mimics the Autopay function. 

12. Check the Reusable box if you want to use the offer in multiple campaigns.

13. If you want the offer team to be able to review and edit the offer, leave the 
Confidential box unchecked. Check the box if you want to deny the team that 
ability.

14. You can enter an owner for the offer. The owner controls the team member list 
and security, for example, the Confidential checkbox.

15. Click Create.

The page refreshes with additional sections.

16. Review the page and make any changes as needed.

17. In the Qualifiers section, add From and To performance dates that affect the 
earning of the lump sum.

Performance Dates are for documentation purposes only, for example, to show 
when the customer is expected to perform in exchange for the lumpsum (which, 
for example, is used to pay for a POP display July 4th week).
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18. If necessary, in the Discount Rules area create discount rules for specific items.

Discount rules show how the sum will be accrued by the products. The rules 
can be amounts, quantities, or a percentage of the sum. Percentages must add 
up to 100%).

19. In the Level column, you can select by item category or item number.

20. Click the Exclusion icon to make specific exclusions to a rule.

21. Click Update to save any changes.

22. Click Request Approval to submit the offer for approval.

Guidelines
If you select a distribution type of Percentage, the value(s) entered in Distribution 
Value under Discount Rules must equal 100% when an offer is in Active status. If 
you selected a distribution type of Amount, the total of the amounts entered in the 
Distribution Value field(s) under Discount Rules must equal the amount in the 
Lump Sum Amount field in the header. 

When any offer is in Draft status, amounts may vary below 100%. If percentages are 
greater than 100% at any time in either Draft or Active status, an error message is 
created. 

When the lumpsum becomes active, the total amount is Committed.

During the time when the lumpsum is active, the funds are utilized at a rate in 
proportion to the total days of the offer. For example, a lumpsum of $12,000 for a 
three month quarter is utilized as $4,000 per month.

5.15 Set Up Net Accrual Offers
The net accrual offer type bypasses Advanced Pricing and directly processes order 
transaction data. Accruals are applied based on the net sales of a specific customer 
and product, rather than on invoiced sales. Net accrual offers can be used to 
establish price protection programs. They create utilization on sales that occurred in 
the past.

Steps
To implement net accrual offer types, run the following concurrent programs in this 
order: 

1. AMS Web Execution: Refresh Offer Products and Parties
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2. OZF-TM: Net Accrual Engine

5.15.1 Set Up Net Accrual Rules
Net accrual rules are used to determine the net sales of product on which an accrual 
discount can be applied. These rules contain all the deductions that need to be 
considered on total sales of any product to arrive at the Net Sales. 

For example, a sales representative sets up a deal with a customer that gives the 
customer a promotion of 5% based on sales to them in the previous quarter. As a 
part of the terms of this promotion, the sales representative wants to exclude the 
credit memos given to the customer in the previous quarter so as to arrive at a net 
sales figure. He can achieve that by creating net accrual rules and group them as a 
net accrual rule set. This rule set can be specified on an Offer of type Net Accrual.

Prerequisites
None

Steps
1. Log in to Oracle Trade Management and navigate to Administration > Trade 

Management > Trade Planning > Net Accrual Rules

2. Click Create.

3. Fill out the following required fields:

a. Name

b. Transaction Source: Supported sources are Account Receivables, Order 
Management Returns, and Trade Management Offers

c. Transaction Type: Shows valid values based on the transaction source

d. Transaction Identifier: Shows valid values based on Transaction Type

e. Description

4. Click Update.

5.15.2 Create Net Accrual Rule Sets
Net accrual rule sets are a grouping of net accrual rules. A rule set must be specified 
while creating a net accrual offer. The rules in the rule set will be used in arriving at 
the Net Sales of a product on which and accrual discount can be applied.
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Prerequisites
Net Accrual Rules must be created.

Steps
1. Log in to Oracle Trade Management and navigate to Administration > Trade 

Management > Trade Planning > Net Accrual Rules.

2. Click Create.

3. Fill out the following required fields:

a. Name

b. Start Date

c. End Date

d. Description

4. Click Create. 

This creates the rule set header, and a table is displayed to capture the rules.

5. Select the Net Accrual Rule from the list of values.

6. Click Update.

5.15.2.1 Verify Net Accrual Rule Sets
Use the following procedure to verify the rule sets.

Prerequisite
Net Accrual Rule sets must have been set up.

Steps
1. Log in to Oracle Trade Management and navigate to the Trade Planning tab.

2. Click the Offers subtab.

3. Click Create.

4. Select an offer type of Net Accrual.

5. The List of Values for Net Accrual Rule Set should display of all the rule sets 
you defined.
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5.16 Set Up Business Events and Flexfields for Trade Planning
You can use the following business events and flexfields to integrate or extend the 
Trade Planning functionality.

5.16.1 Business Events
All the events will publish XML data specific for the event in the form of a CLOB 
object.

Please subscribe to the business events with a phase greater than 99 to read the data 
so that any subscription to the event will be executed in a defferred mode and does 
not interfere with the online processing. 

Prerequisites
None

Steps
1. Log in to Self Service Applications as System Administrator.

2. Select the Workflow Administrator Web Applications responsibility.

3. Select Business Events under Administer Workflow. 

4. Enter Business Event Name in the search criteria and click Go.

5. Click the Subscription icon for the Event.

6. Click Create Subscription.

7. Enter all of the required information.

Table 5–1 Business Events for Trade Planning

Business Event Name Display Name Description

oracle.apps.ozf.offer.OfferApproval Offer Approval Event This event is raised 
whenever an offer is 
approved. 

oracle.apps.ozf.quota.QuotaApproval Quota Approval 
Event

This event is raised 
whenever a quota is 
approved.

oracle.apps.ozf.target.TargetApproval Target Approval 
Event

This event is raised 
whenever a customer 
target is changed.
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             Make sure that the Phase = << any value greater than 99 >> 

For more information, see the Oracle Workflow API Reference, Business Events 
section.

5.16.2 Flexfields
Additional information can be captured at offer header level by enabling the 
descriptive flexfield "Additional Info for List Headers" available in Oracle Pricing.

Prerequisites
None

Steps
1. Log on to Forms Application as System Administrator

2. Navigate to Application > Flexfield > Descriptive > Segment

3. Query for :

a. Application = Oracle Pricing

b. Title = Additional Info for List Headers

4. Add new contexts and define segment values.

5. Check the "Freeze flexfield definition" checkbox.

6. Save your work.

For more information, see the Oracle Applications Flexfields Guide.

5.17 Customize the Account Generator for Offers
If your business requirements call for the need to post promotional accruals (for 
accrual, lump sum offers) to Oracle General Ledger you can customize the Account 
Generator Workflow to accomplish this task. 

Customization is done through the workflow tool. Customization defines the value 
of a certain segment of the whole account. 

For example:

■ Account structure = company-account type-customer-product-spare

■ Base account = 01-0001-0002-0000-000
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■ Customized = 01-0001-8888-2344-000 (e.g. changed based on the customer and 
product derived from an order)

The default account generator assumes an accounting structure with product 
segment and with name of that segment as Product. This needs to be changed in the 
workflow based on the implementation.

In order to debug the account generator workflow, set the profile Account 
Generator: Debug mode to Yes. The workflow process can then be seen from the 
process editor and the owner of the workflow will be the user who runs the 
concurrent program or performs an action which invokes accounting.

Addition attributes, functions or processes can be added and the current process 
can be customized to suit business requirements. Please read the Workflow 
document on preserving Customizations.

Follow these general guidelines when customizing the AMS - Account Generator 
workflow: 

■ Process: Generate a default account

■ Function: Get expand CCID for line

■ Package: AMS_ACCT_GENERATOR

■ Procedure: Get Cost_Sale_Item_Derived

The following attributes are available for customization:

■ Account Type

■ Claim ID

■ Budget ID

■ Offer ID

■ Line ID

■ Inventory Item ID (seeded)

■ Price Adjustment ID

■ Customer ID

■ Order Category

■ Org ID

To customize the Default Account Generator follow the procedures below: 
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Prerequisites
■ Implementation team possesses skills in PL/SQL, Oracle Workflow, and 

General Ledger

■ Accounting Flexfield structure for each set of books is defined

■ Segment values and validation rules for flexfields are defined 

■ Business requirements for using the default Account Generator process versus 
customizing it to meet the organization’s accounting needs are determined 

■ The default Account Generator process is determined

Steps
1. Evaluate the default Account Generator. 

Determine whether or not the Default Account Generator process meets your 
organization’s accounting requirements. The default process may be updated 
later as your needs change. You may make minor changes to the Default 
Account Generator process without changing the name. Trade Management 
comes with the Account Generator item type -- Generate Default Account. 

2. Customize the default Account Generator process. 

If your business requirement determine that the Account Generator process 
must be customized, then note the following: 

a. Set Account Generator : Debug mode to Yes.

In order to debug the account generator workflow, this profile must be set 
to Yes. This enabled the Workflow process to be seen from the process 
editor and the owner of the workflow will be the user who runs the 
concurrent program or performs an action which invokes accounting.

b. Verify segment name as 'Product'.

The default account generator assumes an accounting structure with 
product segment and with name of that segment as 'Product'. This needs to 
be changed in the workflow based on the implementation.

c. Add attributes, functions, or processes. 

Addition attributes, functions or processes can be added and the current 
process can be customized to suit business requirements. Please read the 
Workflow document on preserving customizations.

3. Save your work. 
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For more information, refer to the Oracle Applications Flexfield Guide, Chapter 10 
Account Generator. 
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Implementing Claims

This chapter provides the information you need to set up the Claims module for 
Oracle Trade Management. How this module is implemented will vary depending 
on your business requirements.

To implement claims, follow the procedures in these sections:

■ Section 6.1, "Set Profile Options for Claims"

■ Section 6.2, "Verify Lookups for Claims"

■ Section 6.3, "Run Concurrent Programs for Claims"

■ Section 6.4, "Set System Parameter Defaults"

■ Section 6.5, "Set Up Claim Types"

■ Section 6.6, "Set Up Claim Actions"

■ Section 6.7, "Set Up Claim Reasons"

■ Section 6.8, "Set Up Autopay"

■ Section 6.9, "Set Up Defaults for Claims"

■ Section 6.10, "Set Up Trade Profiles"

■ Section 6.11, "Set Up the History Rule"

■ Section 6.12, "System Status and User Status"

■ Section 6.13, "Set Up Approval Rules for Claims"

■ Section 6.14, "Importing and Mapping Customer Reason Codes"

■ Section 6.15, "Set Up Claim Import"

■ Section 6.16, "Implementing the Claim Creation API"
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■ Section 6.17, "Setting Up the Promotional Payment View"

■ Section 6.18, "Setting Up Claim Ownership Assignment"

■ Section 6.19, "Set Up Pay Over Earnings Threshold Rules"

■ Section 6.20, "Set Up Automatic Write Off Threshold Rules"

■ Section 6.21, "Memo Line Transfer"

■ Section 6.22, "Maintaining Team Access and Security"

■ Section 6.23, "Setting Up Discoverer"

■ Section 6.24, "Implementing a Claim Settlement Workflow"

■ Section 6.25, "The Tax Engine"

■ Section 6.26, "Setting Up Mass Settlement of Claims"

■ Section 6.27, "Setting Up the Claim Aging View"

■ Section 6.28, "Setting Up Auto Write Off"

■ Section 6.29, "Lockbox Integration"

■ Section 6.30, "Subsequent Receipts"
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6.1 Set Profile Options for Claims
There are certain system profile options that must be set for Claims to function 
properly. Select the settings that meet your business requirements. 

To set profile options for Claims, see Appendix A.5, "Profile Options for Claims". 
For the specific procedure for setting up system profile options, see Appendix A.2, 
"Setting Profile Options".

6.2 Verify Lookups for Claims
Lookups supply the content of many of the lists of values (LOVs) in the Oracle 
Trade Management user interface. Most lookups are predefined (seeded in the 
application). The seeded values can be left as is, or you can customize them to fit 
your business needs. Lookup values make choosing information quick and easy, 
they ensure that users enter only valid data into Oracle Trade Management.

To create or verify lookup settings for Claims, see Appendix B.5, "Lookups for 
Claims". For the steps for creating new lookups, see Appendix B.2, "Creating New 
Lookup Types".

6.3 Run Concurrent Programs for Claims
Run the concurrent programs for claims after the use of claims has commenced — 
not at the time of implementation. For the complete list of concurrent programs for 
Claims, see Appendix C.5, "Concurrent Programs for Claims". For steps for running 
a concurrent program, see Appendix C.1, "Running Concurrent Programs".

6.4 Set System Parameter Defaults
On the System Parameters page you can define:

■ Accounting preferences

■ Claim defaults, such as a default claim type, reason, claim owner, and so on

■ Claim settlement defaults, such as a default RMA transaction type, debit memo 
type, credit memo type, write off adjustment type, chargeback type, transaction 
type, and so on

■ Autopay frequency and preferences

■ Pay Over Earnings thresholds
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■ Indirect Sales and Trade Planning preferences

Prerequisites
Claim types and reasons have been created.

Steps
1. Log in to Oracle Trade Management and navigate to Administration > Trade 

Management > Setup > System Parameters.

2. Enter data as required into each section.

3. Click Update.

6.4.1 Accounting Section
In the Accounting section, perform the following procedure to select defaults.

Steps
1. Place a check in the GL Accounting, Posting to GL, or Rounding checkboxes if 

you want to use them in your implementation.

2. Using the drop-down menu, select a GL date type.

3. In the Sales/Expense/Charge Account field, select an appropriate account alias 
(as it related to your business requirements) for the sales/expense/and charge 
account.

4. In the Accrual Liability Account field, select an appropriate account alias (as it 
related to your business requirements) for the accrual liability account.

5. In the Receivable Clearning Account field, select an appropriate account alias 
(as it related to your business requirements) for the receivable clearing account.

When a claim or deduction is created and associated to promotional accruals, 
and if the settlement method is a credit memo, Oracle Trade Management 
creates the following entries in GL:

■ Debit Liabilities

■ Credit Receivables Clearing

6. In the Vendor Clearing Account field, select an appropriate account alias (as it 
related to your business requirements) for the vendor clearing account. 
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When a promotional claim is settled by a check, the following GL entries are 
created:

■ Debit Liabilities

■ Credit Vendor Clearing

The Liabilities account used is the same one used when accruals occurred. The 
Oracle Payables Clearing accounts used during claim settlement are taken from 
the following setups:

■ As defined on claim type and any Account Generator workflow updates.

■ As defined here in system parameters and any Account Generator 
workflow updates

7. Check the Create GL Entries for off invoice discounts box to create General 
Ledger accounting for all off invoice discounts. 

8. From the GL Balancing Segment drop-down list, select an Oracle General 
Ledger balancing segment if you want to filter receivable write off activity 
based on an Oracle General Ledger balancing segment.

These segments refer to the balancing segment values in the A/C flexfield. This 
field is visible only if the profile option OZF : Select Write-Off Activities Based 
on GL Balancing Segments is enabled. 

6.4.2 Claim Section
Specify defaults for claims by entering or selecting the appropriate values in each 
field.

Steps
1. In the Claim Reason field, specify a value to be assigned to deductions and 

overpayments created and passed to Oracle Trade Management from Oracle 
Receivables.

2. In the Claim Type field, specify a default claim type for overpayments and 
deductions created and passed to Oracle Trade Management from Oracle 
Receivables.

3. From the Exchange Type drop-down list, select a default value.

Claims can be created in a transaction currency different from the functional 
currency used by the overall set of books. When the exchange type is unclear, 
the default selected here is used.
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4. In the Default Owner field, select a default value. 

All claims must be assigned an owner. Owner assignment is based on various 
criteria such as claim type or reason. If the assignment manager has not been 
implemented or fails to assign an owner, the default owner specified here is 
used.

5. In the Days Due field, enter a default value.

Specific due dates for customers are designated in their trade profiles. If there is 
no due date in a trade profile, the default specified here is used.

6. Check the Territory Manager Implemented for Claims box if Territory Manager 
is implemented for Claims.

6.4.3 Settlement Section
Enter values in the fields as appropriate.

Steps
1. From the Receivables Batch Source drop-down list, select the receivable batch 

source that you want to use to transfer entries from Oracle Trade Management 
into Oracle Receivables.

The list of values for this field contains all imported transaction sources defined 
in Oracle Receivables. 

2. In the RMA Transaction Type field, select a value to use as a default on claims 
settled with RMAs. 

The list of values contains all return order types defined in Oracle Order 
Management. 

3. In the Debit Memo field, select a value to use as the default value for claims 
settled with debit memos.

This list of values contains all debit memos defined in Oracle Receivables. 

4. In the Credit Memo field, select a value to use as the default value for claims 
settled with credit memos.

This list of values contains all credit memos defined in Oracle Receivables.

5. In the Chargeback field, select a value to use as the default value for claims 
settled with chargeback.
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This list of values contains all chargeback transaction types defined in Oracle 
Receivables. 

6. From Payables Source drop-down list, select the payables batch source that you 
want to use to transfer entries from Oracle Trade Management into Oracle 
Payables.

The drop-down list for this field contains all imported transaction sources 
defined in Oracle Payables. 

7. In the Payables Payment Term field, select the payment term that you want to 
use as a default on invoices created in Oracle Payables for claim settlement.

The list of values for this field contains all payment terms defined in Oracle 
Payables.

8. In the Writeoff Threshold (Deduction) field, enter a minimum value for 
automatic write off.

For example, you enter 200 as the threshold. If you receive a deduction for $190, 
it is under the threshold and is eligible for automatic write off and will be 
automatically flagged for auto write off. The value entered here should always 
be a positive number.

9. In the Writeoff Threshold (Overpayment) field, enter a minimum value for 
automatic write off. 

For example, you enter 150 as the threshold. If you receive an overpayment for 
$140, it is under the threshold and is eligible for automatic write off.

10. In the Writeoff Adjustment field, select from the receivable activities defined in 
Oracle Receivables.

11. In the Receipt Writeoff (Deductions) field, select the appropriate Receivables 
Activity to pass to Oracle Receivables and use during settlement for 
nontransaction-related deductions.

12. In the Receipt Writeoff (Overpayments) field, select the appropriate Receivables 
Activity to pass to Oracle Receivables and use during settlement of 
overpayments.

13. Optionally, check the Route Mass Settlement Approval Based on Net Amount 
box if you want the mass settlement approval to be based on the net amount 
rather than the open amount. 

See Section 6.26, "Setting Up Mass Settlement of Claims" for more information.
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6.4.4 Autopay Section
Complete the Autopay section as follows.

Steps
1. Select the Autopay check box to turn on the autopay functionality.

2. Select a default claim type and reason for autopay claims.

3. Specify a frequency and frequency unit.

For example, if you enter 1 and select Monthly, autopay will run once a 
month.

4. In the Sales Credit field, select either Default Sales Rep or No Sales Credit. 

This field determines the default salesperson used for Autopay and claims 
created manually. 

6.4.5 Earnings Payments Section
Enter values in the fields to allow the early payment of unearned accruals for offers 
for some or all of your customers.

Steps
1. In the Unearned Payments for Offers field, select who is eligible for unearned 

payments.

■ Allow for All: Unearned payments are allowed for all customers unless 
specifically disallowed in a customer’s trade profile.

■ Allow for Selected: Unearned payments are not allowed unless specifically 
allowed in a customer’s trade profile.

The trade profile set up always takes precedence. For example, you select Allow 
for All on the System Parameters page. However, the unearned payment setting 
in customer X’s trade profile is set to Disallow. As such, customer X is not 
eligible for unearned payments on offers.

2. To specify a threshold that restricts the amount of unearned payments, specify a 
Threshold Type and Threshold Value.

Example: An offer has a committed amount of $10,000. The offer is ending soon 
and the customer has earned only $3,000 to date. You established a threshold of 
20% (threshold type = percent; threshold = 20). If a claims processor receives a 
claim equal to or less than $3,000, up to $3,600 can be paid (3,000 x 1.2).
6-8 Oracle Trade Management Implementation Guide



Set Up Claim Types
3. To permit threshold overrides, check the Override Threshold box.

If selected, settlement can still be initiated if the unearned payment amount 
exceeds the threshold amount. However, the claim must go through a special 
approval process before payment can be made.

If not selected, the claim settlement process cannot be initiated. Corresponding 
settings in trade profiles take precedence.

4. Check the Prorate Associate Earnings by products box to have the system 
automatically break up earnings on offers proportionately by product.

Check this box to proportionally allocate associated earnings by 
product/product category. The ratio is based on budget and product. If not 
selected, the first-in first-out approach is used. For more information, see 
Section 6.9.2, "Prorating Associated Earnings by Products".

5. Click Update.

6.4.6 Indirect Sales Preferences Section
For these setups, see Section 7.5.1, "Set System Parameter Defaults for Indirect 
Sales".

6.4.7 Planning Section
For this setup, see Section 5.4.2, "Set Up Quota Allocations".

6.5 Set Up Claim Types
Claims are categorized by type and reason. This categorization allows users to 
group claims for easier analysis and resolution of claim problems.

For example, you might notice that the claim type non-promotional is repetitively 
paired with the claim reason shipping. Based on this and other information, the 
organization might decide to improve its shipping processes to reduce this type of 
claim. 

In addition, information derived from claim types can act as the business driver for 
various integration points by defaulting the transaction types on the claims (for 
example, with Account Receivables and Order Management). Transaction types can 
be specified for credit memos, chargebacks, debit memos and return materials 
authorizations (RMAs). Vendor and receivable clearing accounts can be specified at 
the claim type level.
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Claim and transaction types are org-striped (specific to a particular operating unit.) 
Therefore, they are visible only within the operating unit in which they are created. 

To set up claim types, follow the procedure below.

Prerequisite
None

Steps
1. Log in to Oracle Trade Management and navigate to Administration > Trade 

Management > Claim > Claim Types. 

2. Select Create.

3. On the Create Claim Types page, enter the following information:

■ Name: Enter a unique name for the claim type.

■ Start Date: The starting date from which this claim type can be used. 

■ End Date: The date when the claim type can no longer be used.

■ Description: Enter a description for the claim type.

■ Credit Memo: Select a negative transaction type. 

The transaction types are created in Oracle Receivables for claims and 
deductions settled with credit memos. Trade Management passes it to 
Oracle Receivables during settlement. In Oracle Receivables, this parameter 
helps drive accounting for the credit memo.

■ Debit Memo: Select a positive transaction type.

The transaction types are created in Oracle Receivables for claims and 
deductions settled with debit memos. Trade Management passes it to 
Oracle Receivables during settlement. In Oracle Receivables, this parameter 
helps drive accounting for the debit memo.

■ Chargeback: Select a positive transaction type.

The transaction types are created in Oracle Receivables for deductions 
settled with chargebacks. Trade Management passes it to Oracle 
Receivables during settlement. In Oracle Receivables, this parameter helps 
drive accounting for the chargeback.

■ RMA Transaction Type: Select a transaction type.
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These transaction types are created in Order Management. They drive the 
default price list, line type, and workflows that ultimately determine return 
order processing in Order Management.

■ Write-off Adjustment: Select a receivable activity.

These activities are created in Oracle Receivables for adjustments. The 
activity selected here determines the accounting adjustment used when 
transaction-related deductions are settled by write off.

■ Receipt Writeoff (Deduction): Select a negative receivable activity.

Receivable activities are created in Oracle Receivables for receipt write offs. 
The activity selected here determines the accounting for deductions when 
settled by receipt write off.

■ Receipt Writeoff (Overpayment): Select a positive receivable activity.

Receivable activities are created in Oracle Receivables for receipt write offs. 
The activity selected here determines the accounting for overpayments 
when settled by receipt write off.

■ GL Balancing Segment: Select an Oracle General Ledger balancing 
segment

This field is visible only if the profile option OZF : Select Write-Off 
Activities Based on GL Balancing Segments is enabled. These segments 
refer to the balancing segment values in the A/C flexfield. This option 
allows users to filter receivable write off activity based on the Oracle 
General Ledger balancing segment selected here.

■ Receivable Clearing Account: When promotional claims or deductions are 
being settled with a credit memo, a debit entry for a liability account is 
created. Further, a credit entry is created for this receivable clearing account. 
This is passed to Oracle Receivables as the revenue account for the credit 
memo. The list of Oracle General Ledger accounts displayed for this field is 
determined by the set of books selected in system parameters.

■ Vendor Clearing Account: When promotional claims or deductions are 
being settled with a check, a debit entry for a liability account is created. 
Further, a credit entry is created for the vendor clearing account. It is passed 
to Oracle Receivables as the distribution account on the payables invoice. 
The list of Oracle General Ledger accounts displayed for this field is 
determined by the set of books selected in system parameters.

4. Click Create.
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6.6 Set Up Claim Actions
Actions are predefined templates that contain a series of tasks intended to guide the 
research and resolution of claims. They are organization-specific, and provide the 
claims department with a project management tool. A set of actions can be 
designated as default actions for a specific claim reason.

Prerequisite
None.

Steps
1. Log in to Oracle Trade Management and navigate to Administration > Trade 

Management > Claim > Actions.

2. Select Create.

3. On the Create Action page, enter the following information:

■ Source Object: Defaults to Marketing Claim. 

■ Name: Enter a name for the action. 

■ Start Date: The date from which the action can be used.

■ End Date: The date upon which the action can no longer be used.

■ Description: Enter a description for the action.

4. In the Task Templates section, enter the appropriate information in each field.

■ Priority: The urgency of the task. 

■ Duration and Duration Type: Indicates how much time should be spent on 
the task. For example, enter 2 and select week if the time spent should be 2 
weeks.

■ Task Type: Select General or Approval. 

5. Select Create.

When creating claims reasons, you can designate default actions. See Section 6.7, 
"Set Up Claim Reasons". For more information on tasks, refer to the Oracle Common 
Application Components Implementation Guide. 
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6.7 Set Up Claim Reasons
Claims are categorized by type and reason. This categorization allows users to 
group claims, and makes it easier to analyze claims, identify areas of inefficiency, 
and make improvements that will resolve or prevent further claims.

Claim reasons are used: 

■ For classification purposes

■ When creating claim action defaults

■ For integration point setups

Claim reasons are org-striped (specific to a particular operating unit.) Therefore, 
they are visible only within the operating unit in which they are created.

Prerequisite
Claim actions must be created. See Section 6.6, "Set Up Claim Actions".

Steps
1. Log in to Oracle Trade Management and navigate to Administration > Trade 

Management > Claim > Reasons.

2. Select Create.

3. On the Create Reason page, enter the following information:

■ Reason: Enter a name for the reason.

■ Partner Access: Select this check box to allow partner access in Oracle 
Partner Management.

■ Start Date: The starting date from which this reason can be used. 

■ End Date: The date when the reason can no longer be used.

■ Description: Enter a description for the reason.

■ Credit Memo Reason: Select a reason.

Displays a list of reasons created in Oracle Receivables (CREDIT_MEMO_
REASON QuickCode). This reason is passed to Oracle Receivables when 
claims or deductions using this reason are settled by credit memo.

■ Adjustment Reason: Select an adjustment reason.
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Displays a list of reasons created in Oracle Receivables (ADJUST_REASON 
QuickCode). This reason is passed to Oracle Receivables when 
transaction-related deductions are settled by write-off or chargeback.

■ RMA Transaction Type: Select an RMA transaction type.

Displays a list of transaction types created in Order Management (which are 
created with a Transaction Category of RETURN or MIXED and with a 
default return line populated.) They drive the default price list, line type, 
and workflows that ultimately determine return order processing in Order 
Management.

■ Actions: Select one or more claim action defaults. Select the Active check 
box to make the action available for each claim with this particular reason. 
Select the Default check box to make one of the actions the default for 
claims with this reason. See Section 6.6, "Set Up Claim Actions".

4. Select Create.

6.8 Set Up Autopay
Autopay automates the following business processes: 

■ Creates claims based on unpaid accruals.

■ Selects a settlement method.

■ Associates earnings for claims.

■ Initiates the settlement process.

Autopay is a concurrent program that can be scheduled to run periodically to pay 
customers by credit memo or check. It sums up customer accruals, automatically 
creates claims, associates earnings for claims, and settles claims based on the 
Autopay parameters in customer trade profiles.

For example, Customer A is scheduled to be paid by credit memo every two weeks. 
When Autopay runs, it determines that the customer has utilized $100K and was 
paid $80K. It creates a claim for $20K and settles it by credit memo. The customer 
receives a credit that can be applied towards future purchases.

The following implementation steps are recommended for Autopay: 

1. Set up trade profiles and the Autopay parameters on the System Parameters 
page. 
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See Section 6.10, "Set Up Trade Profiles" and Section 6.8.2, "Set Up Autopay in 
System Parameters"

2. Determine the most frequent setup.

See Section 6.8.1, "Understanding Autopay Frequency"

3. Schedule Autopay either from the Trade Management user interface or from 
Oracle Forms.

See Section 6.8.3, "Running Autopay"

6.8.1 Understanding Autopay Frequency
We recommend that the Autopay concurrent program be scheduled to run at least 
as often as the frequency for your most frequently paid customer (defined in the 
customer’s trade profile).

Example 1: Autopay Runs More Frequently Than Customer’s Trade Profile 
Autopay Frequency
The Autopay concurrent program is set to run daily at 4:00 PM. The autopay 
frequency set up in the trade profile for customer, Business World, is every two 
days. Their threshold is $100.

■ Day 1: The Autopay program runs, looks up all of the accruals for Business 
World, creates one claim for them, and pays it. 

■ Day 2: The Autopay program runs. Although the frequency condition for 
Business World is not met, Autopay checks its threshold condition. If Business 
World has accrued $101 before 4 pm, then it will be paid. Otherwise it will not.

■ Day 3: The Autopay program runs. The frequency condition for Business World 
is met. They are paid for all of their unpaid accruals since the last pay date, 
which may have been Day 1 or Day 2.

Example 2: Autopay Program Runs Less Frequently Than Customer's Trade 
Profile Autopay Frequency
The Autopay concurrent program is set to run every three days at 4:00 PM. The 
autopay frequency set up in the trade profile for customer, Business World, is every 
two days. Their threshold is $100.

■ Day 1: The Autopay program runs, looks up all of the accruals for Business 
World, creates one claim, and pays it.
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■ Day 2 and 3: Autopay does not run. Business World accrues a total of $50 
during these two days.

■ Day 4: The Autopay program runs. It checks the frequency condition for 
Business World which is met, looks up all unpaid accruals since its last pay date 
(Day 1), creates one claim, and pays it. 

In this scenario, the threshold amount for Business World does not affect the 
autopay process.

6.8.2 Set Up Autopay in System Parameters
The values you select for the Autopay section of the system parameters are used as 
the default settings for customer trade profiles. You can override the defaults 
specified here by changing the trade profile for a particular customer. When 
Autopay runs, customer eligibility is based on the Autopay settings in each 
customer’s trade profile. The settings in trade profiles override the Autopay set up 
in system parameters. For instructions on setting up trade profiles, see Section 6.10, 
"Set Up Trade Profiles".

To set up the Autopay system parameters, follow the procedure below: 

Prerequisite
None

Steps
1. Log in to Oracle Trade Management and navigate to Administration > Trade 

Management > Setup > System Parameters.

2. Select the Autopay check box to turn on the autopay functionality.

3. Select a default reason and default claim type.

These values are used as defaults for claims created by Autopay.

4. Specify a frequency and frequency unit.

Example: If you enter 1 and select Monthly, autopay will run once a month. See 
Section 6.8.1, "Understanding Autopay Frequency" for more information.

5. Click Update.
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6.8.3 Running Autopay
Autopay can be run from the Trade Management HTML user interface or from 
Oracle Forms. Both methods run the concurrent program, OZF-TM: Claims 
Autopay, based on how its parameters are set.

Offer terms may include a stipulation that performance requirements be met before 
payment is made. If performance requirements for a particular offer are not met, 
Autopay will fail. For example, you can specify that only if a customer purchases 
goods worth $5 million will they be entitled for a payment against a promotion. In 
such cases, autopay verifies if the performance requirements are met by the 
customer and only then creates and settles the claim.

To run Autopay, follow the steps below.

Prerequisites
Autopay parameters have been set up on the System Parameters page.

Steps
1. To run Autopay from the Trade Management HTML user interface, log in and:

a. Navigate to Claim > Autopay > Submit Request.

b. Enter a name for the Autopay Request and click Next.

2. To run Autopay from Oracle Forms, log in with the Oracle Trade Management 
Administrator responsibility and:

a. Navigate to Concurrent Requests > Run.

b. Select Single Request and click OK. 

c. Select OZF-TM: Claims Autopay. 

3. On the Parameters page, select the appropriate values for each field as follows:

Run Mode is the only required field. All other fields are optional.

■ Run Mode:

All Offers = run Autopay for all offers

Offers with Autopay = run only for offers where Autopay is turned on

Offers without Autopay = run only for offers where Autopay is not turned 
on
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■ Customer Name: Autopay groups accruals by customer accounts. If this 
field is used, but the Related Customer and Buying Group and Members 
fields are left blank, Autopay looks for accruals for this customer only. A 
claim is created for this customer.

■ Relationship: This is the relationship the customer has to its related 
customer. If selected, Autopay looks for accruals for all customers who have 
this relationship with the customer specified above.

■ Related Customer: If you select a related customer, autopay looks for 
accruals for this customer as well. 

■ Buying Group and Members: If you select a buying group, Autopay looks 
for accruals for this buying group. Members are included only when the 
following setting, Include All Member Earnings, is set to Yes.

■ Include All Member Earnings: If set to Yes, Autopay looks for accruals for 
members of the buying group specified above. 

■ Pay To: Valid values are Customer and Related Customer. If Customer, 
claim payments are made to the customer specified. If Related Customer, 
claim payments are made to the related customer.

■ Fund Name: Fund names are funding sources. If this field is used, Autopay 
looks for all accruals for this particular source and sorts them by customer 
account. One claim per customer account is created.

■ Activity Type: If selected, Autopay looks for all accruals for this particular 
activity type.

■ Offer Type: If selected, Autopay looks for all accruals for this particular 
offer type.

■ Activity Name: If selected, Autopay will look for all accruals for this 
particular activity, based on Offer or Price List.

■ Product Category: If selected, Autopay will look for all accruals for this 
particular product category.

■ Product: If selected, Autopay will look for all accruals for this particular 
product.

Any combination of the above parameters will make Autopay check for all 
of the accruals that satisfy all of the parameters specified. For example, if a 
fund and campaign are specified, then only the accruals which satisfy both 
the fund and campaign name criteria are included for Autopay.
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If no parameters are specified, then Autopay looks up the unpaid accruals 
for all Autopay customers, and groups them by customer account.

■ End Date: If selected, Autopay will look for all accruals up through and 
including this date.

4. Click OK then Schedule if in Oracle Forms; click Next if in the HTML interface.

5. Enter the appropriate scheduling parameters.

6. Click OK if in Oracle Forms; click Next if in the HTML interface.

7. To send notifications to individuals after Autopay has run, select the 
appropriate names.

8. Click OK if in Oracle Forms; click Next if in the HTML interface.

9. To print the Autopay file when finished, specify the printing instructions.

10. Click OK if in Oracle Forms; click Next if in the HTML interface.

11. Click Submit if in Oracle Forms; review the Autopay request and click Submit 
if in the HTML interface.

6.9 Set Up Defaults for Claims
When creating claims, you must specify a claim type and reason. Deductions and 
overpayments created in Oracle Receivables and passed to Trade Management do 
not have a claim reason or type. Because these fields are required for claim creation, 
default values for claims from Oracle Receivables must be set up. These values are 
specified on the System Parameters page or on the Claim Defaults page or both. 
Values set on the Claim Defaults page override the defaults set on the System 
Parameters page.

6.9.1 Set Up Claim Defaults
You can define a default claim type and reason for each claim source. Claim sources 
are predefined based on possible claim generation sources.

There are ten seeded claim sources:

■ Manual Claim

■ Referral Claim

■ Soft Fund Claim

■ Special Pricing Claim
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■ Manual Debit Claim

■ Chargeback Deduction

■ Claim Investigation Deduction

■ Claim Investigation Overpayment

■ Debit Memo Deduction

■ Invoice Deduction

These defaults override the default claim type and reason set on the system 
parameters page.

Prerequisites
None

Steps
1. Log in to Trade Management and navigate to Administration > Trade 

Management > Claim > Claim Defaults.

2. Set up defaults for claim sources as follows:

a. Select a claim source.

b. Select a default for one or all of the following:

– Custom setup

– Claim Type

– Claim Reason

c. Select a start date and, optionally, an end date.

3. Click Update.

6.9.2 Prorating Associated Earnings by Products
If the Prorate Associated Earnings by Product option is selected on the System 
Parameters page, the system will automatically divide earnings on offers 
proportionately by product. When a claim is settled that partially relieves the 
accruals for an offer, all of the offer lines are affected proportionately. In addition, if 
multiple budgets track accruals for these products, the budgets will be adjusted 
proportionately as well. Due to product eligibility validation, each budget can track 
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the accruals for some or all of the products. Claims processors have the option of 
overriding this functionality on the Associate Earnings page.

If this option is not selected, the claim amount is associated to the entire offer on a 
first-in-first-out basis irrespective of product categorization on the offer. As such, 
the first order line with associated accruals is cleared first.

Example
The total accruals for an offer are $1,000. $200 has been paid out for previous claims, 
leaving an outstanding accrual balance of $800 broken up by product as follows:

■ Product A = $500

■ Product B = $200

■ Product C = $100

When a claim is created for $500 and the claim processor associates the entire $500 
to this offer, the system automatically splits the associated earnings by product as 
follows:

■ Product A for $500 x (500/800) = $312.50

■ Product B for $500 x (200/800) = $125

■ Product C for $500 x (100/800) = $62.50

For budget adjustments, assume that this offer was funded by two budgets, A and 
B. For this example:

■ The $500 accrual for Product A is tracked by Budget A ($300) and Budget B 
$200)

■ The $200 accrual for Product B is tracked by Budget A ($200)

■ The $100 accrual for Product C is tracked by Budget B.

The associated earnings are relieved from each budget as follows:

■ The $312.50 for Product A is split between Budgets A and B respectively:

– Budget A: $312.50 x (300/500) = $187.50

– Budget B: $312.50 x (200/500) = $125

■ The $125 for Product B is relieved entirely from Budget A

■ The $62.50 for Product C is relieved entirely from Budget B
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In the Trade Management user interface, if you choose Summary View: Offer on the 
Associated Earnings page you see $500 as the total associated earnings for the offer. 
If you choose Summary View: Product, you see the $500 broken down by the 
products included in the offer. The claim processor still has the option of adjusting 
the amount associated with each product.

6.10 Set Up Trade Profiles
Trade profiles are used to:

■ Provide a link to vendor setups if customized.

■ Define Autopay parameters for accrual reimbursements including payment 
frequency, threshold, and method.

■ Define customized parameters for claim payments including days due and 
write off thresholds for deductions and overpayments.

■ Define earning payment parameters for unearned offer accruals including 
various threshold settings.

■ Define indirect sales parameters including batch and line tolerances.

■ Define Code Mapping.

To set up trade profiles, follow the steps below.

Prerequisites
None

Steps
1. Log in to Oracle Trade Management.

2. Navigate to Administration > Trade Management > Customer > Trade Profiles.

3. On the Trade Profile Overview page, click Create.

Enter Basic Customer Information
1. Enter the basic customer information in the Party Name, Account Number, Site 

Use and Address fields.

■ If the customer already has a trade profile, it is displayed when the party 
name or account number is selected.
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■ The primary Bill To site for the account is displayed by default. To change 
it, click the icon next to the Site Use and select another site. Sites are 
org-striped. As such, the site can only be used within an operating unit.

2. If the customer is also a vendor, enter the vendor information in the Vendor, 
Vendor Site, and Address fields.

■ A vendor is a person or company that sells to your company. Vendors are 
set up in Oracle Payables and are separate from TCA. To settle claims using 
a check, you must set up that customer as a vendor in Oracle Payables and 
Purchasing. 

■ The trade profile provides a link between the two setups in the two 
systems. Vendor information on claims is completed automatically; 
therefore, claim processors do not need to determine this. Vendors are not 
org-striped. They can be seen and used across operating units.

If not set up in the trade profile, the claim owner must enter the vendor 
information on the first claim to be settled by check for this account. When 
this occurs, the trade profile information for the account is updated 
automatically.

Define the Autopay Parameters
If Autopay is used, it will evaluate the accruals for this customer and automate 
payments as required. If not used, automatic payments will not be made even if 
accruals exist. 

To set up autopay for this customer, follow these steps:

1. Select the Autopay check box. 

2. Enter a numeric value in Frequency and select a Frequency Unit.

Together, these values define the frequency by which the customer will be paid. 
These values override those in system parameters. For example, if you enter 1 
as the frequency and select month as the frequency unit, this customer will be 
paid once a month as long as the threshold amount is met.

3. Enter a Threshold Amount. 

The threshold amount is also used to trigger Autopay. The threshold currency is 
the functional currency of the set of books selected in system parameters. 

For example, if frequency is set to once per month and the threshold amount is 
$100, then the customer will be paid whenever one of these two conditions is 
met.
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4. Select a Payment Method:

■ Check: If selected, the vendor and vendor sites fields must be filled in.

■ On Account Credit Memo: If selected, the Site Use field must be filled in. 
This field retrieves the Bill-to Site of the customer account. 

Define the Claim Parameters
1. Enter the days due. 

Claim managers may require that claims for this account be resolved within a 
certain number of days. Enter that number here.

For example, your company may require that all claims for an important 
customer account be resolved with 15 days of creation. In the customer trade 
profile, you can assign 15 as the default days due. If a claim for this customer 
account is created on January 1, the due date defaults January 16.

2. Enter values for the overpayment and deduction write off thresholds.

Deductions and overpayments less than the amounts specified here are 
automatically written off.

■ Writeoff Threshold (Deduction) example: You enter 200 as the threshold. If 
you receive a deduction for $190, it is under the threshold and is eligible for 
automatic write off. The value entered here should always be a positive 
number.

■ Writeoff Threshold (Overpayment) example: You enter 150 as the 
threshold. If you receive an overpayment for $140, it is under the threshold 
and is eligible for automatic write off.

Define the Earnings Payments Parameters
The values selected here determine customer eligibility and the threshold for 
unearned payments for offers. This affects all promotional claims and deductions 
except for those related to scan data offers (whether settled by credit memo or 
check.) If a customer does not have a trade profile, the system behaves as if the 
trade profile setting is Null.

If no explicit threshold is set either on the System Parameters page or on the trade 
profile, but unearned payments are allowed, the threshold is zero. Claim payment 
within the thresholds can be settled like any other promotional claim and go 
through the regular claim approval process. 

1. Select a value for the Unearned Payments for Offers field.
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■ Null: customer may or may not be eligible for unearned payments 
depending on the system parameter setting. If set to Allow for All, then this 
customer is eligible for unearned payments. If set to Allow for Selected, 
then this customer is not eligible for unearned payments.

■ Allow: Unearned payments are always allowed for this customer. This 
setting overrides the system parameter setting.

■ Disallow: customer is not eligible for unearned payments for offers 
regardless of the system parameter setting.

2. Select a threshold type.

■ Amount: threshold is a currency amount. If 50 is entered in the threshold 
field, then the threshold is $50. (Assuming the currency being used is U.S. 
dollars.)

■ Percent: threshold is a percentage. If 90 is enter in the threshold field, then 
the threshold is 90% of the earnings.

■ Unconditional: the threshold is infinity. Special approval for overriding the 
unearned payments threshold is never required. Claims simply go through 
the regular claim approval process.

3. Enter a value in the Threshold field.

This value can be greater than 100 if the threshold type is Percent.

Example for Percent: The threshold is 20%. Customer Y’s earnings total $10,000 
for an offer. Claim payments up to $12,000 can be made.

Example for Amount: The value is 2,000, and the functional currency is $. 
Customer Y’s earnings total $10,000 for an offer. Claim payments up to $12,000 
can be made.

4. Select the Override Threshold check box to allow the initiation of settlements 
for unearned payments where the amount is greater than the threshold.

These claims are subject to a special approval process, and the regular approval 
process. This setting overrides the setting on the System Parameters page.

Define the Indirect Sales Parameters
The values defined in a customer’s trade profile override the values set in system 
parameters.

1. Set the batch tolerance as follows:

a. For Batch Tolerance Type, select Percent or Amount.
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b. Enter a numeric value in the Batch Tolerance field.

2. Set the line tolerance as follows:

a. For Line Tolerance Type, select Percent or Amount.

b. Enter a number value in the Line Tolerance Field

For examples of setting these values, see Section 7.5.1, "Set System Parameter 
Defaults for Indirect Sales".

To Finish
To finish, click Update. 

6.11 Set Up the History Rule
Use the History Rule option to record the changes made to a claim while it is being 
researched and processed. 

Prerequisite
None

Steps
1. Log in to Trade Management and navigate to Administration > Trade 

Management > Claim > History Rules.

2. Select an Object Attribute.

These are different pages that can comprise a claim: Main, Lines, Line Detail, 
Associate Earnings, Split, Settlement.

3. Use the arrows to move values that appear on these pages from Available 
Columns to History Rule Columns.

Whatever values appear in History Rule Columns are displayed when the 
history of a claim is accessed.

4. Click Update.

6.12 System Status and User Status
System statuses drive behavior for specific Oracle Trade Management objects. User 
statuses are used in conjunction with system statuses for classification purposes.
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The following table describes the claim statuses used in Trade Management:

Table 6–1 Claim Statuses

Claim Status Description

New The claim status appears as New when it has been created in 
Oracle Trade Management but has not yet been researched.

When a claim is created in Oracle Receivables, by default the 
claim status appears as Open.

Open The claim status appears as Open when a you start the claim 
research process.

The claim status may change to Complete, Pending Approval, 
or Pending Close.

Complete You can manually change the claim status from Open to 
Complete. No approval is required to change the claim status 
from Open to Complete. Complete status means that you have 
completed most of the research, but do not want to settle the 
claim immediately.

When the claim status is Complete, you can request approval 
for the claim and initiate the settlement process.

The claim status may change to either Pending Approval or 
Pending Close.

Pending Approval You may request approval when the claim status is either 
Open or Complete. After you submit the claim for approval, if 
the approvers do not respond to the request, the claim status 
appears as Pending Approval.

Depending on whether the approvers approve or reject the 
request, the claim status changes to either Approved or 
Rejected.

You cannot change this status to any other status.

Approved The claim status changes to Approved after all the approvers 
approve the claim. This is a temporary status because the 
settlement process begins immediately after the claim is 
approved.

The claim status may change to either Closed or Pending 
Close.

Rejected The claim status changes to Rejected if the approvers reject the 
claim.

You may manually change the status to Open and resubmit it 
for approval.
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6.13 Set Up Approval Rules for Claims
Approval rules for claims dictate which individuals in your organization must 
authorize the settlement of a claim and under what circumstances their approval is 
required. Approval rules can be configured using multiple parameters such as 
amount, claim type, claim reason, organization and custom setup.

The rules are evaluated based on the following parameters:

■ Organization = 5

■ Claim Reason = 4

■ Claim Type = 3

■ Custom Setup = 1

The higher the number, the more important the parameter in determining which 
rule will apply to a particular claim.

Prerequisite
None

Steps
1. Log in to Oracle Trade Management and navigate to Administration > Trade 

Management > Setup > Approval Rule.

2. Change the value of the Approval Rule For field to Claim.

The page refreshes and claim specific attributes are displayed.

Pending Close After a claim is approved, the claim status appears as Pending 
Close if the settlement process is not automated in real time, 
but requires some concurrent process such as the Claim 
Settlement Fetcher to finish the claim processing.

After the processing is complete, the claim status changes to 
Closed.

Closed The claim status appears as Closed after the claim is settled.

Cancelled The claim status can be updated to Cancelled only from Oracle 
Receivables and not from Oracle Trade Management.

A claim cannot be settled when it is in the Cancelled status.

Table 6–1 Claim Statuses

Claim Status Description
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3. Enter information in the fields as appropriate.

■ Start Date: The date upon which the rule is available for use.

■ End Date: The date upon which the rule can no longer be used.

■ Organization: Displays a list of operating units.

■ Claim Type:

– Claim: select if this approval rule is for the normal claim approval 
process.

– Earnings: select if this approval rule is for use when the threshold for 
unearned payments for offers is overridden.

– Performance: select if this approval rule is for offer performance 
validation.

■ Minimum Amount and Maximum Amount:

– For unearned payment threshold overrides, this sets a minimum and a 
maximum amount for the difference between the earned amount and 
associated earnings.

4. Select Create.

An Approvers table is displayed.

5. Indicate who must approve the claim and in what order as follows:

■ Order: Enter integers in ascending order.

■ Type: Can be Function (for example, budget owner), Role (for example, 
Manager, Senior Manager), or User (a specific individual).

■ User/Role: Depending on the Type selected above, this displays a list of 
functions, roles or users

■ Start Date: The date upon which the approver becomes active. 

■ End Date: The date upon which the approver becomes inactive.

6. Click Update.

6.14 Importing and Mapping Customer Reason Codes
Claims are created for a variety of reasons related to promotions, shipping 
problems, invoice errors, or quality issues. The reason for a claim can drive the 
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claim research and resolution process. Claim reasons can also help a company 
analyze its claim problems.

Manufacturers and their customers have different claim reasons. During research, a 
claim processor might call a customer and refer to the customer’s reason code. 
Capturing a customer’s original reason code and automatically converting it to an 
internal reason code can make claim research easier.

Example
The retailer Bigmart uses more than 3,500 reason codes for deductions against 
its manufacturers. To make sense out of its deduction patterns and route them 
to the appropriate departments for investigation, the manufacturer Toy House 
maintains only 30 reason codes.

Bigmart electronically remits payments to Toy House (either indirectly via bank 
and then through a lockbox, or directly via an EDI file coming through a 
lockbox.) On their remittances, Bigmart includes a reason code for every line in 
every deduction. 

During the Post Batch process in Oracle Receivables, all deductions taken by 
Bigmart are passed to Trade Management as deductions. If Bigmart’s reason 
codes have been mapped to Toy House’s internal codes, conversion will take 
place during this process.

During claim creation (both in Oracle Receivables and in Trade Management), 
customer reason code mapping works as follows:

■ If the customer reason only is entered, the corresponding internal reason is 
displayed automatically. If no mapping has been done for a particular customer, 
then the internal reason will default to the reason specified on the Claim 
Defaults page or the System Parameters page (in that order.)

■ If a customer reason and an internal reason are entered, the customer reason 
takes precedence. The internal reason will be converted to the one specified 
during mapping.

■ If an internal reason only is entered, the customer reason field is left blank.

6.14.1 Importing and Mapping Customer Reason Codes
To import and map customer reason codes:

■ Import customer reason codes

■ Map customer reason codes
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■ Maintain customer reason code mapping

To import and map customer reason codes, follow the procedure below.

Prerequisites
A trade profile for the customer must exist. WebADI must be implemented.

Steps

To Import Customer Reason Codes
1. Save the customer’s reason code file as a text file.

2. Log in to Oracle Trade Management and navigate to Administration > Trade 
Management > Customer > Trade Profiles.

3. Click a party name.

4. Click Update Code Mapping.

5. Click Import.

6. Select a viewer and click Next.

7. Select Conversion Text Map and click Next.

8. Select the customer’s file, set the file delimiter parameters, and click Next.

9. Review the setup on the Document Creation Review page.

10. Click Create Document.

Several different pages will be displayed. The final one will be a window called 
Download Messages. When the message Transfer Complete is displayed, the 
upload is finished.

11. To proceed and load the file for customer reason code mapping, open the 
Oracle menu item, and select Upload.

12. Enter the batch number which appears on the spreadsheet, and click Upload.

Note: Customer reason code mapping is operating unit specific. It 
is based on the login of the individual performing this task. 
Therefore, customer reasons can differ by operating unit even 
though customer accounts are not org-striped.
Implementing Claims 6-31



Set Up Claim Import
To Map Customer Reason Codes
1. Navigate to Administration > Trade Management > Customer > Trade Profiles.

2. Locate the customer’s name and click the icon in the Code Mapping column.

The Code Conversions page appears. Code conversion type should be Reason, 
and the table should be populated with the customer reasons you have 
imported.

3. Convert the customer codes as follows:

a. Select an internal code for each customer reason.

b. As an option, you can enter map start and end dates.

Map start date defaults to the system import date. Map end date is left 
blank by default. Claim users can add an end date to the code mapping.

4. Click Update.

Maintaining Customer Reason Mapping
As ongoing maintenance, you can:

■ Create additional mappings importing more files from the customer

When you import more files, new mappings are added and updated mappings 
overwrite old ones. 

■ Create additional mappings on an individual basis

Map start date defaults to the system date; map end date is left blank.

■ Change the internal reason, and the map start and end dates.

■ Delete individual mappings.

6.15 Set Up Claim Import
Claims can be imported using the Import Interface tables. When using this features 
the following process takes place: 

1. Data from legacy or third party systems is fetched.

2. The fetched data is used to populate the Claim and Claim Line interface tables.

3. A concurrent process is run.

4. Claims are automatically created in TM.
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To understand and implement Claim Import, see the following: 

■ Section 6.15.1, "Understanding the Claim Concurrent Program"

■ Section 6.15.2, "Understanding Claim Interface Tables"

6.15.1 Understanding the Claim Concurrent Program
The concurrent program, OZF-TM: Import Claim, takes data from the interface 
tables, and creates claims and their associated claim lines. There are no parameters 
for this program. 

First the claim is imported, then its corresponding claim lines are imported. When 
an error occurs, the program writes an error message. This message contains the id 
of the current record in the interface table. After writing the message, the concurrent 
program continues.

6.15.2 Understanding Claim Interface Tables
After the claim and claim lines are created successfully, the claim_id is recorded in 
the claim_id column of the claim interface table.

Two tables are used:

■ OZF_CLAIMS_INT_ALL

■ All claim information

■ Stores the data that must be imported to the ozf_claims_all table by the 
OZF-TM: Import Claim concurrent program

■ OZF_CLAIM_LINES_INT_ALL

■ All claim line information

■ Stores data that needs to be imported to ozf_claim_lines_all table using 
OZF-TM: import Claims program.

6.16 Implementing the Claim Creation API
Use the Claim Creation API to import claims into Trade Management from outside 
sources. See the Oracle Marketing API Reference Guide, Chapter 6, for details.
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6.17 Setting Up the Promotional Payment View
Set up of the promotional payment view consists of running the concurrent 
program called OZF-TM : Refresh Materialized Views for Promotional Payment, 
regularly.

This program updates the materialized view for promotional payments with the 
most recent earnings information.

6.18 Setting Up Claim Ownership Assignment
Three methods are available for claim assignment:

■ Claim Territories: Using the CRM Foundation Module Territory Manager, 
Trade Management can assign claims based on customer, geographical, and 
claim attributes. If you use this method, no API is required. For more 
information, see Section 3.9.2, "Set Up Territory Manager for Trade 
Management".

■ Assignment API: Use this API only if you want to assign a customize claim 
ownership.

■ System Parameters: If territories or the API are not used, the default owner in 
specified in System Parameters is used. 

6.19 Set Up Pay Over Earnings Threshold Rules
Use the Pay Over Earnings feature if you want a customer to be paid more than 
what he actually has earned. The pay over earnings threshold rules determine the 
circumstances under which the pay over earnings can be paid. You can specify an 
amount or percent over the committed amount for which you will allow pay over 
earnings.

The set up is performed on the System Parameters page. See the Earnings Payments 
section of Section 6.4, "Set System Parameter Defaults" for details and an example.

6.20 Set Up Automatic Write Off Threshold Rules
When companies experience high claim volumes, they may prefer not to have their 
claim processors spend time investigating claims under a certain amount. With 
Trade Management, you can set up threshold rules that allow you to automatically 
write off claims with amounts that are under a specific threshold.
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Beginning in this release, you can select a memo line on claim lines or also actively 
create a standard memo line and interface it to Receivables. New in this release, for 
the claims lines on the lines table, there is an item type field which you can use to 
select a product/product category or standard memo line to filter the list of values 
on the line/product field.

To enable automatic threshold write off functionality, perform the following 
procedure.

1. Set the profile option OZF: Claim Write Off Threshold

2. Set threshold rules either on the system parameters page or individually by 
customer in each customer’s trade profile.

■ Instructions are included under Section 6.4, "Set System Parameter 
Defaults".

■ See Section 6.10, "Set Up Trade Profiles" for instructions.

3. Periodically run the concurrent program, OZF-TM : Claim Auto Write-offs 
Program, to settle and close claims marked for automatic write off. This batch 
process can be:

■ Scheduled to run at specific intervals in Oracle Forms.

■ Run for a specific claim class (deductions or overpayments), customer, 
claim type, reason or claim date period.

6.21 Memo Line Transfer
Standard memo line is commonly used by companies in autoaccounting setups for 
items which are not part of their normal inventory. In the past, Trade Management 
did not have the ability to pass credit memos and debit memos to Oracle 
Receivables, so claim settlement for nonstandard items took much longer and 
required manual intervention. Starting in this release, you can pass a memo line to 
Oracle Receivables, thereby enabling the autoaccounting setups. 

6.22 Maintaining Team Access and Security
Each claim must be assigned to a team or group. These are created in the CRM 
Foundation Resource Manager module. After the team or group is created, they can 
be added to a claim. 

■ Groups: Every time a change is made, run the AMS - Group Access Refresh 
Program to update the group information. 
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■ Teams: Every time a change is made, run the AMS - Team Access Refresh 
Program to update the team definitions. 

If teams or groups are frequently changed, you can schedule these two programs to 
run on a regular basis.

6.23 Setting Up Discoverer 
Discoverer is a tool used for querying, reporting, analysis, and web publishing. 
With the appropriate security access, users can view information stored in their 
database for various activities. They can build reports and graphs to dissect the 
information. 

For Trade Management, follow the procedures in these section to set up Discoverer.

■ Section 6.23.1, "Set Up User Security and Privileges"

Table 6–2 Team Access and Security

# Team Member Access

1 Members in the Group specified 
in the profile option AMS: Admin 
Group

Update all fields:

■ Excluding fields locked by the system 
out-of-the-box.

■ Including fields locked by locking rules.

2 Claim owner and team members Update all fields:

■ Excluding fields locked by system 
out-of-the-box.

■ Excluding fields locked by locking rules.

3 Task assignees Update tasks from calendar or task list; view 
report of a claim.

4 All other users in the same 
operating unit as the claim

Access level is determined by the profile option 
AMS: Update Claim Access. The two levels 
allowed are:

■ Update access excluding ability to update 
owner fields, fields locked by the system 
out-of-the-box, and fields locked by locking 
rules.

■ View access of claims only.

5 All other users in different 
operating units from claim.

No access and no view. Claims are org-striped
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■ Section 6.23.2, "Customizing Business Areas"

6.23.1 Set Up User Security and Privileges
The steps below incorporate an example where the Trade Management user is 
added so that these individuals can view the Inventory Business Area. For this 
example, the user name is MKTMGR and the responsibility is Oracle Trade 
Management User. 

Prerequisite
Oracle Discoverer is properly implemented.

Steps
1. Log in to Discoverer Administration version.

2. Click Open.

3. Select the business areas you want to edit. 

In this example, check Inventory and Inventory Value Added.

4. Click Finish.

5. From the Tools menu, select Security to set up user security.

This setup gives your user access to the User Edition of Discoverer for certain 
business areas.

6. Select a Business Area. 

In this example, select the User > Business Area tab.

You can use either the Business Area > User tab, or the User > Business Area 
tab. 

7. Open the User/Resp drop-down list, and select a user. 

In this example, select MKTMGR. 

8. From the Available Business Area, select the business areas that you want to 
grant access to. 

In this example, select Inventory and Inventory Value Added. 

9. Select the > button. 

Your selections display in the selected business areas on the left.
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10. Click Apply.

11. From the User/Resp drop-down, select a user responsibility. 

In this example, select Oracle Trade Management User.

12. From the Available Business Area, select the same business areas for the user 
responsibility that you selected for the user. 

In this example, select Inventory and Inventory Value Added. 

13. Click the > button.

Your selections display in the selected business areas on the left.

14. Click Apply.

15. Click OK.

16. From the Tools menu, select Privileges.

You will now give your user access to the Admin Edition. You can use either the 
Privileges tab, or the User/Role tab. In this example, use the Privileges tab.

17. Make sure that all boxes for Show privileges for User and Show privileges for 
Responsibility are checked. 

18. Open the drop-down list and select MKTMGR.

This user already has privileges for User Editing. The Schedule Workbook 
option is not checked, and no demos are currently planned for this function for 
this user. Select the check box if you would like to schedule a demo. 

19. Check Administration.

20. Select all five boxes under Administration.

21. Click Apply.

Check that the boxes for Show privileges for User and Show privileges for 
Responsibility are checked. 

22. Open the drop-down list and select Oracle Trade Management User.

23. Select all of the boxes for Administration and User Edition.

24. Click Apply.

25. Click OK. 

You must exit the Discoverer Administration Edition for these changes to take 
effect. 
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6.23.2 Customizing Business Areas
To customize business areas, follow the steps below.

Prerequisite
Oracle Discoverer is properly implemented.

Steps
1. Log in to the Discoverer Administration version.

2. Navigate to the Oracle Marketing business area.

3. From the Insert menu, select Folder From Database.

4. Click Next.

5. Assuming data needed is in APPS, check APPS user.

6. Click Next.

7. Click + to expand APPS.

All the tables and views for this user are loaded.

8. Highlight the views you want. 

9. Select the > button to display the views in the Selected window.

10. Click Next.

11. Change the Default aggregate on datapoints to Details. 

12. Click Finish. 

A Loading status window is displayed. It may take a few moments for loading to 
finish. Your changes appear at the bottom of the Oracle Marketing business area.

6.24 Implementing a Claim Settlement Workflow 
Trade Management uses Oracle Workflow to control the sequence of events and 
notifications that occur when settling claims. The following sections provide:

■ Detailed information about OZF: Claim Settlement > workflow process that is 
seeded with Trade Management. For details see:

– Section 6.24.1, "Overview of the Claim Settlement Workflow Process".
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■ Instructions on configuring the AMS: Claim Settlement workflow process to 
extend the settlement process for any non-seeded payment methods your 
organization requires. For details see:

– Section 6.24.2, "Claim Generic Settlement Process"

– Section 6.24.3, "Claim Settlement Seeded and Non-Seeded Processes"

– Section 6.24.4, "Claim Settlement Process Definitions"

– Section 6.24.5, "Receivable Settlement Actions Definition"

– Section 6.24.6, "Receivables Document Correction Process"

– Section 6.24.7, "Non-Seeded Settlement Process Definitions"

For information on the implementation and setup of Oracle Workflow, refer to the 
Oracle Workflow Administrator’s Guide.

6.24.1 Overview of the Claim Settlement Workflow Process
In Trade Management, the settlement process is initiated when a user changes the 
following claim attributes:

■ Settlement method: Select applicable settlement methods for a claim

■ Status: Change claim status to closed.

The claim settlement workflow process is invoked as follows: 

■ If the profile option OZF : Automate Deduction/Overpayment Settlement is set 
to No, the claim settlement workflow process is invoked if the user tries to settle 
deductions or overpayments by a settlement method related to Oracle 
Receivables. 

■ For non-transaction-related deductions, the write off settlement process was not 
automated in 11.5.9 release, but it is automated for this 11.5.10 release. 

■ For credit memo invoice settlements, the claim settlement workflow is invoked 
in the following cases:

– If more than one invoice is defined on the Claim Line page, the user must 
manually create the credit memos for those invoices in Oracle Receivables.

– For non-transaction-related deductions, if the invoice was applied on 
multiple receipts in Oracle Receivables, claim settlement workflow is 
invoked. The user must manually create the credit memo in Oracle 
Receivables.
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– For both transaction-related and non-transaction-related deductions, if the 
invoice defined in the claim line was not applied on the receipt for which 
the deduction was created, the claim settlement workflow is invoked. The 
user must verify the claim information and create a credit memo in Oracle 
Receivables to close the claim.

■ If the profile option OZF: Derive Accrual Account during Claims Settlement is 
set to Yes, when the user settles a claim by changing the claim status to Closed, 
the claim status becomes Pending Close immediately and the claim settlement 
workflow is invoked. The Oracle General Ledger entries and payment creation 
process are put into background processing. The user must run the Workflow 
Background Engine concurrent program to proceed with the settlement 
workflow. 

6.24.2 Claim Generic Settlement Process
Claim Generic Settlement Process is used to verify whether or not a settlement 
method is seeded. It is associated with the following sub-processes:

■ Claim Settlement Process (Node 3)

■ Non-Seeded Settlement Process (Node 4)

Start (Node 1): This activity marks the start of a process and does not perform any 
action. 

Seeded Settlement Method (Node 2): This activity is used to verify whether or not 
the settlement method is seeded. It also sets the item attribute Settlement Type to 
ADHOC if the settlement method is not seeded. The resulting type for this activity 
can be Yes or No.
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Figure 6–1 Generic Claim Settlement Definition

6.24.3 Claim Settlement Seeded and Non-Seeded Processes
■ The Claim Settlement Process (Seeded Subprocess - Node 3) 

This can be a running, stand-alone process. It handles all of the settlement 
methods related to Oracle Receivables. See Section 6.24.1, "Overview of the 
Claim Settlement Workflow Process" for more information.

■ Claim Non-Seeded Settlement Process Configurable Subprocess (Node 4)

The claim non-seeded settlement process is not a stand-alone process. It handles 
the settlement process for non-seeded payment methods. You can extend the 
existing workflow definition and customize it to meet your business needs. 

■ End (Node 5)

Marks the end of a process and does not perform any action. 

6.24.4 Claim Settlement Process Definitions
The claim settlement process workflow is the major workflow used to handle 
non-automated settlement processes in Trade Management. Several scenarios can 
initiate this workflow. See Section 6.24.1, "Overview of the Claim Settlement 
Workflow Process" for more information.

Two associated subprocesses are inside the claim settlement process: 

■ Receivable Settlement Action (Node 10)

■ Receivable Document Correction (Node 14)
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■ Start (Node 1)

Marks the start of a process and does not perform any action. 

■ Promotional Claim (Node 2)

Identifies the claim as promotional or non-promotional. The result type of this 
activity is Yes or No. 

■ Create GL Entries (Node 3)

Table 6–3 Claim Generic Settlement Activity

Activity Result Type

Promotional Claim Yes/No

Create GL Entries Success/Error

Check Claim Class Claim/Deduction

Create Payment Success/Error

Reset Claim Status N/A

Prepare Receivable instructions Yes/No

Update Settlement Document Success/Error

Additional Information requested from 
claims

N/A

Close Claim Settlement N/A

Incomplete Claim N/A

Table 6–4 Claim Generic Settlement: Notification

Notification Message Performer

Notify Claim Owner of Error 
(Node 6)

Settlement Error Claim Owner

Claim Settlement 
Rejection/Cancellation 
(Node 9)

Unresolved Claim Message Receivable Role

Additional Information 
Requested from claims 
(Node 11)

Additional Information Claim Owner
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Creates all accrual Oracle General Ledger entries for all promotional claims. The 
result type of this activity is Success or Error.

■ Check Claim Class (Node 4) 

Checks the claim class. The result type of this function is Claim or Deduction. 

■ Create Payment (Node 5)

Creates payment for promotional claims. The result of this function is Success 
or Error.

■ Reset Claim Status (Node 7)

Reverts claim status from Pending Close to Open if an error occurs. The claim 
amount settled is reverted back to amount remaining. 

■ Prepare Receivables Instruction (Node 8) 

Sets the defaults for all item attributes related to claim settlement. These 
attribute values are included in the notification sent to the Receivables role to 
create payment.

■ Update Settlement Documents (Node 12) 

Once the Receivables role replays the notification with Receivables Transaction 
Number, the result type is Request Processed. The workflow continues to the 
Update Settlement Document activity. Internally, this function verifies any of 
the five transaction numbers entered by the Receivables role, and sets the 
corresponding Transaction Id. 

The Transaction Number could be Adjustment Write-Off Number for 
deductions settled by a write-off. If any of the five transaction numbers is not 
valid in Oracle Receivables, the value is set to item attribute, Error Transaction 
Number1-5. If all of the transaction numbers are valid, claim settlement docs is 
populated with the payment information. 

■ Close Claim Settlement (Node 13)

Updates the claim status to Closed, and payment status to Paid. 

■ Incomplete Claim (Node 15) 

Sets the claim payment status to Incomplete.

■ End (Node 16)

Marks the end of a process and does not perform any action. 
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6.24.5 Receivable Settlement Actions Definition
Receivable Settlement Actions (Node 10) is a workflow process that is associated 
with the Claim Settlement Workflow process. It cannot be run as a stand-alone 
process. 

This process is initiated when item attributes are properly set from the Prepare 
Receivables Settlement action. 

Once the Receivable Settlement Actions process is initiated, a settlement notification 
called Instruction for Settling Claims to Receivable Role is sent to the Receivables 
user and the process waits for a response. A time out value is set by the settlement 
workflow. A workflow background engine must be set up to handle time out 
notification activities. 

If the original notification exceeds the settlement time out value, the workflow 
engine sends another notification called Instruction for Settling Claim - Reminder to 
the Receivables user. The result type of the notification sent to the Receivables user 
is Require More Information or Request Proceed.

6.24.6 Receivables Document Correction Process
Receivables Document Correction (Node 14) is a workflow process that is 
associated with the Claim Settlement Workflow process. It cannot be run as a 
stand-alone process. This process is initiated when Transaction Number1-5 item 
attributes are identified as invalid by Update Settlement Documents (Node 12). 

Invalid transaction numbers are put into item attribute Error Transaction 
Number1-5. Once the Receivables Document Correction process is initiated, a 
settlement notification called Transaction Correction is sent to the Receivables user 
and waits for a response. A time out value is set by the settlement workflow. A 
workflow background engine must be set up to handle time out notification 
activities.

If the original notification exceeds the reminder time out value, the workflow 
engine sends another notification called Transaction Correction - Reminder to the 
Receivables user. The result type of the notification sent to the Receivables User 
should be Corrected.

6.24.7 Non-Seeded Settlement Process Definitions
The purpose of the Claim Non-Seeded Settlement process is to provide a general 
settlement workflow process definition for users. It can be customized to meet your 
business needs.
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One associated subprocess, called Close Settlement Process (Node 6), is inside 
Claim Non-Seeded Settlement Process.

■ Start (Node 1): 

This Start activity marks the start of a process and does not perform any action. 

■ Complete Settlement Documents (Node 2)

Can be customized or overwritten. The customized function must be populated 
with the following item attributes. By setting these attribute, the function Write 
Settlement Doc will take these attribute values and write into the 
OZF_SETTLEMENT_DOCS table.

Table 6–5 Claim Generic Settlement Activity

Activity Result Type Allow Customization

Complete Settlement Document 
(Node 2)

N/A Yes

Create Settlement Document (Node 3) Success/Error No

Revise Settlement Document (Node 4) N/A Yes

Loop Counter (Node 5) Loop/Exit Yes

Table 6–6 Payment Detail Item Attributes

Attribute (Internal Name) Data Type Table Field Validation

Transaction Identifier 1
(AMS_TRX_ID_1)

NUMBER OZF_
SETTLEMENT_
DOCS_ALL. 
settlement_id

Null

Transaction Type 1
(AMS_TRX_TYPE_1)

VARCHAR2(30) OZF_
SETTLEMENT_
DOCS_ALL. 
settlement_type

Status Code should come from AMS_
LOOKUPS where Lookup Type is 
AMS_OBJECT_CLASS.

Possible values include:     

INVOICE, CM, DM, CB, ORDER, 
PCHO, TP_ORDER

Transaction Number 1
(AMS_TRX_NUMBER_1)

VARCHAR2(30) OZF_
SETTLEMENT_
DOCS_ALL. 
settlement_
number

Null
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■ Create Settlement Documents (Node 3)

Cannot be customized or overwritten. Internally, this activity takes the item 
attributes of payment detail (refer to Table - Payment Detail Item Attributes) 
and populates the Settlement Doc table. If no errors occur, it passes the Success 
result type and continues through the next subprocess, Close Claim. 

If an error occurs, it returns the Error result type, and the workflow proceeds 
with the Revise Settlement Documents activity.

■ Revise Settlement Documents (Node 4)

Cannot be customized or overwritten. You must create an API to handle 
instances where the payment detail item attributes are not correct.

■ Loop Counter (Node 5)

The Loop Counter is a standard workflow activity with an activity attribute 
called Loop Limit. The transition path from the Create Settlement Document 
activity to the Loop Counter activity goes in loop patch until the it exceeds the 
number defined in Loop Limit. The value of Loop Limit attribute is starting 
with 0 which means there is only one row of payment detail in settlement. 

■ End (Node 7)

Transaction Amount 1
(AMS_TRX_AMOUNT_1)

NUMBER OZF_
SETTLEMENT_
DOCS_ALL. 
settlement_
amount

Currently, for non-seeded settlement 
process, there is no validation to check 
that the total of settlement amount 
needs to be equal to claim amount. If 
user want to keep this validation true 
for non-seeded payment method also, 
user needs to write its own validation. 

Transaction Date 1
(AMS_TRX_DATE_1)

DATE OZF_
SETTLEMENT_
DOCS_ALL. 
settlement_date

Null

Transaction Status 1
(AMS_TRX_STATUS_1)

VARCHAR2(30) OZF_
SETTLEMENT_
DOCS_ALL. 
status_code

Status Code should come from AMS_
LOOKUPS where Lookup Type is 
AMS_PAYMENT_STATUS.

Possible values include:

IMCOMPLETE, INTERFACED, PAID, 
PENDING

Table 6–6 Payment Detail Item Attributes

Attribute (Internal Name) Data Type Table Field Validation
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Marks the end of a process and does not perform any action. This End activity 
calls standard PL/SQL procedure called WF_STANDARD.NOOP.

■ Close Settlement (Node 6)

Cannot be run as a stand-alone process. Close settlement should be initiated 
only when the Create Settlement Document activity is successfully completed. 
(Refer to Create Settlement Document Node 3 for more information.) 

Once Close Settlement is stated, it goes through the Close Claim Settlement 
activity. Claim status is changed to Closed and payment status to Paid. 

If an error occurs, it returns the Error result type and calls the Reset Claim 
Status activity. The claim status is changed to Open. 

6.25 The Tax Engine
When promotional accruals are created based on sales orders, taxes may have been 
charged to customers, and tax liability may have been accrued. When claims are 
paid, some of the tax liability may be recovered, so the total claim amount may 
consist of payment for promotional accruals and also as a tax recovery amount.

The tax engine supplies an estimate of taxes before transactions are interfaced into 
the Financial or Order Management systems. Trade Management calls the tax 
engine to get a quote of the estimated tax amount. This reduces the changes of 
errors during interfaces with Accounts Receivable and Accounts Payable.

No action is required to set up the tax engine. We do recommend, however, that you 
verify that it is working.

6.26 Setting Up Mass Settlement of Claims
Mass settlement functionality allows claims processors to:

■ Offset overpayments with deductions

■ Net overpayments with all debit items

■ Net multiple deductions against multiple credit memos

■ Specify multiple settlement methods per claim

Once a claims processor performs a mass settlement, the settlement must be 
approved. Approval rules are based on the claim type and reason associated with 
the mass settlement. As part of this set up, you can specify a default claim type and 
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reason for mass settlement groups. This set up is done via the profile options listed 
in the procedure below.

Another profile option is included that would enable the filtering of transaction 
types and receivable activity defined in Oracle Receivables before making them 
available for a particular claim type in Trade Management. The filtering is done 
based on the balancing segment in the account code combinations used to set up the 
various receivables-related accounts on the transaction types and receivables 
activities in Oracle Receivables. Enabling this option, OZF: Enable Balancing 
Segment on Claim Type, will cause the field GL Balancing Segment to be displayed 
on the Create Claim Type page. This field is mandatory if the option is set to Yes.

Prerequisite
None

Steps
1. Log in to Trade Management and navigate to Administration > Trade 

Management > Setup > System Parameters.

2. In the Settlement section of the page, select the check box called Route mass 
settlement approval based on net amount.

Selecting this check box is optional. If selected, the mass settlement amount is 
based on the net amount (post-netting). If not selected, the mass settlement 
approval amount is based on the open claims amount (pre-netting), in other 
words the sum of deductions and overpayments.

For example, if five deductions totalling $100 and two overpayments totalling 
$80 are selected for netting, the open claims amount will be $20.

3. Click Update.

4. Log in to Oracle Forms and select the Oracle Trade Management Administrator 
responsibility.

5. Set the following profile options:

■ OZF: Defaulting Rule for Mass Settlement

■ OZF: LOV for claim type and reason on mass settlement

■ OZF: Enable Balancing Segment on Claim Type

These profile options are described in the table below.
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6.27 Setting Up the Claim Aging View
Provides a summary of claim and deduction amounts by customer and days due. 
To implement the Claims Aging View, you must: 

■ Define the aging bucket in Oracle Receivables. For more information see 
Section 2.2, "Setting Up Oracle Human Resources".

■ Run the OZF-TM: Populate Claims Aging concurrent process.

Table 6–7 Profile Options for Mass Settlement of Claims

Profile Option Name Required Description

OZF: Defaulting Rule 
for Mass Settlement

No Set at the site level.

Values are:

Default nothing: The two other options listed in this 
table are not selected if this value is used. Instead, 
the system parameter defaults for claim type and 
reason are used. Balancing segment on claim type is 
not enabled.

Default from most commonly used claim type and 
reason: Will cause the system to look at all the claims 
included in the settlement and select the most 
frequently used claim type and reason as the mass 
settlement defaults.

Default from split claim: Will cause the system to 
use the claim type and reason designated for the 
split claim (remaining on split mass settlement).

OZF: LOV for claim 
type and reason on 
mass settlement

No Set at the site level.

Show all claim types and reasons: System will 
display all available claim types and reasons.

Show selected claim types and reasons: Default 
value for this option. System will display only the 
claim types and reasons used in the mass settlement.

OZF: Enable Balancing 
Segment on Claim Type

No Set at the responsibility level.

Yes = Filter the values for claim types based on a 
balancing segment. Also displays an additional field 
in the claim type user interface for storing the 
balancing segment the system uses to filter claims.

No = Default value for this option. Filtering 
functionality not enabled.
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6.28 Setting Up Auto Write Off
Claims can also be mass settled by write off — either manually or automatically. 
The process reduces time and resources required for writing off claims.

The Write Off Adjustment field is a place holder for the activity that is used for 
writing off invoice related deductions. The LOV for this field comes from Oracle 
Receivables, and it exposes all receivable activities of type Adjustment. Oracle 
General Ledger accounts associated with these activities are used for creating 
accounting entries for invoice related deduction write offs.

Use Auto Writeoff for small amount deductions and overpayments. You can set 
different thresholds for deductions and overpayments. Writing off claims below the 
threshold amount are completely automated. Optionally, you can manually select 
and deselect claims for auto write off and set approvals.

Follow the procedure below to implement auto write off.

Prerequisite
None

Steps
1. Log in to Trade Management and navigate to Administration > Trade 

Management > Setup > System Parameters.

2. In the Settlement section, select or enter values for the Writeoff parameters.

■ Writeoff Threshold (Deduction) example: You enter 200 as the threshold. If 
you receive a deduction for $190, it is under the threshold and is eligible for 
automatic write off. The value entered here should always be a positive 
number.

■ Writeoff Threshold (Overpayment) example: You enter 150 as the 
threshold. If you receive an overpayment for $140, it is under the threshold 
and is eligible for automatic write off.

■ Writeoff Adjustment: These are receivable activities defined in Accounts 
Receivable.

■ Receipt Writeoff (Deductions): Select the appropriate Receivables Activity 
that will be passed to Oracle Receivables and used during settlement for 
nontransaction-related deductions.
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■ Receipt Writeoff (Overpayments): Select the appropriate Receivables 
Activity that will be passed to Oracle Receivables and used during 
settlement for nontransaction-related overpayments.

3. Log in to Oracle Forms and select the Oracle Trade Management Administrator 
responsibility.

4. Navigate to Setups > Profiles, and enter a numeric value for the profile option 
OZF : Claim Write Off Threshold.

5. OZF : Under Write Off Threshold Approval Required

6. Run concurrent program OZF-TM: Claim Auto Write-offs Program

The concurrent program, OZF-TM: Claim Auto Write-offs Program, is a batch 
process provided to write off claims that have been selected for automatic write off.

The process settles claims for:

■ Transaction-related deductions by creating a write off adjustment against the 
transaction (for example, an invoice.) It reduces the disputed amount on the 
transaction by the claim settlement amount, and closes the claim.

■ Nontransaction-related deductions by creating a negative write off line in 
Oracle Receivables. 

■ Overpayments the process creates a positive write off line in Oracle 
Receivables.

■ For both nontransaction-related deductions and overpayments, it:

– Unapplies the claim investigation line

– Applies the amount to the receipt write off

– Reapplies any remaining amount to the claim

– Creates the accounting entries

– Closes the claim

Claims settled by this process are identified by the Settled By field. Post settlement, 
the auto write off check box is read-only and cannot be changed.

Claims are flagged when they fall below the thresholds that were set up in System 
Parameters. When the OZF-TM: Claim Auto Write-offs Program is run, the claims 
are automatically closed by write-off settlement. You can include claims that are 
over the write-off thresholds in the automatic write-off; these claims require 
approval.
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Special Cases
■ Claims under thresholds that have been deselected for autopay by a claim 

processor will not be flagged again automatically. They can be selected again 
manually as long as the claim status is Open.

■ Claims that were deselected for settlement can still be written off on a one-off 
basis from the Claim Settlement page. Approval may or may not be required 
based on the profile option OZF : Under Write Off Threshold Approval 
Required.

■ Claims that are over threshold amounts can be written off with this concurrent 
program if approval dictates by the custom set up is granted.

■ Claims originally over thresholds whose amounts have been reduced are not 
flagged automatically for write off. Claim processors can manually flag them 
for write off. Approval dictated by the custom set up.

■ Claims originally over thresholds but later split into subclaims are still treated 
as claims over the threshold. They can be flagged for automatic write off with 
approval dictated by the custom set up.

6.29 Lockbox Integration
New in this release, the claim creation functionality includes a lockbox. For large 
volume claim management, lockbox integration automatically creates deductions 
and overpayments and uses the Quickcash feature. This reduces deduction creation 
time and improves deduction processing efficiency. Previously, unmatched amounts 
had to be handled manually.

The lockbox receives payments and automatically creates a claim for any differences 
between the payments received and invoices. Oracle Receivables interprets the 
lockbox entries based on settings in the System Option and Lockbox setup 
windows.

The claim preferences are configurable. Customers can communicate the reasons for 
the difference between their payment and the invoice. The reason codes are 
captured in the lockbox file and they travel through the flow with the remittance 
line to Trade Management, where they are translated into your company’s reason 
code. You can map Customer reason codes to internal reason codes.

The lockbox must be set up in Oracle Receivables. See Section 2.5.13, "Set Up 
Lockbox Integration" for this procedure. See the Oracle Receivables Implementation 
Guide for more information.
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Lockbox integration requires Oracle Receivables Family Pack E or Oracle 11.5.10.

6.30 Subsequent Receipts
This new functionality efficiently applies cash against open receipts. You can view 
accurate claim amounts at any time, and resolve open claims.

Subsequent Receipts updates Trade Management whenever there is a subsequent 
application against a transaction that has an active claim against it. For example, if a 
short payment claim was created for a transaction based on a receipt and a 
subsequent receipt is applied to the transaction, the short payment claim amount 
changes. This requires an update in Trade Management to reflect the change in 
amount.

Subsequent Receipts integration requires Oracle Receivables Family Pack E or 
Oracle 11.5.10.
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Implementing Indirect Sales

This chapter provides the information you need to set up the Indirect Sales module 
for Oracle Trade Management. How this module is implemented will vary 
depending on your business requirements.

To implement claims, follow the procedures in these sections:

■ Section 7.1, "Set Profile Options for Indirect Sales"

■ Section 7.2, "Verify Lookups for Indirect Sales"

■ Section 7.3, "Run Concurrent Programs for Indirect Sales"

■ Section 7.4, "Data Imports"

■ Section 7.5, "Data Processing"

■ Section 7.6, "Special Pricing Requests"

■ Section 7.7, "Soft Fund Requests"

Indirect Sales Management enables a manufacturer to validate requests as well as 
manage and track funds when trade promotions are executed indirectly through 
retailers and wholesalers (or dealers and distributors). Indirect Sales Management 
includes the following features:

■ Chargeback

When wholesalers sell products to retailers or end users, they sometimes sell 
the products at a price that was agreed upon between retailers and the 
manufacturer. If this price is lower than the price the wholesaler paid to 
purchase the products from the manufacturer, the wholesalers can claim the 
difference between their purchase price and selling price from the manufacturer 
through chargeback.

■ Third Party Accruals
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When retailers buy products from wholesalers, they might not get the discounts 
that they are entitled to if they buy directly from the manufacturer. The 
manufacturer can accrue these discounts for the retailers based on the data that 
wholesalers send through Third Party Accrual.

■ Special Pricing

Retailers or wholesalers may request a special price or discount from a 
manufacturer in order to dispose of existing inventory, meet a competitor’s 
price, or win a deal for an existing customer. The manufacturer can pay the 
retailers the discount based on these requests through Special Pricing.

■ Soft Funds

Retailers or wholesalers may request a budget in order to execute trade 
promotion activities on behalf of the manufacturer.

■ Inventory Tracking

The manufacturer can keep track of the inventory level of the wholesalers to 
verify the data that the wholesalers send. This ensures that the manufacturer 
does not overpay the wholesalers’ claims.

■ Referral Management

Referral Management is a feature in Partner Management that integrates with 
Oracle Trade Management to create Referrals benefits and Referral 
compensation payments. Upon activation of a referral benefit, a Net Accrual 
Offer with the custom setup of PV Net Accrual is generated. After a customer 
referred by the partner makes a qualified purchase, when the Net Accrual 
engine program runs a utilization of type 'LEAD_ACCRUAL' is accrued for the 
partner as compensation. Referral Management creates a claim for payment of 
referral compensation for the partner. Claims indicates the source as Referral 
when creating the claim. For Referral claims after the claim approval, an event 
oracle.apps.ozf.claim.referralApproval is raised, which has a subscription from 
the Referrals module for further handling. After the partner accepts the 
compensation, a call is made back to Claims for settlement, after which the 
claim is closed.

Chargeback and Third Party Accrual data are managed in Oracle Marketing. Special 
Pricing and Soft Funds, and Referral Management are features that are available in 
Oracle Partner Management. Oracle Trade Management integrates with Oracle 
Partner Management so that whenever there are any approved requests related to 
Special Pricing or Soft Funds, offers and claims are automatically generated in 
Oracle Trade Management; these claims are settled by the claims user.
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See the Oracle Trade Management User Guide for more information on using this 
application.

7.1 Set Profile Options for Indirect Sales
Set the profile options for Indirect Sales. See Section A.6, "Profile Options for 
Indirect Sales" for the list of profile options. For information on how to set profile 
options, see Section A.2, "Setting Profile Options".

7.2 Verify Lookups for Indirect Sales
There are 11 lookups that you must verify or create for Indirect Sales. See 
Section B.6, "Lookups for Indirect Sales" for details. See Section B.2, "Creating New 
Lookup Types" to create new lookups. 

7.3 Run Concurrent Programs for Indirect Sales
Run the concurrent programs for indirect sales. See Section C.6, "Concurrent 
Program for Indirect Sales" for the table containing the programs.

You normally schedule concurrent programs, but they can be run manually if 
necessary. When the Submit button on the Process page and the Initial Payment 
button on the Detail page are clicked, you must run the concurrent program.

7.4 Data Imports
Data must be imported into Trade Management in order for Indirect Sales to work. 
Data can be imported by WebADI or XML Gateway. These processes are set up by 
setting profile options. 

This section contains two subheadings:

■ Section 7.4.1, "Loading Data Using WebADI"

■ Section 7.4.2, "Setting Up XML Gateway"

7.4.1 Loading Data Using WebADI
To upload data to Trade Management using WebADI, you can create an empty 
spreadsheet and enter new data into it. If the spreadsheet already has data, the 
content should be converted to a delimited text file and uploaded to an empty 
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spreadsheet in WebADI. The APIs are available for you to upload the data, validate 
it, and flag any errors. If any errors occur, no data is uploaded to the database.

It is important to validate that WebADI is installed properly before proceeding with 
loading data. To do this, perform the following procedure.

Installation Steps
1. Install the Diagnostic Wizard patch. This patch copies BNETEST class file up to 

webserver. 

2. Make sure that BNETEST is in the class path. 

3. Copy the BNETEST.class under /servlets directory on the server. 

4. Run the BNETEST using <app server:port>/oa_servlets/BNETEST URL to 
check if there is any problem with WebADI installation.

To set up WEBADI for Indirect Sales, set the BNE profile options to the values 
shown in Appendix A. See Section A.6, "Profile Options for Indirect Sales".

Prerequisites
Give jserv write access to Group and All for $APPL_TOP/bne/11.5.0/log and 
$APPL_TOP/bne/11.5.0/upload directories.

Implementation Steps
1. Log in to Oracle Trade Management and navigate to Indirect Sales Management 

> Chargeback.

2. Click Import Batch and navigate to Select Layout Page in the WebADI 
Application.

a. Select Trade Management: Resale Layout if the data comes from Oracle 
Application. 

b. Select Trade Management: Resale Text Layout if the data comes from a 
third party application and requires external code to internal code 
conversion.

3. Click Next.

4. On the Select Content page,

a. Select Download to update a batch, or

b. Select None to enter the data manually, or
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c. Select Text File to import data to an Excel spreadsheet and upload it to 
Oracle Application Indirect Sales Management Interface Tables.

5. Click Next.

6. On the Select Mapping Page:

a. If Download is selected as content, enter the Batch Number for the batch to 
be downloaded.

b. If Trade Management: Resale Layout is selected, select Download mapping.

c. If Trade Management: Resale Text Layout is selected, select Download Text 
Map mapping.

d. If None is selected as content, skip the Select Mapping Page.

e. If Text File is selected, go to step 7.

7. If Text File is selected as content on the Select Mapping Page:

a. For the Select Text File section:

– Select the text file from local directory that has the data to upload into 
Oracle Application Indirect Sales Management Interface Tables.

– Select one of the delimiters that is used in the text file.

– Enter the number for the line where the actual data starts. Skip the line 
that has the column title. For example, if the header is at line 1 and the 
data starts from Line 2, Enter 2 in the Start Importing at Line Number 
field.

b. For the Select Mapping section:

– If Trade Management: Resale Layout layout is selected, select Text File 
Map mapping.

– If Trade Management: Resale Text Layout layout is selected, select Text 
Entry Map mapping.

8. Click Next.

9. On the Document Creation Review Page, review the entries and click Create 
Document.

When Download and Text File content is selected, an Excel spreadsheet is 
created and populated with data.

– If Download content is selected, update the data.
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– If None content is selected, enter data in the Excel spreadsheet

10. After the data is entered, updated, or downloaded from a text file in the Excel 
spreadsheet, click the Oracle option menu and select Upload.

A status monitor page appears with Upload and Cancel buttons.

11. Click Upload.

The status shown on the page indicates the upload status and importer status.

Note: Importer validates the data uploaded into Oracle Application Interface 
Tables. 

7.4.2 Setting Up XML Gateway
To set up the XML gateway to send and receive data, you must define the trading 
partner. You need to select the OZF transaction type and the two seeded 
transactaion subtypes of POSI (inbound) and POSO (outbound). The POSI subtype 
has two maps you can use with it and the POSO has one. The basic procedure is 
described here, but for additional information, please refer to the Oracle XML 
Gateway User’s Guide. To set up XML Gateway messages, set the three ECX profile 
options in Appendix A. See Section A.6, "Profile Options for Indirect Sales".

Prerequisites
None

Steps
1. Log into Oracle Forms as the XML Gateway responsibility and navigate to 

Trading Partner Setup.

2. Select a Trading Partner type of Customer.

3. Select a Trading Partner Name and Trading Partner Site. These lists of values 
are determined by previous selections.

4. Enter the email address that you want to use.

5. Select a transaction type of OZF for Oracle Trade Management Inbound and 
Outbound Messages. See Guidelines.

If the Document Confirmation Code is 2 for Inbound Message, then select ECX 
for confirmation message.

6. Select OZF for the POSI and POSO transaction subtypes.
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7. Select ECX for the CBOD transaction subtype.

8. Select the following transaction subtypes:

■ For Inbound Message, select POSI.

■ For Outbound Message, select POSO.

■ For Confirmation Message, select CBODO.

9. Perform these mappings:

■ For OZF transaction type and POSI transaction sub type, select OZF_
PROCESS_SHDBT_IN for Inbound 844 Transaction or OZF_PROCESS_
SLRPT_IN for Inbound 867 Transaction. You can add variables to 
USERAREA to customize the map.

■ For "OZF" transaction type and "POSO" transaction sub type select "OZF_
PROCESS_SHDBT_OUT" for Outbound 849 Transactions.

■ If Document Confirmation Code is "2" for inbound Messages, select ECX_
CBODO_OAG72_OUT_CONFIRM for Outbound Confirmation Message.

10. Enter a unique location for the Source Trading Partner Location Code. 

Typically this is the party site ID/location code of the party. Use this to enter the 
party site ID while sending data using XML Gateway.

11. Set the Document Confirmation based on what level of confirmation the trading 
partner wants to receive for inbound and for all outbound messages.

■ 0: Never send a confirmation

■ 2: Always send a confirmation

See Guidelines for Workflow information.

Guidelines
Transaction Type is the standard product short code for the base Oracle Application. 
These values are defined in the Define Transactions form. The list of values displays 
the available combinations of Transaction Type, Transaction Subtype, Standard 
Code, External Transaction Type, External Transaction Subtype, and Direction. 
Select the desired combination. These values are only used internally to connect to 
the XML Gateway. 

When the XML Gateway execution engine, oracle.apps.ozf.idsm.resli subscription, 
is triggered successfully, it processes an inbound message, which in turn starts the 
OZF: Resale Pre Processing workflow. The process is as follows:
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■ When document confirmation is 2 for an inbound message and 
oracle.apps.ozf.idsm.confirm subscription is enabled, a confirmation message is 
sent to the trading partner that the inbound message was received by the Oracle 
Trade Management application.

■ For data received as an inbound message processed by the Data Process, if there 
is any data processing error, an outbound message is sent to the trading partner 
informing them of the error.

■ If there is any system error, the System Administrator is notified of the error.

7.5 Data Processing
Data Processing uses DQM to call an API from the TCA to get information on the 
party, such as name, address, phone number, and so on. This step is also where code 
conversion is set up to map codes from wholesalers and third parties to the codes 
used by your enterprise.

Data processing includes these sections:

■ Section 7.5.1, "Set System Parameter Defaults for Indirect Sales"

■ Section 7.5.2, "Configure Trade Profiles"

■ Section 7.5.3, "Set Up DQM Integration"

■ Section 7.5.4, "Code Conversion"

■ Section 7.5.5, "Import Cross References Using WebADI"

■ Section 7.5.6, "Business Events and Subscription"

7.5.1 Set System Parameter Defaults for Indirect Sales
To implement indirect sales, set up the defaults in the Indirect Sales section of the 
System Parameters page.

Batch and line tolerance are used to set a limit at which the difference between 
manufacturer's calculated rebate and wholesaler's claimed rebate does not cause a 
problem for the manufacturer to pay the claim discount. If the difference is smaller 
than the tolerance, the system allows the process to continue. If the difference is 
greater than the tolerance, the process is stopped and the line or batch is put in 
dispute. Batch tolerance limits the difference allowed for the whole batch, while line 
tolerance limits the difference allowed per unit of the product on the line.
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For example, the batch tolerance is set to Amount type and to $500. A batch is 
claiming $5,000, but the system calculated amount is $4,400. Because the difference 
is greater than the batch tolerance, the batch is put in dispute and cannot be paid. 
However, if system calculated amount is $4,500, the batch is put in PROCESSED 
status and can be paid. These two options are overridden by setups in the trade 
profile or manual entry from the batch process page.

In a similar example, line tolerance is set to Amount type and to $20. If the claimed 
amount is $500 and calculated amount is $470, the line is put in dispute, because the 
difference is greater than the line tolerance.

You can also set batch and line tolerance at the trade profile level. See Section 7.5.2, 
"Configure Trade Profiles" for details.

Use the Chargeback Calculation Basis field to set whether you want to pay a 
claimed amount from a second party or instead pay the amount calculated based on 
your accounting system. Sometimes the claimed amounts are higher than calculated 
amounts, but you may have business reasons for permitting a higher payment to a 
particular client, for example, if they represent a substantial part of your business 
and you want to maintain a good relationship.

You can create accruals on chargeback claims in situations where an offer must 
accumulate towards a final claim., such as in the case of a mail-in rebate or other 
time-sensitive offer.

You can create a relationship between an end customer who is not a party in TCA 
and a reseller. If you check the box, a party is created in TCA and a relationship 
between the end customer and the reseller is set up.

You can use inventory tracking if you are concerned about matching quantities for 
claims. This can be a time-consuming process, so it should not be run unless it is 
necessary.

If you have a need to pay claims from a third party, such as in the case of a coupon 
mailed in from end users, check the box to set it up. Then you can pay the claim to 
the end user after settling the claims of wholesalers.

Steps
1. Log in to Trade Management and navigate to Administration > Trade 

Management > Setups > System Parameters.

2. Enter values for Batch Tolerance Type and Batch Tolerance.

3. Enter values for Line Tolerance Type and Line Tolerance.

4. Make a selection for Chargeback Calculation Basis.
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5. Check the Create Accruals on Chargeback Claims box if needed.

6. Check the Create Relationship between End User and Wholesaler box if needed.

7. Check the Inventory Tracking box if you want to use inventory tracking to 
verify the data received.

8. Check the Run Third Party Accrual After Chargeback Calculation box to run the 
for valid chargebacks.

9. Click Update.

7.5.2 Configure Trade Profiles
You can also configure batch and line tolerance in the trade profile for a party. To set 
up trade profiles, follow the steps below.

Prerequisites
None

Steps
1. Log in to Oracle Trade Management.

2. Navigate to Administration > Trade Management > Customer > Trade Profiles.

3. Select the party for whom you want to set batch or line tolerance. Use the search 
fields if necessary.

4. Set batch and line tolerances (see Section 7.5.1, "Set System Parameter Defaults 
for Indirect Sales").

7.5.3 Set Up DQM Integration
Data Quality Management (DQM) is a tool from the trading community 
architecture (TCA) group that is used to check for potential duplicate customer, 
contact address, and contact points for a given customer, contact, or address. 

There are 3 profiles options which hold value for the DQM: Match rule. These 
profiles are mandatory and must hold value of match rule. See Section A.6, "Profile 
Options for Indirect Sales" for the profile options.

Sample rule definitions that can be used to create a match rule are as follows: 

Party
For Party you can use the following match rule: 
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Match Rule Name: OZF_DUP_PARTY_SEARCH

Description: Finds identical organization parties based on Party name and address 
information 

Purpose: Identify duplicates 

Contact
For Contact you can use the following match rule. 

Match Rule Name: OZF_DUP_PARTY_CONTACT

Description: Finds identical contact based on contact name and contact points                            

Purpose: Find duplicates 

Attribute Match Match Threshold Override Threshold
Automatic Merge 
Threshold

Match Any 40 <null> <null>

Acquisition Attribute Entity Transformation Type

Name PARTY WORD REPLACE + EXACT + REVERSE

Country PARTY_SITES EXACT

Address PARTY_SITES WORD REPLACE + EXACT

City PARTY_SITES EXACT

State PARTY_SITES WORD REPLACE + EXACT

Postal Code PARTY_SITES EXACT

Scoring 
Attribute Entity Score Transformation Weight (%)

Name PARTY 40 WORD REPLACE + EXACT + 
REVERSE

100

Country PARTY_SITES 1 EXACT 20

Address PARTY_SITES 2 WORD REPLACE + EXACT 60

City PARTY_SITES 1 EXACT 80

Postal Code PARTY_SITES 5 EXACT 100
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Party Site
For Party site you can use the following matching rule: 

Match Rule Name: OZF_DUP_PARTY_SITE

Description: Finds identical organization parties based on Party name and address 
information

Purpose: Identify duplicates

Attribute Match Match Threshold Override Threshold
Automatic Merge 
Threshold

Match Any 30 <null> <null>

Acquisition Attribute Entity Transformation Type

Contact Name CONTACTS WORD REPLACE + EXACT + REVERSE

Email Address CONTACT_POINTS EXACT (EMAIL)

Phone Line Type CONTACT_POINTS EXACT

Raw Phone Number CONTACT_POINTS EXACT

Scoring 
Attribute Entity Score Transformation Weight (%)

Contact 
Name

CONTACT 30 WORD REPLACE + EXACT + 
REVERSE

100

Attribute Match Match Threshold Override Threshold
Automatic Merge 
Threshold

Match Any 65 <null> <null>

Acquisition Attribute Entity Transformation Type

Country PARTY_SITES EXACT

Address PARTY_SITES WORD REPLACE + EXACT

City PARTY_SITES EXACT

State PARTY_SITES WORD REPLACE + EXACT
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Use the following procedure to create a match rule.

Steps
1. Log in to the Forms Application. 

2. Select the Trading Community Manager responsibility. 

3. Go to Data Quality Management > Set up 

4. Double click Match Rule to launch the form.

5. Create three rules, one each for party, person and contact.

6. Save.

7.5.3.1 Mapping Acquisition Attributes to Table Column Names
When you define a rule, you need to determine which table column names are to be 
passed to acquisition attributes from the Pre Process API. An acquisition attribute 
can have values passed from several table column names. If you want to pass on the 
Bill_to information, for example, you can send the Name, Address, City, State, 
Country, Postal Code, Contact Name, Email Address, or Raw Phone Number 
acquisition attributes.

Postal Code PARTY_SITES EXACT

Scoring 
Attribute Entity Score Transformation Weight (%)

Address PARTY_SITES 50 WORD REPLACE + EXACT 100

Country PARTY_SITES 5 EXACT 100

City PARTY_SITES 10 EXACT 100

Postal Code PARTY_SITES 15 EXACT 100

State PARTY_SITES 5 EXACT 100

Acquisition Attribute Entity Transformation Type
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7.5.4 Code Conversion
Use code conversions to map the codes in a wholesaler’s system to your 
enterprise’s internal codes. External codes received from customers are converted 
into the internal values for the following data elements:

■ Agreement: Mapping between the Chargeback agreements that are set up as 
Price Lists and the customer’s reference to these agreements.

■ Product: Mapping between internal products and customer references to these 
products.

■ Reason: Mapping between a claim reason and customer reasons.

Table 7–1 Acquisition Attribute and Table Column Name mapping

Acquisition Attribute Table Column Name

Name Sold_from_party_name/Ship_from_party_name/Bill_to_party_name/Ship_to_
Party_name/End_cust_party_name

Address Sold_from_address/Ship_From_Address/Bill_to_Address/Ship_to_
Address/End_cust_Address

City Sold_from_city/Ship_from_city/Bill_to_city/Ship_to_city/End_cust_city

State Sold_from_State/Ship_from_state/Bill_to_state/Ship_to_state/End_cust_state

Country Sold_from_country/Ship_from_Country/Bill_to_country/Ship_to_country

Postal Code Sold_from_postal_code/Ship_from_postal_code/Bill_to_postal_code/Ship_to_
postal_code/End_cust_postal_code

DUNS Number Bill_to_Duns_Number/Ship_to_duns_number

Contact Name Bill_to_Contact_Name/Ship_to_ Contact_Name/Sold_from_Contact_
Name/Ship_from_Contact_Name/End_Cust_Contact_name

Email Address Bill_to_email/Ship_to_email/Sold_from_email/Ship_from_email/End_Cust_
email

Phone Line Type If phone number is not null , value will be "PHONE", if fax_number is not null , 
value will be "FAX"

Raw Phone Number If a phone number is not null , the value will be "PHONE"Bill_to_Phone/Ship_to_
Phone/Sold_from_phone/Ship_from_phone/End_cust_phoneif fax_number is 
not null , value will be "FAX"Bill_to_fax/Ship_to_fax/Sold_from_fax/Ship_from_
fax/End_cust_fax
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■ OUM (Unit of Measure): Mapping between internal unit of measure and the 
customer’s unit of measure. For example, a wholesaler may use EA for a single 
unit but your enterprise uses EACH. 

■ Party: Mapping between an internal party and the customer’s party reference.

■ Party Site: Mapping between an internal party site and the customer’s party 
site reference.

Prerequisites
None

Steps
1. Log in to Oracle Trade Management and navigate to Administration > Trade 

Management > Indirect Sales > Code Conversion.

2. Select a code conversion type from the drop-down list (see above).

3. Enter the external code. Optionally, enter a description.

4. Select the internal code that you want to convert it to from the list of values.

5. Enter a Mapping Start Date. A Mapping End Date is optional.

6. Click Update.

7.5.5 Import Cross References Using WebADI
For code conversion, you can import cross references using WebADI.

Steps
1. Log in to Oracle Trade Management > Administration > Trade Management.

2. Continue navigation using either of the following paths:

a. Indirect Sales > Code Conversion

b. Customer > Trade Profiles > Click Code Mapping icon

3. Click Import.

4. On the Select Viewer Page in the WebADI Application, select Excel 2000 as 
viewer. Click Next.

Note: Steps 4 - 6 may be automated. If so, proceed directly to step 7.
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5. On the Select Integrator Page, select Trade Management: Code Conversion from 
the integrator drop-down list. Click Next.

6. On the Select Layout Page, Trade Management: Code Conversion is defaulted. 
Click Next.

7. On the Select Content page:

a. Select Download to update Code Conversion Mapping, or

b. Select None to enter the data manually, or

c. Select Conversion Text Map, when selected data from a text file is imported 
to an Excel sheet and uploaded to the Oracle Application Code Conversion 
Mapping Table.

8. Click Next.

9. On the Select Mapping page,

a. If Download is selected as content, enter the Code Conversion ID of the 
Code Conversion Mapping to be downloaded.

b. If None is selected as content, the Select Mapping Page is skipped.

c. If Text File is selected, see step 10.

10. If Text File is selected as content,

a. For the Select Text file section

– Select the text file from the local directory that has the data to upload 
into Oracle Application Code Conversion Mapping Table.

– Select one of the delimiters that is used in the text file

– Enter the number for the line where the actual data starts. Skip the line 
that has the column titles. For example, if the header is at line 1 and the 
data starts from Line 2, enter 2 in the Start Importing at Line Number 
field.

b. For the Select Mapping section, Text File Mapping is defaulted.

11. Click Next.

12. On the Document Creation Review Page, review the entries and click Create 
Document.

13. An Excel spreadsheet is created and populated with data when Download and 
Text File Content are selected.
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a. If Download is selected, update the data.

b. If None is selected, enter data in the Excel spreadsheet.

14. In the Context Section:

a. For Account Level Code Conversion Mapping, Enter Value for Account ID

b. For Customer Level Code Conversion Mapping , Enter Value Party ID

c. If Party ID and Account ID then Code Conversion Mapping is set up at Org 
Level

After the data is entered, updated, or downloaded from the text file in the Excel 
spreadsheet, click the Oracle option menu and select Upload. A status monitor 
page appears with Upload and Cancel buttons. Click Upload to display the 
upload status.

7.5.6 Business Events and Subscription
A business event is an event in which you have an interest. The subscriptions to it 
are the actions that need to performed when that event happens.

Business events are used to invoke one process from another. The mainly serve as a 
link for four processing points.

■ Receiving data

■ Processing

■ Payment

■ Sending data

All business events are seeded in the application. You can unsubscribe to any that 
you do not need, except for the following:

■ oracle.apps.ozf.idsm.resli

■ oracle.apps.ozf.idsm.ridp

■ oracle.apps.ozf.idsm.rspi
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7.6 Special Pricing Requests
A special pricing request enables customers to request discounted pricing from the 
user. They can request discounts on competitive sales deals, specific end-customer 
deals, and on inventory that they have not been able to move.

When a request is submitted, it gets routed to the appropriate approver(s). 
Approvers are notified of the request and they review the request and approve or 
decline the request. After the special pricing request has been approved, and the 
customer has closed the sale, they can submit a claim to receive the discount that 
was approved. The claim is routed to the claim approver who then validates the 
claim. When the claim gets approved, the user pays the discount amount.

Table 7–2 Business Events

Business Event Name Display Name Meaning

oracle.apps.ozf.idsm.
WEBADIPayment

Initiate Payment for 
WEBADI Submission

To start payment for batches submitted through 
WEBADI automatically

oracle.apps.ozf.idsm.
WEBADIProcess

Initiate Data Process for 
WEBADI Submission

To start data process for batches submitted through 
WEBADI automatically

oracle.apps.ozf.idsm.
XMLPayment

Initiate Payment for 
XML Gateway 
Submission

To start payment for batches submitted through XML 
Gateway automatically

oracle.apps.ozf.idsm.
XMLProcess

Initiate Data Process for 
XML Gateway 
Submission

To start data process for batches submitted through XML 
Gateway automatically

Oracle.apps.ozf.idsm.
OMStructure 

Populate the Order 
Management structure

To change the values of Order Management global 
structure for pricing simulation

oracle.apps.ozf.idsm.
resli

Resale Inbound XML 
Event

To receive inbound messages through XML Gateway

oracle.apps.ozf.idsm.
reslo

Resale Outbound Event To send messages through XML Gateway

oracle.apps.ozf.idsm.
ridp

Resale Interface Data 
Process

To start data process

oracle.apps.ozf.idsm.
rspi

Resale Data Payment 
Initiation

To initiate the payment process

oracle.apps.ozf.idsm.
confirm

Resale Confirmation 
Event

To send confirmation messages to trading partners
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7.6.1 Setting Up Notifications
Partners and vendors need to be notified of the status of a request when it is 
submitted. Oracle Workflow notifications are triggered to notify partners, channel 
managers and approvers. Notifications for each status is sent to alert different users 
about the request.

Use the following procedure to set up notifications.

Prerequisites
None

Steps
1. Log in to Oracle Trade Management as the Oracle Trade Management 

Administrator.

2. Navigate to Administration > Trade Management > Indirect Sales > Special 
Pricing Notifications.

3. On the Notifications setup page, enter notification rules for the special pricing 
request. 

For example:

■ Status: Pending Approval

■ User Role: Vendor Approvers

■ Notification Name: Request Submitted - Vendor Notification

4. Click Apply.

5. Define the remaining notification rules and click Apply. 

Table 7-4 below provides information on notifications, the user roles that can receive 
the notifications, and the status of the notification the user role can receive. Select 
from these while setting up the notifications.

Table 7–3 Notifications

Notification Name User Role Status

Request Created - Channel 
Manager Notification

Channel Manager Draft

Request Submitted - Partner 
Notification

Partner Contact, Special 
Pricing Super User (Partner)

Pending Approval
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7.6.2 Data Quality Management (DQM)
When a request is created, the end customer name and reseller names are entered 
by the partner and must be matched to an existing record in TCA, if any exists. 
DQM is used for this purpose. See Section 7.5.3, "Set Up DQM Integration" for more 
information on DQM.

■ If there are no matches for the end customer or reseller, a new customer is 
automatically created by the system.

■ If there are possible customer matches, the DQM approver reviews the matches 
and can either select an existing customer in the system or create a new 
customer.

Users must have permission OZF_SPECIAL_PRICE_DQM to be a DQM approver. 
Any user that has this permission and has access to the special pricing function can 
look up requests that need party matching from the entire request list by filtering 
for requests that have the Customer Merge Flag set as false.

7.6.3 Setting Up Approvers in Oracle Approvals Management
When a request is created, it must be approved before it is converted to an offer. The 
approver views requests and approves or rejects them. Approvers are internal 
employees or vendors that are defined in Oracle Approvals Management (AME). 

Approvers are assigned to review requests and can perform the following before 
approval of a request.

■ Validate the information entered by the partner.

■ Check for similar requests and accept or decline a request. 

Request Submitted - Vendor 
Notification

Vendor Channel Manager, 
Vendor Approvers, Special 
Pricing Super User (Vendor)

Pending Approval

Request Approved - Partner 
Notification

Partner Contact, Special 
Pricing Super User (Partner)

Approved

Request Cancelled - Partner 
Notification

Partner Contact, Special 
Pricing Super User (Partner)

Void

Request Declined - Partner 
Notification

Partner Contact, Special 
Pricing Super User (Partner)

Declined

Table 7–3 Notifications

Notification Name User Role Status
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■ Compare pricing details between similar requests.

■ Forward to additional users for review.

For the procedure, see the Oracle Approvals Management Implementation Guide. Use 
the OZF: Special Pricing Request transaction type.

7.6.4 Dependent Setups

Offer Custom Setups
Three offer custom setups have been seeded for special pricing request. 

■ Special Pricing OffInvoice: Ship and Debit special pricing requests use this 
setup.

■ Special Pricing Accrual: New inventory requests approved with Accrual offer 
use this setup.

■ Special Pricing ScanData: New inventory requests approved with Off Invoice 
offer use this setup. The suffix defined in this offer custom setup is used as the 
prefix for the special price request number.

Setting Up Claims
There are some settings related to Claims in Special Pricing. 

Custom Setup
A custom setup can be seeded for Special Price request claims. Creating different 
custom setups provides the following benefits:

■ A different prefix can be used for special pricing claims.

■ Approvals can be routed differently based on this setup.

■ Claim validations can be different.

To create custom setups, see Section 3.6.5, "Create Custom Setups".

Claim Defaults
You can set up a default custom setup, claim type and claim reason for Special 
Pricing claims. For the procedure, see Section 6.9.1, "Set Up Claim Defaults".
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Trade Profiles
Trade Profiles allows defaulting of payment methods, vendor, and vendor site 
mapping for a partner. They also enable setting of the batch level and line level 
threshold limits for error margins of special pricing claims submitted through 
Indirect Sales Management. See Section 6.10, "Set Up Trade Profiles".

7.6.5 Interaction with Other Modules
Special pricing requests interact with other modules of Oracle Trade Management.

7.6.5.1 Offers
When a special pricing request is approved, an offer is generated. Offers are 
generated in Oracle Trade Management and the types of offers are as below:

■ ScanData Offer: This offer enables users to reimburse customers for the 
discounted amount on products that the customer has already bought.

■ Off Invoice Offer: This offer acts as a pricing modifier for future orders. The 
Approver(s) can see this field during approval if the Ship from Stock check box 
is not selected. If approvers specify this type of offer, customers do not have to 
submit a claim. An authorization coded is generated for the customer upon 
approval, which needs to be used when booking their order to get this discount.

■ Accrual Offer: This offer acts as a pricing modifier for future orders. The 
approver(s) can see this field during approval if the Ship from Stock check box 
is not selected. If approvers specify this type of offer, customers have to submit 
a claim. An authorization code is generated for the customer upon approval, 
which needs to be used when booking their order to get this discount.

7.6.5.2 Budgets
A default budget can be set up for sourcing special price requests. When a default 
budget exists, the system generates a budget request for the requested amount upon 
submission. The budget tab can be configured to appear or not appear for the 
approvers. When the budget tab appears, approvers are able to change the budget 
sourcing options. If approvers do not change the sourcing option, the system 
automatically adjusts the budget amount based on the approved amount. 

Budget approval is turned off for special price requests and approvers are able to 
source only from budgets to which they have access.
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7.6.5.3 Claims
After a sale is completed at the discounted price, the customer can submit a claim to 
collect payment. Optionally, claims can be submitted along with the sale data as a 
proof of performance through Indirect Sales. Claims are validated in Oracle Trade 
Management. Claims must be submitted in the same user organization as the one in 
which the special price request was approved.

7.6.6 Seeded Data
The following data is seeded for this functionality:

Permissions
OZF_SPECIAL_PRICING_SUPERUSER

Vendor users with this permission have view, update, approve, and DQM access to 
all requests. Partner users with this permission have view and update access to all 
requests made by their organization.

OZF_SPECIAL_PRICE_DQM

Vendor users with this permission can match a party record to a master TCA record 
or create a new party record. 

Notifications
Notification messages that you can use to communicate on changes of status are 
contained in workflow item type OZFSPBEN - 'Special Price Benefit Notifications'. 
Seeded messages in this workflow are:

■ Request Created - Channel Manager Notification

■ Request Submitted - Partner Notification

■ Request Submitted - Vendor Notification

■ Request Cancelled - Partner Notification

■ Request Declined - Partner Notification

OAM Transaction Types and Attributes
This is the transaction type used with Special Pricing:

SPECIAL_PRICE 'OZF : Special Pricing Request'

The following mandatory attributes are seeded:
Implementing Indirect Sales 7-23



Special Pricing Requests
■ ALLOW_DELETING_RULE_GENERATED_APPROVERS

■ ALLOW_REQUESTOR_APPROVAL

■ AT_LEAST_ONE_RULE_MUST_APPLY

■ EVALUATE_PRIORITIES_PER_LINE_ITEM

■ USE_RESTRICTIVE_LINE_ITEM_EVALUATION

In addition to mandatory attributes, some custom attributes are seeded:

Nonmandatory Header Attributes
ALLOW_EMPTY_APPROVAL_GROUPS: whether to allow approval groups to 
have no members

This attribute requires these approval types: approval-group chain of authority, 
post-chain-of-authority approvals, pre-chain-of-authority approvals. 

CURRENCY_CODE

END_CUSTOMER_COUNTRY

END_CUSTOMER_NAME

IS_VAD: Use to find whether the partner is a value added distributor

MEMBERSHIP_TYPE: Partner Membership Type

PARTNER_COUNTRY

PARTNER_INDUSTRY

PARTNER_LEVEL

PARTNER_NAME

PARTNER_TYPE

REQUESTED_AMOUNT

REQUEST_TYPE_CODE

SHIP_FROM_STOCK

Nonmandatory Line-Item Attributes
DISCOUNT_AMOUNT

DISCOUNT_TYPE 

PRODUCT
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REQUESTED_QUANTITY

REQUESTED_UOM

7.6.7 Security
Access to requests is controlled based on user permissions and roles.

User Permissions
Super User permission can be assigned to both vendors and partners. Vendors with 
this permission can view, update, and approve all requests. Partners with this 
permission can view and update all requests. 

Giving DQM permission enables users to clean up their request by identifying end 
customers and resellers with the master party record. DQM does not have to be 
performed for a request to get approved.

User Types
The types of users assigned in Oracle Trade Management are listed below. To assign 
Partner Superuser, Partner Request User, or Channel Manager, see the Oracle Partner 
Management Implementation Guide.

■ Vendor Superuser: Vendor users with the super user permission OZF_
SPECIAL_PRICING_SUPERUSER. Vendor users with this permission can view, 
update, approve and perform DQM on all requests.

■ Request Approver: Request approvers are defined in OAM and cannot access 
requests until an approval is required. Once access is granted, the approver can 
continue to access requests but will not have the approval privilege.

■ DQM Approver: Users with permission 'OZF_SPECIAL_PRICING_DQM. 
These users can access requests that require data maintenance.

7.7 Soft Fund Requests
Customers can request funds for specific marketing activities and thus boost sales.

When a request is submitted on behalf of a customer, it gets routed to the 
appropriate approver(s). Approvers are notified of the request and they review, 
approve, decline, or return the request. The approver can return the request asking 
the customer to provide additional information. After the customer resubmits the 
request and the request is approved, they can execute the marketing activity and 
submit a claim to redeem money from the user. When they submit a claim, it is 
Implementing Indirect Sales 7-25



Soft Fund Requests
routed to the claim approver who then validates the claim. When the claim gets 
approved, the user pays the amount.

7.7.1 Setting Up a Soft Fund as a Benefit
A soft fund can be set up as a benefit with the benefit type of Soft Funds. The fund 
can have one or many budgets and notifications associated with it. Associated 
budgets are sourced from during fund request approval.

You can set up Notifications rules to send notifications to various roles on changes 
of fund request status.

Use this procedure to create a soft fund as a benefit.

Prerequisites
None

Steps
1. Log in as the Channel Administrator responsibility and navigate to Programs > 

Benefits > Benefit Administration page.

2. Select 'Soft Funds' from the Create list of values and click Go.

3. In the Budget region, enter a default budget. 

The vendor approver will source from this budget during fund request 
approval.

4. In the Notifications region, attach a notification to the benefit. These 
notifications will be sent whenever there is any fund request activity.

5. Click Apply. The benefit is submitted.

7.7.2 Setting up Approvers in Oracle Approval Management
The first step of the approval process is to validate the information entered by a 
partner. Approvers are internal employees or vendors that are defined in Oracle 
Approval Management (AME).

When the approver receives a notification, he or she reviews the request to check if 
it is valid. If it is a valid request, the approver checks to see if the requested amount 
can be funded. 

See the Oracle Approval Management Implementation Guide for the procedure.
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7.7.3 Dependent Setups
These are the dependencies for setting up soft funds.

Setting up Expense Items
Breakdown of expenses are setup as marketing mediums in Oracle Trade 
Management. Accruals that are to be paid on approval of the partner fund are 
tracked against these marketing mediums. See Section 3.6.2, "Create Marketing 
Mediums" for the procedure.

Setting up an Activity
An Activity manages the relationship between an object’s Activity Type and the 
Marketing Medium. To create an activity, see Section 3.6.1, "Create Activities".

Setting up a Budget Category
When you create a soft fund request, you need to set up budget categories. Budget 
categories are used for:

■ Classification

■ Approval rule setups

■ General Ledger account defaults

■ Specifying multiple sets of books

To create categories for budgets, see Section 4.8, "Set Up Budget Categories".

Setting Up Budgets
Every budget belongs to a budget category. Products specified in a soft fund request 
are not validated against the products in a budget. To set up a budget for a soft 
fund, see Chapter 4, "Implementing Budgets".

Setting Up Offers
When a request is approved, a lumpsum offer is generated in the background. The 
offer is used to track the fund committed for the partner.

Vendors can:

■ Submit a claim using Oracle Trade Management by entering the request 
number.

■ Link offers associated with a fund request to a campaign schedule.
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Setting Up Claims
When working with a partner you can set up claims using a custom setup. Claim 
reasons, claim defaults, and trade profiles can be defined in Oracle Trade 
Management for soft fund management.

Custom Setup
A custom setup can be seeded for soft fund request claims. Creating different 
custom setups provides the following benefits:

■ A different prefix can be used for soft fund claims

■ Approvals can be routed differently based on this setup

■ Claim validations can be different

To create custom setups, see Section 3.6.5, "Create Custom Setups".

Claim Reasons
Partners can give specific reasons when submitting claims on special pricing 
requests. Reasons that can be seen by a partner user have to be flagged for 'Partner 
Access'. 

To set up claim reasons, see Section 6.7, "Set Up Claim Reasons".

Claim Defaults
You can set up a default custom setup, claim type and claim reason for Soft Fund 
claims. 

For the procedure, see Section 6.9.1, "Set Up Claim Defaults".

Trade Profiles
Use Trade Profiles to set up default payment methods, vendor and vendor site 
mapping for a partner. 

For this procedure, see Section 6.10, "Set Up Trade Profiles".

Setting Up Approval Rules
Approval rules determine what must be approved, by whom, and at what status. 
Approval rules for claims can be configured using multiple parameters such as 
amount, claim type, claim reason, and organization. 

To set up an approval rule for a soft fund request, see Section 3.6.9, "Create 
Approval Rules".
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Defining Performance Objectives
You must enter performance objectives for the soft fund as lookup codes in the 
OZF_PARTNER_PERFORMANCE lookup. For example, you can use Leads 
Generated, or Revenue Expected as performance objectives. See Section B.2, 
"Creating New Lookup Types" in Appendix B for the procedure. 

Geography
Geographical regions where activities using soft funds will take place are defined in 
Oracle Territory Manager. See the Oracle Territory Manager Implementation Guide for 
the procedure.

7.7.4 Interaction with Other Modules
Soft fund requests interact with other modules of Oracle Trade Management.

7.7.4.1 Offers
When a soft fund request is approved, an offer of type lumpsum is generated. All 
lumpsum offers created from soft funds use the seeded custom setup Soft Fund - 
Lumpsum.

7.7.4.2 Budgets
Budget request approval can be enabled or disabled for soft fund requests from the 
Soft Fund - Lumpsum custom setup. Approvers are able to source onlhy from 
budgets to which they have access.

7.7.4.3 Claims
After a request is approved and the customer has executed the desired activity, they 
can submit a claim to collect payment. Claims are validated in Oracle Trade 
Management. Claims must be submitted in the same vendor organization as the one 
in which the soft fund request was approved.

7.7.5 Seeded Data
The following data is seeded for this functionality:

Permission
OZF_SOFT_FUND_SUPERUSER
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Vendor users with this permission can view, update and approve all requests. 
Partner users with this permission can view and update all requests made by their 
organization.

Notifications
Notification messages that can be used to communicate changes of status are 
contained in workflow item type OZFSFBEN - 'Special Price Benefit Notifications'. 
Seeded messages in this workflow are:

■ Request Created - Channel Manager Notification

■ Request Submitted - Partner Notification

■ Request Approved - Partner Notification

■ Request Returned - Partner Notification

■ Request Cancelled - Partner Notification

■ Request Declined - Partner Notification

Offer Custom Setups
A new custom setup has been seeded for a lumpsum offer created by a soft fund 
request. The suffix defined in this offer custom setup is used as the prefix for the 
soft fund request number.

OAM Attributes
The following mandatory attributes are seeded:

■ ALLOW_DELETING_RULE_GENERATED_APPROVERS

■ ALLOW_REQUESTOR_APPROVAL

■ AT_LEAST_ONE_RULE_MUST_APPLY

■ EVALUATE_PRIORITIES_PER_LINE_ITEM

■ USE_RESTRICTIVE_LINE_ITEM_EVALUATION

In addition to mandatory attributes, some custom attributes are seeded:

Nonmandatory Header Attributes
ALLOW_EMPTY_APPROVAL_GROUPS : Whether to allow approval groups to 
have no members
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This attribute requires these approval types: approval-group chain of authority, 
post-chain-of-authority approvals, pre-chain-of-authority approvals  

CURRENCY_CODE

IS_VAD : To find whether the partner is a value added distributor

MEMBERSHIP_TYPE : Partner Membership Type

PARTNER_AMOUNT

PARTNER_COUNTRY

PARTNER_INDUSTRY

PARTNER_LEVEL

PARTNER_NAME

PARTNER_TYPE

REQUESTED_AMOUNT

SOFT_FUND_ACTIVITY

SOFT_FUND_BENEFIT

TOTAL_AMOUNT : Total Amount

Nonmandatory Line-Item Attribute
EXPENSE_ITEM

7.7.6 Security
Access to requests is controlled based on user permissions and roles. Super User 
permission can be assigned to vendors by assigning them a user type of Vendor 
Superuser with OZF_SOFT_FUND_SUPERUSER permission. Vendors with this 
permission can view, update, and approve all requests.
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System Profile Options

This chapter describes profile option settings that are required for successful 
implementation. 

Topics include: 

■ Section A.1, "Before You Begin"

■ Section A.2, "Setting Profile Options"

■ Section A.3, "Profile Options for Budgets"

■ Section A.4, "Profile Options for Trade Planning"

■ Section A.5, "Profile Options for Claims"

■ Section A.6, "Profile Options for Indirect Sales"

A.1 Before You Begin
Before making Oracle Forms settings, ensure that all Oracle Applications server 
processes are up and running. In particular, if you stopped concurrent managers 
before applying Oracle Applications patchsets, restart them now by changing to 
$COMMON_TOP/admin/scripts, and executing adcmctl.sh <APPS 
username/APPS password> start.

A.2 Setting Profile Options
Use the following procedure to set any profile option.

Steps
1. Log in to Oracle Forms with the System Administrator responsibility.
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2. Go to Profile > System.

The Find System Profile Values window opens.

3. Check the level(s) at which you want to set the profile option. The available 
levels are listed below:

■ Site: The default setting. 

■ Application: If you select this level, choose the application from the 
Application LOV for which you want to set the profile option.

■ Responsibility: If you select this level, choose the responsibility from the 
Responsibility LOV for which you want to set the profile option.

■ User: If you select this level, choose the user from the User LOV for whom 
you want to set the profile option.

4. In the Profile field, enter the profile name, such as OZF: Default Percent 
Formula, or a wildcard search criterion such as OZF%.

5. Click Find.

The System Profile Values form opens with the results of your search.

6. Verify or set the profile option(s) at the levels that you selected.

7. Field and Variable Values window, choose APPLICATION_ID from the Field 
LOV. 

The Value field in the Examine Field and Variable Values window is populated 
with the value of APPLICATION_ID.

8. In the Examine Field and Variable Values window, choose RESPONSIBILITY_
ID from the Field LOV. 

The Value field in the Examine Field and Variable Values window is populated 
with the value of RESPONSIBILITY_ID.

A.3 Profile Options for Budgets
Profile options enable an organization to configure the application to suit business 
requirements. Some profile options are required and some are optional. Most profile 
options have preset default values that you can change as needed.

To implement budgets for Trade Management, set the profiles listed in the following 
table. For the specific procedure for setting up system profile options, see 
Section A.2, "Setting Profile Options".
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Table A–1 Profile Options for Budgets

Option Required Level Setting Effect/Limitation

AMS: Currency 
Conversion Type

Yes Site Select the 
correct 
value

Used across Trade Management for default 
conversion between currencies.

 Default = Corporate.

AMS: Cut Off 
Percentage for 
Approval

No Site Enter any 
number 
(for 
percentage)

This determines what percentage of the estimated 
budget amount an object must secure in actual 
funding before the object can go active. 

For example, if you enter 100, it means 100%. An 
offer’s estimated budget amount is $10K, meaning 
that it is estimated that this offer must get budget 
approved for $10K before the offer can go active.

OZF : Allow 
committed budget 
to exceed total 
budget

No Site

Appl

Resp

User

Yes/No If set to Yes, the committed amount for a budget can 
exceed its total budget amount. 

Set it to yes if you intend to use “budget” for initial 
sourcing but do not want to impost strict control 
over its usage. In such cases, the committed amount 
serves as an estimate for how much you will spend. 
Using this profile value, a budget may become 
negative. For example, there is more money 
spent/utilized than there is available. 

If set to No, the committed amount may not exceed 
the total budget amount. Set to no if you intend to 
use budget not just for sorting but also for imposing 
financial control over budgetary usage.

OZF : Allow 
Recalculation of 
Committed 
Budget

No Site Yes/No Re-Calculated Committed is an option to 
re-calculate the necessary funding level based on the 
actual sales performance of a promotion (i.e. offer). 
Funds can be increased or decreased. If the 
promotion performs well, funding can be 
automatically increased, and vice versa. 

If set to Yes the concurrent process (for recalculate 
commit) will perform re-calculation of offers’ 
committed amounts. 

If set to No re-calculation will not be performed. 
Users are still able to see the Re-Calculated 
Committed budget column, it will simply be equal 
the Committed column.
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OZF : Budget 
Adjustment Grace 
Period in Days

No Site

Appl

Resp

User

Enter any 
integer (for 
number of 
days)

Reconciliation is a way to return the following 
money at the completion of an offer:

■ Adjusts previously committed, but unutilized 
funds, transferring them from the Committed 
column to the Available column (“Reconcile 
Un-Utilized”). 

■ Adjusts previously utilized, but un-paid funds, 
thus adjusting the Utilized column accordingly 
as well as transferring it from the Committed 
column to the Available column (“Reconcile 
Un-Utilized and Un-Paid Earnings”)

Budget reconciliation may be performed manually 
or automatically.

■ If automatic: The “OZF-TM: Release 
Committed Budget Amount After Grace Period 
concurrent program is used to reconcile 
budgets. This program waits before reconciling 
the sourced budgets of an object after the 
closing date of the object. 

■ If manual: The offer is evaluated on a case by 
case basis. Use automatic if you would like to 
systematically reconcile the budgets. 

OZF: Budget has 
Grace Period

No Site

Appl

Resp

User

Yes/No Yes indicates that budgets can have grace periods.

OZF: Create GL 
Entries for Orders

Yes Site Shipped

Invoiced

Default value is Shipped. This is used to drive when 
GL entries are made for orders related accruals in 
Trade Management. 

OZF : Default 
Budget for a 
Person

Yes Site

Appl

Resp

User

Choose a 
budget 
name from 
the list of 
available 
budgets 

During budget request for all objects, users may 
decide to source from a Budget or from a Person. 
When sourcing is made to a person, the system will 
automatically default the budget name specified on 
this profile on to the budget request. Users will be 
able to change it on screen.

Table A–1 Profile Options for Budgets

Option Required Level Setting Effect/Limitation
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OZF : Default_
Cust_View

No Site

Appl

Resp

User

Yes/No Default value is No. 

If set to Yes, a user can see the Budget Customer 
View button from the Budget summary page. 

OZF : Default 
Partner Budget

No Site

Appl

Resp

User

Choose a 
budget 
name from 
the list of 
available 
budgets

Default budget for a partner

OZF : Default 
Period in Days for 
recalculating 
committed budget

No Site

Appl

Resp

User

Enter any 
integer (for 
number of 
days)

This profile determines how often updates to 
Re-Calculated Committed are performed. Enter any 
number greater than or equal to one. 

For example: 

■ If set to 1, Re-Calculated Committed change 
after 1 day. 

■ If set to 2, Re-Calculated Committed change 
after 2 days.

OZF : Default 
value for 
incompatibility 
group

No Site

Appl

Resp

User

Choose an 
incompati
bility group 
from a list 
of available 
incompati
bility 
groups set 
up in 
Advanced 
Pricing.

Incompatibility Group is setup Advanced Pricing, it 
determines how promotions will be grouped 
together and which ones will be applied together 
with other promotions. 

A fully accrued budget creates an offer in the 
background, and that offer will by default have this 
incompatibility group, so this concerns a fully 
accrued budget. 

Users can change this defaulted value while setting 
up the fully accrued budget.

OZF : Show GL 
Accounts On 
Screen

Yes Site

User

Yes/No Default value is Yes.This determines if Oracle 
General Ledger account numbers and dates are 
displayed on the following screens:

■ System Parameters

■ Budget Category Setup

■ Budgets

■ Claim Type Setup

■ GL Date on Claim Settlement

Table A–1 Profile Options for Budgets

Option Required Level Setting Effect/Limitation
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A.4 Profile Options for Trade Planning
The following table lists and describes the system profile options that must be set 
for Trade Planning to function properly. Select the settings that meet your business 
requirements. Most offers, except for lump sum and trade deals) leverage Advanced 
Pricing. 

OZF : Source from 
Parent Object

No Site Yes/No This applies to the following objects:

■ Offers

■ Campaign Schedule

■ Event Schedule

If set to Yes, objects may only source from their 
parent objects. For example, for an offer and a 
campaign schedule, the parent is a campaign; for an 
Event schedule, the parent may be an Event. 

If set to No the schedule sources funds directly from 
a budget.

OZF : Universal 
Currency for 
Budget Rollup 
View

Yes Site Choose any 
valid 
currency 
from a list 
of available 
currencies 

This profile determines the currency for the rollup 
view. It allows the rollup view of a budget to display 
correctly by converting all entries to a single 
currency. 

Different users will, however, be able to see the 
Rollup View in different currencies based on the 
user level profile option JTF_PROFILE_DEFAULT_
CURRENCY. (In other words, the universal currency 
profile is simply for storage in the background).

Once set the profile should not be changed. 

OZF : Validate 
market and 
product eligibility 
between object 
and budget

No Site

Respon-
sibility

Choose a 
value.

Values are:

No validation for customers and products.

Validate customer and products by each budget.

Validate customer by each budget, product by all 
budgets.

Validate product by each budget, customer by all 
budgets.

See Section 4.12, "Set Up Budget-Offer Validation" 
for more information.

Table A–1 Profile Options for Budgets

Option Required Level Setting Effect/Limitation
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For the specific procedure for setting up system profile options, see Section A.2, 
"Setting Profile Options".

Table A–2 Profile Options for Trade Planning

Profile Option Required Level Setting Effect/Limitation

OZF: Currency 
Conversion Type

Yes Site Select the 
correct 
value

Used across Trade Management for default 
conversion between currencies.

 Default = Corporate.

OZF: Currency for 
Quota Allocation

No Site Select the 
correct 
currency

Required to perform quota allocations based on a 
territory hierarchy.

Default = USD.

OZF: Days from 
Offer End Date to 
start auto payment

Yes Site Numeric 
value

This value will be used to determine when an offer 
can be considered for automatic payment.

OZF: Default 
Amount Formula

Yes Site Formula 
support-
ed in 
Advanced 
Pricing

Sets the default formula for a discount rule where 
Discount Type = Amount.

OZF : Default 
Bucket for discount 
rules

Yes All A value 
from 
Advanced 
Pricing 
Lookup 
PRICING
_GROUP_
SE-
QUENCE

The default value for the discount rule default 
bucket.

Pricing buckets determine whether multiple offers 
and Advanced Pricing modifiers cascade from one 
another.

Example: Product A regularly sells for $100. Two 
offers are created in Trade Management. One gives a 
10% discount; the other a 15% accrual. How these 
offers are calculated in regard to the base price of 
$100 is based on this profile option setting. For 
example, the accrual could be calculated based on 
the net price of $90 (net of the discount offer).

OZF : Default 
Forecast UOM

No All One of the 
available 
UOMs

The default unit of measure (UOM) displayed on the 
Forecast page.
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OZF: Default Offer 
Formula

No All A pricing 
formula in 
Advanced 
Pricing

The value selected here will be defaulted on offers 
created in Trade Management. An example of using 
a pricing formula is to handle discount rules for 
product categories when the unit of measure is not 
specified.

Handles discount rules for product categories when 
the unit of measure is not specified.

OZF: Default 
Percent Formula

Yes Site A formula 
supported 
in 
Advanced 
Pricing

Sets the default formula for a discount rule where 
Discount Type = Percent. For example, if the value is 
set to Handling, then when changing the Discount 
Type to Percent the value of formula is set to 
Handling.

OZF : Default phase 
for Line Group level 
discounts

Yes All A value 
derived 
from 
Event 
phase 
setup in 
Advanced 
Pricing

The default value for phase for all discount rules 
with a discount level of Group of Lines.

Please see OZF : Default phase for Line level 
discounts above for a description of phase.

OZF : Default phase 
for Line level 
discounts

Yes All A value 
derived 
from 
Event 
phase 
setup in 
Advanced 
Pricing

The default value for phase for all discount rules 
with a Line discount level.

The phase in Advanced Pricing determines the 
timing of when offers and other modifiers apply, e.g. 
whether they apply during order booking or 
shipping. This option also determines how to resolve 
multiple conflicting offers or modifiers, e.g. by a 
better price or by precedence.

OZF : Default phase 
for Order level 
discounts

Yes All A value 
derived 
from 
Event 
phase 
setup in 
Advanced 
Pricing

The default value for phase for all discount rules 
with a discount level of Order

Please see OZF : Default phase for Line level 
discounts above for a description of phase.

OZF: Default Price 
List used for ROI 
Calculation

Yes All Valid 
price list 
defined in 
the system

The value specified here will be used in calculating 
the default Return on Investment for a given offer 
forecast.

Table A–2 Profile Options for Trade Planning

Profile Option Required Level Setting Effect/Limitation
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OZF: Default Team 
for Offers

No All Any 
available 
user role

All offers will be accessible by all the members of 
this team.

OZF: Default value 
for incompatibility 
group

No All A list of 
available 
incompat-
ibility 
groups set 
up in 
Advanced 
Pricing

Incompatibility Group is set up in Advanced Pricing. 
It determines how promotions will be grouped 
together and which ones will be applied together 
with other promotions. 

A fully accrued budget creates an offer in the 
background, and the offer will by default have this 
incompatibility group, so this concerns a fully 
accrued budget. 

Users can change this defaulted value while setting 
up the fully accrued budget.

OZF : Default value 
for print on invoice 
flag

Yes Site Yes or No The default for all discount rules.

OZF : Default value 
for product 
precedence

Yes All User 
defined

The default for all discount rules.

Precedence is one of the criteria that can be used to 
determine which offers or modifiers are to be used 
when there are conflicts.

OZF : Offer 
Confidential Flag

No All Yes or No Y = Confidential is selected by default.

The default value for the Confidential check box on 
the Create Offer page. Default setting can be 
overridden. Offers marked as confidential are not 
visible to users who are not allowed to update offers. 
Users who can update offers see the offer in the 
summary screen but cannot update it.

OZF : Offer 
Discount Level

Yes All Line

Group of 
Lines

The default value for offer discount level. 

Example: if set to Line, and minimum volume is 5, 
then each order line must have a minimum quantity 
of five to get a discount.

If set to Group of Lines, then multiple order lines 
with the same product will be evaluated together to 
determine whether the offer applies to the order.

OZF: Offer Override 
Flag in QP

Yes Site Yes or No This flag specifies if offer overriding is allowed in 
Advanced Pricing.

Table A–2 Profile Options for Trade Planning

Profile Option Required Level Setting Effect/Limitation
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OZF : Override offer 
performance 
requirement

Yes All Yes or No Determines if Offer performance requirements can 
be overridden. Applies for all the performance rules 
specified as mandatory for an Offer.

OZF: Process Net 
Accrual In Batch 
Mode

Yes Site Yes or No Default value is No. This profile determines if the 
Net Accrual Engine should generate accruals once 
for every time the program is run or for each 
transaction.

OZF : Relationship 
Type for Buying 
Group

Yes Site Any valid 
relation-
ship type 
created in 
TCA

Establishes a hierarchical group of customers in 
Trading Community Architure (TCA). For example, 
if value is set to subsidiaries then all parties who 
share this relationship are part of a buying group. 
Used as a qualification criteria for offers.

OZF : Scan Data 
UOM

Yes All One of the 
available 
UOMs

The default UOM value for discount rules for Scan 
Data offers. For example, if you choose Each, then all 
empty discount rules in Scan Data offers will display 
the UOM of Each.

OZF: Source from 
Parent Object

Yes Site Yes or No This applies to the following objects:

■ Offers

■ Campaign Schedule

■ Event Schedule

If set to Yes, objects may only source from their 
parent objects. For example, for an offer and a 
campaign schedule, the parent is a campaign; for an 
Event schedule, the parent may be an Event or a 
campaign. 

If set to No the schedule sources funds directly from 
a budget.

OZF : Store Date in 
Qualifiers

Yes Site Yes or No Specifies the location to store date qualifiers in offers. 
If set to Yes, the date qualifier (for example, shipping 
date) is stored in the qualifier. If set to No, the date 
qualifier is stored in the header. 

OZF: Unit Of 
Measure for Quota 
Allocation

Yes Site Set 
appropri-
ate value

Required to perform quota allocations based on a 
territory hierarchy.

Select the appropriate value. Default = Each.

All automatic currency conversions use the rates 
defined in the conversion type entered in this profile.

Table A–2 Profile Options for Trade Planning

Profile Option Required Level Setting Effect/Limitation
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OZF : Validate 
market and product 
eligibility between 
object and budget

No Site

Resp

Set value 
(see right)

Values are:

No validation for customers and products.

Validate customer and products by each budget.

Validate customer by each budget, product by all 
budgets.

Validate product by each budget, customer by all 
budgets.

See Section 5.10, "Set Up Budget-Offer Validation" 
for more information.

QP : Accrual UOM 
Class

Yes Site UOM 
classes as 
set up in 
Oracle 
Inventory

Used by accrual offers. All accrual units fall under 
this UOM class (for example, frequent flyer miles).

QP : Item Validation 
Organization

Yes Site

Resp

Inventory 
organiza-
tions as 
set up in 
Inventory

Default value: Blank

Set this profile by site or responsibility to an 
organization at the level in your organization 
hierarchy where prices can be set for items.

Indicates to the Oracle Manufacturing organization 
that items are validated and viewed against when 
entering items in the price list or Offer windows.

Values are all inventory master organizations 
currently defined to Oracle.

This profile option is visible and can be updated at 
the site and responsibility levels.

QP : Source System 
Code

No Appl One of the 
Source 
Systems 
that can 
define 
offers

Offers created using this relationship are tagged with 
this system source code and are used to determine 
update privileges of offers within the pricing 
module.

If Source System Code = Advanced Pricing, then 
offers can be edited in Oracle Advanced Pricing.

If Source System Code = Oracle Marketing, then 
offers cannot be edited in Advanced Pricing.

Table A–2 Profile Options for Trade Planning

Profile Option Required Level Setting Effect/Limitation
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A.5 Profile Options for Claims
The following table lists and describes the system profile options that must be set 
for Claims to function properly. Select the settings that meet your business 
requirements. 

For the specific procedure for setting up system profile options, see Section A.2, 
"Setting Profile Options".

Table A–3 System Profiles for Claims

Option Required Level Setting Effect/Limitation

OZF : Allow 
Un-Related Ship To On 
Claims

No Site Yes/No Yes = the ship to site can be un-related to the 
bill to site. Order Management and Oracle 
Receivables both allow this. Since TM 
integrates closely with these two, a similar 
profile option is provided.

OZF : AR Credit 
Method For 
Installment

Yes Site 

Resp

Credit 
method 
values 
from AR

Determines which revenue and transaction line 
balances will be impacted when TM creates an 
invoice credit to settle a deduction. The 
selections are passed to Oracle Receivables.

OZF : AR Credit 
Method For Rule

Yes Site

Resp

Credit 
method 
values 
from AR

Determines which revenue and transaction line 
balances will be impacted when TM creates an 
invoice credit to settle a deduction. The 
selections are passed to Oracle Receivables.

OZF : Claim Update 
Access

No Site

User

Yes/No Yes = non-claim owners AND non-claim team 
members can update and view claims.

No = non-claim owners AND non-claim team 
members can view claims only.

OZF : Claim Write Off 
Threshold

No Site

Appl

Resp

User

Amount The difference between the total and the 
settlement value returned from Oracle 
Receivables. For an invoice-related deduction, 
if the difference (claim amount less the Oracle 
Receivables credit memo amount) is less than 
the write off threshold, TM automatically 
creates a write off claim line and creates a 
negative adjustment to the invoice.

OZF: Derive accrual 
account during claim 
settlement

Yes Site Yes/No Determines whether the workflow background 
process is required to run for carrying out 
promotional claim settlement. If set to Yes, 
users need to run the process to populating 
interface tables in Oracle Receivables. Is set to 
No, they do not need to. The default is No.
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A.6 Profile Options for Indirect Sales
Set the following profile options for Indirect Sales.

OZF : Implement 
Contra Charge 
Payment Method

Yes Site Yes/No Yes = contra charge settlement method is 
available. Contra charges are used to track 
offsetting balances for creditors who are also 
debtors.

OZF : Implement 
Payables Integrations

Yes Site

Appl

Resp

User

Yes/No Yes = settlement by check is available in Trade 
Management.

No - settlement by check is not available in 
Trade Management.

OZF: Select write off 
activity based on GL 
balancing segment.

No Site Yes/No This option allows users to filter receivable 
write off activity based on the Oracle General 
Ledger balancing segment selected when 
defining claim types.

OZF : Show GL 
Accounts on Screen 

No Site

Appl

Resp

User

Yes/No Yes = Oracle General Ledger account numbers 
are displayed.

OZF : Under Write Off 
Threshold Approval 
Required

No Y/N Y = approval required as dictated by custom 
setup.

N = approval not required even if dictated by 
custom setup.

Table A–4 System Profiles for Indirect Sales

Option Required Level Setting Effect/Limitation

OZF: Allow Tolerance 
Override

No Site

Appl

Yes/No Used to indicate whether the tolerance can 
be overwritten during the process.

OZF: Chargeback 
Budget

Yes Site

Appl

List of active 
fixed budgets

Used with chargebacks.

OZF: Common 
Currency

Yes Site

Appl

Lists of 
currencies

Sets a common currency for use in inventory 
tracking.

Table A–3 System Profiles for Claims

Option Required Level Setting Effect/Limitation
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OZF: Common UOM Yes Site

Appl

List of Unit 
Of Measures

Sets a common unit of measure for inventory 
tracking.

OZF: Currency 
Conversion Type 

Yes Site Corporate Sets the type of currency conversion. It is 
used in inventory tracking.

OZF: Default benefit 
for soft funds

No Site List of soft 
fund benefits

Used to set up the default benefit for soft 
fund requests.

OZF: Default budget 
for special pricing

No Site List of active 
fixed budgets

Budget from this profile is used to create the 
budget request on submission of a special 
price request.

OZF: Default soft fund 
request approver

No Site List of 
internal 
employees

Request is sent to this default approver 
when Oracle Approval Management does 
not find any rule that matches the special 
pricing request criteria.

OZF: Default Special 
Pricing Request 
Approver

No Site List of 
internal 
employees

Request is sent to this default approver 
when Oracle Approvals Manager does not 
find any rule that matches the special pricing 
request criteria.

OZF: Event for Pricing 
Simulation

No Site

Appl

BATCH

BOOK

SHIP

Indicates which price phase third party 
should simulate. 

OZF: Global Start Date 
(mm/dd/yyyy)

Yes Site Enter date Sets the start date for the manufacturer to 
track wholesalers’ inventory.

OZF: Item Validation 
Master Organization

Yes Site

Appl

List of 
Inventory 
Organizations

Indicates the current org_id of the products 
that are found.

OZF: Match Rule for 
Address Search Resale 
Contact

Yes Site List of DQM 
rules for 
Contact 
match

Used to find the master contact record for 
the reseller and end customer names 
submitted by partners when submitting a 
special price request.

OZF: Match Rule for 
Address Search Resale 
Party

Yes Site List of DQM 
rules for 
Party match

Used to find the master party record for the 
reseller and end customer names submitted 
by partners when submitting a special price 
request.

OZF: Match Rule for 
Address Search Resale 
party Site

Yes Site List of DQM 
rules for Site 
match

Used to find the master site record for the 
reseller and end customer names submitted 
by partners when submitting a special price 
request.

Table A–4 System Profiles for Indirect Sales

Option Required Level Setting Effect/Limitation
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OZF: Price Difference 
Budget

Only 
with 
Third 
Party 
Accrual

Site

Appl

Y/N Used only with third party accrual. Set to Y 
if you want to rebate the difference when a 
third party customer purchases from a 
wholesaler at a higher price when you are 
unable to fill an order for the third party.

OZF: Request grace 
period in days for soft 
funds

No Site Numeric Used to set up grace days to close soft fund 
requests. Default is 0 if not set.

OZF: Request grace 
period in days for 
special pricing

No Site Numeric Used to set up grace days to close soft fund 
requests. Default is 0 if not set.

OZF: Third Party 
Accrual Price List

Yes Site

Appl

List of 
available 
price lists

Used to set a price list for third party accrual.

OZF: Third Party 
Accrual on Selling 
Price

No Site

Appl

Yes/No Sets whether you want the third party 
accrual calculation to be based on the selling 
price. The default value is No, which means 
that the calculation is based on list price.

Application 
Framework Agent

Yes Appl Enter URL Used to construct the return url, which is 
passed to the Web.

Apps Servlet Agent Yes Appl Enter URL Used to construct the return url, which is 
passed to the Web.

ICX: HTML directory Yes Appl Directory 
name

Used to construct the return url, which is 
passed to the Web.

Table A–4 System Profiles for Indirect Sales

Option Required Level Setting Effect/Limitation
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Lookups

This chapter describes all of the lookup values and settings that are required for 
successful implementation of Oracle Trade Management. Lookups that relate to 
specific areas of Trade Management, such as Budgets or Offers, are listed in the 
individual chapters. 

Topics include:

■ Section B.1, "Understanding Lookups"

■ Section B.2, "Creating New Lookup Types"

■ Section B.3, "Lookups for Budgets"

■ Section B.4, "Lookups for Trade Planning"

■ Section B.5, "Lookups for Claims"

■ Section B.6, "Lookups for Indirect Sales"
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Understanding Lookups
B.1 Understanding Lookups
Lookups supply the content of many of the lists of values (LOVs) in the Oracle 
Trade Management user interface. Most lookups are predefined (seeded in the 
application). The seeded values can be left as is, or you can customize them to fit 
your business needs. Lookup values make choosing information quick and easy, 
they ensure that users enter only valid data into Oracle Trade Management.

You can add new lookup values at any time. You can set the Enable flag for a value 
to No, so that the value no longer appears in the list of values, or you can use the 
start date and end date to control when a value will appear in a list. 

B.2 Creating New Lookup Types
To create a new lookup type, add values to an existing lookup type, or prevent 
existing values from appearing in a lookup type, use the Application Utilities 
Lookups window. You must log out and log in again to see the effect of your 
changes. 

To define a new lookup type and lookup value, use the following procedure:

Prerequisites
None

Steps
1. Log in to Oracle Forms with System Administrator Responsibility.

2. Navigate to Application > Lookups. 

3. Choose the access level for the lookup type.

4. Enter the lookup type.

5. Enter the user name of the lookup. This is the name that users will see from 
within the application.

6. Select the application in which the lookup will be used.

7. Optionally, add a description of the lookup type.

8. If you want to add lookup values specific to the security group/business group 
linked to your current responsibility, un–check the Global Security Group check 
box. Existing lookup values are available to all business groups.
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9. Enter the code, meaning and optionally a description for each value. Leave the 
Tag column blank.

10. If you do not enter a start date, the new lookup is valid immediately. If you do 
not enter an end date, the new lookup is valid indefinitely.

11. Save your work.

B.2.1 Adding Values to an Existing Lookup
To add a new value to an existing Lookup use the following procedure:

Prerequisites
None

Steps
1. Query the lookup type to which you want to add a value.

You cannot add values if the access level is System.

2. If you want to add lookup values specific to the security group/business group 
linked to your current responsibility, un–check the Global Security Group check 
box. Existing lookup values are available to all business groups.

3. Enter the code, meaning and optionally a description for each value. Leave the 
Tag column blank.

4. If you do not enter a start date, the new lookup is valid immediately. If you do 
not enter an end date, the new lookup is valid indefinitely.

5. Save your work. 

B.3 Lookups for Budgets
For Trade Planning and Offers, create or verify the following lookup settings. For 
steps of this procedure, see Section B.2, "Creating New Lookup Types".
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Table B–1 Lookups for Budgets

Key Type Values Meanings

OZF_ACCOUNTING_
METHOD

System ACCRUAL

CASH_BASIS

Accrual 

Cash Basis

These Lookups are the available values for 
Accounting Methods in the System 
Parameters page. The majority of the time this 
will be selected as Accrual. 

OZF_ ACCRUAL_ BASIS System CUSTOMER

SALES

Customer

Sales

This lookup is the value for Fully Accrued 
Budget’s Accrue To selection. Changing the 
meaning here will change the display of the 
values on screen.

OZF_ACCRUAL_PHASE System ACCRUAL

VOLUME

Accrual Per Order

Cumulative Order Volume.

These Lookups are the Available selections 
for Accrual Basis when defining a fully 
accrued Budget. Changing the meaning here 
will change the display of the values on 
screen. For example, you may change the 
meaning from “Cumulative Order Volume” 
to “Volume Offer”, and when you need to 
select this on a fully accrued budget, the 
value will be displayed as “Volume Offer”. 
Lookups B-5



Lookups for Budgets
OZF_ ADJUSTMENT_
TYPE

Extensible DECREASE_
COMMITTED

DECREASE_
COMM_EARNED 

DECREASE_
EARNED

INCREASE_
COMMITTED

INCREASE_
COMM_EARNED

RECALCULATE_
COMMITTED

STANDARD

UTILIZATION

Decrease Committed Amount

Decrease Committed and Earned Amounts

Decrease Earned Amount

Increase Earned Amount

Increase Commitment

Increase Committed and Earned Amounts

Recalculate Committed

Standard (Increase Earned)

Utilization for adjusted offer

These Lookups are used for: 

■ Manual budget adjustments: Decrease 
Committed, Decrease Committed and 
Earned, Decrease Earned, Increase 
Earned or called Standard. Changing the 
meaning of these will change the display 
of the values on the budget’s Adjustment 
screen.

■ Budget request: Request

■ Budget transfer: Transfer

■ Systematic budget adjustments used for 
scan data offers: Increase Earned, 
Increase Committed and Earned).

OZF_BUDGETOFFR_
VALIDATION_TYPE

System NO

PRODUCT_
LOOSE_
CUSTOMER_
STRICT

PRODUCT_ 
STRICT_
CUSTOMER_ 
LOOSE

PRODUCT_
STRICT_
CUSTOMER_
STRICT

No

Product loose, customer strict

Product strict, customer loose

Product strict, customer strict

These are validation types for Offer Budget 
Validation.

Table B–1 Lookups for Budgets

Key Type Values Meanings
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Lookups for Budgets
OZF_ BUDGETSOURCE_ 
STATUS

System APPROVED

CLOSED

NEW

PENDING

PENDING_
VALIDATION

REJECTED

Approved

Closed

Planning

Pending

Pending Validation

Rejected

This lookup creates different statuses of a 
budget request.

OZF_FUND_ALLOC_
ACTION

System CREATE_NEW_
BUDGET

TRANSFER_TO_
BUDGET

Create New Budget from this Allocation

Add on to Existing Budget Hierarchy

Lookup values here are the Available values 
for Budget Allocation purpose. Create New 
Budget from this Allocation means that the 
budget allocation will create sub-budgets; 
Add on to Existing Budget Hierarchy means 
that the allocation will simply add budget 
amounts to the existing sub-budgets. 
Changing the meaning here will change the 
display of these two Actions on the budget 
Allocation screen).

OZF_FUND_ALLOC_
HIERTYPE

System BUDGET_HIER

TERRITORY

Budget Hierarchy

Territory

These Lookups are the Values used when 
allocating budget. 

OZF_FUND_ALLOC_
METHOD

System EVEN

MANUAL

PRIOR_SALES_
TOTAL

Even Distribution

Manual

Prior Year Sales Total in Amount

These Lookups are the Available values for 
budget Allocation Method.

Table B–1 Lookups for Budgets

Key Type Values Meanings
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OZF_FUND_ALLOC_
STATUS

System ACTIVE

CANCELLED

NEW

PLANNED

REJECTED

SUBMITTED

Active

Cancelled

New

Planned

Rejected

Submitted

These Lookups are the Available values for 
budget Allocation statuses. This is different 
from budget status.

OZF_FUND_ALLOC_TYPE System DISTRIBUTING

RECEIVING

Distributing

Receiving

This Lookup is used for budget Allocation 
purpose. With top down bottoms up 
budgeting, both a user allocating/distributing 
the budget and a user receiving the allocation 
will see a budget worksheet. Distributing 
indicates the user is looking at an allocation 
he created; Receiving indicates the user is 
looking at an allocation he received. These 
values appear on the Allocation Summary 
screen and are not editable. Changing the 
meaning here will change the display of 
them. 

Table B–1 Lookups for Budgets

Key Type Values Meanings
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OZF_FUND_ALLOC_
USERACTION

System APPROVE_
ALLRECOMM

APPROVE_
ALLREQUESTS

APPROVE_
RECOMM

APPROVE_
REQUEST

REQUIRE_
RESUBMIT

Approve All Recommended

Approve All Requests

Approve Recommended

Approve Request

Require to re-submit

These Lookups are values used for the actions 
that users can take during the top down 
bottoms up budgeting process. 
Recommended amounts are the budget 
amounts recommended on a “top down” 
basis. Requested amounts are the budget 
amounts submitted on a “bottoms up” basis. 
After some rounds of edits, an allocator can 
then decide which budget numbers to 
approve, or if he wants to ask his child 
territories to re-submit their requests. The 
lookup values here are used for such actions. 

OZF_FUND_ SOURCE System CAMP

CSCH

DELV

EONE

EVEH

EVEO

FUND

OFFR

PTNR

OPTN

PRIC

SOFTFUND

SPECIAL_PRICE

VEND

USER

Campaign

Campaign Schedule

Deliverable

One Off Event

Event

Event Schedule

Budget

Offer

Partner

Other Partner

Price List

Soft Fund Request

Special Pricing Request

Vendor

Person

Table B–1 Lookups for Budgets

Key Type Values Meanings
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OZF_FUND_ STATUS System ACTIVE

ARCHIVED

CANCELLED

CLOSED

DRAFT

ON_HOLD

PENDING

REJECTED

Active

Archived

Cancelled

Closed

Draft

On Hold

Pending Approval

Rejected

OZF_FUND_ TYPE System FIXED

FULLY_
ACCRUED

QUOTA

Fixed

Fully accrued

Quota

This lookup is the Available Type values for 
creating a budget. Changing the meaning of 
this lookup will change the display of these 
values on the budget creation screen. 

For example, you may change “Fully 
Accrued” to “Live Funds”, in this cae, in the 
screen you will see that while creating a 
budget and selecting a type.

OZF_OBJECT_ CLASS System ORDER

ORDER_LINE

INVOICE

Order

Order Line

Invoice

OZF_ORDER_GLPOST_
PHASE

System INVOICED

SHIPPED

Invoiced

Shipped

The Order Line Phase to create GL entries.

OZF_ PARTNER_ 
HOLDING_ TYPE

(Holding Owner)

System PTNR

VEND

Partner

Vendor

Only used when Oracle Partner Management 
is implemented.

OZF_ PRODUCT_ LEVEL System PRODUCT

FAMILY

Item Number

Item Category

Table B–1 Lookups for Budgets

Key Type Values Meanings
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Lookups for Budgets
OZF_QP_ ARITHMETIC_ 
OPERATOR

System %

AMT

LUMPSUM

NEWPRICE

Percent

Amount

Lumpsum

NewPrice

OZF_TRANSFER_REASON User SOURCING Initial Sourcing

This Lookup determines the list of values 
available on any Budget Request screen. 

OZF_ TRANSFER_ TYPE Extensible RELEASE

RESERVE

TRANSFER

REQUEST

UTILIZED

Release

Reserve

Transfer

Request

Utilized

OZF_UTILIZATION_TYPE System ACCRUAL

ADJUSTMENT

CHARGEBACK

LEAD_ACCRUAL

LEAD_
ADJUSTMENT

REQUEST

SALES_
ACCRUAL

TRANSFER

UTILIZED

Accrual: Used to identify accruals.

Adjustment: Used for budget adjustments. 

Chargeback

Lead Referral Accrual

Lead Referral Adjustment

Budget Request: Used to identify budget 
requests. 

Sales Accruals

Budget Transfer: Used to identify budget 
transfers.

Budget Utilized: Used to identify utilization; 
different from accrual in that this identifies 
either off invoice type of discount offers or 
campaign/offer’s cost postings to budget. 

These Lookups are the different “Type” 
values for the budget Committed and 
Utilized columns. Changing the meaning here 
will change the display of these values in the 
budget checkbooks and cells.

Table B–1 Lookups for Budgets

Key Type Values Meanings
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Lookups for Trade Planning
B.4 Lookups for Trade Planning
Lookups supply the content of many of the lists of values (LOVs) in the Oracle 
Trade Management user interface. Most lookups are predefined (seeded in the 
application). The seeded values can be left as is, or you can customize them to fit 
your business needs. Lookup values make choosing information quick and easy, 
they ensure that users enter only valid data into Oracle Trade Management.

For Trade Planning, create or verify the following lookup settings. For steps of this 
procedure, see Section B.2, "Creating New Lookup Types".

OZF_VALUE_ LIMIT Extensible BALANCE

COMMITTED

EARNED

PAID

PLANNED

RECOMMITTED

UTILIZED

Balance

Committed

Earned

Paid

Planned

Re-Committed

Utilized

Table B–2 Trade Planning Lookups

Key Type Values Meanings

OZF_ACCRUAL_BASIS System CUSTOMER

SALES

Customer

Sales

OZF_ACCRUAL_OPERAND System PERCENTAGE Percentage

OZF_ARITHMETIC_OPERATOR System %

AMT

Percent

Amount

OZF_DENORM_QUERY_FOR System ELIG

PROD

Market Eligibility

Product Eligibility

OZF_FCAST_BASE_VOL_SOURCE System CUSTOM_
DATE_RANGE

LAST_YEAR_
SAME_PERIOD

OFFER_CODE

Custom date range

Last year same period

Offer code

Table B–1 Lookups for Budgets

Key Type Values Meanings
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OZF_FCAST_PERIOD_VIEW System PERIOD

QUARTER

YEAR

Period

Quarter

Year

OZF_FCAST_PERIOD_VIEW_TYPE System 1

16

32

64

128

Day

Week

Month

Quarter

Year

OZF_FCAST_SPREAD System ACROSS_ALL_
EVENLY

BASELINE_
RATIO

BUY_GET_
RATIO

Across All Evenly

Baseline Ratio

Buy - Get Ratio

OZF_LUMPSUM_DISTRIBUTION_TYPE System %

AMT

QTY

Percent

Amount

Quantity

OZF_MODIFIER_LEVEL_CODE System LINE

LINEGROUP

Line

Group of Lines

OZF_NA_AR_TXN_TYPE System CM

DM

Credit Memo

Debit Memo

OZF_NA_ARITHMETIC_OPERATOR System %

AMT

Percent

Amount

OZF_NA_OM_TXN_TYPE System OM_TXN OM Transaction

OZF_NA_TIER_LEVEL System HEADER

LINE

Offer

Product

OZF_NA_TIER_TYPE System DIS Single

OZF_NA_TM_TXN_TYPE System OFFR Offer

Table B–2 Trade Planning Lookups

Key Type Values Meanings
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Lookups for Trade Planning
OZF_NA_TXN_SRC System AR

OM

TM

Accounts Receivable

Order Management

Trade Management

OZF_OFFER_ADJUST_STATUS System ACTIVE

CANCELLED

CLOSED

DRAFT

PENDING

REJECTED

TERMINATED

Active

Cancelled

Closed

Draft

Pending Approval

Rejected

Terminated

OZF_OFFER_BREAK_TYPE System POINT

RECURRING

Point

Recurring

OZF_OFFER_DATE_QUALIFIER System QUALIFIER_
ATTRIBUTE1

QUALIFIER_
ATTRIBUTE17

QUALIFIER_
ATTRIBUTE18

Order Date

Request Date

Shipped Date

OZF_OFFER_ DEAL_ CUSTOMER_ TYPES System BUYER

CUSTOMER

CUSTOMER_
BILL_TO

LIST

SEGMENT

SHIP_TO

TERRITORY

Buying Group

Customer Name

Customer - Bill To

List

Segment

Customer - Ship To

Territories

OZF_OFFER_LUMP_CUST_ TYPES System BUYER

CUSTOMER

Buying Group

Customer

OZF_OFFER_ LUMPSUM_ PAYMENT System ACCRUE

CHECK

Accrue

Issue Check

Table B–2 Trade Planning Lookups

Key Type Values Meanings
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OZF_OFFER_OV_DISCOUNT_TYPE System DIS

TSN

Percent

Terms Upgrade

OZF_OFFER_ STATUS System ACTIVE

ARCHIVED

CANCELLED

CLOSED

COMPLETED

DENIED_TA

DRAFT

FAILED

ONHOLD

PENDING

PENDING_
ACTIVE

PENDING_
VALIDATION

PLANNING

REJECTED

SUBMITTED_
TA

TERMINATED

Active

Archived

Cancelled

Closed

Completed

Rejected - Theme Approval

Draft

Validation Failed

On Hold

Pending Budget Approval

Pending Active

Pending Validation

Planning

Budget Rejected

Submitted - Theme Approval

Terminated

OZF_OFFER_TIER_TYPE System DIS

PHB

Single

Multiple

Table B–2 Trade Planning Lookups

Key Type Values Meanings
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OZF_OFFER_ TYPE System ACCRUAL

DEAL

OID

LUMPSUM

NET_
ACCRUAL

OFF_INVOICE

ORDER

SCAN_DATA

TERMS

VOLUME_
OFFER

Accruals

Trade Deal

Promotional Goods

Lump Sum

Net Accrual

Off Invoice

Order Value

Scan Data

Terms Upgrade

Volume Offer

OZF_OFFR_PERF_REQ_TYPE System AMOUNT

VOLUME

Amount

Quantity

OZF_PERFORMANCE_UOM System AMOUNT

NUMBER

Amount

Number

OZF_PRODUCT_LEVEL System FAMILY

PRODUCT

Item Category

Item Number

OZF_QP_ ARITHMETIC _OPERATOR System %

AMT

LUMPSUM

NEWPRICE

Percent

Amount

Lump Sum

New Price

OZF_QP_ VOLUME_ TYPE System PRICING_
ATTRIBUTE10

PRICING_
ATTRIBUTE12

Quantity

Amount

OZF_QUOTA_ALERT_TYPE System ACCEPTABLE

UNACCEPT-
ABLE

WARNING

Unacceptable

Not Acceptable

Warning

OZF_QUOTA_ALLOC_ACTION System CREATE_NEW_
BUDGET

Create New Quota from this 
Allocation

Table B–2 Trade Planning Lookups

Key Type Values Meanings
B-16 Oracle Trade Management Implementation Guide



Lookups for Trade Planning
OZF_QUOTA_BASE_LINE System LYSP_SALES

MONTHLY_
QUOTA

PRIOR_YEAR_
SALES

QUARTERLY_
QUOTA

YEARLY_
QUOTA

LYSP Sales

Monthly Quota

Prior Year Sales

Quarterly Quota

Yearly Quota

OZF_QUOTA_COMPAR_TYPE System CONSTANT

PERCENT

Constant

Percent

OZF_QUOTA_VALUE_LIMIT System BACK_ORDERS

MTD

OUTSTAND-
ING_ORDERS

QTD

YTD

Back Orders

MTD Sales

Outstanding Orders

QTD Sales

YTD Sales

OZF_ROI_VIEW System FCST_
ACTUALS_ROI

FORECAST_
ROI

Forecast vs Actuals

Forecast

OZF_SD_CUSTOMER_TYPES System Buying Group

Customer

Buying Group

Customer

OZF_TP_ACCOUNT_TYPES System BILL_TO

PARTY

SHIP_TO

ALL

CSCH

OFFR

Bill To

Party

Ship To

All

Schedule

Offer

OZF_TP_ARITHMETIC_OPERATOR System %

AMT

Percent

Amount

Table B–2 Trade Planning Lookups

Key Type Values Meanings
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Lookups for Claims
B.5 Lookups for Claims
Lookups supply the content of many of the lists of values (LOVs) in the Oracle 
Trade Management user interface. Most lookups are predefined (seeded in the 
application). The seeded values can be left as is, or you can customize them to fit 
your business needs. Lookup values make choosing information quick and easy, 
they ensure that users enter only valid data into Oracle Trade Management.

For Claims, create or verify the following lookup settings. For steps of this 
procedure, see Section B.2, "Creating New Lookup Types".

OZF_TP_PRODUCT_LEVEL System PRICING_
ATTRIBUTE1

PRICING_
ATTRIBUTE2

Item

Category

OZF_TP_TIME_SPREAD System 1

16

32

64

128

Day

Week

Month

Quarter

Year

OZF_VO_ARITHMETIC_OPERATOR System %

AMT

Percent

Amount

OZF_VO_CUSTOMER_TYPES System Buying Group

Customer - Ship 
To

Customer - Bill 
To

Buying Group

Customer - Ship To

Customer - Bill To

Customer Name

OZF_VOLUME_OFFER_TYPE System ACCRUAL

OFF_INVOICE

Accrual

Off Invoice

Table B–2 Trade Planning Lookups
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Table B–3 Lookups for Claims

Key Type Values Meanings

OZF_ASSO_SUMMARY_
VIEW

User ACTIVITY

DOC_CLASS

ORDER

PERIOD

PRODUCT

SCHEDULE

Activity

Document Class

Order 

Period

Product

Schedule

When associating earnings, promotional 
accruals can be summarized by the views in 
these lookup.

OZF_AUTOPAY_CUST_
TYPES

User CUSTOMER

CUSTOMER_BILL_
TO

SHIP_TO

Customer - Sold To

Customer - Bill To

Customer - Ship To

OZF_AUTOPAY_METHOD User CHECK

CREDIT

CREDIT-MEMO

Issue Check

Account Credit

Account Credit (1)

OZF_AUTOPAY_PERIOD_
TYPE

System ANNUAL

DAILY

DAYS

MONTHLY

MONTHS

QUARTERLY

QUARTERS

SEMI_ANNUAL

WEEKLY

WEEKS

YEAR

Annual

Daily

Days

Monthly

Months

Quarterly

Quarters

Semi-annual

Weekly

Weeks

Year

OZF_CLAIM_ASSO_ACT_
TYPE

System OFFR

PRIC

SOFT_FUND

SPECIAL_PRICE

Offer

Price List

Soft Fund

Special Price
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Lookups for Claims
OZF_CLAIM_AUTOPAY_
RUNMODE

System OFFER_ALL

OFFER_AUTOPAY

OFFER_NO_
AUTOPAY

All Offers

Offers with Autopay

Offers without Autopay

OZF_CLAIM_ CLASS System CHARGE

CLAIM

DEDUCTION

GROUP

OVERPAYMENT

Debit Claim

Claim

Deduction

Claim Group

Overpayment

OZF_CLAIM_HISTORY_ 
EVENT

System CHANGED

CLOSED

LINE

NEW

SPLIT

Changes

Closed

Line

New

Split

OZF_CLAIM_ITEM_TYPE System FAMILY

MEDIA

PRODUCT

Product Category

Media

Product

OZF_CLAIM_LINE_
ACTION

System TAX_ADJ_LINE

TAX_LINE

Calculate Tax and Adjust Line Amount

Calculate Tax on Line Amount.

OZF_CLAIM_LINE_ITEM_
TYPE

User FAMILY

MEDIA

MEMO_LINE

PRODUCT

Product Category

Media

Standard Memo Line

Product

OZF_CLAIM_PAYMENT_
METHOD

System CHECK

CREDIT_MEMO

REJECT

WRITE_OFF

Check

Credit Memo-On Account

Reject

Write Off

OZF_CLAIM_PAYTO_
TYPE

System CUSTOMER

RELATED

Customer

Related Customer

Table B–3 Lookups for Claims
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OZF_CLAIM_
SALESCHAN

User ORDER

TP_ORDER

Direct Sales

Indirect Sales

OZF_CLAIM_SOURCE_
OBJECT

User BATCH

CB

CM

DM

INVOICE

REFERRAL

SOFT_FUND

SPECIAL_PRICING

Batch

Chargeback

Credit Memo

Debit Memo

Invoice

Referral

Soft Fund;

Special Pricing

OZF_CLAIM_STATUS System APPROVED

CANCELLED

CLOSED

COMPLETE

DUPLICATE

NEW

ONHOLD

OPEN

PENDING

PENDING_
APPROVAL

PENDING_CLOSE

REJECTED

Approved

Cancelled

Closed

Complete

Duplicate

New

Onhold

Open

Pending

Pending Approval

Pending Close

Rejected

OZF_CODE_
CONVERSION_TYPE

User OZF_
AGREEMENT_
CODES

OZF_PRODUCT_
CODES

OZF_REASON_
CODES

OZF_UOM_CODES

Agreement

Product

Reason

UOM

Table B–3 Lookups for Claims
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OZF_CREATION_ SIGN System +

-

A

Positive

Negative

Any

These lookups are the filter conditions 
available for selecting transaction types in 
claim types.

OZF_CREDIT_CODE User C

D

Credit

Debit

OZF_CUSTOMIZED_
OBJECT_CLASS

Exten-
sible

CB

CM

DM

INVOICE

ORDER

PCHO

WRITE_OFF

Chargeback

Credit Memo

Debit Memo

Invoice

Order

Purchase Order

Write Off

OZF_ EVENT_ STATUS System ACCOUNTED

ACCOUNTED 
WITH ERROR

CREATED

Accounted

Accounted with error

Created a new transaction

Values for the statuses of TM Oracle General 
Ledger postings.

OZF_GL_ DATE_TYPE System CLAIM_DATE

DUE_DATE

SYSTEM_DATE

Claim Date

Due Date

System Date

Values for selecting a Oracle General Ledger 
date in system parameters.

OZF_GL_ EVENT_ LINE_
TYPE

System ACCRUAL_
LIABILITY

EXPENSE 
ACCOUNT

REC_CLEARING

VEN_CLEARING

Accrual Liability

Expense Account

Receivable Clearing Acct.

Vendor Clearing Account

Values for the types of accounts used by TM 
Oracle General Ledger postings.

Table B–3 Lookups for Claims
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Lookups for Claims
OZF_GL_ EVENT_TYPE System ACCRUAL

ACCRUAL_
ADJUSTMENT

CONTRA_
CHARGE

SETTLE_BY_
CHECK

SETTLE_BY_
CREDIT

SETTLE_BY_DEBIT

SETTLE_BY_WO 

Accrual Liability

Accrual Adjustment

Settle by Contra Charge

Settle by Payment Voucher

Settle by Credit Memo

Settle by Debit Memo

Settle by Writing Off 

OZF_HISTORY_ RULE_ 
OBJECTS

System CLAM Claim

OZF_LINE_OVER_TYPE System CAMP

CB

CM

CSCH

DELV

DM

EVEH

INVOICE

INV_LINE

OFFR

ORDER

PCHO

PROD

SOFT_FUND

SPECIAL_PRICE

TP_ORDER

Campaign

Chargeback

Credit Memo

Schedule

Deliverable

Debit Memo

Event

Invoice

Invoice Line

Offer

Order

Purchase Order

Product

Soft Fund

Special Price

Third Party Order

Types used when entering a claim line.

Table B–3 Lookups for Claims

Key Type Values Meanings
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OZF_LINE_ACTIVITY_
TYPE

System CAMP

DELV

EVEH

OFFR

SOFT_FUND

SPECIAL_PIRCE

Campaign

Deliverable

Event

Offer

Soft Fund

Special Price

Activities used when entering claim line 
details.

OZF_OBJECT_CLASS System CB

CM

DM

INVOICE

INV_LINE

OFFR

OM_TXN

ORDER

ORDER_LINE

PCHO

TP_ORDER

Chargeback

Credit Memo

Debit Memo

Invoice

Invoice Line

TM Activity

RMA Transaction

Order

Order Line

Purchase Order

Third Party Order

Table B–3 Lookups for Claims
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OZF_PAYMENT_METHOD Exten-
sible

ADJUSTMENT

CHARGEBACK

CHECK

CONTRA_
CHARGE

CREDIT_MEMO

DEBIT_MEMO

MASS_
SETTLEMENT

ON_ACCT_
CREDIT

REG_CREDIT_
MEMO

REJECT

RMA

WRITE_OFF

Adjustment

Chargeback

Check

Contra Charge

Credit Memo - On Account

Debit Memo

Mass Settlement

On Account Credit

Credit Memo - Invoice

Reject

Return Materials Authorization

Write Off

These are available payment methods for 
claims. The user can add any customized 
settlement method.

OZF_PAYMENT_ STATUS System INCOMPLETE

INTERFACED

PAID

PENDING

WAITING_
ACCEPTANCE

Incomplete

Interfaced

Paid

Pending

Waiting for Referral Acceptance

Payment status is different from claim status. 
Once a claim has been approved, the claim 
settlement process begins. These values 
indicate the status of the payment (credit 
memo, check, chargeback, write off, and so 
on). When claim status is Closed, payment 
status is always Paid. When claim status is 
Pending Close, the payment status can be 
Interface or Pending.

Table B–3 Lookups for Claims
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Lookups for Indirect Sales
B.6 Lookups for Indirect Sales
For Indirect Sales, create or verify the following lookup settings. For steps of this 
procedure, see Section B.2, "Creating New Lookup Types".

OZF_ REASON_ CODE_
TYPE

User ADJUST_REASON

INVOICING_
REASON

Adjustment Reason

Invoicing Reason

When creating claim reasons, Oracle 
Receivables reasons can be associated. The 
two types of Oracle Receivables reasons 
available are created using this lookup. 

Table B–4 Lookups for Indirect Sales

Key Type Values Meanings

OZF_AGREEMENT_TYPE User PL

SPO

Price List

Special Price

OZF_CREDIT_CODE User C

D

Credit

Debit

OZF_FOLLOWUP_
ACTION_CODE

User C

D

E

N

P

R

S

W

X

Y

Please Correct and Resubmit

Resubmit Entire Claim

Resubmit This Item Only

Resubmission Not Allowed

Please Resubmit Original Transaction

Resubmission Allowed

Do Not Resubmit; Inquiry Initiated to a Third 
Party

Please Wait 30 Days and Resubmit

Please Wait 10 Days and Resubmit

Do Not Resubmit; We Will Hold Your Request 
and Respond Again Shortly

Table B–3 Lookups for Claims
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Lookups for Indirect Sales
OZF_FUND_SOURCE System SPECIAL_PRICE

SOFT_FUND

Special Price

Soft Fund

Use this setting for special pricing and soft 
fund requests. There are many more values in 
this lookup.

OZF_PARTNER_
PERFORMANCE

Extensible LEAD

REVENUE

Lead

Revenues

OZF_PERFORMANCE_
UOM

System AMOUNT

NUMBER

Amount

Number

OZF_PRODUCT_TSFR_
MVMT_TYPE

User CD

DC

TI

TO

Customer to Distributor

Distributor to Customer

Transfer In

Transfer Out

OZF_REJECT_REASON_
CODE

User 01

02

03

04

14

26

28

29

T6

Price Authorization Invalid

Price Authorization Expired

Product not on the price authorization

Authorized Quantity Exceeded

Invalid part number

Invalid Customer Number

Duplicate Invoice Number

Claim Submitted Past Exercise Period

Claim does not contain enough information 
for re-pricing

OZF_REQUEST_CLASS System SOFT_FUND

SPECIAL_PRICE

Soft Fund

Special Price

Table B–4 Lookups for Indirect Sales

Key Type Values Meanings
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OZF_REQUEST_STATUS System APPROVED

ARCHIVED

CLOSED

DECLINED

DRAFT

RETURNED

SUBMITTED_
FOR_APPROVAL

VOID

Approved

Archived

Closed

Declined

Draft

Returned

Pending Approval

Void

OZF_REQUEST_TYPE System BID_REQUEST

BLANKET_
REQUEST

MEET_
COMPETITOR

Bid Request

Blanket Request

Meet Competitor Price

OZF_RESALE_BATCH_
TYPE

System CHARGEBACK

SHIP_DEBIT

TP_ACCRUAL

TRACING

Chargeback

Ship and Debit

Third Party Accrual

Tracing

OZF_RESALE_PARTNER_
TYPE

System BG

BY

DB

DS

MF

SE

WH

Buying Group

Buying Party

Distributor Branch

Distributor

Manufacturer of Goods

Selling Party

Warehouse

OZF_RESALE_
TRANSFER_TYPE

User BN

IB

SD

SS

Return

Transfer

Ship and Debit Sale

Stock Sale

Table B–4 Lookups for Indirect Sales

Key Type Values Meanings
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OZF_RESPONSE_TYPE System N

R

U

W

Y

No

Response Code

Unknown

Not Applicable

Yes

OZF_SF_DECLINE_CODE Extensible COLLATERAL

DUPLICATE

INVALID

Collateral Did Not Meet Criteria

Duplicate Request

Invalid Request

OZF_SF_RETURN_CODE Extensible COLLATERAL

OTHER

MISS_INFO

Collateral Submission Requested

Other

Request Missing Information

OZF_SP_REQUEST_
DECLINE_CODE

Extensible CANNOT_MEET

NEED_MORE_
INFO

Cannot Meet Discount Requested

Need More Information

OZF_SP_REQUEST_
DISTYPE

System AMT

%

NEWPRICE

Discount Amount

Discount Percent

New Price

OZF_SP_REQUEST_
OUTCOME

Extensible IN_PROGRESS

LOST

WON

In Progress

Lost

Won

OZF_TRANSACTION_
PURPOSE_CODE

System 00 Original

OZF_TRANSACTION_
TYPE_CODE

User 01

02

RA

Product Transfer

Resale

Request for Credit

Table B–4 Lookups for Indirect Sales

Key Type Values Meanings
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Summary of Concurrent Programs

This appendix provides tables of the Request Sets and Concurrent Manager 
Programs used by Oracle Trade Management. They are arranged by section, based 
on the chapters in the main body of the this Implementation Guide.

Topics include: 

■ Section C.1, "Running Concurrent Programs"

■ Section C.2, "Checking Concurrent Program Status"

■ Section C.3, "Concurrent Programs for Budgets"

■ Section C.4, "Concurrent Programs for Trade Planning"

■ Section C.5, "Concurrent Programs for Claims"

■ Section C.6, "Concurrent Program for Indirect Sales"
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Running Concurrent Programs
C.1 Running Concurrent Programs
Use the following instructions for running any Oracle Applications concurrent 
program or program set. You can use these procedures to run or schedule any of the 
Oracle Trade Management concurrent programs. 

See Oracle Applications System Administrator’s Guide for complete details on Oracle 
Applications concurrent programs.

Prerequisites
None

Steps
1. Log in to Oracle Forms and select the Oracle Trade Management Administrator 

responsibility. 

The Submit a New Request Form automatically opens. Responsibilities can vary 
by module.

2. Choose Single Request (if running a single concurrent program) or Request Set 
(if running a set of concurrent programs). 

3. Select OK. The Submit Request form opens.

4. Query for the appropriate concurrent program, if necessary. 

5. Enter run immediately or select Schedule to schedule batch jobs. 

6. If scheduling, select the timeframe: 

– As soon as Possible: Select this option if running the program 
immediately. 

– Once: Select this option to run the program(s) one at a time.

– Periodically or On Specific Days: Select this option to run the program 
on a schedule that you will later specify. 

7. Select Submit to submit the request. 
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Concurrent Programs for Budgets
C.2 Checking Concurrent Program Status
Use the following procedure to check the status of a concurrent program. 

Prerequisites
None

Steps
1. Log in to Oracle Forms with System Administrator Responsibility. 

2. Choose Concurrent > Request. 

The Find Request window (defaulted to “All My Requests”) opens. 

3. In the Find Request window, search for your concurrent program request. 

– If the server is not busy, then selecting Find may be the fastest way to find 
your request. 

– If the server is busy, it may be better to enter search criteria and look for 
Specific Requests. 

4. The Request window displays a list of submitted requests. The Oracle 
Marketing concurrent programs should be listed. 

5. Select Refresh Data occasionally to check the completion status. 

6. Once in the “red” state or Phase = “completed” the “View Output” and “View 
Log” buttons will become active (if the log output files have been setup 
correctly). 

C.3 Concurrent Programs for Budgets
The following table provides a summary of the concurrent programs used for Trade 
Budgets. Note: All BIM concurrent programs are documented in the Oracle 
Marketing Implementation Guide.

Table C–1 Concurrent Programs for Budgets

Concurrent Manager Required Description

AMS - Team Access Refresh 
Program

No This program is used for all objects with Teams. When any team 
changes, this program needs to be run to accurately reflect who the 
team members are.
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Concurrent Programs for Budgets
OZF-TM: Chargeback 
Purge

No This program purges the entries in the OZF_RESALE_LINES_INT_
ALL interface table.

No parameter.

OZF-TM: Funds Accrual 
Engine

Yes This is an engine that extracts all accrual and discount information 
from sales orders executed at all ordering channels. The following 
are the categories of Events handled by this engine: 

■ Calculates budget utilization and earnings based on ship 
confirmed orders. 

■ Handles a return orders’ impact on budget utilization and 
earnings.

■ For fully accrued type of budgets with accrue to is ‘customer’, it 
updates Budget and Utilized columns with the accrued amount. 

■ For budgets with accrue to ‘Sales’, it updates the Budget 
column but does not update the Committed and Utilized 
columns. 

■ For Volume offer adjustments, it calculates the accruals for each 
sales order and makes accrual adjustments that are necessary as 
a result of volume offers.

■ For accrual rates that are adjusted retroactively, it creates the 
adjustments based on sales order information in the past. 

Parameters: 

p_debug: Run in Debug Mode

p_run_backdated_adjustment: Run Budget Utilization for Adjusted 
Offer

p_run_exception: Set to Y to run Order Management Except Queue.

p_run_unposted_gl: Repost Failed GL Posting

p_run_volume_off_adjustment: Run Budget Utilization for Volume 
Offer

OZF-TM: Import Territory 
Hierarchy

Yes This concurrent program uploads the hierarchy data from jtf_
territories to OZF schema used for budget allocation to that territory 
hierarchy. It is also used for defining budget hierarchy for a fully 
accrued budget. The concurrent program expects a hierarchy id 
meaning which particular hierarchy the user wants to import.

Parameters: Hierarchy Id
These are represented by all the root territories under Oracle Trade 
Management in the Territory Manager module.

Table C–1 Concurrent Programs for Budgets

Concurrent Manager Required Description
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OZF-TM: Perform 
Recalculated Commitment 
for Offers

No Re-Calculated Committed is an option to re-calculate the necessary 
funding level based on the actual sales performance of a promotion. 
Funds can be increased or decreased. If the promotion performs 
well, funding can be automatically increased, and vice versa. 

This program performs the re-calculation.

No parameters

OZF-TM: Release 
Committed Budget Amount 
After Grace Period

Yes Reconciliation is a way to return the following money at the end of 
an offer:

■ Adjusts previously committed, but un-utilized funds, 
transferring them from the Committed column to the Available 
column (“Reconcile Un-Utilized”).

■ Adjusts previously utilized, but un-paid funds, thus adjusting 
the Utilized column accordingly as well as transferring it from 
the Committed column to the Available column (“Reconcile 
Un-Utilized and Un-Paid Earnings”).

Budget reconciliation may be performed manually on each object 
such as an offer, or automatically via this concurrent process. 

Parameters:

p_object_code: Object code

p_object_end_date: Object end date

p_object_status: Object status, for example, active, draft

p_object_type: Object Type, for example, CAMP, OFFR, EVEH

p_util_paid: Reconcile both utilized and paid

Table C–1 Concurrent Programs for Budgets

Concurrent Manager Required Description
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Concurrent Programs for Budgets
OZF: Transfer to General 
Ledger

No This program is run to transfer the accounting entries created by 
claims/accruals into Oracle General Ledger accounting tables. 

The accounting entries are transferred from Trade Management’s 
interface tables to Oracle General Ledger’s interface tables. There is 
an option to automatically create the entries as Journals using 
Journal Import upon arriving at Oracle General Ledger. After the 
entries are turned into Journals, they need to be "Posted" to complete 
the Oracle General Ledger process. 

Parameters:

Set Of Books: Primary set of books 

Batch Name: Name of batch for transfer. This is optional.

From Date: Transfer entries created starting from this date. 

To Date: Transfers entries created ending this date. 

Journal Category: All, fixed budgets (for promotional accruals 
created for offers funded by fixed budgets), Accrual budgets (for 
promotional accruals created by a fully accrued budget) and 
Settlement (for promotional claims). 

Validate Accounts: Yes/No. Determines whether Oracle General 
Ledger accounts will be validated during transfer.

Transfer to GL Interface: In Detail (each accrual record on its own), 
Summarize by Accounting Date (grouping accrual records by 
accounting date during transfer), Summarize by Accounting Period 
(grouping accrual records by Accounting Period during transfer). 

Submit Journal Import: Yes/No. Determines whether Journal Import 
will be run when the entry gets transferred to Oracle General 
Ledger; if Yes, a journal will be created for an entry; if No, the entries 
sit in Oracle General Ledger’s interface tables until a Oracle General 
Ledger user runs the Journal Import program in Oracle General 
Ledger.

OZF-TM : Unutilized 
Commitment Mass Transfer

No Evaluates to see if the end dates of the selected budgets have passed, 
and if true, performs transfers to new linked budgets, if any.

Parameters:

p_amount_flag: Check the Amount flag

p_fund_id: Getting the Fund Name

p_hierarchy_flag: Check the Hierarchy flag

p_query_id: Getting the Query Name

Table C–1 Concurrent Programs for Budgets

Concurrent Manager Required Description
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OZF-TM Utilize Lumpsum 
Offers

Yes If a lump sum offer’s start date is in the future, the offer has already 
been approved for budgets, and is active, this program is run to 
update the budget’s Utilized volume. 

In the case when the Offer is active on the date when Offer was 
created, then the budget utilization will be updated immediately not 
by this program.

OZF-TM: Validate Budget 
and Quota Thresholds

Yes Threshold alerts are designed to help users monitor their budgets' 
activities. Different rules can be established to send out alert 
notifications to inform users of fund usage, depletion levels, and 
monitoring over spending or under spending. 

A threshold contains a set of rules. After being set up, it is assigned 
to a budget. Alerting budget owners to the danger of spending 
exceeding budget norms can help avoid over-spending. 

This concurrent process is run to monitor the different budgets and 
see if they meet the rules and definitions of their budget thresholds. 
If it does, it automatically sends a workflow notification to the 
budget owner.

Parameters: None

OZF-TM : Validate market 
and product eligibility for 
budget

No An offer that is are executed in Oracle Marketing is sourced by 
budgets approved for that offer. This concurrent program validates 
which budgets are eligible to fund an executed offer based on 
product and market eligibility. Various business scenarios cause 
offers to need funding from multiple budgets. In previous releases, 
each budget’s product and market eligibility had to be a superset of 
that of the offer for validation to succeed. Now, the restriction can be 
relaxed to support the following scenarios:

■ No validation for customers and products

■ Validate customers and products by each budget

■ Validate customer by each budget, products by all budgets 
(relax product)

■ Validate products by each budget, customers by all budgets 
(relax customer)

Parameters:

p_actbudget_id: Budget request ID

p_object_id: Offer ID

p_object_type: OFFR

Table C–1 Concurrent Programs for Budgets

Concurrent Manager Required Description
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Concurrent Programs for Trade Planning
C.4 Concurrent Programs for Trade Planning
The following table provides a summary of the concurrent programs used for Trade 
Planning.

Table C–2 Trade Planning Concurrent Programs

Concurrent Program Name Required Description

OZF-TM: Funds Accrual Engine Yes Calculates the budget utilization and accrual earnings 
based on the offers executed in Order Management. 
Updates the budgets utilization column accordingly. If 
fully accrued budget with accrue as customer, the 
budget, committed and utilized columns are populated. 

For budgets with accrue as sales, only the budget 
column is populated. You can transfer money from 
fully accrued budgets to any fixed budgets. 

OZF-TM: Generate Party List for Market 
Qualifiers

Y Generates the party list for Trade Management 
territories and Buying Groups. Customers are qualified 
for Offers, Quota, and Target allocations only when this 
program is run after creation or modification of a Trade 
Management Territory or a Buying Group.

OZF-TM: Net Accrual Engine Y Calculates the net accruals for all offers of type "Net 
Accrual" only.
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OZF-TM: Refresh Materialized Views 
for Order Sales

OZF-TM: Refresh Account Manager 
Dashboard

OZF-TM: Refresh Trade Management 
Activities (Offers and Schedules)

Yes OZF-TM: Refresh Materialized Views for Order Sales 
must be run at least once. It refreshes the materialized 
view (OZF_ORDER_SALES_SUMRY_MV) that 
summarizes the Orders data from Order Management. 
This materialized view is the source for all Order sales 
information used across Trade Management.

The OZF-TM: Refresh Account Manager Dashboard 
program refreshes the data on the Account Manager 
Dashboard.

When you run OZF-TM: Refresh Trade Management 
Activities (Offers and Schedules), Offers and Schedules 
are denormalized into OZF tables for faster 
performance in the application. Offers are searched 
across Trade Management based on this denormalized 
data.

These three programs must be run in the order listed 
for account planning functions to work properly. The 
frequency that they are run is set by the user and can be 
different for each program. For example, the first 
program can be run frequently during the day, the 
second can be run daily, and the third program can be 
run less often.

OZF-TM: Transfer to General Ledger Yes Transfers Oracle General Ledger postings from Oracle 
Trade Management to Oracle General Ledger. 

OZF-TM: Update Time Structure Yes Must be run the first time these system profiles are set, 
and any time thereafter one of these profiles is changed: 
AMS: Marketing Calendar; OZF: Start Day of Week; 
OZF: Period Type; OZF: Global Start Date 
(mm/dd/yyyy); OZF: Degree of Parallelism-Src; OZF: 
Debug Mode.

See Section 5.1, "Set Profile Options for Trade Planning" 
for more information.

OZF-TM: Utilize Lumpsum Offers Yes Accounts budget utilization against the lump sum offer 
whenever the offer start date arrives, rather than on the 
offer approved or create date. If the offer is active on 
the date it is created, then budget utilization is updated 
immediately. 

OZF-TM: Validate Budget and Quota 
Thresholds

Yes Must be run daily to send alerts related to quota 
thresholds.

Table C–2 Trade Planning Concurrent Programs

Concurrent Program Name Required Description
Summary of Concurrent Programs C-9



Concurrent Programs for Claims
C.5 Concurrent Programs for Claims
Run the following concurrent programs for claims after the use of claims has 
commenced — not at the time of implementation.

OZF-TM : Validate market and product 
eligibility for budget

No See text for this concurrent program in Section C.3, 
"Concurrent Programs for Budgets".

Table C–3 Concurrent Programs for Claims

Concurrent Manager Required Description

AMS - Team Access Refresh 
Program

Yes This program is used for all objects using teams including 
claims. When changes occur to teams, this program must be 
run to update the team information.

AutoInvoice - Oracle Receivables Yes This program is an Oracle Receivables concurrent program 
used to create transactions such as credit memos and debit 
memos.

For TM purposes, this program is run for the batch source 
defined in system parameters. It must be run because all 
claim settlements for Receivables are created with that batch 
source. 

For more information on options see the Oracle Receivables 
Implementation Guide.

OZF-TM: Claim Auto Write-offs 
Program

No Batch process to automatically write off claims that have the 
automatic write off check box selected.

Process can be run for:

■ Claim class—deduction or overpayment. If blank, all 
claims included.

■ Customer—select a customer. If blank, all claims 
included.

■ Claim type—select a claim type. If blank, all claims 
included

■ Claim reason—select a claim reason. If blank, all claims 
included

For more information, see Section 6.27, "Setting Up the Claim 
Aging View".

Table C–2 Trade Planning Concurrent Programs

Concurrent Program Name Required Description
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OZF-TM: Claims Aging Populating Yes Required for using the Claims Aging View. It must be run 
when using time periods, defined in the Aging Bucket 
created in Oracle Receivables. This program populates the 
Aging Bucket, grouping them by customer. 

Aging is run based on the system date. This program has to 
be run on a daily basis to get the daily aging analysis for the 
customers. 

Claims can be aged using a past due type.

OZF-TM: Claims Autopay Yes Autopay can be set up to regularly pay accruals based on a 
customer, budget, campaign or offer.

When it runs, it looks at the specified budget, customer, offer, 
or campaign; finds their outstanding accruals; finds an 
Autopay payment frequency or threshold set up for each 
customer; finds the payment preference; and automatically 
creates a claim. 

It also triggers the claim settlement process, which may first 
go through the approval process. The settlement method 
selected for each claim is either check or credit and is based 
on the payment preference set up in the offer and customer’s 
trade profile. 

OZF-TM: Claims Import Purge No This program is used to purge the claims import interface 
table.

Parameters: None. 

Table C–3 Concurrent Programs for Claims

Concurrent Manager Required Description
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OZF-TM: Claims Settlement 
Fetcher 

Yes This program retrieves transactions created in Payables 
(check) or Receivables (credit memo or debit memo) as a 
result of a claim settlement, update, or closure. 

Claim settlement on manual claims is created through 
Autoinvoice or Payables Open Interface Import. These 
programs run in batch mode. After the actual payment is 
created in Oracle Receivables or Oracle Payables, Claim 
Settlement Fetcher must run. This causes the data to show in 
claims.

The Claim Settlement Fetcher closes the claim, updates the 
claim with payment details, and in case of deduction, also 
updates the receiving application with pay details.

The program is also used:

■ To close out deductions or overpayments settled with 
credit or debit memos using Autoinvoice.

■ When deductions are settled with a return materials 
authorization (RMA).

Parameters: 

Claim Class

Payment Method

Claim Type

Reason 

Customer

OZF-TM: Import Claims Yes In addition to creating claims manually in TM, you can also 
import claims using the Import Interface. This data is from 
legacy or third party systems. Companies implementing TM 
can populate an interface table and run a concurrent process 
to create claims automatically in TM.

The Import Claims program pushes the data from the 
interface tables into TM claims. It runs through the standard 
validation process for claims creation, rejecting the claims 
that are not successful for import.

Parameters: None.

OZF-TM: Refresh Materialized 
Views for Promotional Payment

Yes Updated the materialized view for promotional payments 
with the most recent earnings information.

Table C–3 Concurrent Programs for Claims

Concurrent Manager Required Description
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C.6 Concurrent Program for Indirect Sales
Run the following concurrent programs for indirect sales:

OZF-TM: Transfer to General 
Ledger 

Yes This program transfers accounting entries created in TM 
interface tables to Oracle General Ledger interface tables. 
Optionally, you can automatically create the entries as 
journals using Journal Import. In this case, after the entries 
are turned into journals, they must be Posted to complete the 
Oracle General Ledger process. 

Parameters:

Set Of Books: Primary set of books. 

Batch Name: Name of batch for transfer. This is optional. 

From Date: Transfer entries created starting from this date.

To Date: Transfer entries created ending this date. 

Journal Category: Options are All, Fixed Budgets, Accrual 
Budgets, and Settlement.

Validate Accounts: Options are Yes or No. This value 
determines whether Oracle General Ledger accounts are 
validated during transfer.

Transfer to GL Interface: Options are In Detail, Summarize by 
Accounting Date, and Summarize by Accounting Period.

Submit Journal Import: Options are Yes or No. This value 
determines whether Journal Import is run when the entry is 
transferred to Oracle General Ledger. If Yes, a journal is 
created for an entry. If No, the entries sit in Oracle General 
Ledger interface tables until an Oracle General Ledger user 
runs the Journal Import program in Oracle General Ledger.

Payables Open Interface Import - 
Oracle Payables

Yes This program is used to create invoices in Payables. For TM 
purposes, this program is run for the batch source defined in 
system parameters. It must be run because all claim 
settlements for Payables are created with that batch source. 

For more information on parameters and options see the 
Oracle Payables Implementation Guide.

Table C–3 Concurrent Programs for Claims

Concurrent Manager Required Description
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Table C–4 Concurrent Programs for Indirect Sales

Concurrent Program Name Required Description

OZF-TM: Third Party Accrual from 
Interface table

No This program is used to create a third party accrual 
based on the resale data in the OZF_RESALE_LINES_
INT_ALL table.

This replaces the OZF-TM: Chargeback Accrual 
concurrent program used in 11.5.9.

OZF-TM: Chargeback Purge No This program purges the entries in the OZF_RESALE_
LINES_INT_ALL interface table.

No parameter.

OZF-TM: Refresh Materialized View Yes This program is used to refresh various materialized 
views. Choose inventory mv to refresh the inventory 
materialized view. Run this program for manual 
inventory adjustments to be reflected on the UI.

OZF-TM: Refresh Materialized Views 
for Order Sales

Yes This program imports sales orders from Order manager 
to Trade management so that inventory tracking can be 
performed based on the sales order. Choose N for 
incremental mode if you want to import all the Order 
management. This option is recommended at the 
beginning. Choose Y for incremental mode if you want 
to add the orders made after the last refresh.

OZF-TM: Release Committed Budget 
Amount After Grace Period

Yes This program closes a soft fund request after the grace 
period. It can be scheduled to run periodically.

OZF-TM: Third Party Accrual from 
Interface Table

Yes This program creates third party accrual for data that 
users import. This program uses data stored in OZF_
RESALE_LINES_INT_ALL table that does not have a 
batch. The program creates batches based partner_
party_id for these lines first. It then generated 
utilizations based on accruals that should be applied to 
them. The program does not create any claim or claim 
lines.

Parameter: Data source code. When there is an error, 
the program writes an error message that contains id of 
the current record in the interface table, and continues.

OZF-TM: Third Party Accrual from 
Resale Table

Yes This program is used to create a third party accrual 
based on the resale data in the OZF_RESALE_LINES_
ALL table.

Workflow Agent Listener Yes Set to Wf-deferred
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Seeded User Statuses

This appendix outlines the various seeded user statuses found in Oracle Trade 
Management. 

Topics include: 

■ Section D.1, "User Status Overview"

■ Section D.2, "Seeded User Statuses"

■ Section D.3, "User Status Limitations"
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User Status Overview
D.1 User Status Overview
User Statuses can be created across the application for a combination of Activity 
and Status. The application is seeded with the following User Statuses. These user 
statuses can be modified or extended to meet your organization’s Business Rules. 

D.2 Seeded User Statuses
The seeded User Status values are as follows:

Table D–1 Seeded User Statuses

User Status For SYSTEM_STATUS User Status Name

Budget Sourcing Status ACTIVE Active

Budget Sourcing Status APPROVED Approved

Budget Sourcing Status CLOSED Accounting Closed

Budget Sourcing Status PLANNING Planning

Budget Sourcing Status PENDING Pending Approval

Budget Sourcing Status PENDING VALIDATION Pending Validation

Budget Sourcing Status REJECTED Rejected by Approver

Budget Status ACTIVE Active

Budget Status ARCHIVED Archived

Budget Status CANCELLED Cancelled

Budget Status CLOSED Closed

Budget Status DRAFT Draft

Budget Status DRAFT Draft Budget Status - LAF

Budget Status ON_HOLD On Hold

Budget Status PENDING APPROVAL Pending Approval

Budget Status REJECTED Rejected

Claim Status APPROVED Approved

Claim Status CANCELLED Cancelled

Claim Status CLOSED Closed

Claim Status COMPLETE Complete

Claim Status DUPLICATE Duplicate
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Claim Status NEW New

Claim Status OPEN Open

Claim Status PENDING Pending

Claim Status PENDING_APPROVAL Pending Approval

Claim Status PENDING_CLOSE Pending Close

Claim Status REJECTED Rejected

Offer Status ACTIVE Active

Offer Status ARCHIVED Archived

Offer Status CANCELLED Cancelled

Offer Status CLOSED Closed

Offer Status COMPLETED Completed

Offer Status DRAFT Draft

Offer Status ONHOLD On-Hold

Offer Status PENDING BUDGET 
APPROVAL

Submitted - Budget Approval

Offer Status PENDING_ACTIVE Pending Active

Offer Status PENDING VALIDATION Pending Validation

Offer Status PLANNING Planned

Offer Status REJECTED Rejected - Budget Approval

Offer Status REJECTED - THEME 
APPROVAL

Rejected - Theme Approval

Offer Status SUBMITTED - THEME 
APPROVAL

Submitted - Theme Approval

Offer Status SUBMITTED - THEME 
APPROVAL

Offer - Theme Approval Submitted

Offer Status TERMINATED Terminated

Price List Statuses ACTIVE Active

Price List Statuses CANCELLED Cancelled

Price List Statuses DRAFT Draft

Price List Statuses SUBMITTED FOR 
APPROVAL

Submitted For Approval

Table D–1 Seeded User Statuses

User Status For SYSTEM_STATUS User Status Name
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D.3 User Status Limitations
If you add a large number of user statuses, the number of values seen in the 
drop-down list for an Object’s Status increases by the same number.

Price List Statuses REJECTED Rejected

Table D–1 Seeded User Statuses

User Status For SYSTEM_STATUS User Status Name
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Claim Interface Tables

This appendix contains interface tables for claims. After the claim and claim lines 
are created successfully, the claim_id is recorded in the claim_id column of the claim 
interface table. 

OZF-TM: Third Party Accrual from Interface table is a concurrent program which 
creates third party accrual for data that users import for Indirect Sales. This 
program uses data stored in OZF_RESALE_LINES_INT_ALL table that does not 
have a batch. The program creates batches based on partner_ party_id for these 
lines first. It then generated utilizations based on accruals that should be applied to 
them. The program does not create any claim or claim lines.

■ Section E.1, "OZF_CLAIMS_INT_ALL Table" for claim information

■ Section E.2, "OZF_CLAIM_LINES_INT_ALL Table" for claim line information.

■ Section E.3, "OZF_RESALE_LINES_INT_ALL" for third party accrual.

E.1 OZF_CLAIMS_INT_ALL Table
The OZF_CLAIMS_INT_ALL table stores the data that must be imported to the 
OZF_CLAIMS_ALL table by the AMS-TM: Import Claim concurrent program.

Column Name: INTERFACE_CLAIM_ID

■ Value: Primary key of the ozf_claims_int_all table. Cannot be null for any 
record.

■ Validation: None.

■ Destination: None.

Column Name: OBJECT_VERSION_NUMBER

■ Value: version number of this record. Defaults to 1.
ables E-1



OZF_CLAIMS_INT_ALL Table
■ Validation: None.

■ Destination: None.

Column Name: CLAIM_ID

■ Value: The claim_id for a claim record in ozf_claims_all table.

■ Validation: Should be null before the import program.

■ Destination: None.

Column Name: CLAIM_NUMBER

■ Value: Customer specified claim number of a claim. If not specified, a 
unique number is generated.

■ Validation: Claim number must be unique in the ozf_claims_all table.

■ Destination: ozf_claims_all.claim_number.

Column Name: CLAIM_TYPE_ID

■ Value: Id of a claim type. Defaulted from system parameters if not specified.

■ Validation: Must exist in ozf_claim_types_all_b.claim_type_id.

■ Destination: ozf_claims_all.claim_type_id.

Column Name: CLAIM_DATE

■ Value: The date when a claim is created. Defaults to the system date if null. 

■ Validation: None.

■ Destination: ozf_claims_all.claim_date.

Column Name: DUE_DATE

■ Value: The date that a claim must be settled. 

■ Validation: Due_date >= claim_date.

■ Destination: ozf_claims_all.due_date.

Column Name: SPLIT_FROM_CLAIM_ID

■ Value: Do not populate this column.

■ Validation: None.

■ Destination: None.

Column Name: AMOUNT
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■ Value: The amount in the current (transactional) currency that is claimed.

■ Validation: None.

■ Destination: ozf_claims_all.amount.

Column Name: ACCTD_AMOUNT

■ Value: Do not populate this column. 

■ Validation: None.

■ Destination: None.

Column Name: CURRENCY_CODE

■ Value: Currency code for the current transaction. 

■ Validation: Must exist in FND_CURRENCIES.CURRENCY_CODE.

■ Destination: ozf_claims_all.currency_code.

Column Name: EXCHANGE_RATE_TYPE

■ Value: Enter the exchange rate type for this transaction. If the currency of 
the transaction is not the same as the functional currency, one of the 
following combinations should exist:

– exchange_rate_type and exchange_rate

– exchange_rate_type and exchange_rate_date

Otherwise, the exchange_rate_type is defaulted based on the ozf_sys_
parameters_all table and the current exchange_rate_date. 

■ Validation: Must exist in GL_DAILY_CONVERSION_TYPES. 
CONVERSION_TYPE

■ Destination: ozf_claims_all.exchange_rate_type.

Column Name: EXCHANGE_RATE_DATE

■ Value: The date when the exchange occurred. 

■ Validation: None.

■ Destination: ozf_claims_all.exchange_rate_date.

Column Name: EXCHANGE_RATE

■ Value: The exchange rate between transactional and functional currency.
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■ Validation: If ozf_claims_int_all.exchange_rate_TYPE = 'User' then this 
column must not be null; otherwise, it must be null.

■ Destination: ozf_claims_all.exchange_rate.

Column Name: SET_OF_BOOKS_ID

■ Value: The set of books id for the current organization. 

■ Validation: Must be the same ozf_sys_parameters_all.set_of_books_id 
based on ozf_claims_int_all.org_id and ozf_sys_parameters_all.org_id.

■ Destination: ozf_claims_all.set_of_books_id.

Column Name: ORIGINAL_CLAIM_DATE

■ Value: Do not populate. 

■ Validation: None.

■ Destination: None.

Column Name: SOURCE_OBJECT_ID

■ Value: The id for an invoice.

■ Validation: If defined, it must exist in ra_customer_trx_all.cusomter_trx_id.

■ Destination: ozf_claims_all. SOURCE_OBJECT_ID.

Column Name: SOURCE_OBJECT_NUMBER

■ Value: The invoice number for an invoice 

■ Validation: If the claim_class is DEDUCTION and source_object_id is not 
null, then this column cannot be null. It must be the trx_number in ra_
customer_trx_all where customer_trx_id = source_object_id.

■ Destination: ozf_claims_all. SOURCE_OBJECT_NUMBER.

Column Name: SOURCE_OBJECT_CLASS

■ Value: The source object class of a deduction. If the claim_class is 
DEDUCTION and source_object_id is not null, then the value of this 
column is INVOICE. 

■ Validation: None.

■ Destination: ozf_claims_all. SOURCE_OBJECT_CLASS.

Column Name: SOURCE_OBJECT_TYPE_ID

■ Value: The transaction type id for an invoice. 
E-4 Oracle Trade Management Implementation Guide



OZF_CLAIMS_INT_ALL Table
■ Validation: If the claim_class is DEDUCTION and source_object_id is not 
null, then this column cannot be null. It must be the cust_trx_type_id in ra_
customer_trx_all where customer_trx_id = source_object_id.

■ Destination: ozf_claims_all. SOURCE_OBJECT_TYPE_ID.

Column Name: CUST_ACCOUNT_ID

■ Value: The account_id of a customer.   

■ Validation: Cannot be null. It is cust_account_id in hz_cust_accounts 
WHERE hz_cust_accounts.status = 'A'. 

■ Destination: ozf_claims_all. CUST_ACCOUNT_ID.

Column Name: CUST_BILLTO_ACCT_SITE_ID

■ Value: The billto_account_site_id for the customer. 

■ Validation: Must be the site_use_id for BILL_TO site from hz_cust_site_uses 
table for the customer.

■ Destination: ozf_claims_all.CUST_BILLTO_ACCT_SITE_ID

Column Name: CUST_SHIPTO_ACCT_SITE_ID

■ Value: The shipto_account_site_id for the customer. 

■ Validation: Must be the site_use_id for SHIP_TO site from hz_cust_site_
uses table for the customer.

■ Destination: ozf_claims_all.CUST_SHIPTO_ACCT_SITE_ID.

Column Name: LOCATION_ID

■ Value: For future use. Do not populate.

■ Validation: None.

■ Destination: None.

Column Name: REASON_TYPE

■ Value: For future use. Do not populate. 

■ Validation: None.

■ Destination: None.

Column Name: REASON_CODE_ID

■ Value: Id for the reason_code.
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■ Validation: Must exists in ozf_reason_codes_all_b.reason_code_id. 

■ Destination: ozf_claims_all.REASON_CODE_ID.

Column Name: STATUS_CODE

■ Value: The status of the claim. Defaults to open when claim is created. Do 
not populate.

■ Validation: None.

■ Destination: None.

Column Name: USER_STATUS_ID

■ Value: The user_status_id of the claim. Defaults to open when claim is 
created. Do not populate. 

■ Validation: None.

■ Destination: None.

Column Name: PAYMENT_METHOD

■ Value: The method of a payment. 

■ Validation: It is the lookup_code from AMS_LOOKUPS where lookup type 
is AMS_CLAIM_PAYMENT_METHOD.

■ Destination: ozf_claims_all.payment_method

Column Name: SALES_REP_ID

■ Value: Id for the sales rep. 

■ Validation: It is the hz_cust_site_uses.primary_salesrep_id based on either 
the cust_shipto_acct_site_id or cust_billto_acct_site_id.

■ Destination: ozf_claims_all. SALES_REP_ID.

Column Name: COLLECTOR_ID

■ Value: For future use. Do not populate.

■ Validation: None.

■ Destination: None.

Column Name: CONTACT_ID

■ Value: Id for the contact person of the customer. 
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■ Validation: must be a party_id from hz_parties with CONTACT_OF 
relationship.

■ Destination: ozf_claims_all.CONTACT_ID.

Column Name: BROKER_ID

■ Value: Id of the broker.

■ Validation: must be a party_id from hz_parties with BROKER_OF 
relationship.

■ Destination: ozf_claims_all.BROKER_ID.

Column Name: CUSTOMER_REF_DATE

■ Value: The date an agent made a reference. 

■ Validation: None.

■ Destination: ozf_claims_all.CUSTOMER_REF_DATE.

Column Name: CUSTOMER_REF_NUMBER

■ Value: The reference number from an agent.

■ Validation: None.

■ Destination: ozf_claims_all. CUSTOMER_REF_NUMBER.

Column Name: RECEIPT_ID

■ Value: The id of the receipt that the claim is referring to.

■ Validation: Cannot be null if claim_class is DEDUCTION.

■ Destination: ozf_claims_all. RECEIPT_ID.

■ Column Name: RECEIPT_NUMBER.

■ Value: The receipt number that the claim is referring to.

■ Validation: Cannot be null if claim_class is DEDUCTION.

■ Destination: ozf_claims_all. RECEIPT_NUMBER.

Column Name: SECURITY_GROUP_ID

■ Value: Do not populate.

■ Validation: None.

■ Destination: None.
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Column Name: ORG_ID

■ Value: Do not populate.

■ Validation: None.

■ Destination: None.

Column Name AMOUNT_ADJUSTED

■ Value: Do not populate. 

■ Validation: None.

■ Destination: None.

Column Name: AMOUNT_REMAINING

■ Value: Do not populate.

■ Validation: None.

■ Destination: None.

■ Column Name: AMOUNT_SETTLED

■ Value: Do not populate.

■ Validation: None.

■ Destination: None.

Column Name: CLAIM_CLASS

■ Value: It has two values CLAIM or DEDUCTION. It defaults to 
DEDUCTION if not specified. 

■ Validation: None.

■ Destination: ozf_claims_all.CLAIM_CLASS.

Column Name: PAY_RELATED_ACCOUNT_FLAG

■ Value: Indicates whether there is a related account to pay. Its value is Y or 
N.

■ Validation: Y or N.

■ Destination: ozf_claims_all. PAY_RELATED_ACCOUNT_FLAG.

Column Name: RELATED_CUST_ACCOUNT_ID

■ Value: Account_id of the related customer.
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■ Validation: Same as cust_account_id. It cannot be null if PAY_RELATED_
ACCOUNT_FLAG = 'Y'.

■ Destination: ozf_claims_all.RELATED_CUST_ACCOUNT_ID.

Column Name: RELATED_SITE_USE_ID

■ Value: Bill to site of a related customer.

■ Validation: Same as cust_billto_acct_site_id. It cannot be null if PAY_
RELATED_ACCOUNT_FLAG = Y.

■ Destination: ozf_claims_all.RELATED_SITE_USE_ID.

Column Name: RELATIONSHIP_TYPE

■ Value: relationship type with the related customer.

■ Validation: None.

■ Destination: ozf_claims_all. RELATIONSHIP_TYPE.

Column Name: VENDOR_ID

■ Value: Id of the vendor.

■ Validation: Must exist in po_vendors.vender_id.

■ Destination: ozf_claims_all.VENDOR_ID.

Column Name: VENDOR_SITE_ID

■ Value: Site id of the vendor.

■ Validation: Must exist in po_vendor_sites.site_id.

■ Destination: ozf_claims_all.VENDOR_SITE_ID.

Column Name: TASK_TEMPLATE_GROUP_ID

■ Value: Id for the template group from task module. 

■ Validation: None.

■ Destination: ozf_claims_all. TASK_TEMPLATE_GROUP_ID.

Column Name: GL_DATE

■ Value: The date on which the claim settlement amount will be posted to 
Oracle General Ledger. It defaults based on the payment method.

■ Validation: None.

■ Destination: ozf_claims_all.GL_DATE.
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Column Name: EFFECTIVE_DATE

■ Value: Id for the template group from task module.

■ Validation: None.

■ Destination: ozf_claims_all.EFFECTIVE_DATE. 

Column Name: CUSTOM_SETUP_ID

■ Value: Do not populate.

■ Validation: None.

■ Destination: None.

Column Name: TASK_ID

■ Value: Do not populate. 

■ Validation: None.

■ Destination: None.

Column Name: COUNTRY_ID

■ Value: Do not populate. 

■ Validation: None.

■ Destination: None.

Column Name: COMMENTS

■ Value: Comments about the claim.

■ Validation: None.

■ Destination: ozf_claims_all.COMMENTS.

Column Name: OWNER_ID

■ Value: For future use. Do not populate.

■ Validation: None.

■ Destination: None.

Column Name: HISTORY_EVENT

■ Value: For future use. Do not populate. 

■ Validation: None.

■ Destination: None.
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■ Column Name: HISTORY_EVENT_DATE.

■ Value: For future use. Do not populate.

■ Validation: None.

■ Destination: None.

Column Name: HISTORY_EVENT_DESCRIPTION

■ Value: For future use. Do not populate. 

■ Validation: None.

■ Destination: None.

Column Name: DUPLICATE_CLAIM_ID

■ Value: For future use. Do not populate. 

■ Validation: None.

■ Destination: None.

Column Name SPLIT_DATE

■ Value: For future use. Do not populate. 

■ Validation: None.

■ Destination: None.

Column Name ROOT_CLAIM_ID

■ Value: For future use. Do not populate. 

■ Validation: None.

■ Destination: None.

Column Name: ACCTD_AMOUNT_REMAINING

■ Value: For future use. Do not populate. 

■ Validation: None

■ Destination: None

Column Name: TAX_AMOUNT

■ Value: For future use. Do not populate. 

■ Validation: None

■ Destination: None
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Column Name: TAX_CODE

■ Value: For future use. Do not populate. 

■ Validation: None.

■ Destination: None.

Column Name: TAX_CALCULATION_FLAG

■ Value: For future use. Do not populate. 

■ Validation: None.

■ Destination: None.

Column Name: DOC_SEQUENCE_ID

■ Value: For future use. Do not populate. 

■ Validation: None.

■ Destination: None.

Column Name: DOC_SEQUENCE_VALUE

■ Value: For future use. Do not populate. 

■ Validation: None.

■ Destination: None.

Column Name: VOUCHER_ID

■ Value: For future use. Do not populate. 

■ Validation: None.

■ Destination: None.

Column Name: VOUCHER_NUMBER

■ Value: For future use. Do not populate. 

■ Validation: None.

■ Destination: None.

Column Name: SETTLED_BY

■ Value: For future use. Do not populate. 

■ Validation: None.

■ Destination: None.
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Column Name: SETTLED_DATE

■ Value: For future use. Do not populate. 

■ Validation: None.

■ Destination: None.

Column Name: APPROVED_FLAG

■ Value: For future use. Do not populate. 

■ Validation: None.

■ Destination: None.

Column Name: APPROVED_BY

■ Value: For future use. Do not populate. 

■ Validation: None.

■ Destination: None.

Column Name: PAYMENT_STATUS

■ Value: For future use. Do not populate. 

■ Validation: None.

■ Destination: None.

Column Name: PAYMENT_REFERENCE_ID

■ Value: For future use. Do not populate. 

■ Validation: None.

■ Destination: None.

Column Name: PAYMENT_REFERENCE_NUMBER

■ Value: For future use. Do not populate. 

■ Validation: None.

■ Destination: None.

Column Name: PAYMENT_REFERENCE_DATE

■ Value: For future use. Do not populate. 

■ Validation: None.

■ Destination: None.
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Column Name: TERRITORY_ID

■ Value: For future use. Do not populate. 

■ Validation: None.

■ Destination: None.

Column Name: ASSIGNED_TO

■ Value: For future use. Do not populate. 

■ Validation: None.

■ Destination: None.

Column Name: ATTRIBUTE_ CATEGORY

■ Enter the Descriptive Flexfield category information for this transaction. 
Descriptive Flexfield categories allow you to store different categories of 
attributes. This column is optional.

■ Validation: None.

■ Destination: ozf_claims_all.ATTRIBUTE_ CATEGORY.

Column Name:ATTRIBUTE1-15

■ Enter the Descriptive Flexfield attribute information for this transaction. 
Descriptive Flexfield attributes allow you to store additional columns, the 
contents of which you define. These columns are optional.

■ Validation: None.

■ Destination: ozf_claims_all.ATTRIBUTE1-15.

Column Name :DEDUCTION_ATTRIBUTE_ CATEGORY

■ Enter the Descriptive Flexfield category information for this transaction. 
Descriptive Flexfield categories allow you to store different categories of 
attributes. This column is optional.

■ Validation: None.

■ Destination: ozf_claims_all.DEDUCTION_ATTRIBUTE_ CATEGORY.

Column Name: DEDUCTION_ATTRIBUTE1-15

■ Enter the Descriptive Flexfield attribute information for this transaction. 
Descriptive Flexfield attributes allow you to store additional columns, the 
contents of which you define. These columns are optional.
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■ Validation: None.

■ Destination: ozf_claims_all.DEDUCTION_ATTRIBUTE1-15.

E.2 OZF_CLAIM_LINES_INT_ALL Table
This is the claim lines interface table. It stores data that needs to be imported to ozf_
claim_lines_all table using AMS-TM: import Claims program.

Column Name: INTERFACE_CLAIM_LINE_ID

■ Value: Primary key of the ozf_claim_lines_int_all table. Cannot be null for 
any record.

■ Validation: None.

■ Destination: None.

Column Name: OBJECT_VERSION_NUMBER

■ Value: version number of this record. Defaults to 1.

■ Validation: None.

■ Destination: None.

Column Name: INTERFACE_CLAIM_ID

■ Value: Foreign key to the ozf_claims_int_all table.interface_claim_id. 
Cannot be null for any record. 

■ Validation: None.

■ Destination: None.

Column Name: SPLIT_FROM_CLAIM_LINE_ID

■ Value: Do not populate this column. 

■ Validation: None.

■ Destination: None.

Column Name: AMOUNT

■ Value: The amount in the current (transactional) currency for this line. 

■ Validation: None.

■ Destination: ozf_claim_lines_all.amount.

Column Name: CLAIM_CURRENCY_AMOUNT
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■ Value: The amount in the currency of the claim for the current line.

■ Validation: None.

■ Destination: ozf_claim_lines_all.CLAIM_CURRENCY_AMOUNT.

Column Name: ACCTD_AMOUNT

■ Value: Do not populate this column. 

■ Validation: None.

■ Destination: None.

Column Name: CURRENCY_CODE

■ Value: Currency code for the current line. 

■ Validation: Must exist in FND_CURRENCIES.CURRENCY_CODE.

■ Destination: ozf_claim_lines_all.currency_code.

Column Name: EXCHANGE_RATE_TYPE

■ Value: same as ozf_claim_int_all.exchange_rate_type.

■ Validation: same as ozf_claim_int_all.exchange_rate_type.

■ Destination: ozf_claim_lines_all.exchange_rate_type.

Column Name: EXCHANGE_RATE_DATE

■ Value: same as ozf_claim_int_all.exchange_rate_date.

■ Validation: None.

■ Destination: ozf_claim_lines_all.exchange_rate_date.

Column Name: EXCHANGE_RATE

■ Value: same as ozf_claim_int_all.exchange_rate.

■ Validation: same as ozf_claim_int_all.exchange_rate.

■ Destination: ozf_claim_lines_all.exchange_rate.

Column Name: SET_OF_BOOKS_ID

■ Value: same as ozf_claim_int_all.set_of_books_id. 

■ Validation: same as ozf_claim_int_all.set_of_books_id.

■ Destination: ozf_claim_lines_all.set_of_books_id.

Column Name: SOURCE_OBJECT_ID
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■ Value: same as ozf_claim_int_all.source_object_id.

■ Validation: same as ozf_claim_int_all.source_object_id.

■ Destination: ozf_claim_lines_all. SOURCE_OBJECT_ID.

Column Name: SOURCE_OBJECT_CLASS

■ Value: same as ozf_claim_int_all.source_object_class.

■ Validation: None.

■ Destination: ozf_claim_lines_all. SOURCE_OBJECT_CLASS.

Column Name: SOURCE_OBJECT_TYPE_ID

■ Value: same as ozf_claim_int_all.source_object_type_id.

■ Validation: same as ozf_claim_int_all.source_object_type_id.

■ Destination: ozf_claim_lines_all. SOURCE_OBJECT_TYPE_ID.

Column Name: PAYMENT_STATUS

■ Value: For future use. Do not populate. 

■ Validation: None.

■ Destination: None.

Column Name: APPROVED_FLAG

■ Value: For future use. Do not populate. 

■ Validation: None.

■ Destination: None.

Column Name: APPROVED_DATE

■ Value: For future use. Do not populate. 

■ Validation: None.

■ Destination: None.

Column Name: APPROVED_BY

■ Value: For future use. Do not populate. 

■ Validation: None.

■ Destination: None.

Column Name: SETTLED_DATE
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■ Value: For future use. Do not populate. 

■ Validation: None.

■ Destination: None.

Column Name: RELATED_CUST_ACCOUNT_ID

■ Value: Account_id of the related customer.

■ Validation: same as cust_account_id. It cannot be null if PAY_RELATED_
ACCOUNT_FLAG = 'Y'.

■ Destination: ozf_claim_lines_all.RELATED_CUST_ACCOUNT_ID.

Column Name: RELATIONSHIP_TYPE

■ Value: relationship type with the related customer.

■ Validation: None.

■ Destination: ozf_claim_lines_all. RELATIONSHIP_TYPE.

Column Name: COMMENTS

■ Value: Comments about the claim.

■ Validation: None.

■ Destination: ozf_claim_lines_all.COMMENTS.

Column Name: PAYMENT_METHOD

■ Value: The method of a payment.

■ Validation: same as ozf_claims_int_all.payment_method.

■ Destination: ozf_claim_lines_all.payment_method.

Column Name: PAYMENT_REFERENCE_ID

■ Value: For future use. Do not populate. 

■ Validation: None.

■ Destination: None.

Column Name: PAYMENT_REFERENCE_NUMBER

■ Value: For future use. Do not populate. 

■ Validation: None.

■ Destination: None.
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Column Name: PAYMENT_REFERENCE_DATE

■ Value: For future use. Do not populate. 

■ Validation: None.

■ Destination: None.

Column Name: VOUCHER_ID

■ Value: For future use. Do not populate. 

■ Validation: None.

■ Destination: None.

Column Name: VOUCHER_NUMBER

■ Value: For future use. Do not populate. 

■ Validation: None.

■ Destination: None.

Column Name :ATTRIBUTE_ CATEGORY

■ Enter the Descriptive Flexfield category information for this transaction. 
Descriptive Flexfield categories allow you to store different categories of 
attributes. This column is optional.

■ Validation: None.

■ Destination: ozf_claim_lines_all.ATTRIBUTE_ CATEGORY.

Column Name:ATTRIBUTE1-15

■ Enter the Descriptive Flexfield attribute information for this transaction. 
Descriptive Flexfield attributes allow you to store additional columns, the 
contents of which you define. These columns are optional.

■ Validation: None.

■ Destination: ozf_claim_lines_all.ATTRIBUTE1-15.

Column Name : LINE_NUMBER                            

■ Value: Number for the line created. Do not populate. 

■ Validation: None.

■ Destination: None.

Column Name: VALID_FLAG                                         
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■ Value: Indicates if the line is valid.

■ Validation: None.

■ Destination: None.

Column Name: PLAN_ID                                       

■ Value: 

■ Validation: None.

■ Destination: None.

Column Name: OFFER_ID                                     

■ Value: For future use. Do not populate. 

■ Validation: None.

■ Destination: None.

Column Name: PERFORMANCE_COMPLETE_FLAG 

■ Value: Indicates if performance was completed for the line. 

■ Validation: None.

■ Destination: None.

Column Name: PERFORMANCE_ATTACHED_FLAG 

■ Value: Indicates if performance was attached to the line.

■ Validation: None.

■ Destination: None.

Column Name: ORG_ID                            

■ Value: Do not populate. 

■ Validation: None.

■ Destination: None.

Column Name: SECURITY_GROUP_ID 

■ Value: Do not populate. 

■ Validation: None.

■ Destination: None.

Column Name: UTILIZATION_ID 
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■ Value: For future use. Do not populate. 

■ Validation: None.

■ Destination: None.

Column Name: TAX_CODE 

■ Value: Tax code to be applied to line. Specify AR Tax codes for Credit 
Memo, Chargeback and Debit Memo settlement and Oracle Payables Tax 
codes for Check settlement. 

■ Validation: None.

■ Destination: None.

Column Name: ITEM_ID 

■ Value: Product identifier from MTL_SYSTEM_ITEMS.inventory_item_id.

■ Validation: None.

■ Destination: None.

Column Name: ITEM_DESCRIPTION

■ Value: Product name or description.

■ Validation: None.

■ Destination: None.

Column Name: QUANTITY                        

■ Value: Quantity of product.

■ Validation: None.

■ Destination: None.

Column Name: QUANTITY_UOM            

■ Value: Unit of measure for the product. 

■ Validation: None.

■ Destination: None.

Column Name: RATE                                 

■ Value: Product price per UOM. 

■ Validation: None.
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■ Destination: None.

Column Name: ACTIVITY_TYPE             

■ Value: Indicates the type of promotional activity (Campaign, Event or 
Offer).

■ Validation: Must be a valid lookup_code in AMS_ACTIVITY_TYPE.

■ Destination: None.

■ ACTIVITY_ID .

■ Value: Internal identifier for the activity. 

■ Validation: Checks if the activity exists in OMO.

■ Destination: None.

Column Name: EARNINGS_ASSOCIATED_FLAG                           

■ Value: Indicates if earnings are associated to the claim. Do not populate. 

■ Validation: None.

■ Destination: None.

E.3 OZF_RESALE_LINES_INT_ALL
This is the claim interface table. It stores data that needs to be imported to ozf_
resale_lines_all, ozf_resale_headers_all, ozf_resale_adjustments_all table using 
OZF-TM: Third Party Accrual from Interface table.

Column Name: RESALE_LINE_INT_ID          

■ Value: Primary key of the ozf_resale_lines_int_all table. Can not be null for 
any record. 

■ Validation: None

■ Destination: None

Column Name: OBJECT_VERSION_NUMBER

■ Value: Version number of this record. Defaults to 1.

■ Validation: None

■ Destination: None

Column Name: RESALE_BATCH_ID
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■ Value: resale_batch_id to which the current line belongs.

■ Validation: Should be null before the import program.

■ Destination: ozf_resale_adjustments_all.RESALE_BATCH_ID

Column Name: STATUS_CODE

■ Value: Status of the current line

■ Validation: None

■ Destination: None

Column Name: RESALE_TRANSFER_TYPE 

■ Value: Transfer type of the current line

■ Validation: Based on lookup code with lookup type as 'OZF_RESALE_
TRANSFER_TYPE'

■ Destination: ozf_resale_lines_all.RESALE_TRANSFER_TYPE 

Column Name: PRODUCT_TRANSFER_MOVEMENT_TYPE

■ Value: transfer movement type of the current line

■ Validation: based on lookup code with lookup type as 'OZF_PRODUCT_
TSFR_MVMT_TYPE'

■ Destination: ozf_resale_lines_all.PRODUCT_TRANSFER_MOVEMENT_
TYPE

Column Name: PRODUCT_TRANSFER_DATE

■ Value: date of transfer for the current line

■ Validation: none

■ Destination: ozf_resale_lines_all.PRODUCT_TRANSFER_DATE

Column Name: SHIP_FROM_CUST_ACCOUNT_ID

■ Value: customer account id of the ship from party

■ Validation: It is cust_account_id in hz_cust_accounts  WHERE hz_cust_
accounts.status = 'A'

■ Destination: ozf_resale_lines_all.SHIP_FROM_CUST_ACCOUNT_ID, ozf_
resale_headers_all.SHIP_FROM_CUST_ACCOUNT_ID

Column Name: SHIP_FROM_SITE_ID
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■ Value: site id of the ship from party

■ Validation: none

■ Destination: ozf_resale_lines_all.SHIP_FROM_ SITE_ID

Column Name: SHIP_FROM_PARTY_NAME

■ Value: party name of the ship from party

■ Validation: none

■ Destination: ozf_resale_lines_all.SHIP_FROM_PARTY_NAME

Column Name: SHIP_FROM_LOCATION

■ Value: location of the ship from party

■ Validation: none

■ Destination: ozf_resale_lines_all.SHIP_FROM_LOCATION

Column Name: SHIP_FROM_ADDRESS 

■ Value: address of the ship from party

■ Validation: none

■ Destination: ozf_resale_lines_all.SHIP_FROM_ADDRESS

Column Name: SHIP_FROM_CITY

■ Value: city of the ship from party

■ Validation: none

■ Destination: ozf_resale_lines_all.SHIP_FROM_CITY

Column Name: SHIP_FROM_STATE 

■ Value: state of the ship from party

■ Validation: none

■ Destination: ozf_resale_lines_all.SHIP_FROM_STATE

Column Name: SHIP_FROM_POSTAL_CODE

■ Value: postal code of the ship from party

■ Validation: none

■ Destination: ozf_resale_lines_all.SHIP_FROM_POSTAL_CODE

Column Name: SHIP_FROM_COUNTRY 
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■ Value: country of the ship from party

■ Validation: none

■ Destination: ozf_resale_lines_all.SHIP_FROM_COUNTRY

Column Name: SHIP_FROM_CONTACT_PARTY_ID

■ Value: party id of contact of the ship from party

■ Validation: must be a party_id from hz_parties with "CONTACT_OF" 
relationship.

■ Destination: ozf_resale_lines_all.SHIP_FROM_CONTACT_PARTY_ID

Column Name: SHIP_FROM_CONTACT_PARTY_NAME

■ Value: party name of contact of the ship from party

■ Validation: must be a party_id from hz_parties with "CONTACT_OF" 
relationship.

■ Destination: ozf_resale_lines_all.SHIP_FROM_CONTACT_PARTY_ NAME

Column Name: SHIP_FROM_EMAIL

■ Value: email address of the contact of the ship from party

■ Validation: none

■ Destination: ozf_resale_lines_all.SHIP_FROM_EMAIL

Column Name: SHIP_FROM_PHONE

■ Value: phone number of the contact of the ship from party

■ Validation: none

■ Destination: ozf_resale_lines_all.SHIP_FROM_PHONE

Column Name: SHIP_FROM_FAX

■ Value: fax number of the contact of the ship from party

■ Validation: none

■ Destination: ozf_resale_lines_all.SHIP_FROM_FAX

Column Name: SOLD_FROM_CUST_ACCOUNT_ID

■ Value: customer account id of the sold from party

■ Validation: It is cust_account_id in hz_cust_accounts  WHERE hz_cust_
accounts.status = 'A'
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■ Destination: ozf_resale_lines_all.SOLD_FROM_CUST_ACCOUNT_ID, ozf_
resale_headers_all.SOLD_FROM_CUST_ACCOUNT_ID

Column Name: SOLD_FROM_SITE_ID

■ Value: site id of the sold from party

■ Validation: none

■ Destination: ozf_resale_lines_all.SOLD_FROM_ SITE_ID

Column Name: SOLD_FROM_PARTY_NAME

■ Value: party name of the sold from party

■ Validation: none

■ Destination: ozf_resale_lines_all.SOLD_FROM_PARTY_NAME

Column Name: SOLD_FROM_LOCATION

■ Value: location of the sold from party

■ Validation: none

■ Destination: ozf_resale_lines_all.SOLD_FROM_LOCATION

Column Name: SOLD_FROM_ADDRESS 

■ Value: address of the sold from party

■ Validation: none

■ Destination: ozf_resale_lines_all.SOLD_FROM_ADDRESS

Column Name: SOLD_FROM_CITY

■ Value: city of the sold from party

■ Validation: none

■ Destination: ozf_resale_lines_all.SOLD_FROM_CITY

Column Name: SOLD_FROM_STATE 

■ Value: state of the sold from party

■ Validation: none

■ Destination: ozf_resale_lines_all.SOLD_FROM_STATE

Column Name: SOLD_FROM_POSTAL_CODE

■ Value: postal code of the sold from party
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■ Validation: none

■ Destination: ozf_resale_lines_all.SOLD_FROM_POSTAL_CODE

Column Name: SOLD_FROM_COUNTRY 

■ Value: country of the sold from party

■ Validation: none

■ Destination: ozf_resale_lines_all.SOLD_FROM_COUNTRY

Column Name: SOLD_FROM_CONTACT_PARTY_ID

■ Value: party id of contact of the sold from party

■ Validation: must be a party_id from hz_parties with "CONTACT_OF" 
relationship.

■ Destination: ozf_resale_lines_all.SOLD_FROM_CONTACT_PARTY_ID

Column Name: SOLD_FROM_CONTACT_PARTY_NAME

■ Value: party name of contact of the sold from party

■ Validation: none

■ Destination: ozf_resale_lines_all.SOLD_FROM_CONTACT_PARTY_ 
NAME

Column Name: SOLD_FROM_EMAIL

■ Value: email address of the contact of the sold from party

■ Validation: none

■ Destination: ozf_resale_lines_all.SOLD_FROM_EMAIL

Column Name: SOLD_FROM_PHONE

■ Value: phone number of the contact of the sold from party

■ Validation: none

■ Destination: ozf_resale_lines_all.SOLD_FROM_PHONE

Column Name: SOLD_FROM_FAX

■ Value: fax number of the contact of the sold from party

■ Validation: none

■ Destination: ozf_resale_lines_all.SOLD_FROM_FAX
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Column Name: BILL_TO_CUST_ACCOUNT_ID

■ Value: customer account id of the bill to party

■ Validation: It is cust_account_id in hz_cust_accounts  WHERE hz_cust_
accounts.status = 'A'

■ Destination: ozf_resale_lines_all.BILL_TO_CUST_ACCOUNT_ID, ozf_
resale_headers_all.BILL_TO_CUST_ACCOUNT_ID

Column Name: BILL_TO_SITE_USE_ID

■ Value: site use id of the bill to party

■ Validation: Must be the site_use_id for "BILL_TO" site from hz_cust_site_
uses table for the customer

■ Destination: ozf_resale_lines_all.BILL_TO_ SITE_USE_ID, ozf_resale_
headers_all.BILL_TO_ SITE_USE_ID

Column Name: BILL_TO_PARTY_NAME

■ Value: party name of the bill to party

■ Validation: none

■ Destination: ozf_resale_lines_all.BILL_TO_PARTY_NAME, ozf_resale_
headers_all.BILL_TO_PARTY_NAME

Column Name: BILL_TO_PARTY_ID

■ Value: id of the bill to party

■ Validation: none

■ Destination: ozf_resale_lines_all.BILL_TO_PARTY_ID, ozf_resale_headers_
all.BILL_TO_PARTY_ID

Column Name: BILL_TO_PARTY_SITE_ID

■ Value: site id of the bill to party

■ Validation: none

■ Destination: ozf_resale_lines_all.BILL_TO_PARTY_SITE_ID, ozf_resale_
headers_all.BILL_TO_PARTY_SITE_ID

Column Name: BILL_TO_DUNS_NUMBER

■ Value: duns number of the bill to party

■ Validation: none
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■ Destination: ozf_resale_lines_all.BILL_TO_DUNS_NUMBER, ozf_resale_
headers_all.BILL_TO_DUNS_NUMBER

Column Name: BILL_TO_LOCATION

■ Value: location of the bill to party

■ Validation: none

■ Destination: ozf_resale_lines_all.BILL_TO_LOCATION

Column Name: BILL_TO_ADDRESS 

■ Value: address of the bill to party

■ Validation: none

■ Destination: ozf_resale_lines_all.BILL_TO_ADDRESS

Column Name: BILL_TO_CITY

■ Value: city of the bill to party

■ Validation: none

■ Destination: ozf_resale_lines_all.BILL_TO_CITY

Column Name: BILL_TO_STATE 

■ Value: state of the bill to party

■ Validation: none

■ Destination: ozf_resale_lines_all.BILL_TO_STATE

Column Name: BILL_TO_POSTAL_CODE

■ Value: postal code of the bill to party

■ Validation: none

■ Destination: ozf_resale_lines_all.BILL_TO_POSTAL_CODE

Column Name: BILL_TO_COUNTRY 

■ Value: country of the bill to party

■ Validation: none

■ Destination: ozf_resale_lines_all.BILL_TO_COUNTRY

Column Name: BILL_TO_CONTACT_PARTY_ID

■ Value: party id of contact of the bill to party
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■ Validation: must be a party_id from hz_parties with "CONTACT_OF" 
relationship.

■ Destination: ozf_resale_lines_all.BILL_TO_CONTACT_PARTY_ID

Column Name: BILL_TO_CONTACT_PARTY_NAME

■ Value: party name of contact of the bill to party

■ Validation: none

■ Destination: ozf_resale_lines_all.BILL_TO_CONTACT_PARTY_ NAME

Column Name: BILL_TO_EMAIL

■ Value: email address of the contact of the bill to party

■ Validation: none

■ Destination: ozf_resale_lines_all.BILL_TO_EMAIL

Column Name: BILL_TO_PHONE

■ Value: phone number of the contact of the bill to party

■ Validation: none

■ Destination: ozf_resale_lines_all.BILL_TO_PHONE

Column Name: BILL_TO_FAX

■ Value: fax number of the contact of the bill to party

■ Validation: none

■ Destination: ozf_resale_lines_all.BILL_TO_FAX

Column Name: SHIP_TO_CUST_ACCOUNT_ID

■ Value: customer account id of the ship to party

■ Validation: It is cust_account_id in hz_cust_accounts  WHERE hz_cust_
accounts.status = 'A'

■ Destination: ozf_resale_lines_all.SHIP_TO_CUST_ACCOUNT_ID, ozf_
resale_headers_all.SHIP_TO_CUST_ACCOUNT_ID

Column Name: SHIP_TO_SITE_USE_ID

■ Value: site use id of the ship to party

■ Validation: Must be the site_use_id for "SHIP_TO" site from hz_cust_site_
uses table for the customer
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■ Destination: ozf_resale_lines_all.SHIP_TO_ SITE_USE_ID, ozf_resale_
headers_all.SHIP_TO_ SITE_USE_ID

Column Name: SHIP_TO_PARTY_NAME

■ Value: party name of the ship to party

■ Validation: none

■ Destination: ozf_resale_lines_all.SHIP_TO_PARTY_NAME, ozf_resale_
headers_all.SHIP_TO_PARTY_NAME

Column Name: SHIP_TO_PARTY_ID

■ Value: id of the ship to party

■ Validation: none

■ Destination: ozf_resale_lines_all.SHIP_TO_PARTY_ID, ozf_resale_headers_
all.SHIP_TO_PARTY_ID

Column Name: SHIP_TO_PARTY_SITE_ID

■ Value: site id of the ship to party

■ Validation: none

■ Destination: ozf_resale_lines_all.SHIP_TO_PARTY_SITE_ID, ozf_resale_
headers_all.SHIP_TO_PARTY_SITE_ID

Column Name: SHIP_TO_DUNS_NUMBER

■ Value: duns number of the ship to party

■ Validation: none

■ Destination: ozf_resale_lines_all.SHIP_TO_DUNS_NUMBER, ozf_resale_
headers_all.SHIP_TO_DUNS_NUMBER

Column Name: SHIP_TO_LOCATION

■ Value: location of the ship to party

■ Validation: none

■ Destination: ozf_resale_lines_all.SHIP_TO_LOCATION

Column Name: SHIP_TO_ADDRESS 

■ Value: address of the ship to party

■ Validation: none
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■ Destination: ozf_resale_lines_all.SHIP_TO_ADDRESS

Column Name: SHIP_TO_CITY

■ Value: city of the ship to party

■ Validation: none

■ Destination: ozf_resale_lines_all.SHIP_TO_CITY

Column Name: SHIP_TO_STATE 

■ Value: state of the ship to party

■ Validation: none

■ Destination: ozf_resale_lines_all.SHIP_TO_STATE

Column Name: SHIP_TO_POSTAL_CODE

■ Value: postal code of the ship to party

■ Validation: none

■ Destination: ozf_resale_lines_all.SHIP_TO_POSTAL_CODE

Column Name: SHIP_TO_COUNTRY 

■ Value: country of the ship to party

■ Validation: none

■ Destination: ozf_resale_lines_all.SHIP_TO_COUNTRY

Column Name: SHIP_TO_CONTACT_PARTY_ID

■ Value: party id of contact of the ship to party

■ Validation: must be a party_id from hz_parties with "CONTACT_OF" 
relationship.

■ Destination: ozf_resale_lines_all.SHIP_TO_CONTACT_PARTY_ID

Column Name: SHIP_TO_CONTACT_PARTY_NAME

■ Value: party name of contact of the ship to party

■ Validation: none

■ Destination: ozf_resale_lines_all.SHIP_TO_CONTACT_PARTY_ NAME

Column Name: SHIP_TO_EMAIL

■ Value: email address of the contact of the ship to party
E-32 Oracle Trade Management Implementation Guide



OZF_RESALE_LINES_INT_ALL
■ Validation: none

■ Destination: ozf_resale_lines_all.SHIP_TO_EMAIL

Column Name: SHIP_TO_PHONE

■ Value: phone number of the contact of the ship to party

■ Validation: none

■ Destination: ozf_resale_lines_all.SHIP_TO_PHONE

Column Name: SHIP_TO_FAX

■ Value: fax number of the contact of the ship to party

■ Validation: none

■ Destination: ozf_resale_lines_all.SHIP_TO_FAX

 Column Name: END_CUST_PARTY_ID

■ Value: id of the end customer party

■ Validation: none

■ Destination: ozf_resale_lines_all.END_CUST_PARTY_ID, ozf_resale_
headers_all.END_CUST_PARTY_ID

Column Name: END_CUST_SITE_USE_ID

■ Value: site use id of the end customer 

■ Validation: none

■ Destination: ozf_resale_lines_all.END_CUST_ SITE_USE_ID, ozf_resale_
headers_all.END_CUST_ SITE_USE_ID

Column Name: END_CUST_SITE_USE_CODE

■ Value: site use code of the end customer

■ Validation: none

■ Destination: ozf_resale_lines_all.END_CUST_SITE_USE_CODE, ozf_resale_
headers_all.END_CUST_SITE_USE_CODE

Column Name: END_CUST_PARTY_SITE_ID

■ Value: site id of the end customer 

■ Validation: none
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■ Destination: ozf_resale_lines_all.END_CUST_PARTY_SITE_ID, ozf_resale_
headers_all.END_CUST_PARTY_SITE_ID

Column Name: END_CUST_PARTY_NAME

■ Value: party name of the end customer 

■ Validation: none

■ Destination: ozf_resale_lines_all.END_CUST_PARTY_NAME, ozf_resale_
headers_all.END_CUST_PARTY_NAME

Column Name: END_CUST_LOCATION

■ Value: location of the end customer

■ Validation: none

■ Destination: ozf_resale_lines_all.END_CUST_LOCATION

Column Name: END_CUST_ADDRESS 

■ Value: address of the end customer 

■ Validation: none

■ Destination: ozf_resale_lines_all.END_CUST_ADDRESS

Column Name: END_CUST_CITY

■ Value: city of the end customer

■ Validation: none

■ Destination: ozf_resale_lines_all.END_CUST_CITY

Column Name: END_CUST_STATE 

■ Value: state of the end customer

■ Validation: none

■ Destination: ozf_resale_lines_all.END_CUST_STATE

Column Name: END_CUST_POSTAL_CODE

■ Value: postal code of the end customer

■ Validation: none

■ Destination: ozf_resale_lines_all.END_CUST_POSTAL_CODE

Column Name: END_CUST_COUNTRY 
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■ Value: country of the end customer

■ Validation: none

■ Destination: ozf_resale_lines_all.END_CUST_COUNTRY

Column Name: END_CUST_CONTACT_PARTY_ID

■ Value: party id of contact of the end customer

■ Validation: must be a party_id from hz_parties with "CONTACT_OF" 
relationship.

■ Destination: ozf_resale_lines_all.END_CUST_CONTACT_PARTY_ID

Column Name: END_CUST_CONTACT_PARTY_NAME

■ Value: party name of contact of the end customer

■ Validation: none

■ Destination: ozf_resale_lines_all.END_CUST_CONTACT_PARTY_ NAME

Column Name: END_CUST_EMAIL

■ Value: email address of the contact of the end customer

■ Validation: none

■ Destination: ozf_resale_lines_all.END_CUST_EMAIL

Column Name: END_CUST_PHONE

■ Value: phone number of the contact of the end customer

■ Validation: none

■ Destination: ozf_resale_lines_all.END_CUST_PHONE

Column Name: END_CUST_FAX

■ Value: fax number of the contact of the end customer

■ Validation: none

■ Destination: ozf_resale_lines_all.END_CUST_FAX

Column Name: DIRECT_CUSTOMER_FLAG

■ Value: Indicator whether the order is made by a direct cusotmer   

■ Validation: none

■ Destination: ozf_resale_lines_all.DIRECT_CUSTOMER_FLAG
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Column Name: ORDER_TYPE_ID

■ Value: id of the order type  

■ Validation: none

■ Destination: ozf_resale_lines_all.ORDER_TYPE_ID

Column Name: ORDER_CATEGORY

■ Value:category of the order   

■ Validation: none

■ Destination: ozf_resale_lines_all.ORDER_CATEGORY

Column Name: AGREEMENT_TYPE

■ Value: type of the agreement. 

■ Validation: has value of 'PL' or 'SPO'

■ Destination: ozf_resale_adjustments_all.AGREEMENT_TYPE

Column Name: AGREEMENT_ID

■ Value: ID of the agreement. 

■ Validation: none

■ Destination: ozf_resale_adjustments_all.AGREEMENT_ID

Column Name: AGREEMENT_NAME

■ Value: name of the agreement. 

■ Validation: none

■ Destination: ozf_resale_adjustments_all.AGREEMENT_NAME

Column Name: AGREEMENT_PRICE

■ Value: price based on the agreement. 

■ Validation: none

■ Destination: ozf_resale_adjustments_all.AGREEMENT_PRICE

Column Name: AGREEMENT_UOM

■ Value: unit of measure based on the agreement. 

■ Validation: none

■ Destination: ozf_resale_adjustments_all.AGREEMENT_UOM
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Column Name: CORRECTED_AGREEMENT_ID

■ Value: ID of the corrected agreement. 

■ Validation: none

■ Destination: ozf_resale_adjustments_all.CORRECTED_AGREEMENT_ID

Column Name: CORRECTED_AGREEMENT_NAME

■ Value: name of the corrected agreement. 

■ Validation: none

■ Destination: ozf_resale_adjustments_all.CORRECTED_AGREEMENT_
NAME

Column Name: PRICE_LIST_ID

■ Value: id of the price list. 

■ Validation: none

■ Destination: ozf_resale_lines_all.PRICE_LIST_ID

Column Name: PRICE_LIST_NAME

■ Value: name of the price list. 

■ Validation: none

■ Destination: ozf_resale_lines_all.PRICE_LIST_NAME

Column Name: ORIG_SYSTEM_REFERENCE

■ Value: reference of the line in distributor's system 

■ Validation: none

■ Destination: ozf_resale_lines_all.ORIG_SYSTEM_REFERENCE

Column Name: ORIG_SYSTEM_LINE_REFERENCE

■ Value: reference of the line in distributor's system 

■ Validation: none

■ Destination: ozf_resale_lines_all.ORIG_SYSTEM_LINE_REFERENCE

Column Name: ORIG_SYSTEM_CURRENCY_CODE

■ Value: currency code in distributor's system 

■ Validation: none
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■ Destination: ozf_resale_lines_all.ORIG_SYSTEM_CURRENCY_CODE

Column Name: ORIG_SYSTEM_SELLING_PRICE

■ Value: selling price of the line in orig_system_curreny_code 

■ Validation: none

■ Destination: ozf_resale_lines_all.ORIG_SYSTEM_SELLING_PRICE

Column Name: ORIG_SYSTEM_UOM 

■ Value: unit of measure in distributor's system 

■ Validation: none

■ Destination: ozf_resale_lines_all.ORIG_SYSTEM_UOM

Column Name: ORIG_SYSTEM_QUANTITY

■ Value: quantity in orig_system_UOM 

■ Validation: none

■ Destination: ozf_resale_lines_all.ORIG_SYSTEM_QUANTITY

Column Name: ORIG_SYSTEM_PURCHASE_UOM

■ Value: unit of measure of in distributor's system when the purchase was 
made 

■ Validation: none

■ Destination: ozf_resale_lines_all.ORIG_SYSTEM_PURCHASE_UOM

Column Name: ORIG_SYSTEM_PURCHASE_QUANTITY

■ Value: quantity of the product in orig_system_purchase_uom when the 
purchase was made 

■ Validation: none

■ Destination: ozf_resale_lines_all.ORIG_SYSTEM_PURCHASE_QUANTITY

Column Name: ORIG_SYSTEM_PURCHASE_CURR

■ Value: concurrency code in distributor's system when the purchase was 
made 

■ Validation: none

■ Destination: ozf_resale_lines_all.ORIG_SYSTEM_PURCHASE_CURR

Column Name: ORIG_SYSTEM_PURCHASE_PRICE
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■ Value: price in orig_system_purchase_curr when the purchase was made 

■ Validation: none

■ Destination: ozf_resale_lines_all.ORIG_SYSTEM_PURCHASE_PRICE

Column Name: ORIG_SYSTEM_ITEM_NUMBER

■ Value: item number in distributor's system 

■ Validation: none

■ Destination: ozf_resale_lines_all.ORIG_SYSTEM_ITEM_NUMBER

 Column Name: ORIG_SYSTEM_PURCHASE_PRICE

■ Value: price in orig_system_purchase_curr when the purchase was made 

■ Validation: none

■ Destination: ozf_resale_lines_all.ORIG_SYSTEM_PURCHASE_PRICE

Column Name: ORIG_SYSTEM_AGREEMENT_UOM

■ Value: unit of the measurement in agreement in distributor's system 

■ Validation: none

■ Destination: ozf_resale_adjustments_all.ORIG_SYSTEM_AGREEMENT_
UOM

Column Name: ORIG_SYSTEM_AGREEMENT_NAME

■ Value: name of agreement in distributor's system 

■ Validation: none

■ Destination: ozf_resale_ adjustments_all.ORIG_SYSTEM_AGREEMENT_
NAME

Column Name: ORIG_SYSTEM_AGREEMENT_TYPE

■ Value: type of agreement in distributor's system 

■ Validation: none

■ Destination: ozf_resale_adjustments_all.ORIG_SYSTEM_AGREEMENT_
TYPE

Column Name: ORIG_SYSTEM_AGREEMENT_STATUS

■ Value: status of the agreement in distributor's system 

■ Validation: none
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■ Destination: ozf_resale_adjustments_all.ORIG_SYSTEM_AGREEMENT_
STATUS

Column Name: ORIG_SYSTEM_AGREEMENT_CURR

■ Value: currency code of the agreement in distributor's system 

■ Validation: none

■ Destination: ozf_resale_adjustments_all.ORIG_SYSTEM_AGREEMENT_
CURR

Column Name: ORIG_SYSTEM_AGREEMENT_PRICE

■ Value: price in orig_system_agreement_curr 

■ Validation: none

■ Destination: ozf_resale_adjustments_all.ORIG_SYSTEM_AGREEMENT_
PRICE

Column Name: ORIG_SYSTEM_AGREEMENT_QUANTITY

■ Value: quantity of the product in orig_system_agreement_uom 

■ Validation: none

■ Destination: ozf_resale_adjustments_all.ORIG_SYSTEM_AGREEMENT_
QUANTITY

Column Name: CURRENCY_CODE

■ Value: Currency code for the current transaction.  

■ Validation: Must exist in FND_CURRENCIES.CURRENCY_CODE

■ Destination: ozf_resale_lines_all.currency_code

Column Name: EXCHANGE_RATE_TYPE

■ Value: Enter the exchange rate type for this transaction. If the currency of 
the transaction is not the same as the functional currency, the one of the 
following combination should exist, exchange_rate_type and exchange_rate 
or exchange_rate_type and exchange_rate_date. Otherwise, we will default 
the exchange_rate_type based on the ozf_sys_parameters_all table and 
exchange_rate_date base on current sysdate.  

■ Validation:  Must exist in GL_DAILY_CONVERSION_TYPES. 
CONVERSION_TYPE

■ Destination: ozf_resale_lines_all.EXCHANGE_RATE_TYPE
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Column Name: EXCHANGE_RATE_DATE

■ Value: The date when the exchange happened  

■ Validation: none

■ Destination: ozf_ resale_lines_all.EXCHANGE_RATE_DATE

Column Name: EXCHANGE_RATE

■ Value: The exchange rate between transactional and functional currency

■ Validation: If ozf_claims_int_all.exchange_rate_TYPE = 'User' then this 
column must not be null; otherwise, it must be null.

■ Destination: ozf_ resale_lines_all.EXCHANGE_RATE

Column Name: PO_NUMBER

■ Value: purchase number

■ Validation: none.

■ Destination: ozf_ resale_lines_all.PO_NUMBER

Column Name: PO_RELEASE_NUMBER

■ Value: purchase release number

■ Validation: none.

■ Destination: ozf_ resale_lines_all.PO_RELEASE_NUMBER

Column Name: PO_TYPE

■ Value: purchase type

■ Validation: none.

■ Destination: ozf_ resale_lines_all.PO_TYPE

Column Name: INVOICE_NUMBER

■ Value: invoice number in distributor's system

■ Validation: none.

■ Destination: ozf_ resale_lines_all.INVOICE_NUMBER

Column Name: DATE_INVOICE

■ Value: date of invoice

■ Validation: none.
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■ Destination: ozf_ resale_lines_all.DATE_INVOICE

Column Name: ORDER_NUMBER

■ Value: order number

■ Validation: none.

■ Destination: ozf_ resale_lines_all.ORDER_NUMBER

Column Name: DATE_ORDERED

■ Value: date of the order

■ Validation: none.

■ Destination: ozf_ resale_lines_all.DATE_ORDERED

Column Name: DATE_SHIPPED

■ Value: date of the shippment

■ Validation: none.

■ Destination: ozf_ resale_lines_all.DATE_SHIPPED

Column Name: CLAIMED_AMOUNT

■ Value: claimed amount per unit 

■ Validation: none

■ Destination: ozf_resale_adjustments_all.CLAIMED_AMOUNT

Column Name: ALLOWED_AMOUNT

■ Value: allowed amount per unit 

■ Validation: none

■ Destination: ozf_resale_adjustments_all.ALLOWED_AMOUNT

Column Name: ACCEPTED_AMOUNT

■ Value: amount accepted by the system

■ Validation: none

■ Destination: ozf_resale_adjustments_all.ACCEPTED_AMOUNT

Column Name: TOTAL_CLAIMED_AMOUNT

■ Value: total claimed amount by distributor 

■ Validation: none
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■ Destination: ozf_resale_adjustments_all. TOTAL_CLAIMED_AMOUNT

Column Name: TOTAL_ALLOWED_AMOUNT

■ Value: total allowed amount by calculation 

■ Validation: none

■ Destination: ozf_resale_adjustments_all. TOTAL_ALLOWED_AMOUNT

Column Name: TOTAL_ACCEPTED_AMOUNT

■ Value: total amount accepted by the system

■ Validation: none

■ Destination: ozf_resale_adjustments_all. TOTAL_ACCEPTED_AMOUNT

Column Name: LINE_TOLERANCE_AMOUNT

■ Value: tolerance amount of the line

■ Validation: none

■ Destination: ozf_resale_adjustments_all. LINE_TOLERANCE_AMOUNT

Column Name: TOLERANCE_FLAG

■ Value: indicator to use tolerance for the calculation

■ Validation: none

■ Destination: ozf_resale_adjustments_all. TOLERANCE_FLAG

Column Name: PURCHASE_PRICE

■ Value: price of which distirbutor purchase the product

■ Validation: none

■ Destination: ozf_resale_lines_all. PURCHASE_PRICE

Column Name: PURCHASE_UOM_CODE

■ Value: uom_code at the time of purchase

■ Validation: none

■ Destination: ozf_resale_lines_all. PURCHASE_UOM_CODE

Column Name: ACCTD_PURCHASE_PRICE

■ Value: purchase price of functional currency code

■ Validation: none
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■ Destination: ozf_resale_lines_all. ACCTD_PURCHASE_PRICE

Column Name: SELLING_PRICE 

■ Value: price of which distirbutor sold the product

■ Validation: none

■ Destination: ozf_resale_lines_all. SELLING_PRICE

Column Name: ACCTD_SELLING_PRICE 

■ Value: price of which distirbutor sold the product in functional currency

■ Validation: none

■ Destination: ozf_resale_lines_all. ACCTD_SELLING_PRICE

Column Name: UOM_CODE

■ Value: unit of measure of the product 

■ Validation: none

■ Destination: ozf_resale_lines_all. UOM_CODE

Column Name: QUANTITY 

■ Value: quantity of the product in uom_code

■ Validation: none

■ Destination: ozf_resale_lines_all.QUANTITY

Column Name: CALCULATED_PRICE

■ Value: price based on the agreement id

■ Validation: none

■ Destination: ozf_resale_adjustments_all.CALCULATED_PRICE

Column Name: ACCTD_CALCULATED_PRICE

■ Value: calculated price based on functional currency code

■ Validation: none

■ Destination: ozf_resale_adjustments_all.ACCTD_CALCULATED_PRICE

Column Name: CALCULATED_AMOUNT

■ Value: CALCULATED_price * quantity

■ Validation: none
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■ Destination: ozf_resale_adjustments_all.CALCULATED_AMOUNT

Column Name: CREDIT_CODE

■ Value: 'C' OR 'D'

■ Validation: none

■ Destination: ozf_resale_adjustments_all.CREDIT_CODE

Column Name: CREDIT_ADVICE_DATE

■ Value: none

■ Validation: none

■ Destination: ozf_resale_adjustments_all. CREDIT_ADVICE_DATE

Column Name: UPC_CODE 

■ Value: UPC code of the product

■ Validation: none

■ Destination: ozf_resale_lines_all. UPC_CODE

Column Name: INVENTORY_ITEM_ID 

■ Value: id of the product 

■ Validation: none

■ Destination: ozf_resale_lines_all. INVENTORY_ITEM_ID

Column Name: ITEM_NUMBER

■ Value: item number of the product

■ Validation: none

■ Destination: ozf_resale_lines_all. ITEM_NUMBER

Column Name: ITEM_DESCRIPTION 

■ Value: description of the product 

■ Validation: none

■ Destination: ozf_resale_lines_all. ITEM_DESCRIPTION

Column Name: INVENTORY_ITEM_SEGMENT1-20 

■ Value: item segment 1-20 of the product 

■ Validation: none
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■ Destination: ozf_resale_lines_all.INVENTORY_ITEM_SEGMENT1-20

Column Name: PRODUCT_CATEGORY_ID

■ Value: id of the product category

■ Validation: none

■ Destination: ozf_resale_lines_all. PRODUCT_CATEGORY_ID

Column Name: CATEGORY_NAME

■ Value: name of the product category 

■ Validation: none

■ Destination: ozf_resale_lines_all. CATEGORY_NAME

Column Name: RESPONSE_TYPE

■ Value: response type

■ Validation: none

■ Destination: ozf_resale_lines_all. RESPONSE_TYPE

Column Name: RESPONSE_CODE

■ Value: response code

■ Validation: none

■ Destination: ozf_resale_lines_all. RESPONSE_CODE

Column Name: REJECT_REASON_CODE

■ Value: reason of the rejection 

■ Validation: none

■ Destination: ozf_resale_lines_all. REJECT_REASON_CODE

Column Name: FOLLOWUP_ACTION_CODE

■ Value: followup action code 

■ Validation: none

■ Destination: ozf_resale_lines_all. FOLLOWUP_ACTION_CODE

Column Name: DISPUTE_CODE

■ Value: dispute code of the line

■ Validation: none
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■ Destination: ozf_resale_lines_all. DISPUTE_CODE

Column Name: TRACING_FLAG

■ Value: indicator whether it's tracing order

■ Validation: none

■ Destination: ozf_resale_lines_all.TRACING_FLAG

Column Name :HEADER_ATTRIBUTE_CATEGORY

■ Value: Enter the Descriptive Flexfield category information for this 
transaction. Descriptive Flexfield categories allow you to store different 
categories of attributes. This column is optional.

■ Validation:  None

■ Destination:  ozf_resale_headers_all.HEADER _ATTRIBUTE_CATEGORY

Column Name:HEADER_ATTRIBUTE1-15

■ Value: Enter the Descriptive Flexfield attribute information for this 
transaction. Descriptive Flexfield attributes allow you to store additional 
columns, the contents of which you define. These columns are optional.

■ Validation:  None

■ Destination:  ozf_resale_headers_all.HEADER_ATTRIBUTE1-15

Column Name :LINE_ATTRIBUTE_CATEGORY

■ Value: Enter the Descriptive Flexfield category information for this 
transaction. Descriptive Flexfield categories allow you to store different 
categories of attributes. This column is optional.

■ Validation:  None

■ Destination:  ozf_resale_lines_all.LINE_ATTRIBUTE_CATEGORY

Column Name:LINE_ATTRIBUTE1-15

■ Value: Enter the Descriptive Flexfield attribute information for this 
transaction. Descriptive Flexfield attributes allow you to store additional 
columns, the contents of which you define. These columns are optional.

■ Validation:  None

■ Destination:  ozf_resale_lines_all.LINE_ATTRIBUTE1-15
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